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1
Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services Lending
and Leasing. Since this section details the general options available in the User Interface,
some or all the parts of this section are applicable to you as per access provisions & licensing.

Note

The application can be best viewed in 1280 x 1024 screen resolution.

The document is organized into below topics:

• Audience

• Conventions Used

• Logging In

• Template and Navigation

• Common Operations

• Keyboard Compatibility

• Tool Tips

• Accessibility

1.1 Audience
This document is intended to all Prospective Users who would be working on the application.

1.2 Conventions Used
Table 1-1    Conventions

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

1.3 Logging In
The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system
administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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When you invoke the application, the Sign In screen is displayed.

Figure 1-1    Login page

• User ID – Specify a valid User ID.

• Password – Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

1.4 Template and Navigation
This section provides a brief input on the template and navigation of the system.

Details are grouped into two categories to enable easy understanding. These include:

• Home Screen

• Screens

1.4.1 Home Screen
Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

• Header

• Left Pane

• Right Pane/Work Area

Chapter 1
Template and Navigation
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Figure 1-2    Home screen

You can view the application version details and copyright information by clicking About link at
the right bottom corner of the screen.

Figure 1-3    About

Header

In the Header, system displays the following:

• Sign Out [Environment] - Sign Out option along with the application environment details
based on information maintained in ENVIRONMENT_TYPE_CD lookup code.

• User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow, the
system displays the following options:

Chapter 1
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Figure 1-4    User ID - Options

– Change Password – Click to change the current password.

Figure 1-5    Change Password

Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

– User Info – Click to view the current user info.

Figure 1-6    User Info

Chapter 1
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In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language – Select a language that you need to set for the session, from the
drop-down list.

Debug Enabled Ind – Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the following
two types of system parameters:

Table 1-2    System Parameter

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES_HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then
the debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database Server
Log Files.

You can click on  List Files button to view the list of logged files.

Figure 1-7    Database Server Log files

Click on  Show File button to view the selected file contents in the File Content

section. You can also click  Download File button to extract a copy of debug
details.

Chapter 1
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Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of this
user manual.

Click Submit to save the changes or Close to close the screen without changes.

• Accessibility – Click the link to view accessibility features of the system.
Refer accessibility document for further details.

• NextGenUI - This is Next Generation User Interface option which is an enhanced interface
provided in OFSLL using the Oracle JavaScript Extension Toolkit (Oracle JET) frame work.
This is an additional interface supported from OFSLL to the existing system and both
intended to coexist in the system till further updates.
This option is enabled only if the corresponding system parameter is enabled in the base
system as configured by your system administrator. For more information, refer to
Appendix - Oracle JET Interface section in Servicing guide.

• Sign Out – Click the link to sign off from the application. You can also click on

 icon to sign off from the application.

Left Window

In the left pane, system lists and provides drop-down links for various modules available in the
product. Click  to expand the Module Master Tabs and  to collapse them.
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Figure 1-8    Left Pane

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press Enter. The screen is
displayed in the main window/work area.
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Figure 1-9    Left Pane Search

When there are multiple matches with same screen name, you can filter the results through the
module from which the screen is accessed which is indicated in angular brackets. For example
typing VEN displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

Figure 1-10    Right Pane

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.
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Figure 1-11    15 Screens

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background. Also,
operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications Accounts at the same time as separate tabs in the
right window, provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'
= 'Y’ in MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 ApplicationsAccounts in
parallel tabs and Oracle Financial Services Lending and Leasing renders dynamic data across
all the opened tabs.

However, this option is restricted only to the following screens in OriginationServicing Module
Master Tab. In the Left Menu of Origination Module Master Tab, you can open multiple
applications by clicking on the following links. Each successive click, opens a new Origination
tab.

• Simple Application Entry

• Application Entry

• Underwriting

• Funding

Chapter 1
Template and Navigation

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 9 of 26



Figure 1-12    Multi tab - Origination

In the Left Menu of Servicing Module Master Tab, you can open multiple accounts by clicking
on the Customer Service link. Each successive click, opens a new Customer Service tab.

Figure 1-13    Multi tab - Servicing

Few screens in OriginationServicing and CollectionsWFP are identical and are linked. Hence,
when multi tab option is not enabled, you can open only one screen at a time from the group. A
sample of the grouping structure is given below, based on stages of the screens:

Origination:
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• Simple Application Entry

• Application Entry

• Underwriting

• Funding

Collection:

• Collection

• Bankruptcy

• Repossession

• Deficiency

WFP

• Producers

• Credit Lines

• Units

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on Application and Customer Service screens. You can
click  and  to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

Figure 1-14    Right Split Window Application

• Use Quick Search to search for an application based on application number, last 4 digits
of SSN (SSN of the primary applicant) or identification number. If multiple applications or
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accounts are found during Identification # search, the system displays an error message
as “Multiple Matches found for the Identification #, Please use normal Search”.

• Summary section displays critical information that has to be referred repeatedly during
origination like – DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate and
Term.

• Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the Change Status will be read-only.

• Use Add Comment section to post an alert or comment during Underwriting and Funding
stages.
For detailed information on the above options, refer to respective sections in the document.

Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

Figure 1-15    Right Split Window Customer Service

• Use Quick Search to search for an account based on account number, or customer Id, or
last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during Identification # search, the system displays an
error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking Next Account button opens the subsequent account listed in search and clicking
Filtered Account opens the subsequent account fetched during a queue search and listed
in Queue Assignment section.

• Use Add Comment section to post an alert or comment based on Type and Sub Type.

• Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is similar
to the option available in Call Activities sub tab under Customer Service tab.
For detailed information on the above options, refer to respective sections in the document.
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The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click  to toggle upper pane and  to toggle left pane.
To un-toggle click  and  respectively.

This section consists of the following topic:

• Time Zone Preference

1.4.1.1 Time Zone Preference

Figure 1-16    User Info

You can select any of the following three time zones from the User Info screen:

• Application Server Time Zone

• Company Branch Time Zone

• User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at UI does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)
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This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

• Navigate to Setup > Administration > User > Organization and select the company or
division listed under Division Definition.

• In the Display Formats tab, select Time Zone and click Edit.

• In the Format field, select the required time zone from the adjoining options list and click
Save.

If Company Branch Time Zone is selected as the time zone in User Info screen, then on
save, all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:

• Navigate to Setup > Administration > User > Users.

• Select the required User record listed in User Definition section and click Edit.

• In the Time Zone field, select the required time zone from the adjoining options list and
click Save.

If User Time Zone is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

1.4.2 Screens
Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped. As
similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on Customer
Service tab, the corresponding tabs are displayed.

Figure 1-17    Customer Service_Example
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You can click  to view the hidden tabs, if any.

1.5 Common Operations
Some of the operations are common to most of the screens.

These are grouped into following categories, based on their features.

• Basic Operations

• Basic Actions

• Personalization Options

• De-supported Special characters

• Skip Zip Code Validation

• Export data to Excel

1.5.1 Basic Operations
All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

• Add

• Edit

• View

• Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Table 1-3    Basic Operation

Basic Operation Description

Add Click to add a new record. When you click Add, the
system displays a new record enabling you to
specify the required data. It is mandatory to specify
details for the fields marked with ‘*’ symbol.

Edit Click to edit an existing record. Select the record
you want to edit and click Edit. The system
displays an existing record in editable mode. Edit
the required details.

View Click to view an existing record. Select the record
you want to view and click View. The system
displays the record details in display mode.

Audit Click to view audit info. If an audit is set for a field,
then the system tracks the changes for that field.
Select the record for which you want to view the
audit info and click Audit. The system displays the
details tracked for that field.
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Table 1-3    (Cont.) Basic Operation

Basic Operation Description

Close Click to close a screen or a record. When you try to
close an unsaved, modified record, then the system
alerts you with an error message. You can click Yes
to continue and No to save the record.

1.5.2 Basic Actions
Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

The table below gives a snapshot of them:

Table 1-4    Basic Actions

Basic Actions Description

Save And Add Click to save and add a new record. This button is
displayed when you click Add button.

Save and Stay Click to save and remain in the same page. This
button is displayed when you click Add/Edit button.

Save And Return Click to save and return to main screen. This button
is displayed when you click Add or Edit buttons.

Return Click to return to main screen without
modifications. This button is displayed when you
click Add, Edit or View buttons.

The Payment maintenance screens consist of the following actions.

The table below gives a snapshot of them:

Table 1-5    Basic Actions

Basic Actions Description

Post and Stay Click to post the transaction and remain in the
same section. This button is displayed when you
click Modify Payment/Modify Payment
Transaction button.

Post and Return Click to save and return to main section. This
button is displayed when you click Modify
Payment/Modify Payment Transaction buttons.

Return Click to return to main section without
modifications. This button is displayed when you
click Modify Payment/Modify Payment
Transaction buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Table 1-6    Navigations

Basic Actions Description

 

 

Click to navigate to the first record.

 

 

Click to navigate to the previous record.

 

 

Click to navigate to the next record.

 

 

Click to navigate the last record.

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Table 1-7    Buttons for Specific actions

Basic Actions Description

 

 

Show File - Click to view the details of selected file.

 

 

List Files - Click to generate and view the list of
files maintained in the system.

 

 

Download File - Click to download the details of
selected data.

1.5.3 Personalization Options
You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

Figure 1-18    Personalization Operations

The table below gives a snapshot of them:
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Table 1-8    Personalization Options

Options Description

View Click to personalize your view. The drop-down list provides the following
options of customization:
• Customize columns you wish to view
• Sort the order of displayed data
• Reorder columns

Additionally, the drop-down list provides selection of options adjoining
View.
 

 

Format Click to resize columns or wrap a data in the table cells.

 

 

Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

 

 

Specify the Width and unit for the selected column. Click OK to apply
changes and Cancel to revert.

Query by Example Click to query for the data by an example. When this option is selected,
the system displays an empty row above column heads. You can specify
all or any of the details of the record you wish to query.

 

 

Freeze Select the column at which you need to freeze the table and click
Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Table 1-8    (Cont.) Personalization Options

Options Description

Wrap Select the column in which the data needs to be wrapped and click
Wrap.
 

 

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens have
View Last option to sort the volume of data being displayed on screen
based on elapsed days.

 

 

You can select the View Last option as 1 Day / 1 Week / 1 Month / By
Date. When By Date is selected you can specify a date range (within 3
months) in Start Dt and End Dt fields using the adjoining calendar and
clicking Search.

Print option in Customer Service screen

The Print button  option in Customer Service/Collection screen facilitates you to print
the contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new tab
is opened where the print content is displayed.

Detach
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Figure 1-19    Detached Table

Click Add, Edit or View button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you provide
the alphabet, system limits the selection to the values starting with the specified alphabet.
These lists are grouped into two types:

• Drop-down list – Provides the selection option. You can either select a record from the list
or enter first alphabet of the required value.

• Combo drop-down list – The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

Figure 1-20    Combo drop-down

Click the arrow button available before Search to toggle the search options.
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Table 1-9    Search options

Buttons/Menu Do this

Basic Click Basic for normal search.

Advanced Click Advanced for advanced search. In this mode,
you can select the search option from drop-down
list adjoining the search criteria. Selected record
will be highlighted (Hover to select).

Match Select All to display results exactly matching the
specified characters. Select Any to display results
matching any of the specified characters.

Search Click to search for values based on the specified
search criteria. The search results are displayed
below with the details in respective columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the Match field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual
ones.

Figure 1-21    Search Memory

Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

1.5.4 De-supported Special characters
OFSLL does not support the following special characters while accepting data through UI,
web service and file upload process.

< > { } | \ ^ [ ] `

Hence, ensure that the same is not used while processing any input data in the system.

1.5.5 Skip Zip Code Validation
While accepting data for interdependent fields through User Interface, OFSLL validates and
auto-populates the values for subsequent fields based on previous selection.

Chapter 1
Common Operations

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 21 of 26



Accordingly, when a specific Country is selected from drop-down list which is populated based
on COUNTRY_CD (COUNTRY CODE) lookup code, OFSLL validates and populates the list of
corresponding zip codes maintained in Zip Code setup.

However, in case the zip code validation is to be skipped for a specific Country, then define the
Sub Code as NO_ZIP_VAL against the COUNTRY_CD in lookups screen as indicated below:

Figure 1-22    Skip Zip Code Validation

On Selecting that particular Country from drop-down in any of the UI screen, only the default
value ‘0000000000’ is available for Zip field drop-down list. On selecting the same, the City and
State fields are set as UNDEFINED.

Figure 1-23    Skip Zip Code Validation
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Note

Skipping zip code validation has significant impact in the system since the change
impacts all the UI screens - Setup screens, Origination, Servicing and Collection
module screens, Interface, Customer Credit Limit, Collateral Management, and so on.
Hence it is recommended to be done with careful consideration and OFSLL is not
responsible for any impact/ mismatch resulting out of this change.

1.5.6 Export data to Excel
While working on any of the screens in User Interface, OFSLL provides a flexibility to Export
the data that is displayed on screen to an Excel file. This helps to download and view the data
offline especially with data intensive screens.

Clicking Export to Excel option provides option to save the data to .xls file.

Figure 1-24    Export to Excel

However, Export to Excel option is currently available only to following screens and is also
access controlled depending on configuration defined in setup.

• Queues/Search Results - Origination, Servicing, and Collections

• Account Information

• Balances

• Call Activities

• Maintenance

• Promises

• Due Date History

• Collateral

• Tracking Attributes

• Condition Details / Condition / Queue History

In additional, OFSLL displays the total count of records fetched from database. The count is
displayed in the right bottom corner of records table. However, note that this is not the total
count of all the records in the database but only the records which are fetched based on
specific selection. For example, if there are 50,000 records in database and UI is fetching
1,000 records, then the count is displayed as 1,000.
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1.6 Keyboard Compatibility
The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as Hot Keys. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
Accessibility screen, press ‘Shift + Alt + y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

3. Space bar to check or uncheck Check Box.

4. Arrow Keys to hover within the drop-down list.

• Keyboard Compatibility

1.6.1 Keyboard Compatibility
The application is made compatible with keyboard only-operations. However, there is a change
in key combination based on the browser on which the application is running.

Table 1-10    Keyboard Compatibility

Browser Operating System Key Combination Action

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option +
mnemonic

Click

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet
Explorer 7

Windows Alt + mnemonic Set focus

Microsoft Internet
Explorer 8

Windows Alt + mnemonic Click or set focus

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option +
mnemonic

Click

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom
level.

Table 1-11    Keyboard shortcuts

Shortcut Action

Ctrl++ To increase zoom level.

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.
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1.7 Tool Tips
The system is facilitated with tool tip option.

When the cursor is moved on any of the user interface field in the screen, a popup is
displayed. It consists of a tip with the action that has to be performed.

1.8 Accessibility
This section consists of the following:

• Understanding Accessibility

• Application Accessibility Preferences

• Documentation Accessibility Preferences

1.8.1 Understanding Accessibility
Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

1.8.2 Application Accessibility Preferences
Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility to
make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

• The application user interface contents are readily accessible for all types of users without
the need to select special accessibility modes.

• The components within the user interface are optimized for use with a screen reader by
default.

• The contents are zoomable by default, eliminating the need for an application large fonts
mode.

• The user interface components auto-detect if operating system (OS) is set to high contrast
mode and automatically render content that is compatible with OS high contrast,
eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built on
Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

1.8.3 Documentation Accessibility Preferences
Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.
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• Addition of text equivalent to all graphics

• Usage of standard fonts and avoiding shadow or reversed text

• Usage of strong foreground and background color contrast

• Color usages as per Oracle Accessibility guidelines have been ensured

• Usage of styles and formatting elements

• Documentation in simple language to ensure easy understanding

• Including accurate and effective navigational features, such as cross-reference, tables of
content and bookmarks as appropriate.
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2
Administration System

In Administration > System, you can record setup data related to the application’s overall
functionality and performance. This data affects;

• The mechanics of the system

• The processes of the system

• The search for Location of files to complete the tasks.

Navigating to Administration System

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > System

The System drop-down link records the following data. Using the below screens, you can
control the behavior of the system from a technical perspective. For example, determine
parameter values, define what information is audited, and record default values. However, note
that the product provides default values for parameters in all these screens.

• System Parameters

• Lookups

• User Defined Tables

• Audit Tables

• User Defined Defaults

• User Defined Parameters

• Transaction Codes

• Data Files

• Dedupe

• Securitization

• Events

• Batch Jobs

• Producer Cycles

• Vendors

• Collection Cycles

• Reports

• Error Messages

• Translation

• Label Configuration

• Seed Data

• Sales Tax

• Data Masking
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• Webhook

2.1 System Parameters
System parameters define information or values used throughout the system. They act as
switches that control the manner in which a function is implemented, or whether or not the
system performs a particular task. Parameters are used throughout the system to control
everything from user access to what information is stored on any given form. Parameters also
define configuration data, such as the location of the system files, the URLs for the report and
image servers, and other administration controlled data. Some of the system parameters are
setup when the system is installed, but the values associated with the parameters need to be
reviewed and maintained.

There are three types of parameters in the system, grouped by what part of the system they
affect:

Table 2-1    Types of Parameters

Parameter Type Parameter Range

System parameters These parameters apply to the entire system.
Examples: batch processes, archiving, aging.

Organization parameters These parameters apply to the organization,
division, and user responsibility.

Examples: User login control, password expiration.

Company parameters These parameters apply to the company and
branch.

Examples: decision fax control, scoring model.

Hence, the System Parameters screen contains the following three tabs:

• System Parameters Setup

• Organization Parameters

• Company Parameters

2.1.1 System Parameters Setup
The System Parameters Setup screen displays and records each system wide parameter,
along with its current value and whether or not it is enabled. These parameters relate to the
overall processing of the system, such as application server file locations and data purging
configuration.

Note

You can only define these parameters. Changing the values of any of these
parameters affects the related processing.

To set up the System Parameters

1. Click Setup > Setup > Administration > System > System Parameters > System. The
system displays the System Parameter screen.
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2. In the System Parameters section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-1    System Parameters

A brief description of the fields is given below:

Table 2-2    System Parameters setup

Parameter Type Parameter Range

Parameter System parameter of the specified parameter
description is displayed here.

Parameter Description Select the description of system parameter from
the drop-down list.

Parameter Value Specify the value for the system parameter
(required).

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix System Parameters chapter.

This section consists of the following topic:

• FCUBS Integration

2.1.1.1 FCUBS Integration
Oracle Financial Services Lending and Leasing (OFSLL) is integrated with Oracle FLEXCUBE
Universal Banking System (FCUBS) with the capability to integrate the centralized CIF
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(Customer Information Files), ELCM (Enterprise Limits and Collateral Management) and CASA
(Current Account and Savings Account) modules.

To work with the integrated environment functionalities, you need to enable the following core
banking indicator.

Table 2-3    FCUBS Integration

Parameter Parameter Description

CMN_CORE_BANK CORE BANKING INTERFACE INDICATOR

Note

Re-qualification is pending for Core and Direct Banking Integration.

For detailed information about integration changes, you can refer to ‘FCUBS Integration
Documents’ section at OTN library (http://docs.oracle.com/cd/E59770_01/homepage.htm).

2.1.2 Organization Parameters
The Organization parameters control the system functions related to user log in, such as
passwords and expiration dates, responsibility levels and the ability to access the system
features. Individual parameters can be created with different values for uniquely defined
organizations, divisions, and responsibility combinations.

When determining which parameter to use, the system selects the best match based on a
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL
being a lower order match than an exact match.

For example:

Assume the organization parameter UIX_APP_VIEW_ALL_APPS (VIEW ALL APPLICATIONS)
is as follows:

• If a user belongs to an organization as DMC with a responsibility of SUPERUSER and is
using the Underwriting screen of Lending menu, the system will return with a value N, and
the system will not allow the user to view all applications.

• If the user belongs to any organization with a responsibility of SUPERUSER, and is using
the Underwriting screen of Lending menu, the system will return with a value Y, and the
system will allow the user to view all applications.

Note

Be aware that while the system allows for Organization parameters to be defined at all
three hierarchical (organization, division, and responsibility) levels, not all will be
applicable to each parameter. For example, while you can define the
UIX_SMTP_SERVER (EMAIL SERVER FOR USER) for a responsibility, you would
normally want only to define this parameter based on organization or division.

To set up the Organization Parameters

1. Click Setup > Setup > Administration > System > System Parameters > Organization
tab.
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2. In the Organization Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.

Figure 2-2    Origination System Parameters Setup

A brief description of the fields is given below:

Table 2-4    Organization Parameters

Field Do this

Parameter Parameter of the specified parameter description
is displayed here.

Parameter Description Select the description of system parameter from
the drop-down list.

Parameter Value Specify the value for the system parameter.

Organization Select the organization for which the parameter
will be valid from the drop-down list.

Division Select the department for which the parameter
will be valid from the drop-down list.
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Table 2-4    (Cont.) Organization Parameters

Field Do this

Responsibility Select the responsibility for which the parameter
will be valid from the drop-down list.

IMPORTANT: In selecting which organization
parameter to use, the system searches for a best
match using the following attributes:

1. Organization

2. Division

3. Responsibility

Hence, Oracle Financial Services Software
recommends creating a version of each
organization parameter, where ALL is these
fields.

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix System Parameters chapter.

2.1.3 Company Parameters
The Company parameters control the system processes associated with functions that may
vary for different companies or branches. These parameters address credit scoring, credit
bureau interfaces, fax services, and fax generation. Individual parameters may be set up with
different values for uniquely defined company and branch combinations.

When these parameters values are requested by the system, the system responds with the
best match based on a hierarchical sort ordered on company and branch fields, with values of
ALL being a lower order match than an exact match. For example, assume the company
parameter UIX_RUN_AAI_ACT (ONLINE ACCOUNT CREATION AND ACTIVATION) has
been defined as:

The system uses these two parameters to determine whether to create and activate an
account online.

• When processing items for the company US01, the system will return a value N and not
create and activate an account online.

• When processing items for the company other than US01 and within the value ALL, the
system will return with a value Y and create and activate an account online.

To set up the Company Parameters

1. Click Setup > Setup > Administration > System > System Parameters > Company tab.

2. On the Company Parameters screen, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 2-3    Company Parameters

A brief description of the fields is given below:

Table 2-5    Company Parameters setup

Field Do this

Parameter The system displays the parameter, when you
select parameter description.

Parameter Description Select the description of system parameter from
the drop-down list.

Parameter Value Specify the value for the system parameter.

Company Select the portfolio company for which the
parameter will be valid from drop-down list.

Branch Select the portfolio branch for which the
parameter will be valid from the drop-down list
(required).

IMPORTANT: In selecting which company
parameter to use, the system searches for a best
match using the following attributes:

1. Company

2. Branch

For this reason, the Software recommends
creating a version of each company parameter
where ALL is the value in these fields.

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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For a detailed list of available parameters, refer to Appendix System Parameters chapter.

2.2 Lookups
The Lookups setup screen defines the contents in many drop-down fields used throughout the
system. Fields that make use of drop-down field will accept only entries that are stored on this
screen.

The Lookups screen contains two sections: Lookup Types and Lookup Codes. Lookup types
and codes can be system-defined or user-defined. The lookup types describe the function of
the related lookup codes.

For system-defined lookup types, only the Description field may be changed.

A system-defined lookup type (Lookup Types block, System Defined is selected) is one that
is critical to the system and cannot be changed. However, you can still modify the lookup type
description and Record indicator (Enabled/Disabled).

A user-defined lookup type (Lookup Types block, System Defined is not selected) is one that
can be modified, depending on a user's business needs. You can modify the description,
system indicator and record indicator. If a lookup type is user-defined, the lookup code
belonging to that lookup type can either be system-defined or user-defined.

A system-defined lookup code (Lookups screen, System Defined is selected) is one on which
the system processing is dependent. Without this lookup code, the process produces incorrect
results or fails.

A user-defined lookup code (Lookups screen, System Defined is not selected) is one that
can be defined or altered by a user.

WARNING: System-defined lookup types are those that are required by the system. Their
related lookup codes will also be system defined. If you update and save a user-defined lookup
type as a system-defined-lookup type (that is, change the System Defined button from No to
Yes in the Lookup Type sub screen), the system will not allow you to change the lookup type
back to user-defined in the future.

Note

Lookup codes cannot be deleted, as they may have been used in the past, and the
display and processing of that data is still dependent on the existing setup.

Typically, the system Administrator would modify the descriptions of lookup codes and add new
lookup codes to the existing lookup types as needed.

To set up the Lookups

1. Click Setup > Setup > Administration > System > Lookups. The system displays the
Lookups screen. The details are grouped into two:

• Lookup Types

• Lookup Codes

2. In the Lookup Types section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 2-4    Lookups

A brief description of the fields is given below:

Table 2-6    Lookups setup

Field Do this

Lookup Type Specify the lookup type.

Description Specify the description for the lookup type.

System Defined Yes/No Select Yes, if you wish to maintain the lookup
type as system defined and No, if you wish to
maintain lookup type as User defined.

Enabled Check this box to enable the lookup type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Lookup Codes section, you can setup individual codes that a field or process using
the related lookup type can have. Perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-7    Lookup Codes

Field Do this

Lookup Code Specify the lookup code. These are solely
dependent on the function of the Lookup Type.

Description Specify the lookup code description. This may be
changed as per your business requirement.
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Table 2-7    (Cont.) Lookup Codes

Field Do this

Sort Specify the sort order for the lookup code. This
determines the order these lookup codes are
displayed or processed.

Sub Code Specify the sub code for the lookup code.

System Defined Yes/No Select Yes, if you wish to maintain the lookup
code as system defined and No, if you do not
want to maintain it as system defined. System
defined lookup codes cannot be modified, except
for changing the Description or Sorting fields. If
the lookup type is not system defined, then the
code can be modified.

Enabled Check this box to enable the lookup code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.3 User Defined Tables
In User Defined Tables you can maintain user-defined tables, such as the data attributes the
system uses on its Search screens.

In the following example, the list of attributes in the Criteria column are computed from the
User Defined Tables screen.

To set up a user-defined table, you must:

1. Define the fields on the table.

2. Join the related tables.

3. Assign the table a lookup type.

You can create tables for different products, funding, and collateral types.

After creating the user-defined tables, the system sorts the attributes to make the system
usage more efficient. These details are used with different functions of the system, including:

• Searching applications and accounts

• Tracking follow-up items

• Creating details in bankruptcy, foreclosure/repossession, and deficiency

Note

Many of these tables, (ASSET TRACKING ATTRIBUTES for example) may be
configured during the initial setup of the application to provide for your specific
business needs. Others, such as APPLICATION SEARCH, may be changed
whenever your business needs change. Still others should not be changed without
consulting Oracle Financial Services Software, as changing them would require
changes to existing code for the expected results to be implemented. As a thumb
rule, it is better to add or disable information on the User Defined Tables screen
than to edit existing entries.

To set up the User Defined Tables
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1. Click Setup > Setup > Administration > System > User Defined Tables. The system
displays the User Defined Tables screen. The details are grouped into two:

• User Defined Tables

• User Defined Table Attributes

2. In the User Defined Tables section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-5    User Defined Tables

A brief description of the fields is given below:

Table 2-8    User Defined Tables

Field Do this

Table Specify the user-defined table name.

User Table Type Select the user-defined table type from the drop-
down list. This determines where and how the
related data is being used.

Description Specify the description for user-defined table.

System Defined Yes/NO Select Yes, if you wish to maintain the User table
type as system defined and No, if you do not
want to maintain it as system defined. System
defined entries cannot be modified. If the entry is
not system defined, then it can be modified.

Enabled Check this box to enable the user-defined table
(optional).
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Table 2-8    (Cont.) User Defined Tables

Field Do this

Product Type Select the product type from the drop-down list.

Funding Type Select the funding type associated with the user-
defined table from the drop-down list.

Collateral Type Select the collateral type associated with the
user-defined table from the drop-down list.

View Name Specify the view name.

SQL Statement Specify the SQL version of the statement.

For Example: For SEARCH_ACC_ACCOUNTS
table, the SQL is as follows:

SELECT /*+ FIRST_ROWS */ ACC_AAD_ID
FROM ACCOUNTS WHERE

Note: For the above SQL, the where criteria is
part of the User Defined Table Attributes

Sort Specify the sort order for the user-defined table
relative to other tables of the same type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the User Defined Table Attributes section, perform any of the Basic Operations
mentioned in Navigation chapter.

Figure 2-6    User Defined Table Attributes

A brief description of the fields is given below:
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Table 2-9    User Defined Table Attributes

Field Do this

Attribute Specify the user-defined table attribute.

Description Specify the description for the user-defined table
attribute.

Data Type Select the data type for the attribute
(CHARACTER, NUMBER, or DATE) from drop-
down list.

Length Specify the maximum length of the user-defined
table attribute.

Sort Specify the sort order of the user-defined table
attribute. If the sort order is changed it will only
affect new instances of the User Defined Table,
and will not affect existing data.

Operator Select the operator for the user-defined table
attribute from the dropdown list.

System Defined Yes/No Select Yes, if you wish to maintain the User table
attribute as system defined and No, if you do not
want to maintain it as system defined. System
defined entries cannot be modified. If the entry is
not system defined, then it can be modified.

Enabled Check this box to enable the user-defined table
attribute so that the attribute will be considered
when creating new instances of the User Defined
Table.

Sub Attribute Specify the sub-attribute for the attribute (sub
attributes are used to associate related
attributes).

LOV Type Select the list of value (LOV) type for the user-
defined table attribute from the drop-down list.

LOV Validation Ind Check this box to enable LOV validation of the
user-defined table attribute. This indicates
whether the data must come from the LOV.

Lookup Types Specify the lookup type of the LOV associated
with the user-defined table attribute.

Default Value Specify the default value for the user-defined
table attribute.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.4 Audit Tables
The system allows you to track changes in the database during line of creditloan origination.
This includes the tracking of:

• Application status history

• Account status history

• Audit history of specified fields

The Audit Tables Setup screen records the tables and columns requiring an audit. the system
stores the following details for the fields you want to audit for changes:

• Current value in field

• New value field
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• User who changed the field’s content

• Date and time when the value was changed

IMPORTANT: The system recommends that only a database administrator perform the
following steps.

To set up the Audit Tables

1. Click Setup > Setup > Administration > System > Audit Tables. The system displays
the Audit Tables screen. The details are grouped into two:

• Audit Tables

• Audit Columns

2. In the Audit Tables section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 2-7    Audit Tables

A brief description of the fields is given below:

Table 2-10    Audit Tables

Field Do this

Table The table name on which audit trigger needs to
be created is displayed here (the system table
being audited).

Description Specify the table description.

Chapter 2
Audit Tables

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 14 of 207



Table 2-10    (Cont.) Audit Tables

Field Do this

Display Description Specify the column description to be displayed
on audit screen.

Display Column Select the table column to be displayed on audit
screen from the drop-down list.

Enabled Check this box to enable the audit table so that it
will be considered while generating the database
triggers.

Reset Row ID Check this box to allow resetting the row
identifier.

Primary Key 1 (unlabeled) The table primary key column 1 is displayed
here. (These columns define how to access the
data in the table.)

Primary Key 2 (unlabeled) The table primary key column 2 is displayed
here.

Primary Key 3 (unlabeled) The table primary key column 3 is displayed
here.

Primary Key 4 (unlabeled) The table primary key column 4 is displayed
here.

Primary Key 5 (unlabeled) Table primary key column 5 is displayed here.

Primary Key 6 (unlabeled) Table primary key column 6 is displayed here.

Primary Key 7 (unlabeled) The table primary key column 7 is displayed
here.

Primary Key 8 (unlabeled) The table primary key column 8 is displayed
here.

Primary Key 9 (unlabeled) The table primary key column 9 is displayed
here.

Primary Key 10 (unlabeled) The table primary key column 10 is displayed
here.

Primary Key 11 (unlabeled) The table primary key column 11 is displayed
here.

Primary Key 12 (unlabeled) The table primary key column 12 is displayed
here.

Primary Key 13 (unlabeled) The table primary key column 13 is displayed
here.

Primary Key 14 (unlabeled) The table primary key column 14 is displayed
here.

Primary Key 15 (unlabeled) The table primary key column 15 is displayed
here.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Audit Tables Columns section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-11    Audit Tables Columns

Field Do this

Column Specify the column name on which the audit
needs to be created from drop-down list (column
in the table that is being audited)
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Table 2-11    (Cont.) Audit Tables Columns

Field Do this

Description Specify the column description (description of
the data contained in the column).

Data Type The data type for the attribute is displayed here.

Enabled Check this box to enable the audit column.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Once the required fields data is created or updated, click Generate in Audit Tables section
to initiate a trigger to update the details in the system.

2.5 User Defined Defaults
The User Defined Defaults Setup screen allows you to set up default values to automatically
populate in frequently used fields on the Application Entry screen. This streamlines the data
entry process when entering an application.

To set up the User Defined Defaults

1. Click Setup > Setup > Administration > System > User Defined Defaults.The system
displays User Defined Defaults screen.

2. In the Application Defaults section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-8    Application Defaults

A brief description of the fields is given below:
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Table 2-12    Application Defaults

Field Do this

Org Select the organization for which these defaults
are applicable from drop-down list.

Division Select the division for which these defaults are
applicable from dropdown list.

Application Defaults

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Priority Select the priority from the drop-down list.

Channel Select the channel from the drop-down list.

Producer Type Select the producer type from the drop-down list.

Purpose Select the purpose from the drop-down list.

Product Select the product from the drop-down list.

Applicant Defaults

Relation Type Select the applicant relation type from the drop-
down list.

Gender Select the applicant gender from the drop-down
list.

Marital Status Select the applicant marital status from the drop-
down list.

Language Select the applicant language from the drop-
down list.

ECOA Select the applicant ecoa from the drop-down
list.

Class Type Select the applicant class type from the drop-
down list.

Race National Origin Select the applicant race or national origin from
the drop-down list.

Privacy Opt-Out Check this box to indicate that the applicant has
elected to refrain from the non-public sharing of
information.

Address Defaults

Address Type Select the address type from the drop-down list.

Postal Type Select the postal address type from the drop-
down list

Street Pre Select the street pre type from the drop-down
list.

Street Type Select the street type from the drop-down list.

Street Post Select the street post type from the drop-down
list.

Country Select the country from the drop-down list.

Rent Amount Specify the rent amount. The system defaults
this rent amount if the rent amount received from
the interface is zero.

This rent amount will be defaulted for a new
application also.

State Frequency Select the stated frequency from the drop-down
list.

Actual Frequency Select the actual frequency from the drop-down
list.
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Table 2-12    (Cont.) Application Defaults

Field Do this

Ownership Select the ownership type from the drop-down
list.

Employment Defaults

Type Select the employment type from the drop-down
list.

Occupation Select the occupation from the drop-down list.

Country Select the country from the drop-down list.

Stated Frequency Select the stated frequency from the drop-down
list.

Actual Frequency Select the actual frequency from the drop-down
list.

Income Defaults

Income Type Select the income type from the drop-down list.

Frequency Select the frequency from the drop-down list.

Liability Defaults

Liability Type Select the liability type from the drop-down list.

Frequency Select the frequency from the drop-down list.

Asset Defaults

Status Select the asset status from the drop-down list.

Condition Select the asset condition from the drop-down
list.

Country Select the country from the drop-down list.

Vehicle Defaults

Asset Type Select asset type from the drop-down list.

Sub Type Select asset sub type from the drop-down list.

Class Select the asset class from the drop-down list.

Valuation Source Select the asset valuation source from the drop-
down list.

Home Defaults

Asset Type Select asset type from the drop-down list.

Sub Type Select asset sub type from the drop-down list.

Class Select the asset class from the drop-down list.

Occupancy Select the occupancy type from the drop-down
list.

Valuation Source Select the asset valuation source from the drop-
down list.

Other Defaults

Asset Type Select asset type from the drop-down list

Sub Type Select asset sub type from the drop-down list.

Class Select the asset class from the drop-down list.

Valuation Source Select the asset valuation source from the drop-
down list

Comment Defaults

Comment Type Select the comment type from the drop-down list.

Comment Sub Type Select the comment sub type from the drop-
down list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6 User Defined Parameters
The User Defined Parameters setup screen facilitates to define field-level configurations which
helps to perform various day to day business specific calculations. In this screen you can
define parameters and logic for each field to compute and populate data.

For example, you can setup User Defined Parameters in the system to calculate Trade Equity,
Collateral Coverage Ratio, Net Rental Yield and so on.

Note

Currently system supports defining user defined parameters for entities like Account
and Collateral. The computed values are populated into Customer Service > Account
Details > Account Information section and Servicing > Collateral Management >
Collateral Details screen respectively on clicking Calculate Parameters button.

Defining user defined parameters basically involves identifying a scenario and creating/
configuring the required parameters. Here, a scenario can refer to what category of accounts
are to be considered for computation.

User defined parameters consists of the following two types of configurable parameters:

Table 2-13    Types of configurable parameters

Parameter Description

Target Parameters These parameters store values for the
customizable user defined fields in user defined
tables and is used for calculation based on
Selection Criteria.

These parameters are available as per the View
Name defined in user defined tables for each
Account and Collateral Entity and persist the
calculation values into the table columns of
database after its first execution.

Formula Parameters These parameters are used for computation of the
target parameters. These contain the generic
formula/logic that can be used for any computation
based on System Defined Functions and Table
Columns. These parameters does not persist the
calculation values into the table columns of
database.

Since system supports Account and Collateral entity types, the configurable user defined
Target/Formula parameters along with selection criteria can be defined using specific table
type as indicated below:
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Table 2-14    Account and Collateral entity types

Entity Type Parameter Type Description

Accounts Formula Parameters Formula parameters are used for
computation of the target
parameters for Account Entity.

OFSLL supports predefined set
of calculation based Formula
Parameters. These parameter
definitions start with $ in User
Defined Tables.

These parameters does not have
any selection criteria.

Existing factory shipped seed
data provided by OFSLL product
like GL date, System Date,
ACC_DLQ_DAYS and so on is
based on below User Defined
Table Type:

USER DEFINED: ACCOUNTS
FORMULA PARAMETERS

USER DEFINED: COMMON
FORMULA PARAMETERS

USER DEFINED: COMMON
CUSTOMER SERVICE
FORMULA PARAMETERS

Target Parameters These calculations are based on
formula parameters and other
target parameters.

A selection criteria is available for
each calculation.

These are based on User Defined
Table Type: USER DEFINED:
ACCOUNT TARGET
PARAMETERS

Selection Criteria These parameters define the
criteria on which accounts are
picked for calculation of defined
target parameters.

These are available only for
Target parameters and are based
on User Defined Table Type:
USER DEFINED: ACCOUNT
CRITERIA PARAMETERS
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Table 2-14    (Cont.) Account and Collateral entity types

Entity Type Parameter Type Description

Collateral Formula Parameters These Formula parameters are
used for computation of the target
parameters for Collateral Entity.

They are based on below User
Defined Table Type:

USER DEFINED: COLLATERAL
FORMULA PARAMETERS

USER DEFINED: COMMON
FORMULA PARAMETERS

USER DEFINED: COMMON
CUSTOMER SERVICE
FORMULA PARAMETERS

Target Parameters These are based on User Defined
Table Type: USER DEFINED:
COLLATERAL TARGET
PARAMETERS

Selection Criteria These are available only for
Target parameters and are based
on User Defined Table Type:
USER DEFINED: COLLATERAL
CRITERIA PARAMETERS

Note

The execution of User Defined Parameters require additional processing at the server
level and can have significant performance impact delaying the EOD processing.
Hence it is recommended to have careful consideration while defining the Target and
Formula parameter configurations.

In this framework, you can either create new parameters and/or use the available pre-defined
formula parameters to populate computed values to custom user defined fields.

For example - a formula parameter can be defined with an expression as
*$TOTAL_ITM_GRP_IEQ + $PAID_BAL_ADV which is total equity in itemizations on account
added with total advance amount paid. An expression can have a stored function (represented
with $ sign) and Account Columns (fields).

There are some formula parameters in the system with basic pre-defined calculation which can
readily be used for configuration along with account fields. Pre-defined formula parameters are
associated with specific acronyms appended with parameter name for identification. The table
below lists the available pre-defined formula parameters. However, you can also define custom
formula parameters with acronyms.

Table 2-15    Pre-defined formula parameters

User Defined Column Description Description

$GL_DATE Value of GL Date System Parameter

$SYSTEM_DATE Current System Date
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Table 2-15    (Cont.) Pre-defined formula parameters

User Defined Column Description Description

$COLLATERAL_VALUE Sum of all collateral current valuation

$PRIMARY_COLLATERAL_VALUE Sum of all primary collateral current valuation

$ASE_GRAND_FATHER_POINTS Sum of all grandfather points

$ASE_TIER_POINTS Total Tier Points

$INTEREST_ACCRUED Interest Accrued on Account for a specific date.
This is used to calculate Trade Equity Calculation.

$OUTSTANDING_AMOUNT Current Account Outstanding Amount

$OUTSTANDING_BAL_ (BALANCE TYPE *) This is a dynamic balance value calculation based
on type variable.

For example:
• $OUTSTANDING_BAL_ADV - Will calculate

outstanding Advance/Principal amount
• $OUTSTANDING_BAL_LSR - Will calculate

outstanding Lease Receivable amount

$PAID_BAL_(BALANCE TYPE *) This is a dynamic balance value calculation based
on type variable.

For example:
• $PAID_BAL_ADV - Will calculate paid

Advance/ Principal amount
• $PAID_BAL_LSR - Will calculate paid Lease

Receivable amount

$SUM_PRIN_ESC_MAX_EXPIRY_ DT This is used to calculate sum of total principal
amount till Extended Service Warranty Max Expiry
Date.

$TOTAL_ITM_GRP_ (ITM GROUP*) This is a dynamic itemization group value
calculation based on type variable.

For example:
• $TOTAL_ITM_GRP_IDC - Will calculate total

ITM DOWN PAYMENT CASH group amount
• $TOTAL_ITM_GRP_IPF - Will calculate total

ITM PREPAID FEE group amount

$TOTAL_ITM_ (ITM*) This is a dynamic itemization value calculation
based on type variable.

For example:
• $TOTAL_ITM_IDC_1 - Will calculate total ITM

DOWN PAYMENT amount
• $TOTAL_ITM_IUN_4 - Will calculate total ITM

CASH DOWN amount

Both the parameters (formula and target) supports the following data types:

• Number / Integer (both are considered as floating numbers)

• Date

• Character

While defining specific parameter, system auto-filters the variable list based on the supported
data type.

To enable any target parameters, ensure that there is at the least one enabled formula
parameter and selection criteria defined. Also while defining target parameters, ensure that
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there is no circular dependency where two or more parameters are either directly or indirectly
dependent on each other. For example, If formula parameter A is defined as ACC_FIELD1 +
formula parameter B, and formula parameter B is defined as ACC_FIELD2 + formula
parameter A. In such a case, system displays an error indicating ‘CIRCULAR DEPENDENCY
DETECTED FOR PARAMETER:<<PARAMETER NAME>>’.

The user defined parameters calculation can be triggered in any of the following ways:

Table 2-16    User Defined Parameters

Option Trigger Action Type

User Interface Clicking Calculate Parameters
button in Account Details screen,
Account Information section.

Target parameters of Frequency
= None and Daily are computed
and updated for an account and
all collaterals associated to the
account.

System calculates and updates
target parameter through
background job process which is
created to update UDP values
asynchronously.

Error/Validation messages
received during calculation of
user defined fields are displayed
under Background job and not
displayed in UI.Clicking Calculate Parameters

button in Collateral Management,
Collateral Details screen.

Target parameters of Frequency
= None and Daily are computed
and updated only for the selected
collateral.

Batch Job for Account Target
Parameters update

On executing batch jobs - USER
DEFINED ROOT BATCH JOB
and USER DEFINED ACCOUNT
TARGET PARAMETER
CALCULATOR in SET-CUP batch
job-set

On execution, this batch job
calculates all target parameters
defined for Account that satisfy
the selection criteria.

Root batch job is parent batch job
and is executed first to pick all
accounts eligible for calculation
for the child batch job i.e. Account
Target Parameter Calculator. This
helps to enhance system
performance.

The batch job periodically
calculates for target parameters
of frequency other than None and
updates the Next Run Date for
parameter as per frequency
defined.

Note that, batch job picks-up
accounts only once per day and
refers to company specific GL
date.

Accounts in OFSLL are
associated to specific company -
branch combination. Hence this
batch set and job should be
configured at every company
branch level.
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Table 2-16    (Cont.) User Defined Parameters

Option Trigger Action Type

Batch Job for Collateral Target
Parameters update

On executing batch jobs - USER
DEFINED ROOT BATCH JOB
and USER DEFINED
COLLATERAL TARGET
PARAMETER CALCULATOR in
SET-CUP1 batch job-set

On execution, this batch job
calculates all target parameters
defined for collateral entity that
satisfy the selection criteria.

Root batch job is parent batch job
and is executed first to pick all
accounts eligible for calculation
for the child batch job i.e.
Collateral Target Parameter
Calculator. This helps to enhance
system performance.

The batch job periodically
calculates for target parameters
of frequency other than None and
updates the Next Run Date for
parameter as per frequency
defined.

Note that, batch job picks-up
accounts only once per day and
refers to company = ALL GL date.

Collateral in OFSLL are not
associated to any specific
company hence this batch set
and job should be configured for
company = All.

Event Configured Event Action Type -

1. UPDATE ACCOUNT USER
DEFINED PARAMETERS

2. UPDATE COLLATERAL
USER DEFINED
PARAMETERS

For more details on defining
event action type, refer to Events
(New Framework) section.

Update Account/Collateral Target
Parameters of frequency = None
and Daily when specific type of
changes occurs in OFSLL for
Account/Collateral event entity.

Restful Web Service Calculate Parameter Update
Service (available in common
Swagger module)

When third-party system post a
request to update specific or all
Target Parameters for a single
Account, single Collateral or all
collateral associated to an
account based on Entity Type
parameter updated in web
service request.

This parameter accepts only ACC
for accounts and ASE for
Collateral target parameters.
Target parameter of frequency
None and Daily are updated
through this web service.

Refer swagger documentation for
more details.
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During executing, system looks into the enabled user defined parameters, and considering
only those accounts matching the selection criteria, values are computed into the user defined
fields.

During computation of target parameters, system displays an error if there are more than one
definition defined for a target parameter.

To set up the User Defined Parameters

1. Click Setup > Setup > Administration > System > User Defined Parameters.

Figure 2-9    User Defined Parameters Setup

2. In the Parameters section, do one of the following:

• Use the Create Copy feature to quickly create new parameter with the existing
parameter details. For Target Parameters, select required record and click Create
Copy. For Formula Parameters, select required record, specify New Parameter name
and click Create Copy. The new parameter created this way will be in disabled state
by default.

• Add/Edit user defined parameter by performing any of the Basic Operations mentioned
in Navigation chapter.
A brief description of the fields is given below:

Table 2-17    Parameters section

Field Do this

Module Select the module from the drop-down list. The
list is displayed based on the modules that
support User Defined Parameters calculation.
Currently only Customer Serving (accounts) is
supported.
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Table 2-17    (Cont.) Parameters section

Field Do this

Entity Type Select the required entity for which calculation
is to be defined from the drop-down list. The
list is populated based on entity type
maintained in CUP_ENTITY_CD lookup code.

Currently, system supports ACCOUNTS and
COLLATERALS entity types.

Note that, entity can be selected only while
creating User Defined Parameter and the
same cannot be modified in Edit mode.

Parameter Type Select the type of parameter to be defined as
either Target Parameter or Formula Parameter
from the drop-down list.

Parameter Name For Target Parameter, system displays the list
of custom fields available in user defined table
for selection. Select the required Parameter
from the drop-down list. By default the first field
in the user defined table is selected.

For Formula Parameter, this is a text field to
record the new parameter name. Specify the
name of the formula parameter.

Description For Target Parameter, the description is auto-
populated from user defined table and is
Read-Only.

For Formula Parameter, specify the description
of the formula parameter.

Data Type For Target Parameter, the data type associated
for the parameter is auto-populated from user
defined table and is Read-Only.

For Formula Parameter, select the data type as
one of the following from the drop-down list -
INTEGER, DATE, NUMBER, or CHARACTER

Priority Specify the order in which system should
evaluate the parameter definitions while
executing the batch job or on clicking
Calculate Parameters button.

For example, if a formula parameter A has
dependency on parameter B, then B has to be
calculated first in the order and priority is set
as 0.
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Table 2-17    (Cont.) Parameters section

Field Do this

Frequency Select the required frequency at which the
target parameters are to be calculated from
the drop-down list.

Frequency field is applicable only for Target
Parameters and the list of frequency supported
is populated based on values maintained in
CUP_FREQUENCY_TYPE_CD lookup code.

Note the following:
– Frequency can be defined only in Edit

mode.
– Frequency is not applicable for Formula

Parameters.
– Frequency None can be selected for

target parameters that are required to be
calculated on adhoc basis.

Run Date Next View the date on which the Target parameter is
calculated. The Run Date Next is auto
calculated based on frequency defined.

This field is applicable only for Target
parameters and for frequency other than
None.

Note the following:
– For multi-company implementation, it is

recommended to add same User Defined
Parameter definition multiple times for
each company. This in-turn updates Run
Date Next for each company and
supports updating values at different zone
based on batch job setup.

– Currently the Run Date Next is updated
even if not all the records are computed
based on selection criteria. Since this
impacts to restart failed records, the same
shall be addressed in subsequent patch
releases.

Enabled Check this box to enable the parameter
definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

This section consists of the following topics:

• Formula Definition

• Selection Criteria

2.6.1 Formula Definition
The Formula Definition section allows you to define a mathematical expression of the formula
to evaluate the parameter definition. The expression may consist of one or more sequenced
entries. All arithmetic rules apply to the formula definition. If errors exist in the formula
definition, the system displays an error message in this section when you choose Show
Expression.
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1. In the Formula Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-18    Formula Definition

Field Do this

Seq Specify the sequence number (the order in which
the formula definition variable will be assembled
and evaluated).

( Specify a left bracket, if you need to group part of
your formula definition.

Variable Select the variable from the drop-down list which
consists of a validated list derived from user
defined table type as indicated below:
• For Number, system displays only numeric

fields
• For Date, system displays numeric + date

fields
• For String, system displays numeric +

character fields

Parameters for Account entity type in Customer
Service is derived from:

USER DEFINED: ACCOUNTS FORMULA
PARAMETERS

USER DEFINED: COMMON FORMULA
PARAMETERS

USER DEFINED: COMMON CUSTOMER
SERVICE FORMULA PARAMETERS

Parameters for Collateral entity type in
Customer Service is derived from:

USER DEFINED: COLLATERAL FORMULA
PARAMETERS

USER DEFINED: COMMON FORMULA
PARAMETERS

USER DEFINED: COMMON CUSTOMER
SERVICE FORMULA PARAMETERS

Constant Value Specify the constant value (optional).
• For Number, system supports only numeric

constants
• For Date, system supports only numeric

constants
• For String, system supports both numeric

and character constants

Note: System displays an error indicating
‘VARIABLE OR CONSTANT VALUE IS
REQUIRED’ if both Variable and Constant Value
or None is provided.
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Table 2-18    (Cont.) Formula Definition

Field Do this

Mathematical Operator Select the math operator to be used on the
adjacent formula definition rows, from the drop-
down list. The list is derived and displayed based
on data type / variable as indicated below:
• For Number, system allows all numeric

operators (+, -, x, and %).
• For Date, system supports (+ and -)

operators.
• For String, system supports concatenation

(i.e. +) operator.

Note

In the Parameter's section if the Data
Type is selected as 'Character', then the
mathematical operator can be selected
as either Blank or Plus. System does
not allow to select other mathematical
operators and displays an error
‘Operation Minus, Multiplication and
Division not allowed for Parameter of
CHARACTER data type’.

) Specify a right bracket, if you are grouping part
of your formula definition.

Enabled Check this box to enable the formula and
indicate that it is included when building a
parameter definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. In the Parameters section, click Show Expression. The mathematical expression appears
in the Formula Expression section (in sequential order) in the Expression field.

2.6.2 Selection Criteria
The sub tab is enabled only for Target Parameters and facilitates to define the selection criteria
indicating the type of accounts to be picked for computation. The parameters are derived from
user defined table - USER DEFINED: ACCOUNT CRITERIA TYPE CODE and USER
DEFINED: COLLATERAL TYPE CODE as per Account and Collateral Entity type.

1. In the Selection Criteria section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.
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A brief description of the fields is given below:

Table 2-19    Selection Criteria

Field Do this

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.
The list is populated based on the values
maintained in user defined table - Customer
Service: USER DEFINED: CUSTOMER
SERVICE CRITERIA PARAMETERS.

Comparison Operator Select comparison operator from the drop-down
list.

Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Select logical operator from the drop-down list.

Enabled Check this box to enable the selection criteria.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. Click Check Criteria for system to validate the query and display the results.

If the formula expression is mathematically incorrect when parameters are calculated, system
displays error indicating ‘INVALID FORMULA EXPRESSION: <<FORMULA PARMETER>>’.

2.7 Transaction Codes
The system uses transaction codes to define the actions and tasks it can perform; for example,
activating an account, changing a due date, applying a late fee, and charging off an account.

The system uses transaction codes to define the actions and tasks it can perform; for example,
defining itemization, menu items, setting up lock and unlock, and generating reports.

The Transaction Codes Setup screen catalogs and defines these core system actions.

The system organizes transaction codes in Super Groups. All transaction codes within a
particular super group are processed in a similar manner. The transaction super groups in the
system are as follows:

Table 2-20    Transaction Super Group

Super Group Type Description

ACCOUNT CONDITION TXN These transaction codes control a user’s ability to
open and close account conditions.

ACCOUNT MONETARY TXN These transaction codes affect the monetary value
of accounts in the system; for example, activating
accrual of interest, the assessment of fees, and
closing the account.

ACCOUNT NON MONETARY TXN These transaction codes do not have a direct effect
on the monetary value of the account, but are used
in maintaining account information. This includes
changing a customer’s driving license, or adding
information for automated clearing house (ACH).
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Table 2-20    (Cont.) Transaction Super Group

Super Group Type Description

AMORTIZATION TXN These transaction codes affect the amortized
balances of the accounts in the system.

CORRESPONDENCES These transaction codes relate to the system
correspondences.

ESCROW ANALYSIS AND DISBURSEMENTS These transaction codes allow for reviewing and
approving escrow analysis, stopping an escrow
override, and posting escrow disbursement.

ESCROW MONETARY TRANSACTIONS These transaction codes affect the monetary value
of escrow accounts in the system; for example,
disbursing escrow to a customer and insurance,
and receiving payment.

ESCROW NON MONETARY TRANSACTIONS These transaction codes do not have a direct effect
on the monetary value of an escrow account, but
are used in maintaining account information, such
as changing insurance maturity date and adding
new escrow tax details.

FEE ASSESSMENTS These transaction codes determine if fees such as
nonsufficient funds fees or membership fees are to
be applied.

FUNDING TXN These transaction codes affect the funding of
applications and accounts within the system.

ITEMIZATION TXN These transaction codes affect the itemization of
applications and accounts within the system.

MENU TXN These transaction codes affect the menus within
the system.

PRODUCER MONETARY TXN These transaction codes relate to the monetary
transactions that apply to the system producers (or
dealers).

REPORTS These transaction codes are related to generating
the system reports.

SECURITIZATION TXN These transaction codes affect the pools of
securitized loanslease or accounts within a pool of
securitized loanslease.

SETUP LOCK/UNLOCK These transaction codes limit a user’s ability to
change the existing setup data, even if they are
allowed access to the form, by restricting access to
the Lock/ Unlock Record icon on the system tool
bar.

ACCOUNT CONDITION TXN These transaction codes control a user’s ability to
open and close account conditions.

CORRESPONDENCES These transaction codes relate to the system
correspondences.

MENU TXN These transaction codes affect the menus within
the system.

REPORTS These transaction codes are related to generating
the system reports.

SECURITIZATION TXN These transaction codes affect the pools of
securitized loanslease or accounts within a pool of
securitized loanslease.
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Table 2-20    (Cont.) Transaction Super Group

Super Group Type Description

SETUP LOCK/UNLOCK These transaction codes limit a user’s ability to
change the existing setup data, even if they are
allowed access to the form, by restricting access to
the Lock/ Unlock Record icon on the system tool
bar.

Three sub screens, Parameters, Access Grid, and Products, record any additional information
required to perform a transaction, the user types that can perform the transaction, and the
product type to which the transaction codes apply.

Note

The Software recommends that you restrict the access to the seed data once you are
in production.

To set up the Transaction Codes

1. Click Setup > Setup > Administration > System > Transaction Codes. The system
displays the Transaction Codes screen.

2. In Transaction Super Group section, you can view the following information.

Figure 2-10    Transaction Super Group

A brief description of the fields is given below:
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Table 2-21    Transaction Super Group Fields

Field Do this

Super Group Select the Super Group you want to work with in
the Transaction Codes screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Transaction Codes section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-11    Transaction Codes

A brief description of the fields is given below:

Table 2-22    Transaction Codes Fields

Field Do this

Txn Code Specify the transaction code (required).

Description Specify the description for the transaction.

Group Select the transaction group (the group within the
Transaction Super Group that the transaction
code belongs to) from the drop-down list.

Action Select the action type code for the transaction
(what action will take place when the transaction
occurs) from the drop-down list.

Monetary Check this box to maintain the transaction as a
monetary transaction. If unchecked, then the
transaction is nonmonetary.
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Table 2-22    (Cont.) Transaction Codes Fields

Field Do this

System Defined Yes/ No Select Yes, if you wish to maintain the
transaction code as system defined and No, if
you do not want to maintain it as system defined.
System defined entries cannot be modified. If
entry is not system defined, then it can be
modified.

Enabled Check this box to enable the transaction.

Txn/Bal Type Select the transaction / balance type affected by
the Transaction from the drop-down list.

Statement Txn Type Select the statement transaction type (how the
transaction should appear on the customer
statement) from the drop-down list.

Batch Check this box to perform the transaction in a
batch process.

Manual Check this box, if the transaction is a manual
transaction. If you define a transaction as
manual, the system recommends that the
transaction that reverses it also be defined as
manual.

Stmt Print Check this box to print the transaction on
customer statements.

GL Check this box, if the transaction is a general
ledger transaction.

Event On selecting this check box, the particular
Monetary/Non-Monetary transaction is
considered for triggering of respective Monetary
and Nonmonetary transaction posting Event
type. The particular Monetary/Non- Monetary
transaction is available while defining Event
Actions.

For more information, refer to Events (New
Framework) section.

Recalc Master Txns Check this box for system to recalculate and
repost consolidated fee at Master Account level.
This is done automatically by identifying those
monetary transactions which should trigger
recalculation of Late Charge, Cycle Based Late
Fee and Cycle Based Collection Late Fee at
Master Account level when backdated
transaction is posted on any Associated Account
that is marked for fee consolidation.

For more information, refer to Cycle Based Fees
and Fee Consolidation sections in Contract
setup screen.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

This section consists of the following topic:

• Transaction Codes sub screens
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2.7.1 Transaction Codes sub screens

Note

Please contact your System Administrator / Implementation Manager before making
any changes in these sub screens.

The Transaction Codes screen contains three sub screens:

• Parameters

• Access Grid

• Products

2.7.1.1 Parameters
Here, you can define the parameter information for the associated transaction. The Parameters
apply exclusively to these super groups:

• ITEMIZATION TXN

• ACCOUNT MONETARY TXN

• ACCOUNT NON MONETARY TXN

• SECURITIZATION TXN

• ESCROW MONETARY TRANSACTIONS

• ESCROW NON MONETARY TRANSACTIONS

• ESCROW ANALYSIS AND DISBURSEMENTS

• AMORTIZATION TXN

• PRODUCER MONETARY TXN

• FUNDING TXN

• ACCOUNT CONDITION TXN

• CORRESPONDENCES

• FEE ASSESSMENTS

(For manual transactions, these are the parameters that appear when you click Load
Parameters on the Customer Service screen’s Maintenance screen.)

Note

Treat the Transaction Parameters sub screen as containing view-only information.
This is very sensitive data and you should not change it without consulting Oracle
Financial Services Lending and Leasing.

To set up the Parameters

1. Click Setup > Setup > Administration > System > Transaction Codes > Parameters.
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2. In the Transaction Parameters section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-23    Transaction Parameters

Field Do this

Parameter Code Select the parameter code associated with the
transaction code, from the drop-down list.

Default Specify the default value for the transaction
parameter (value to initially populate, or used if
no value is supplied).

Sort Specify the sort order for the transaction
parameter.

Displayed? Yes/No Select Yes to display the parameter and No if
you do not want to display in current use.

Required? Yes/No Select Yes if the parameter is required and No if
you do not require the parameter. (You must
select Required as empty values are not
allowed.)

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.1.2 Access Grid
The Access Grid sub screen allows you to control access to each transaction according to user
responsibility, account status, and account condition. It allows the administrator to control when
these transactions may be conducted. Normally, you would create or modify the access based
on either the user responsibility or account condition. Account status access is left unchanged.

To set up the Access Grid sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Access Grid.

2. In the Transaction User Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 2-24    Transaction User Access Definition

Field Do this

Access Type Select the access grid function type (ACCOUNT
CONDITION AND ACCOUNT STATUS) that is
being used to control the creation of the
associated transaction, from the drop-down list.

Access Value Select the access function grid value from the
drop-down list (based on a lookup associated
with the Access Type. Multiple entries for each
access type may be created as long as each has
a different access value).

Allowed? Yes/No Select Yes if the access is allowed and No if the
access is not allowed (indicates whether the
current Access Type / Access Value may create
the associated transaction).
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Table 2-24    (Cont.) Transaction User Access Definition

Field Do this

System Defined Yes/ No Select Yes, if you wish to maintain access type
as system defined and No, if you do not want to
maintain it as system defined. System defined
entries cannot be modified. If entry is not system
defined, then it can be modified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.1.3 Products
The Products sub screen allows you to define the products to which the transaction codes
apply. It allows the administrator to control if the associated transaction code will be available
for use for specific product types and or funding types.

Normally, an Access Value of ALL is defined for one or more Access Types with a given
Allowed value. Additional Access Values are then defined for the same Access Types with the
opposite Allowed value. This controls access to the associated transaction.

To set up the Products sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Products.

2. In the Transaction Product Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 2-25    Transaction Product Definition

Field Do this

Product Type Select the product type associated with the
transaction code from the drop-down list.

Funding Type Select the funding type associated with the
transaction code from the drop-down list.

Allowed? Yes/No Select Yes if the transaction is allowed and No if
the transaction is not allowed (indicates whether
the current Access Type / Access Value may
create the associated transaction).

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8 Data Files
The Data Files Setup screen organizes information pertaining to the various input/output data
files that the system can generate. The system uses the Data Files Setup screen to outline the
file layouts of each data file produced/received within the system, including the length and data
type of each column name.

These files are typically produced during the nightly process.

One major advantage for the system-defined data files is the format mask of each column
name within each data file. A format mask is like a stencil that forces data input to be of the
same format before accepting the data.

You can change the order in which the fields are displayed in the file.
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Note

Any addition or removal of a field or change in the data type length requires the
Software involvement.

Data Files screen consists of the following two tabs:

• Output tab

• Input tab

2.8.1 Output tab
The "Output tab" in the Data Files screen allows you to define the structure of output data file
through the following sections:

• Data File Definitions

• Record Definitions

• Column Definitions

2.8.1.1 Data File Definitions
The Data File Definitions section defines specific data files. Each is associated with a specific
Output Data Definition (ODD) batch job that gathers the data that the file will contain. While
new data file definitions may be created they will have no use unless a batch job is also
created to populate the data.

To set up Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Output tab.

2. In the Data Files Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-12    Data Files Definitions
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A brief description of the fields is given below:

Table 2-26    Data Files Definitions

Field Do this

Name Specify data file type (name of data file
definition).

Description Specify data file description.

File Name Specify data file name. Prefix used for files
generated for this Data File. This is the only field
on the Data File Definitions screen that can or
should be modified by your Administrator. The
generated file name will be in the form of <FILE
NAME>_<COMPANY ID>_<BRANCH
ID>_<MMDDYYYY>_<PROCESS ID>.DAT. The
inclusion of _<COMPANY ID> and _<BRANCH
ID> depends entirely on the associated batch
process.

Directory Path Specify the directory path.

System Defined Yes/No Select Yes, if you wish to maintain the data file
definition as system defined and No, if you do
not want to maintain it as system defined.
System defined entries cannot be modified. If the
entry is not system defined, then it can be
modified.

Enabled Check this box to enable the data file definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.1.2 Record Definitions
Each data file definition is made up of one or more record definitions. These define
organization of the data. The associated batch file determines how these records are used.
The order in which the data is populated determines the order in which those records will
appear in the output file. This is generally related to the order the records appear in the Data
File Definition section.

1. In the Record Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-27    Record Definitions

Field Do this

Record Type Specify the type of record being defined.

Description Specify record description.

Record Format Select the format of output data (FIXED,
VARIABLE) from the dropdown list.

Delimiter Specify the delimiter (column separator used
with VARIABLE format).

Terminator Select the record terminator code (how the end
of each record is indicated within the file --
CARRIAGE RETURN, LINE FEED, or
CARRIAGE RETURN AND LINE FEED) from the
drop-down list.
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2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.1.3 Column Definitions
Each record definition is made up of one or more column definitions. These define the output
of the data. Much of this data is informational; it indicates what data is being provided by the
associated batch job. Unless otherwise noted, the data should not be changed without
changing the associated batch job.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-28    Column Definitions

Field Do this

Seq Specify the order in which the output data dump
will process the column information.

Column Name Specify name/description of the column
(informational only).

Data Type Specify the data type. This describes the type of
data the column is expected to contain
(CHARACTER, DATE, or NUMBER). This effects
how the ODD process handles the data, and
should not be changed.

Format Mask Select the format mask for the column from the
drop-down list. For DATE or NUMBER columns,
this field defines the output format of the data.
For example; Date fields may be entered using
the MM/DD/ YYYY format, Number fields may be
entered as decimal numbers with varying
degrees of precision. Other formats for each data
type are available.

Length Specify the column length (the maximum number
of characters of the output data to be included in
the output file). Each output data details column
may contain up to 240 characters of data. If the
output data details column contains more data
than the length value the data will be truncated.
For VARIABLE records the length should be set
to “-1” or a Delimited file will be created with
FIXED LENGTH columns.

Data Column Specify the data column sequence. This is the
column that will be used to select the data that is
being output. This should not be changed.

Output Column Specify the output column sequence. This is the
column that will appear in Output File. The
Output Data Dump process allows for the output
of 250 columns of data per record. No output
column should be repeated in the setup for a
record.

2. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.8.2 Input tab
Oracle Financial Services Lending and Leasing facilitates processing of a input data file
received from external interface into the system through an automated batch job
(IDDPRC_BJ_000_01) triggered on regular intervals.

The "Input tab" in the Data Files screen allows you to define the input data file through the
following sections:

• Input Data File Definitions

• Column Definitions

• Configurable Bulk Upload

2.8.2.1 Input Data File Definitions
In the Input Data File Definitions section, you can define and maintain the structure of input
data file to populate data from external system.

Oracle Financial Services Lending and Leasing also supports bulk upload of data into the
system through input file processing for a set of process listed in Setup > Administration >
System > Lookups > Lookup Code section.

Lookup Type: INCOMING_FILE_TYPE_CD

Description: INCOMING LOG FILE TYPE CODE

In addition, there is also an option for configurable bulk upload of data in which the input file
delimiter is configurable to required value. For more information, refer to Configurable Bulk
Upload section.

To set up Input Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Input tab.

2. In the Input Data Files Definitions section, you can make use of the copy option to copy the
Input file definition and corresponding column definitions. To do so, click on the required
record in the list, select the target company for which records needs to be created from
Company drop-down list and click Create Copy. The following records are copied:

• ITU_TXN_UPLOAD

• ASSET_ASE_UPLOAD

• ASSET_ATA_UPLOAD

• ASSET_ATR_UPLOAD

• ASSET_AVL_UPLOAD

• CURE_LTR

• BKRP_NEW

• BKRP_UPDATE
Records for above files are created with External Table Name as External Table
Name_Company code.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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Figure 2-13    Input Data File Definitions

A brief description of the fields is given below:

Table 2-29    Input Data File Definitions

Field Do this

Name Specify a unique name for the input data file.

File Name Specify the data file name with the correct prefix.

Description Specify data file description.

Directory Path Specify the directory path configured within
OFSLL Database server to process the input
data file.

Delimiter Specify the delimiter used to separate column
data. (Ex: Comma).

Record Format System defaults the record format as
VARIABLE.

External Table Name View the name of external table from which input
data is populated.

Company View the company name selected in external
table.

Enabled Check this box to enable the input data file
definition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.2.2 Column Definitions
Each input data file definition is made up of one or more column definitions. These define the
structure of data to be loaded from external system.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 2-30    Column Definitions

Field Do this

Seq Specify the order in which the input data dump
will process the column information.

Column Name Specify name of the column.

Column Description Specify description of the column.

Data Type Select the data type from the drop-down list. The
selected data type describes the type of data the
column is expected to contain such as
INTEGER/DATE/NUMBER/CHARACTER. This
effects how the input data file processing handles
the data, and should not be changed.

Format Mask Select the format mask for the column from the
drop-down list. The list displays the format
depending on the Data Type selected.

For example; Date fields may be entered using
the MM/DD/YYYY format, Number fields may be
entered as decimal numbers with varying
degrees of precision. Other formats for each data
type are available.

Length Specify the column length (the maximum number
of characters of the data to be included in the
input file)

Each input data details column may contain up to
240 characters of data. If the output data details
column contains more data than the length value
the data will be truncated. For VARIABLE
records the length should be set to “-1” or a
Delimited file will be created with FIXED
LENGTH columns.

Sort Specify the order in which the column definitions
are to be sorted for display in the external
interface screen (Customer Service > External
Interfaces). There can be a maximum of 61
column definitions.

Enabled Default selected. If not, you can check this box to
enable the column definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.2.3 Configurable Bulk Upload
In the process of configurable bulk upload of data, the input file delimiter is configurable to
required value and data is processed based on the column definitions defined. This option is
supported for Transactions and Collateral uploads to create new transactions and asset
records in bulk.

For bulk upload of data, the input CSV (comma separated values) file is to be constructed in
specific format as defined in Setup > Data Files > Input screen’s Input Data File Definitions
and Column Definitions sections.

For example, consider the following Column Definition details:

Chapter 2
Data Files

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 43 of 207



Table 2-31    Column Definition Details

Seq Column Name Column
Description

Data Type Length Sort

1 ASE_OPERATI
ON_ IND

OPERATION
IND

CHARACTER 30 1

2 ASE_NBR ASSET
NUMBER

NUMERIC 30 2

3 ASE_REGN_D
T

REGISTRATIO
N DATE

DATE 30 3

If the delimiter in Input Data file definitions is set as ‘,’ (comma), then the csv can be
constructed in same format and sequence of column definition as indicated below with each
row as one record:

ASE_OPERATION_IND,ASE_NBR,ASE_REGN_DT

NEW,20151200010476,12/08/2015

EXISTING,20111300010468,13/10/2011

NEW,20101400010812,14/11/2016

The CSV file is to be paced in the directory path/work area which is the base path defined in
system parameter - UIX_INCOMING_FILE_PATH (INCOMMING FILE PATH OF APP
SERVER) by the system administrator and further appended by the configurable sub folder
name such as ITU or ICC. For example: /scratch/work_area/<domain name>/input/
itu.

Following are the Lookup code maintained in Setup > Administration > System > Lookups >
Lookup Code section for respective process type:

Table 2-32    Lookup Code

Process Type Lookup Code Description

Transaction File Upload ITU TRANSACTION UPLOAD

Asset File Upload ICC INPUT CREATE COLLATERAL

• For Transaction File Upload, only one csv file can be created with multiple records and on
processing, the data is populated into Servicing > Customer Service > Transaction >
History > Transactions tab.

• For Asset File Upload, separate csv files are to be created to upload the data into
Collateral Management screen’s Collateral details, Valuation, Addons/Attributes, and
Tracking sections respectively.

On executing the scheduled batch job in SET-IFP, IDDPRC_BJ_000_02 (BULK INPUT DATA
INSERTION), the data in csv file is processed and is displayed in Servicing Customer Service
> External Interfaces tab. Such data does not need authorization and is directly uploaded on
validating the sequence, position, and format.

The status of batch job can be viewed in DashBoard > System Monitor > Batch Jobs screen.
The records which resulted in error are listed in the bad file.
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2.9 Dedupe
Oracle Financial Services Lending and Leasing’s dedupe feature can be configured to identify
possible fraudulent information and misrepresentation of details on an application based on
duplicate information between applications.

The system checks for duplicate information from existing applications, already rejected
applications, and applications currently being processed.

The following application entry information is used as the dedupe criteria.

Table 2-33    Dedupe

Label Description

First Name First name of the applicant.

Last Name Last name of the applicant.

Date of Birth Date of Birth of the applicant.

Mother’s Maiden Name Applicant’s mother name.

National ID National ID of the applicant.

SSN Applicant’s SSN number.

Driving License Applicants driving license number.

Passport Number Passport number of the applicant.

Customer SSN Customer’s SSN number.

Customer First Name First name of the customer.

Customer Last Name Last name of the customer.

Customer Date of Birth Date of Birth of the customer.

Customer Mother’s Maiden Name Customer’s mother name.

Customer National ID National ID of the customer.

Customer Driving License Customer’s driving license number.

Customer Passport Number Passport number of the customer.

The Dedupe Setup screen enables you to define the dedupe criteria from the fields listed
above. In the Criteria section of Dedupe screen, you can specify the logical operators AND or
OR while defining the criterion.

If you choose AND as the logical operator between the criterion components, the system
retrieves the records that are matching with the details in the criterion components.

For example, if you define the dedupe criteria as First Name and Passport Number, the system
retrieves all records in which both the first name and passport number match the current
application. On the contrary, if you choose OR as the logical operator, the system retrieves all
the records in which either the First Name or Passport Number match the current application.

To set up the Dedupe screen

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Dedupe.

2. The system displays the Dedupe screen. The details are grouped into two:

• Dedupe

• Criteria
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3. In the Dedupe section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 2-14    Dedupe

A brief description of the fields is given below:

Table 2-34    Fields

Field Do this

Code Specify the code of the dedupe.

Description Specify a description of the dedupe.

Enabled Check this box to enable the dedupe.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Criteria section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 2-35    Criteria

Field Do this

Sort Specify the sequence numbers.

( Specify left bracket.

Attribute Select the attribute from the drop-down list.

Comparison Operator Select comparison operator from the drop-down
list.
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Table 2-35    (Cont.) Criteria

Field Do this

) Specify right bracket.

Logical Operator Select logical operator from the drop-down list.

Enable Check this box to enable the criteria.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

A dedup code can have one or more criteria.

7. Click Check Criteria button on the Dedupe screen.

8. The system reviews the selection criteria for errors.

• If the Error Message box displays NO ERROR, click OK.

• If the Error Message box displays errors, make the necessary modifications in the
Criteria section.

During the underwriting and funding processes, you can initiate the de-dupe check by clicking
Dedupe Liabilities in Liabilities section of Applicant and Dedupe Applicant in the Duplicate
Applicant section of Applicants Details respectively.

2.10 Securitization
With the Securitization Setup screen, the system provides a powerful tool that enables financial
institutions to create account pools, to track and manage portfolios.

The Securitization Setup screen enables you to:

• Query account information

• Select accounts based on selection criteria

• Create a pool of selected accounts for sale

• Maintain the pools created and report transactions on these accounts

• Report on investors

• Repurchase pools or specific accounts from pools.

Securitization screen enables you to define the securitization cycles, as well as the
responsibilities that can access the various statuses in each cycle. The following diagram
demonstrates the status cycle:
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Figure 2-15    Securitization Status Cycle

To create a cycle

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Securitization. The system displays the Status Cycle set
up screen. The details are grouped into three:

• Status Cycle

• Current/Next Status

• Status Change Responsibilities

2. In the Status Cycle section, you can view the following details.
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Figure 2-16    Securitization Cycle

A brief description of the fields is given below:

Table 2-36    Status Cycle

Field Do this

Cycle View the cycle code.

Type View the cycle type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Current/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-37    Status Cycle

Field Do this

Current Status Select the current status from the adjoining drop-
down list.

Next Status Select the next status from the adjoining drop-
down list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Status Change Responsibilities section, you can define the responsibilities that
are authorized to change the code. Perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-38    Status Change Responsibilities

Field Do this

Responsibility Select the responsibility that will be capable of
executing this transition, from the drop-down list.
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Table 2-38    (Cont.) Status Change Responsibilities

Field Do this

Allowed Select Yes to allow change to the status
responsibility and No to disallow.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

2.11 Events
In the current version of Oracle Financial Service Lending and Leasing, the Events framework
has undergone changes in the processing type from earlier Engine based framework to Entity
based framework and OFSLL is enabled to support both old and new type of events
processing.

If you have upgraded from an older version of OFSLL, the existing events listed in Event
Types tab and action types listed in Event Action Types’ tab will still be functional as intended
but cannot be added or modified. Along with these two tabs, the data in Online and Batch tab
are also displayed in read-only mode. However, new events and action types can only be
created in Events tab.

• For existing events defined in the system, refer to Events (Existing Framework).

• To work with new events framework, refer to Events (New Framework).

This section consists of the following topics:

• Events (Existing Framework)

• Events (New Framework)

• Monitoring JMS Event Actions

2.11.1 Events (Existing Framework)
During Origination account processing, when an application account moves from one
status/sub status to another, or changes condition, the system can trigger an event and
perform the associated event actions. This can occur either online or in batch mode.

Note

Only predefined events and actions can be set up on the Events Setup screen. You
cannot create new event types or action types.

As processing events and associated actions require additional processing at the server level,
the performance of the transactions, for which the events are setup, may be adversely affected
dependent upon your specific configuration.

In the Events screen you can view trigger events with associated actions which the system
performs during application entry account processing. The fields on this screen are both
system and user defined. There are four sub screens on the Events screen to set up and
maintain these events:

• Events Types

• Event Action Types

• Online
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• Batch

Event Types and Action Types sections of this screen provide a master table for setting up the
online and batch events. This setup triggers the event, which in turn triggers the actions
associated with the events, during application entry account processing.

Navigating to Events

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Events.

This section consists of the following topics:

• Event Types

• Event Action Types

• Online

• Batch

2.11.1.1 Event Types
1. Click Setup > Setup > Administration > System > Events > LoanLine of creditLease >

Events Types.

2. In the Event Types tab, you can view the existing events and its details maintained in the
system.

Figure 2-17    Events Setup
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Figure 2-18    Events Setup

Figure 2-19    Events Setup

A brief description of the fields is given below:
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Table 2-39    Event Types

Field Do this

Event Type Code View the event type code.

Description View the event description.

Process Type View the event action processing type (BATCH or
ONLINE).

Entity Type View the entity type (ACCOUNTS or
APPLICATIONS).

Engine Type View the engine type (MONETARY
TRANSACTIONS PROCESSING, NON-
MONETARY TRANSACTION PROCESSING,
CONDITION/ASSIGNMENT PROCESSING,
APPLICATION STATUS CHANGE, CREDIT
BUREAU PROCESSING, LETTERS
PROCESSING or CORRESPONDENCE).

Enabled Y indicates event type is enabled and N indicates
disabled.

System Defined If Yes indicates that the event type is system
defined. If No indicates that the event type is user
defined.

2.11.1.2 Event Action Types
The Event Action Types section is system defined and lists the action codes supported in the
system.

1. Click Setup > Setup > Administration > System > Events > LoanLine of creditLease >
Event Action Types.
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Figure 2-20    Events Action Setup

Figure 2-21    Events Action Setup
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Figure 2-22    Events Action Setup

A brief description of the fields is given below:

Table 2-40    Event Action Types

Field Do this

Action Code View the action code.

Description View the action description.

Process Type View the event action processing type (BATCH or
ONLINE).

Entity Type View the entity type.

Engine Type View the engine type.

Enabled Y indicates event action type is enabled and N
indicates disabled.

System Defined If Yes indicates that the event action type is system
defined. If No indicates that the event action type is
user defined.

2.11.1.3 Online
The Online tab allows you to view the online events defined in the system along with the event
criteria actions. The system supports the following online events:

1. For change in account’s status system processes the event's actions when the:

• Account status of ACTIVE is reversed

• Account status is changed to PAID

• Account status change to PAID is reversed
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• Account status is changed to CHARGE OFF

• Account status change to CHARGE OFF is reversed.

2. The opening or closing of an accounts conditions. The system processes the event’s
actions during:

• Account condition DELINQUENT is opened

• Account condition DELINQUENT is closed

• CHG OFF Reversal

• Paid Off Reversal

• BKRP is closed

• BKRP Is Opened

• When Queue is Closed

• When status/ Sub status changed to Approved- Rehashed

• Account condition SCHG is closed

• Account condition SCHG is Opened

• Change in application status / sub status to APPROVED – REHASHING

3. The change in application status / sub status to APPROVED – REHASHING.

4. The posting of a non-monetary transaction to the account.

The events that can be performed online after each of the events listed above are as follows:

• Send correspondence for an account

• Generate correspondence for an account

• Send a credit bureau request for an account

• Post a monetary transaction for an account

• Post a condition transaction for an account

• Generate correspondence for an application

• Send a credit bureau request for an application.

To view Online Event

Click Setup > Setup > Administration > System > Events > LoanLine of creditLease >
Online.
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Figure 2-23    Online Setup

Figure 2-24    Online Setup
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Figure 2-25    Online Setup

A brief description of the fields is given below:

Table 2-41    Online Event

Field Do this

Event Code View the event code.

Event Type View the event type.

Synchronous S indicates that the event is synchronous (i.e. any
failure in triggering the event will fail to trigger the
entire transaction). If A indicates that the event is
asynchronous (i.e. any failure in the event will not
affect the transaction, which will be successfully
completed).

Enabled Y indicates event type is enabled and N indicates
disabled.

The Event Criteria section allows you to view the query defined for an event.

A brief description of the fields is given below:

Table 2-42    Event Criteria

Field Do this

Query Name View the query name.

Description View the query description.

Enabled Y indicates event criteria is enabled and N
indicates disabled.
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Criteria Details

The Criteria Details sub tab allows you to view the defined selection criteria for the event.
System uses these criteria to determine which application account to include in the event
action.

Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can have
significant performance impact delaying the EOD processing/web services. Hence it is
recommended to have careful consideration while defining the additional selection
criteria (like using user-defined tables and columns) and/or get approval from your
database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 2-43    Criteria Details

Field Do this

Seq View sequence number.

( Indicates opening bracket.

Parameter View the parameter selected for the criteria.

Comparison Operator View the comparison operator selected for the
criteria.

Criteria Value View the criteria value.

) Indicates closing bracket.

Logical Expression View the logical operator selected for the criteria.

Enabled Y indicates event selection criteria is enabled and
N indicates disabled.

Actions

In the Actions sub tab, you can view the actions that the system performs when event is
triggered. There can be more than one event action for a particular event and the Seq field
defines the order in which the event action should occur.

A brief description of the fields is given below:

Table 2-44    Actions

Field Do this

Description View the event action description.

Seq View sequence number defined for the action.

Enabled Y indicates event action is enabled and N indicates
disabled.

For each event action, view the Action Parameters defined. A brief description of the fields is
given below:
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Table 2-45    Action Parameters

Field Do this

Description View the parameter description.

Value View the parameter value.

Required Y indicates action parameter is required and N
indicates not-required

2.11.1.4 Batch
The Batch screen allows you to view the events performed as a batch transaction by the
system. The system supports the following predefined batch events for applicationaccount
processing. (These batch events are listed in the Events Types tab):

• ACCOUNT LEVEL BATCH EVENT #01

• APPLICATION LEVEL BATCH EVENT #01

• ACCOUNT LEVEL BATCH EVENT #02

• APPLICATION LEVEL BATCH EVENT #02

• ACCOUNT LEVEL BATCH EVENT #03

• APPLICATION LEVEL BATCH EVENT #03

• ACCOUNT LEVEL BATCH EVENT #04

• APPLICATION LEVEL BATCH EVENT #04

• ACCOUNT LEVEL BATCH EVENT #05

• APPLICATION LEVEL BATCH EVENT #05

• ACCOUNT LEVEL BATCH EVENT #06

• APPLICATION LEVEL BATCH EVENT #06

• ACCOUNT LEVEL BATCH EVENT #07

• APPLICATION LEVEL BATCH EVENT #07

• ACCOUNT LEVEL BATCH EVENT #08

• APPLICATION LEVEL BATCH EVENT #08

• ACCOUNT LEVEL BATCH EVENT #09

• APPLICATION LEVEL BATCH EVENT #09

• ACCOUNT LEVEL BATCH EVENT #10

• APPLICATION LEVEL BATCH EVENT #10

To view the Batch Event

Click Setup > Setup > Administration > System > Events > LoanLine of creditLease >
Batch.
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Figure 2-26    Batch Setup

Figure 2-27    Batch Setup
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Figure 2-28    Batch Setup

A brief description of the fields is given below:

Table 2-46    Batch Event

Field Do this

Event Code View the event code.

Event Type View the event type.

Frequency View the event frequency.

Enabled Y indicates event type is enabled and N indicates
disabled.

The Events Criteria section allows you to view the query name and event description defined
for an event.

A brief description of the fields is given below:

Table 2-47    Events Criteria

Field Do this

Query Name View the query name.

Description View the event description

Enabled Y indicates event criteria is enabled and N
indicates disabled.

Criteria Details
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The Criteria Details sub tab allows you to view the defined selection criteria for the event.
System uses these criteria to determine which applicationaccount to include in the event
action.

Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can have
significant performance impact delaying the EOD processing/web services. Hence it is
recommended to have careful consideration while defining the additional selection
criteria (like using user-defined tables and columns) and/or get approval from your
database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 2-48    Criteria Details

Field Do this

Seq View sequence number.

( Indicates opening bracket.

Parameter View the parameter selected for the criteria.

Comparison Operator View the comparison operator selected for the
criteria.

Criteria Value View the criteria value.

) Indicates closing bracket.

Logical Expression View the logical operator selected for the criteria.

Enabled Y indicates event selection criteria is enabled and
N indicates disabled.

Action

In the Actions sub tab, view the actions that the system performs after the event is triggered.
There can be more than one event action for a particular event. The Seq field defines the order
in which the event action should occur. System supports the following batch event actions:

• Send letter for an applicationaccount

• Generate correspondence for an applicationaccount

A brief description of the fields is given below:

Table 2-49    Action

Description View the event action description.

Seq View sequence number defined for the action.

Enabled Y indicates event action is enabled and N indicates
disabled.

For each event action, view the Action Parameters defined. A brief description of the fields is
given below:
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Table 2-50    Action Parameters

Field Do this

Description View the parameter description.

Value View the parameter value.

Required Y indicates action parameter is required and N
indicates not-required

2.11.2 Events (New Framework)
Events in OFSLL refers to user/system generated actions on the system such as updating an
account condition as delinquent or moving the status of a collateral from INACTIVE to ACTIVE
and so on. Whenever such a type of event occurs some defined action can be performed by
the system.

When there is change in entities like Account, Customer and so on by performing an insert/
update operation on the base table, system can trigger a defined event with an associated
event action to expose the same for third-party applications through JMS message or perform
OFSLL actions like posting Comment/Call Activity and so on.

The Events tab serves as a common framework for LoanLineLease module. In a single flow
you can define events with associated actions for entities like Account, Customer and so on
with the type of processing mode as either Online or Batch mode. Further, you can define one
or more event criteria as a trigger when the corresponding event occurs. For each defined
criteria you can define the available event action and associated action parameter(s) to initiate
corresponding action in external / internal system.
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Figure 2-29    Events Workflow

As per the above workflow:

• During Servicing stage, when an event is triggered, the main transaction is committed and
a new parallel transaction is created to check if there is an event definition available.

• If there is an event definition available, system places an AQ (Advanced Queueing)
message in database to check for any matching event criteria. There can be one or more
criteria for an event in database which is further evaluated to get the matching criteria. On
identifying a matching criteria, the defined event with criteria is logged into event entities.

• Based on the Event Type, system executes the associated Event Actions.

– If the event is configured to Batch mode, the event action is performed when the
following batch jobs - EVEPRC_BJ_100_01 (BATCH EVENTS PROCESSING for the
Entities Account/Application/Assets) and/or EVEPRC_BJ_100_03 (BATCH EVENTS
PROCESSING for the Entities Customer/Business/Vendors/Producers) is executed.

– If the event is configured to Online mode, system performs the corresponding actions
immediately.
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• If the Event Action is defined as JMS, a json message is generated with the below format.
You can configure additional details into the message by using response User Defined
Tables. The data added in this table will be represented in Custom Block as illustrated in
the example below.

Figure 2-30    Events_Json_ format

• The following table indicates parameters available for JMS action type definition.

Table 2-51    JMS action type definition

Parameter Description Display

EVENTID System Generated Sequence N

EVENTTYPE Lookup Code of Event Type
Code

N

EVENTMESSAGE User entered event action
message

Y

ENTITYNBR Entity Number. For example,
Account / Customer Number

N
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Table 2-51    (Cont.) JMS action type definition

Parameter Description Display

EVENTSTARTDATE Event Generation Date and
Time

N

EVENTPROCESSDATE Event Process Date and Time N

Note

The parameter marked as Y in Display column are only available in event action
screen for user configuration. Other parameters are system defined and will be
part of every event.

• For each Event Action, there is a User Defined Table maintained in the system and the
same is configurable. There is also User Defined Table maintained based on Response
Parameters and the response fields can be used to configure Entity Key, Non-Key and
Data columns for custom block of json message. Following combination of Event to UDT
mapping are maintained in the system:

– Entity Type | Event | Criteria UDT Type

– Entity | Event Action | UDT Type | UDT Response Type

For complete list of the Events and Actions mapping maintained in the table
event_action_type_mapping, refer to the reference below: https://docs.oracle.com/cd/
F40454_01/pdf/refdocs/Events_UDT_Mapping.pdf

Navigating to Events

On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > System > Events > Events tab.

To define an Event

1. Click Setup > Setup > Administration > System > Events > Events tab.

Figure 2-31    Define an Event
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A brief description of the fields is given below:

Table 2-52    Navigation to Events

Field Do this

Event Code Specify the unique event code.

Description Specify the event description.

Entity Type Select the entity type from the drop-down list.
The list is populated based on
EVENT_ENTITY_TYPE_CD lookup code.

Event Type Select the event identification type for the entity
from the dropdown list. The list is populated
based on EVENT_TYPE_CD lookup code.

Processing Type Specify the processing type as either ONLINE or
BATCH from the drop-down list. The list is
populated based on
EVENT_PROCESS_TYPE_CD lookup code.
• For Online events, when the event is

triggered corresponding actions are
processed immediately. Here all the event
action executions are asynchronous and
does not impact main transaction.

• For Batch events, the event is triggered
when the following batch jobs -
EVEPRC_BJ_100_01 (BATCH EVENTS
PROCESSING for the Entities Account/
Application/Assets) and/or
EVEPRC_BJ_100_03 (BATCH EVENTS
PROCESSING for the Entities Customer/
Business/Vendors/Producers) is executed
and actions are processed.

Enabled Check this box to activate the event type.

2. Perform any of the Basic Actions mentioned in Navigation chapter. In the Event Criteria
sub tab, you can create a query to an event.

3. In the Event Criteria sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-53    Event Criteria

Field Do this

Query Name Specify the unique query name.

Description Specify the event criteria description.

Enabled Check this box to enable the event criteria.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
Criteria Details

The Criteria Details sub tab allows you to define the selection criteria for the event. System
uses these criteria to determine which application account to include in the event action.

5. In the Criteria Details sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
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Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 2-54    Criteria Details

Field Do this

Seq Specify sequence number.

( Specify the opening bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator Select comparison operator from the drop-down
list.

Criteria Value Specify the criteria value.

) Specify the closing bracket.

Logical Expression Select the logical operator from the drop-down
list.

Enabled Check this box to enable the criteria details.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
Actions

In the Actions sub tab, you can define the event action that the system need to perform
when the event is triggered. You can define more than one event action for a particular
event and use the Seq field to define the order in which the event action should occur.

7. In the Action sub tab, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 2-55    Actions

Field Do this

Action Type Select the action type from the drop-down list.
The list is populated based on
EVENT_ACTION_TYPE_CD lookup code.

Action Code The action code is displayed as None by default.

Seq Specify the sequence number of executing the
event action.

Enabled Check this box to enable the event action.

8. Perform any of the Basic Actions mentioned in Navigation chapter.
Action Parameters

In the Action Parameters sub tab, you can define the action parameters with
corresponding values for each event action.
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9. To define the Action Parameters, in the Action sub tab, click Add or Edit. You can also
perform any of the Basic Operations mentioned in Navigation chapter.

10. Click Load Parameters. The applicable Action Parameters are loaded for update.
A brief description of the fields is given below:

Table 2-56    Action Parameters

Field Do this

Description System auto populate the description from user
defined table based on Action code selected.

Value Type Select the value type as one of the following
which is to be included during event action
execution from the drop-down list. The list is
populated based on
EVENT_VALUE_TYPE_CODE lookup code.
• CONSTANT
• SYSTEM DRIVEN
• USER INPUT
• COLUMN VALUE (For this value type, the

Action Parameter values are displayed from
User Defined Tables based on the Event
Type. However, note that if the column value
cannot be fetched due to multiple records or
if no record exist, then action parameter
value is displayed blank/null).

Currently the Column Value is configured to refer
only Accounts table (Entity Type) and can
process the following Event Actions Type:
• POST COMMENT
• POST MONETARY TRANSACTION
• POST NON MONETARY TRANSACTION

For SEND CORRESPONDENCE Action Type,
there are additional parameters - USER
DEFINED ELEMENT and USER DEFINED
CONSTANT available in Setup >
Correspondence screen to provide input during
execution of Event Action. The same is available
in Events screen and can be modified before
triggering the event action.

Value If the Value Type is selected as CONSTANT,
specify the required action parameter value.

If the Value Type is selected as SYSTEM
DRIVEN, you can add the following values for
system to derive the parameter values during the
execution of the Event.

$GLDATE - GL DATE System Parameter Value

$PAYMENTAMOUNT - Account Monthly
Payment Amount

$OUTSTANDINGAMOUNT - Account Total
Outstanding Amount

$RATE - Account Rate

$TOTALTERM - Account Total Term

$AVAILABLETERM - Account Available Term

Required Y indicates the action parameter is required, else
No.
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11. Perform any of the Basic Actions mentioned in Navigation chapter.

2.11.3 Monitoring JMS Event Actions
You can verify the status of events and event actions on the Monitor Jobs screen of the System
Monitor screen.

To monitor events

1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor > JMS Queues.
The JMS Queues screen displays the Status for all asynchronous events processed in the
system.

For more details, refer to Dashboard > System Monitor section in any of the User Guides.

2.12 Batch Jobs
Batch jobs refer to the back-end processes that automatically run at a certain time. There are
two types of batch jobs:

• Business processes (such as billing and delinquency processing)

• Housekeeping tasks (such as application aging and application purging)

• Batch Jobs

• Batch Jobs Available

2.12.1 Batch Jobs
The Batch Job screen allows you to set up, monitor, and maintain batch jobs in the system.

Batch jobs can be set up to be performed on a daily, weekly, monthly, and ad-hoc basis. Batch
jobs can also be configured to trigger an e-mail or phone message if a batch job fails.

Critical batch jobs control job flow and system date rollover to allow recovery during errors.
Errors are instances where a process did not successfully complete. Failures indicate that a
particular job encountered errors that require remedial action. The number of errors allowed
before failure is defined for each job. Some errors automatically result in a failure.

Navigating to Batch Jobs:

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Batch Jobs. The Batch Jobs details are further grouped
into two tabs:

• Batch Jobs

• Job Holidays

2.12.1.1 Batch Jobs
In the Batch Job Setup screen, you can track and maintain all batch processes within the
system. Using this form, the system administrator can configure the frequency and start time of
each batch process, as well as set the number of threads to improve performance.

Threading allows a specific job to be separated into smaller units that are processed at the
same time. This allows Oracle Financial Services Lending and Leasing to complete the job in
less time.
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You can set up multiple batch jobs within a batch set. In the Batch Job Sets section, each
process is listed with the last run date (Last Run Dt field) and the next scheduled process date
(Next Run Dt field). In the Freq Code and Freq Value fields, you can determine the frequency
of each batch set, such as daily, weekly and monthly. You can also set up batch sets to
incorporate a dependency on another batch set. This way, if the initial batch fails, the
dependent set will not be processed.

In the Batch Jobs section, you can configure the process to run on weekends and holidays
using the respective option boxes.

CAUTION: As the batch job setup widely affects the Oracle Financial Services Lending and
Leasing system, Oracle Financial Services Software suggests that the system administrator
has a clear understanding of the various functionalities within Oracle Financial Services
Lending and Leasing before creating and updating the batch processes.

For the standard job set please review the Visio document,
dbk_std_detail_design_job_sets.vsd

Configure Batch Jobs at Company Level

OFSLL is enabled to process the configured batch jobs at each Company level giving a
flexibility to schedule and run batch job or EOD processing at desired time zone. Irrespective of
Company or Branch, the batch jobs can be run independently on specific time in scheduler. For
more details on configuring the batch job at each company definition level, refer to Appendix -
Configuration at Company Level chapter.

To setup a Batch job

1. Click Setup > Setup > Administration > System > Batch Jobs.

2. In the Batch Job Sets section, you can make use of the copy option to copy the whole
batch job set at one go with header and detailed records for each company definition. To
do so, select the Company from drop-down list and click Create Copy. System copies the
batch job sets from the selected Company record to the Company selected from dropdown
list. All those batch job set which are not already available in the selected Company are
copied.
Note that:

• The Create Copy option can be used multiple times.

• The Company drop-down list is displayed based on the User Access defined for the
logged-in user.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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Figure 2-32    Batch Jobs

A brief description of the fields is given below:

Table 2-57    Batch job - Setup

Field Do this

Company Select the company from the drop-down list. The
list is populated only with those Company
Definitions to which you have been provisioned
access.

This company is considered if system is setup to
process batch jobs at Company level. For more
information, refer to Appendix - Company Level
GL Date Configuration section.

Set Code Specify the code for the batch job set.

Job Set Description Specify the description for the batch job set.

Frequency Select the frequency at which the job set is to be
executed from the drop-down list.

Frequency Value Select the frequency value from the drop-down
list. The frequency value will be displayed based
on the frequency code selected.

Start Time Specify the start time for the job set.

Critical Check this box to set job as critical. A critical job
is one that prevents the General Ledger (GL)
post date from rolling forward, should the job fail.

Enabled Check this box to enable the job set.

Last Run Dt The system displays the last run date of the job
set.

Next Run Dt Specify the next run date for job set. You can
select the data from adjoining calendar icon.

Parent Select the parent job set from drop-down list.

Chapter 2
Batch Jobs

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 73 of 207



Table 2-57    (Cont.) Batch job - Setup

Field Do this

Dependency Select the type of dependency on the parent
from drop-down list.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Batch Job section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 2-58    Batch Job - Navigation

Field Do this

Seq Specify the batch job sequence number.

Note: Within a job set, jobs are executed
sequentially based on the sequence number
assigned.

Job Type Select the batch job request type from the drop-
down list.

Job Code Specify the batch job request code.

Job Description Specify the batch job description.

Threads The system displays the number of threads used
by the job.

Commit Count Specify the number of rows after which auto-
commit is triggered.

Errors Allowed Specify the number of errors allowed.

Weekend Check this box to perform batch jobs on
weekend.

Holiday Check this box to perform batch jobs on a
holiday. (Holidays are defined on the Job
Holidays screen.)

Enabled Check this box to enable the batch job.

Parent Select the parent batch job from the drop-down
list.

Dependency Select the dependency clause of the batch job
from the drop-down list.

Command Specify the command line for the job (required).

RollbackSegment If you choose, use this field to specify the
rollback segment for job.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Batch Job Thread section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-59    Batch Job Thread

Field Do this

Thread Specify the name of thread.
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Table 2-59    (Cont.) Batch Job Thread

Field Do this

Trace Specify the SQL trace level (0, 1, 4, 8, 12). The
higher the number, the more activities the system
can trace.

Enabled Check this box to enable the thread.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

2.12.1.2 Job Holidays
The system allows you to define holidays within the company on Job Holidays screen. You can
then use the Batch jobs screen to set up whether you want the system to perform batch jobs
on these days or not, using the Holiday box of Batch Jobs section.

To define job holidays

1. Click Setup > Setup > Administration > System > Batch Jobs > Job Holidays.

2. In the Job Holidays section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 2-33    Job Holidays

A brief description of the fields is given below:

Table 2-60    Job Holidays

Field Do this

Holiday Dt Specify the date of the job holiday. You can
select the date from the adjoining calendar icon.

Description Specify the job holiday description (required).
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Table 2-60    (Cont.) Job Holidays

Field Do this

Company Select the company from the drop-down list. The
list is populated only with those Company
Definitions to which you have been provisioned
access.

This company is considered if system is setup to
process holiday at Company level. For more
information, refer to Appendix - Company Level
GL Date Configuration section.

Enabled Check this box to enable the holiday.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.12.2 Batch Jobs Available
The below table provides a list of Batch Jobs maintained in the system and a brief description
to each:

Table 2-61    Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

AAE Applicatio
n Account
Interface

aaiprc_bj_
100_01

APPLICA
TION TO
ACCOUN
T
INTERFA
CE

No Yes No Common This
process
periodicall
y picks up
applicatio
ns in
Approved
-Verified
status and
creates
accounts.

ACH ACH
Accounts

acaprc_bj
_100_01

ACCOUN
T ACH
PROCES
SING

No Yes No Common This
process
produces
the ACH
file for the
eligible
customer
payments.

ACH ACH
Producers

acpprc_bj
_100_01

PRODUC
ER ACH
PROCES
SING

Yes Yes No Common This
process
produces
the ACH
file for the
eligible
producer
payments
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ACH ACH
Vendors

acvprc_bj
_100_01

VENDOR
ACH
PROCES
SING

No Yes No Common This
process
produces
the ACH
file for the
eligible
vendor
payments.

ACH ACH
Producer/
Vendors/
Customer/
Third
Party

acxprc_bj
_100_01

ACH
Producer/
Vendors/
Customer/
Third
Party

Yes Yes No Common This
process
producers
the ACH
file for the
eligible
Producer/
Vendors/
Customer/
Third
Party

AGE Aging
Applicatio
ns

agaapp_b
j_100_01

APPLICA
TION
AGING
PROCES
S

Yes No No Common This
process
puts
applicatio
ns into
Aged-
Applicati
on
substatus.

AGE Aging
Contracts

agccon_bj
_100_01

CONTRA
CT
AGING
PROCES
S

Yes No No Common This
process
puts
contracts
into
Aged-
Contract
substatus.

ALTPFS ALLOTME
NT
EXTRACT
FILE
DUMP

PFSEFTP
RC_BJ_1
11_01

BACKUP
EFT

No Yes No Common This
process
creates
the
Backup
EFT file

ALTPFS ALLOTME
NT
EXTRACT
FILE
DUMP

PFSLBAP
RC_BJ_1
00_01

POSTING
ALLOTME
NT
PAYMENT
S

No Yes No Common This
process
posts the
payments
from the
allotment
file
received
from the
bank
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ALTPFS ALLOTME
NT
EXTRACT
FILE
DUMP

PFSODD
ALT_BJ_1
00_01

ALLOTME
NT
EXTRACT
FILE
DUMP

No Yes No Common This
process
sends the
allotment
draft
notice to
the bank

ALTPFS ALLOTME
NT
EXTRACT
FILE
DUMP

PFSNSFP
RC_BJ_1
00_01

NSF
BATCH

No Yes No Common This
process
posts the
NSF file
received
from the
bank

API API
Accounts

accaai_bj
_100_01

API AAI No Yes No Common This
process
creates
accounts
from
validated
conversio
n
applicatio
ns/
contracts

API API
Accounts

accdmp_b
j_100_01

MOVE
API_XX
TO ITABS

No Yes No Common This
process
copies
data from
conversio
n API
tables to
conversio
n
applicatio
ns table

API API
Accounts

accval_bj
_111_01

VALIDATE
ITABS
(LOAN)

No Yes No Loan This
process
validate
all
conversio
n
applicatio
ns loan
accounts
by
running
the edits
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

API API
Accounts

accval_bj
_112_01

VALIDATE
ITABS
(LINE)

No Yes No Line This
process
validate
all
conversio
n
applicatio
ns line of
credit
accounts
by
running
the edits

API API
Accounts

acmprc_
bj_100_0
1

LOAD
API_COM
MENTS

No Yes No Common This
process
creates
account
comments
from
conversio
n
applicatio
ns/
contracts
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

API API
Accounts

APIDMP_
BJ_100_0
1

LOAD API
RECORD
S

No Yes Yes Common This
process
directly
reads
data from
database
folder and
using the
external
tables
loads it
into API
tables for
creating
accounts.

This
eliminates
the need/
dependen
cy of SQL
loader
and
Control
files.

Ensure
that
account
data in
Input file
has same
structure
as defined
in Setup >
Data Files
> Input
definition
specificall
y for
Loan,
Line &
Lease
accounts.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SETAPI2 ASYNCH
RONOUS
ACCOUN
T
CREATIO
N

ACXVAL_
BJ_100_0
1

VALIDATE
IAPP
TABS

Yes Yes Yes Common This
process is
used to
validate
the data
from the
Account
On-
Boarding
request.

This
process is
the first
stage in
processin
g
asynchron
ous
account
creation
using
Account
on-
boarding
web
service
and is
controlled
based on
value
defined in
system
parameter
-
ACCOUN
T_PROC
ESSING_
THRESH
OLD.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SETAPI2 ASYNCH
RONOUS
ACCOUN
T
CREATIO
N

ACXAAI_
BJ_100_0
1

ASYNCH
RONOUS
ACCOUN
T
CREATIO
N

Yes Yes Yes Common This
process is
used for
asynchron
ous
accounts
creation
using
Account
on-
boarding
web
service.

This
process is
the next
stage
after
successfu
l
validation
of account
creation
request
without
any
errors.

Based on
the
request
and
system
parameter
value in
ACCOUN
T_PROC
ESSING_
-
THRESH
OLD
accounts
are
created in
the
system
with all
the details
and with
Status of
account
as Active,
Error,
Void.

Note:
These
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

Accounts
can have
Account
Number
generated
externally
or require
OFSLL to
generate
these
number.

COL Appointm
ent
Cancellati
on

capprc_bj
_100_01

APPPOIN
TMENT
CANCEL
PROCES
SING

No Yes Yes Common This
process
cancels
all the
expired
appointm
ents.

COL Payment
Promise
Processin
g

cppprc_bj
_100_01

BROKEN
PROMISE
PROCES
SING

No Yes No Common This
process
updates
any
broken
promises
as of the
run time.

CRB Credit
Bureau
Reporting

cbuutl_bj_
100_01

CREATE
METRO2
FILE

No Yes No Common This
process
creates
the
METRO2
file for
Credit
Bureau
reporting
for the
specified
date.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

DOT Document
Tracking
Load

dolprc_bj_
000_01

ACCOUN
T
DOCUME
NT LOAD

No Yes Yes Common This
process
reads
acct_doc_
load
directory.
Attach the
document
s to
specified
accounts
and move
document
s to
appropriat
e
directory

DLX Accounts
Dialer
Exclusion

ODXPRC
_BJ_100_
0 1

ACCOUN
TS
DIALER
EXCLUSI
ON

No Yes Yes Common This
process
generates
a dialer
exclusion
file with
account
details
and
checks if
the
maintaine
d call
action
result
entry is
made on
any
account
during the
specified
time
interval.

GLP GL
Interface

gliprc_bj_
100_01

GL
SUMMAR
IZATION

No Yes No Common This
process
summariz
es GL
transactio
ns for the
day.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

GOV Debt
Reporting
IRS
1099A /
1099C

gdraap_bj
_100_01

IRS 1099-
A
PROCES
SING

No Yes No Common This
process
generates
the 1099-
A flat file
for
governme
nt
reporting.

GOV Debt
Reporting
IRS
1099A /
1099C

gdrcad_bj
_100_01

IRS 1099-
C
PROCES
SING

No Yes No Common This
process
generates
the 1099-
C flat file
for
governme
nt
reporting.

GOV HMDA
Reporting

ghrprc_bj
_100_01

IRS
HMDA
PROCES
SING

Yes No No Common This
process
generates
the HMDA
flat file for
governme
nt
reporting.

GOV Interest
Reporting
IRS 1098

girprc_bj_
100_01

IRS 1098
PROCES
SING

No Yes No Common This
process
generates
the 1098
flat file for
governme
nt
reporting.

JOB Scheduler jsctst_bj_
000_01

Scheduler Yes Yes Yes Common This
process
test the
job
scheduler

LBP Lockbox lbxprc_bj_
100_01

LOAD
LOCKBO
X
PROCES
SING

No Yes No Common This
process
loads any
lockbox
files
available.
This
process
can be set
to run
periodicall
y
throughou
t the day.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

LNT Lien
Tracking

OFDPRC
_BJ_111_
0 3

OUTPUT
LIEN
TRACKIN
G FOR
DATA
CHANGE

No Yes No Common This
process
generates
output file
with
changes
in
customer
informatio
n such as
Address/
Phone
no./
Borrower/
Coborrow
er name.

LNT Lien
Tracking

OFDPRC
_BJ_111_
0 4

OUTPUT
LIEN
TRACKIN
G FOR
VOID
ACCOUN
T

No Yes No Common This
process
generates
output file
for Void
Accounts
to be sent
to dealer
track.

LTR Collection
s Letter

lcolt1_bj_
100_01

GENERA
TE FIRST
COLLECT
ION
LETTER

No No Yes Common This
process
generates
the first
collection
letter for
eligible
accounts.

LTR Collection
s Letter

lcolt2_bj_
100_01

GENERA
TE
SECOND
COLLECT
ION
LETTER

No No Yes Common This
process
generates
the
second
collection
letter for
eligible
accounts.

LTR Collection
s Letter

lcolt3_bj_
100_01

GENERA
TE THIRD
COLLECT
ION
LETTER

No No Yes Common This
process
generates
the third
collection
letter for
eligible
accounts.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

LTR Customer
Service
Letter

lcspdf_bj_
111_01

PAID IN
FULL
LETTER

No Yes No Loan This
process
generates
the paid-
in full
letter for
the
relevant
accounts.

LTR Customer
Service
Letter

lcspoq_
bj_111_0
1

PAYOFF
QUOTE
LETTER

No Yes No Common This
process
generates
the payoff
quote
letter for
the
requested
accounts.

LTR Customer
Service
Letter

lcsstm_
bj_100_0
1

CUSTOM
ER
STATEME
NT
LETTER

No Yes No Common This
process
generates
the
customer/
business
statement
letter for
requested
accounts.

LTR Customer
Service
Letter

lcswel_bj_
111_01

WELCOM
E
LETTER

No Yes No Loan This
process
generates
the
welcome
letter for
the newly
funded
accounts.

LTR Originatio
n Letter

loraco_bj_
111_01

Originatio
n Adverse
Action
Letter
(Condition
al) (Loan)

Yes No No Loan This
process
generates
the
adverse
action
letter for
relevant
applicatio
ns.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

LTR Originatio
n Letter

loradv_bj_
111_01

Originatio
n Adverse
Action
Letter
(Loan)

Yes No No Loan This
process
generates
the
adverse
action
letter for
relevant
applicatio
ns.

ODD Coupon
Book
Dump File

ocnprc_bj
_100_01

CUSTOM
ER
COUPON
BOOK
GENERA
TION

No Yes No Common This
process
generates
coupon
books, if
appropriat
e.

ODD Output
Data
Dump File

oddprc_bj
_000_01

CREATE
OUTPUT
DATA
DUMP
FILES

Yes Yes Yes Common This
process
creates
any
defined
output
data
dump files
set in the
system.

ODD Collection
s Letter

olclt1_bj_
100_01

COLLECT
ION
LETTER
1 FILE
CREATIO
N

No No Yes Commom This
process
generates
the first
collection
letter for
eligible
accounts.

ODD Collection
s Letter

olclt2_bj_
100_01

COLLECT
ION
LETTER
2 FILE
CREATIO
N

No No Yes Common This
process
generates
the
second
collection
letter for
eligible
accounts.

ODD Collection
s Letter

olclt3_bj_
100_01

COLLECT
ION
LETTER
3 FILE
CREATIO
N

No No Yes Common This
process
generates
the third
collection
letter for
eligible
accounts.

Chapter 2
Batch Jobs

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 88 of 207



Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ODD Originatio
n Letter

oloaco_
bj_100_0
1

ADVERS
E
ACTION
CONDITI
ONAL
LETTER
FILE
CREATIO
N

Yes No No Common This
process
generates
the
adverse
action
letter for
relevant
applicatio
ns.

ODD Originatio
n Letter

oloadv_
bj_100_0
1

ADVERS
E
ACTION
LETTER
FILE
CREATIO
N

Yes No No Common This
process
generates
the
adverse
action
letter for
relevant
applicatio
ns.

ODD Customer
Service
Letter

olspdf_bj_
100_01

PAID IN
FULL
FILE
CREATIO
N

No Yes No Common This
process
generates
the paid-
in full
letter for
the
relevant
accounts.

ODD Customer
Service
Letter

olspoq_
bj_100_0
1

PAY OFF
QUOTE
FILE
CREATIO
N

No Yes No Common This
process
generates
the payoff
quote
letter for
the
requested
accounts.

ODD Customer
Service
Letter

olswel_
bj_100_0
1

WELCOM
E
LETTER
FILE
CREATIO
N

No Yes No Common This
process
generates
the
welcome
letter for
the newly
funded
accounts.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ODD Producer
Statement
Dump File

opsprc_bj
_100_01

DEALER
STATEME
NTS
GENERA
TION

No Yes No Common This
process
generates
the
dealer/
producer
statement
s at the
specified
frequency.

ODD Customer
Statement
Dump File

ostprc_bj_
100_01

CUSTOM
ER
STATEME
NTS
GENERA
TION

No Yes No Common This
process
generates
the
customer/
business
statement
for eligible
accounts.

PRQ Payable
Requistio
n
Customer

pcuprc_bj
_100_01

CUSTOM
ER
REFUND
PAYMENT
REQUISI
TIONS

No Yes No Common This
process
creates
requisition
s for
customer/
business
overpaym
ent
refunds.

PRQ Payable
Requisitio
n
Producer

ppores_bj
_100_01

MONTH
END
DEALER
RESERV
E
PAYMENT
REQUISI
TIONS

No Yes No Common This
process
creates
requisition
s for
dealer
compensa
tion
payments
on month-
end.

PRQ Payable
Requisitio
n Vendor

pvnprc_bj
_100_01

VENDOR
INVOICE
PAYMENT
REQUISI
TIONS

No Yes No Common This
process
creates
requisition
s for
vendor
invoice
payments.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR Archive
Accounts

pacarc_bj
_100_01

ARCHIVE
ACCOUN
T DATA
TO
OTABLES

No Yes Yes Common This
process
archives
account
data from
ACCOUN
TS table
to
OACCOU
NTS
table.

PUR Archive
Accounts

pacarc_bj
_100_02

ARCHIVE
ACCOUN
T DATA
TO
OOTABLE
S

No Yes Yes Common This
process
archives
account
data from
OACCOU
NTS table
to
OOACCO
UNTS
table.

PUR Archive
Applicatio
ns

paparc_bj
_100_01

ARCHIVE
APPLICA
TION
DATA TO
OTABLES

Yes No No Common This
process
archives
applicatio
n- related
data from
APPLICA
TIONS to
OAPPLIC
ATIONS
table.

PUR Archive
Applicatio
ns

paparc_bj
_100_02

ARCHIVE
APPLICA
TION
DATA TO
OOTABLE
S

Yes No No Common This
process
archives
applicatio
n- related
data from
OAPPLIC
ATIONS
to
OOAPPLI
CATIONS
table.

PUR Archive
GL

pglarc_bj_
100_01

ARCHIVE
GL DATA
TO
OTABLES

No Yes Yes Common This
process
archives
General
Ledger
data from
GL tables
to OGL
tables.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR Archive
GL

pglarc_bj_
100_02

ARCHIVE
GL DATA
TO
OOTABLE
S

No Yes Yes Common This
process
archives
General
Ledger
data from
OGL
tables to
OOGL
tables.

PUR Purge Job
Requests

pjrjrq_bj_
100_01

Purge Job
Requests

Yes Yes Yes Common This
process
purges
job
requests
from the
system.

PUR Purge
Output
Data
Dump

pododh_b
j_100_01

PURGE
OUTPUT
DATA
HEADER
S

No Yes Yes Common This
process
purges
Output
Data
Headers
from the
system
based on
the days
defined in
system
parameter
POD_AR
CHIVE_D
AYS..

PUR Archive
Securitiza
tion

ppaarc_bj
_100_01

ARCHIVE
POOL
DATA TO
OTABLES

No Yes No Common This
process
archives
securitizat
ion data
from
TABLE to
correspon
ding
OTABLE.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR Archive
Securitiza
tion

ppaarc_bj
_100_02

ARCHIVE
POOL
DATA TO
OOTABLE
S

No Yes No Common This
process
archives
securitizat
ion data
from
OTABLE
to
correspon
ding
OOTABLE
.

PUR Archive
Producers

pprarc_bj
_100_01

ARCHIVE
PRODUC
ER DATA
TO
OTABLES

Yes Yes Yes Common This
process
archives
producer
data from
PRODUC
ERS table
to
OPRODU
CERS
table.

PUR Archive
Producers

pprarc_bj
_100_02

ARCHIVE
PRODUC
ER DATA
TO
OOTABLE
S

Yes Yes Yes Common This
process
archives
producer
data from
OPRODU
CERS
table to
OOPROD
UCERS
table.

PUR Archive
Producers
Txns

ppxarc_bj
_100_01

ARCHIVE
PRODUC
ER TXNS
DATA TO
OTABLES

No Yes No Common This
process
archives
producer
transactio
n data
from
PRODUC
ERS table
to
OPRODU
CERS
table.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR Archive
Producers
Txns

ppxarc_bj
_100_02

ARCHIVE
PRODUC
ER TXNS
DATA TO
OOTABLE
S

No Yes No Common This
process
archives
producer
transactio
n data
from
OPRODU
CERS
table to
OOPROD
UCERS
table.

PUR Archive
Statement
s

pstarc_bj_
100_01

ARCHIVE
ACCOUN
T
STATEME
NT AND
TXNS
DATA TO
OTABLES

No Yes No Common This
process
archives
account
statement
and
transactio
n data
from
TABLE to
correspon
ding
OTABLE.

PUR Archive
Statement
s

pstarc_bj_
100_02

ARCHIVE
ACCOUN
T
STATEME
NT AND
TXNS
DATA TO
OOTABLE
S

No Yes No Common This
process
archives
account
statement
and
transactio
n data
from
OTABLE
to
OOTABLE
.

PUR Terminate
User

ptuusr_
bj_100_0
1

Terminate
User

Yes Yes Yes Common This
process
terminate
s user
satisfying
the
selection
criteria.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR Archive
Txns (To
O tables)

ptxarc_bj_
100_01

ARCHIVE
TXNS
DATA TO
OTABLES

No Yes No Common This
process
archives
data from
TXNS
table to
OTXNS
table.

PUR Archive
Txns (To
OO
tables)

ptxarc_bj_
100_02

ARCHIVE
TXNS
DATA TO
OOTABLE
S

No Yes No Common This
process
archives
data from
OTXNS
table to
OOTXNS
table.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-PUR ARCHIVE
PURGE
JOB SET

PTXARC_
BJ_100_1
1

NEW
ARCHIVE
TXNS
DATA TO
OTABLES

No Yes No Common This
process
archives
the
following
table data
based on
the
number of
archive
days
configure
d in
system
parameter
PTX_INA
CTIVE_T
XN_ARC
HIVE_DA
YS +
inactive
transactio
ns (if
txn_prima
ry_ind =
NO) and
when the
'transactio
n post
date
(txn_post
_dt) is
less than
batch job
process
date.
• TXN

S to
OTX
NS

• TXN_
GRO
UPS_
TEM
P to
OTX
N_G
ROU
PS_T
EMP

• TXN
S_AU
THO
RIZA
TION
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

_HIS
TOR
Y to
OTX
NS_A
UTH
ORIZ
ATIO
N_HI
STO
RY

Also, this
process
archives
table data
from:
• TXN

S_TE
MP to
OTX
NS_T
EMP
when
the
txn_p
ost_d
t less
than
batch
job
proce
ss dt
and
base
d on
the
numb
er of
archi
ve
days
confi
gured
in
syste
m
para
meter
PTX_
TXN_
TMP
_AR
CHIV
E_DA
YS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

• From
PAYM
ENT
S_TE
MP to
OPAY
MEN
TS_T
EMP
when
the
pmt_
dt
less
than
batch
job
proce
ss dt
and
base
d on
the
numb
er of
archi
ve
days
confi
gured
in
syste
m
para
meter
PTX_
PMT
_TM
P_AR
CHIV
E_DA
YS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-PUR ARCHIVE
PURGE
JOB SET

PTXARC_
BJ_100_1
2

NEW
ARCHIVE
TXNS
DATA TO
OOTABLE
S

No Yes No Common This
process
archives
the
following
table data
based on
the
number of
archive
days
configure
d in
system
parameter
PTX_INA
CTIVE_T
XN_OAR
CHIVE_D
AYS +
inactive
transactio
ns (if
txn_prima
ry_ind =
NO) and
when the
'transactio
n post
date
(txn_post
_dt) is
less than
batch job
process
date.
• OTX

NS to
OOT
XNS

• OTX
N_G
ROU
PS_T
EMP
to
OOT
XN_
GRO
UPS_
TEM
P

• OTX
NS_A
UTH
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ORIZ
ATIO
N_HI
STO
RY to
OOT
XNS_
AUT
HORI
ZATI
ON_
HIST
ORY

Also, this
process
archives
table data
from:
• OTX

NS_T
EMP
to
OOT
XNS_
TEM
P
when
the
txn_p
ost_d
t less
than
batch
job
proce
ss dt
and
base
d on
the
numb
er of
archi
ve
days
confi
gured
in
syste
m
para
meter
PTX_
TXN_
TMP
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

_OA
RCHI
VE_D
AYS.

• From
OPM
T_TM
P to
OPM
T_TM
P
when
the
pmt_
dt
less
than
batch
job
proce
ss dt
and
base
d on
the
numb
er of
archi
ve
days
confi
gured
in
syste
m
para
meter
PTX_
PMT
_TM
P_O
ARC
HIVE
_DAY
S.

PUR Purge
User
Logins

pululg_bj_
100_01

Purge
User
Logins

Yes Yes Yes Common This
process
purges
user login
data from
the
system.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR Archive
Vendor
Assignme
nts

pvaarc_bj
_100_01

ARCHIVE
VENDOR
ASSIGNM
ENTS
DATA TO
OTABLES

No Yes Yes Common This
process
archives
vendor
assignme
nt data
from
TABLE to
OTABLE.

The
criteria for
archival is
based on
following
validation
- Work
Order
Status =
Closed /
Complete
d /
Reposses
sed +
Days
mentione
d in
system
parameter
PVA_AR
CHIVE_-
DAYS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR Archive
Vendor
Invoices

pviarc_bj_
100_01

ARCHIVE
VENDOR
INVOICE
S DATA
TO
OTABLES

No Yes Yes Common This
process
archives
vendor
invoice
data from
TABLEs
to
OTABLEs.

The
criteria for
archival is
based on
following
validation
- Invoice
Status =
Close +
Days
mentione
d in
system
parameter
PVI_ARC
HIVE_-
DAYS.

PUR Archive
Vendor
Invoices

pviarc_bj_
100_02

ARCHIVE
VENDOR
INVOICE
S DATA
TO
OOTABLE
S

No Yes Yes Common This
process
archives
vendor
invoice
data from
OTABLEs
to
OOTABLE
s based
on the
days
mentione
d in
system
parameter
PVI_OAR
CHIVE_
DAYS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR Archive
Vendors

pvearc_bj
_100_01

ARCHIVE
VENDOR
S DATA
TO
OTABLES

No Yes Yes Common This
process
archives
vendor
invoice
data from
TABLEs
to
OTABLEs.

The
criteria for
archival is
based on
following
validation
- Vendor
end date
is less
than
system
date -
Days
mentione
d in
system
parameter
PVE_AR
CHIVE_-
DAYS.

PUR Archive
Vendors

pvearc_bj
_100_02

ARCHIVE
VENDOR
S DATA
TO
OOTABLE
S

No Yes Yes Common This
process
archives
vendor
invoice
data from
OTABLEs
to
OOTABLE
s based
on the
days
mentione
d in
system
parameter
PVE_OA
RCHIVE_
DAYS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

QUE Queue
Customer
Service

qcsprc_bj
_100_01

CUSTOM
ER
SERVICE
QUEUE
PROCES
SING

No Yes Yes Common This
process
creates
the
customer
service/
collection
s queues

SETQCS QUEUES QCCPRC
_BJ_100_
01

CRITERI
A BASED
CONDITI
ON
POSTING

No Yes Yes This
process
facilitates
to post
criteria
based
conditions
on
Account.

SETQRT REAL
TIME
QUEUES

QCCPRC
_BJ_100_
02

CRITERI
A BASED
CONDITI
ON
POSTING
REAL
TIME
PROCES
SING

Yes Yes This batch
job
processes
criteria
based
condition
posting
queues
marked
as real
time
based on
refresh
frequency
setup in
the job
set.

RDB1 RDB1
Accounts

racdmp_b
j_100_01

Data
Dump
Accounts

No Yes Yes Common This
process
transfers
the
account
data from
(OLTP)
Regular
tables to
Temporar
y T tables
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RDB1 RDB1
Applicatio
ns

rapdmp_b
j_100_01

LOAD
APPLICA
TION
RELATED
DATA
INTO T
TABLES

Yes No No Common This
process
transfers
the
applicatio
n data
from
(OLTP)
Regular
tables to
Temporar
y T tables

RDB1 RDB1
Asset
Tracking

ratdmp_bj
_100_01

LOAD
ASSET
RELATED
DATA
INTO T
TABLES

No Yes No Common This
process
transfers
the
account
asset data
from
(OLTP)
Regular
tables to
Temporar
y T tables

RDB1 RDB1
Bankruptc
y

rbkdmp_b
j_100_01

LOAD
BANKRU
PTCY
DATA TO
T TABLES

No No Yes Common This
process
transfers
the
account
bankruptc
y data
from
(OLTP)
Regular
tables to
Temporar
y T tables

RDB1 RDB1
Call
Activities

rcadmp_b
j_100_01

LOAD
CALL
ACTIVITI
ES DATA
INTO T
TABLES

No No Yes Common This
process
transfers
the
account
call
activity
data from
(OLTP)
Regular
tables to
Temporar
y T tables
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RDB1 RDB1
Deficiency

rchdmp_b
j_100_01

LOAD
DEFICIE
NCY
DATA
INTO T
TABLES

No No Yes Common This
process
transfers
the
account
deficiency
data from
(OLTP)
Regular
tables to
Temporar
y T tables

RDB1 RDB1
Contracts

rcodmp_b
j_100_01

LOAD
CONTRA
CT DATA
INTO T
TABLES

Yes Yes No Common This
process
transfers
the
account
contracts
data from
(OLTP)
Regular
tables to
Temporar
y T tables

RDB1 RDB1
Reposses
sions

rfodmp_bj
_100_01

LOAD
REPO
FORECL
OSURE
DATA
INTO T
TABLES

No No Yes Common This
process
transfers
the
account
bankruptc
y data
from
(OLTP)
Regular
tables to
Temporar
y T tables

RDB1 RDB1
Producers

rprdmp_bj
_100_01

LOAD
PRODUC
ER AND
ITS TXNS
DATA
INTO T
TABLES

No Yes No Common This
process
transfers
the
producer
and
producer
transactio
ns data
from
(OLTP)
Regular
tables to
Temporar
y T tables
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RDB1 RDB1
Setup

rstdmp_bj
_100_01

LOAD
SETUP
RELATED
DATA
INTO T
TABLES

Yes Yes Yes Common This
process
transfers
the setup
data from
(OLTP)
Regular
tables to
Temporar
y T table

RDB1 RDB1
Txns

rtxdmp_bj
_100_01

LOAD
TXN
DATA
INTO T
TABLES

No Yes No Common This
process
transfers
the
account
transactio
ns data
from
(OLTP)
Regular
tables to
Temporar
y T tables

RDB2 RDB2
Accounts

racacc_bj
_100_01

Load
Reporting
Tables
Accounts

No Yes Yes Common This
process
transfers
the
account
data from
T tables
to RDB
tables

RDB2 RDB2
Accounts
(Derived
Fields)

racdrv_bj
_100_01

Update
Reporting
Tables
Accounts

No Yes Yes Common This
process
updates
the codes
with
descriptio
n for
account
RDB
tables

RDB2 RDB2
Applicatio
ns

rapapp_bj
_100_01

Load
Reporting
Tables
Applicatio
ns

Yes No No Common This
process
transfers
the
applicatio
n data
from T
tables to
RDB
tables
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RDB2 RDB2
Applicatio
ns
(Derived
Fields)

rapdrv_bj
_100_01

Update
Reporting
Tables
Applicatio
ns
(Derived
Fields)

Yes No No Common This
process
updates
the codes
with
descriptio
n for
applicatio
n RDB
tables

RDB2 RDB2
Asset
Tracking

ratase_bj
_100_01

Load
Reporting
Tables
Asset
Tracking

No Yes No Common This
process
transfers
the
account
asset
tracking
data from
T tables
to RDB
tables

RDB2 RDB2
Asset
Tracking
(Derived
Fields)

ratdrv_bj_
100_01

Update
Reporting
Tables
Asset
Tracking
(Derived
Fields)

No Yes No Common This
process
updates
the codes
with
descriptio
n for
account
asset
tracking
RDB
tables

RDB2 RDB2
Bankruptc
y

rbkabd_
bj_100_0
1

Load
Reporting
Tables
Bankruptc
y

No No Yes Common This
process
transfers
the
account
bankruptc
y data
from T
tables to
RDB
tables

Chapter 2
Batch Jobs

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 109 of 207



Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RDB2 RDB2
Call
Activities

rcacac_bj
_100_01

Load
Reporting
Tables
Call
Activities

No No Yes Common This
process
transfers
the
account
call
activities
data from
T tables
to RDB
tables

RDB2 RDB2
Deficiency

rchaof_bj
_100_01

Load
Reporting
Tables
Deficiency

No No Yes Common This
process
transfers
the
account
deficiency
data from
T tables
to RDB
tables

RDB2 RDB2
Contracts

rcocon_bj
_100_01

Load
Reporting
Tables
Contracts

Yes Yes No Common This
process
transfers
the
account
contract
data from
T tables
to RDB
tables

RDB2 RDB2
Contracts
(Derived
Fields)

rcodrv_bj
_100_01

Update
Reporting
Tables
Contracts
(Derived
Fields)

Yes Yes No Common This
process
updates
the codes
with
descriptio
n for
account
contract
RDB
tables

RDB2 RDB2
Reposses
sions

rfoafr_bj_
100_01

Load
Reporting
Tables
Reposses
sions

No No Yes Common This
process
transfers
the
account
repossess
ion data
from T
tables to
RDB
tables
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RDB2 RDB2
Producers
(Derived
Fields)

rprdrv_bj_
100_01

Update
Reporting
Tables
Producers
(Derived
Fields)

No Yes No Common This
process
updates
the codes
with
descriptio
n for
producer
and
producer
transactio
ns RDB
tables

RDB2 RDB2
Producers

rprpro_bj_
100_01

Load
Reporting
Tables
Producers

No Yes No Common This
process
transfers
the
producer
and
producer
transactio
ns data
from T
tables to
RDB
tables

RDB2 RDB2
Setup

rststp_bj_
100_01

Load
Reporting
Tables
Setup

Yes Yes Yes Common This
process
transfers
the setup
data from
T tables
to RDB
tables

RDB2 RDB2
Txns

rtxdrv_bj_
100_01

Load
Reporting
Tables
Txns

No Yes Yes Common This
process
transfers
the
account
transactio
n data
from T
tables to
RDB
tables
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RDB2 RDB2
Txns
(Derived
Fields)

rtxtxn_bj_
100_01

Update
Reporting
Tables
Txns
(Derived
Fields)

No Yes Yes Common This
process
updates
the codes
with
descriptio
n for
account
transactio
ns RDB
tables

SEC Pool
Summary

ssmprc_bj
_100_01

POOL
SUMMAR
Y TABLE
POPULAT
ION

No Yes No Common This
process
populates
summary
tables for
all pools

SETOVR OVERPAY
MENT
REALLO
CATIONS

PFSTXN
OVR_BJ_
100_01

OVERPAY
MENT
REALLO
CATIONS

No Yes No Common This
process
handles
the
overpaym
ents/
overages
existing
on an
account

TPE Earning/
Amortizati
on

tamprc_bj
_100_01

AMORTIZ
ATION
TRANSA
CTIONS
PROCES
SING

No Yes No Common This
process
creates
the
monthend
interest
accrual
transactio
ns on
monthend
.

TPE Earning/
Amortizati
on

tamprc_bj
_111_01

MONTH
END
AMORTIZ
ATION
TRANSA
CTIONS

No Yes No Loan This
process
creates
the
monthend
interest
accrual
transactio
ns on
monthend
.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE Escrow
Non
Monetary
Transactio
ns

tenbmt_bj
_100_01

Escrow
Non
Monetary
Batch
Transactio
ns

No Yes Yes Common This
process
posts
escrow
non
monetary
transactio
ns in the
backgrou
nd at the
specified
time
interval.

TPE Escrow
Analysis
&
Disburse
ments

tesanl_bj_
100_01

Escrow
Analysis
Posting

No Yes No Common This
process
posts all
approved
escrow
analysis
to the
account

TPE Escrow
Analysis
&
Disburse
ments

tesanl_bj_
100_02

Create
batches
for
Customer
Refund
Requests

No Yes No Common This
process
creates
company
branch
wise
batches
for
customer
refund
requests.

TPE Escrow
Analysis
&
Disburse
ments

tesanl_bj_
100_03

Create
Transactio
n of
Customer
Refund
Requests

No Yes No Common This
process
populate
customer
refund
request in
respective
batch
created
above

TPE Escrow
Analysis
&
Disburse
ments

tesanl_bj_
100_04

Compute
control
totals for
customer
refund
request
batches

No Yes No Common This
process
populates
control
totals for
the
bathes
created
for
customer
refund
requests.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE Escrow
Analysis
&
Disburse
ments

tesanl_bj_
100_05

Escrow
complianc
e
checking

No Yes No Common This
process
checks
escrowabl
e account
for
complianc
e

TPE Escrow
Analysis
&
Disburse
ments

tesdsb_
bj_100_0
5

Escrow
disbursem
ent
posting &
requisition
creation

No Yes No Common This
process
posts
processed
escrow
disbursem
ent and
creates
requisition
s.

TPE Non
Monetary
Transactio
ns

tnmbmt_b
j_100_01

NON
MONETA
RY
TRANSA
CTIONS
POSTING

No Yes Yes Common This
process
posts non
monetary
transactio
ns in the
backgrou
nd at the
specified
time
interval.

TPE Compens
ation

tprcom_bj
_111_01

Compens
ation

No Yes No Loan This
process
creates
transactio
n for
month-
end
producer
compensa
tion

TPE Statement tprpsg_bj
_111_01

Producer
Statement

No Yes No Loan This
process
creates
the
monthend
interest
accrual
transactio
ns on
monthend
.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE Monetary
Transactio
ns

txnacr_bj_
100_01

INTERES
T
ACCRUA
L AND
DELINQU
ENCY
PROCES
SING

No Yes No Common This
process
posts any
payment
batches
open in
the
system.
This
process
can be set
to run
periodicall
y.

TPE Monetary
Transactio
ns

txnact_bj_
100_01

ACCOUN
T
ACTIVATI
ON

No Yes No Common This job
activates
new
accounts
i.e.
changes
status
from
PENDING
to
ACTIVE.

TPE Monetary
Transactio
ns

txnadv_bj
_112_01

Advance
Posting

No Yes No Line This
process
posts any
advance
batches
open in
the
system.
This
process
can be set
to run
periodicall
y.

TPE Monetary
Transactio
ns

txnann_bj
_100_01

ANNIVER
SARY
PROCES
SING

No Yes No Common This
process
carries
out the
anniversa
ry
processin
g for
eligible
accounts
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE Monetary
Transactio
ns

txnbmt_bj
_100_01

MONETA
RY
TRANSA
CTIONS
POSTING

No Yes No Common This
process
posts
monetary
transactio
ns in the
backgrou
nd at the
specified
time
interval.

TPE Monetary
Transactio
ns

txnchg_bj
_100_01

Chargeoff
Processin
g

No Yes No Common This
process
charges
off eligible
or
scheduled
for
chargeoff
accounts.

TPE Monetary
Transactio
ns

txnchg_bj
_100_03

Chargeoff
reversal

No Yes No Common On
posting
charge off
reversal
transactio
n, this
process
moves the
remaining
expense
and fee
from
charge off
balance to
active
balance.

TPE Monetary
Transactio
ns

txncls_bj_
100_01

VOID/
PAID
ACCOUN
T CLOSE
PROCES
SING

No Yes No Common This
process
closes
void and
paid off
accounts.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE Monetary
Transactio
ns

txnddt_bj_
100_01

BILLING/
DUE
DATES
PROCES
SING

No Yes No Common This
process
creates/
updates
the due
dates for
the
accounts
in the
system.

In
addition,
this
process
can also
do Asset
Billing
using
asset
parameter
s defined
for Home
collateral.

For more
details,
refer to 
Asset
Billing
Rate
section.

TPE Monetary
Transactio
ns

txnfpd_bj_
100_01

FIRST
PMT
DEDUCTI
ON
PROCES
SING

No Yes No Common This
process
posts the
first
payment
deduction
payment
to the
eligible
accounts.

TPE Monetary
Transactio
ns

txnfpr_bj_
111_01

FIRST
PMT
REFUND
PROCES
SING

No Yes No Loan This
process
posts the
first
payment
deduction
payment
to the
eligible
accounts.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE Monetary
Transactio
ns

txnltc_bj_
100_01

LATE
CHARGE
PROCES
SING

No Yes No Common This
process
assesses
late
charge
dependin
g on the
rules, for
all
accounts
in the
system.

TPE Monetary
Transactio
ns

txnmtd_bj
_100_01

MONTH
END
PROCES
SING

No Yes No Common This
process
populates
the month
end
balances
and
carries
over the
balances
to next
month.

TPE Monetary
Transactio
ns

txnpmt_bj
_100_01

Payment
Posting

No Yes No Common This
process
does the
daily
accrual
and
delinquen
cy
processin
g.

TPE Monetary
Transactio
ns

txnprm_bj
_100_01

PROMOTI
ON END
PROCES
SING

No Yes No Common This
process
ends the
promotion
on the
account.

TPE Monetary
Transactio
ns

txnprm_bj
_100_03

TLP
PROMOTI
ON
CANCEL
PROCES
SING

No Yes No Common This
process
cancels
the
promotion
on the
account.

TPE Monetary
Transactio
ns

txnrat_bj_
100_01

RATE
CHANGE
PROCES
SING

No Yes No Common This
process
changes
the
prevalent
rate on an
account.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE Monetary
Transactio
ns

txnsch_bj
_100_01

SCHEDU
LE FOR
CHARGE
D OFF
PROCES
SING

No Yes No Common This
process
puts the
Schedule
for
Charge
Off
condition
on eligible
accounts.

TPE Monetary
Transactio
ns

txntip_bj_
100_01

TERMINA
TION
PROCES
SING

No Yes No Common This
process
puts the
Paid
status on
eligible
accounts

TPE Monetary
Transactio
ns

txnytd_bj_
100_01

YEAR
END
PROCES
SING

No Yes No Common This
process
populates
the year
end
balances
and
carries
over the
balances
to next
year.

TPE Usage
Charge
Processin
g

TXNUSG
_BJ_100_
01

Billing
Batch job
to process
and post
lease
usage/
rental
fees on
account

No Yes Yes Common This
process is
used to
derive the
billing
amount to
be
charged
for Lease
Usage/
Rental
based
asset for
consumed
units
calculated
by the
applicable
charge
matrix.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE MOCK
BILLING/
DUE
DATES
PROCES
SING

TXNMDT
_BJ_100_
01

MOCK
BILLING/
DUE
DATES
PROCES
SING

Yes Yes Yes Common This
process
generates
the future
dues/
balances
based on
the
parameter
s defined
in the
criteria.
This batch
job is a
prerequisi
te run for
the mock
statement
s to get
generated
.

TPE CAPITALI
ZATION
PROCES
SING

TXNCPT_
BJ_100_0
1

CAPITALI
ZATION
PROCES
SING

Yes Yes Yes Common This
process is
used to
capitalize
the
balance
on all
qualified
accounts
and is
configure
d to run
after
running
the billing
batch job.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE POST
MATURIT
Y EVER
GREEN
TRANSA
CTION
PROCES
SING

TXNEGC
_BJ_121_
01

POST
MATURIT
Y EVER
GREEN
TRANSA
CTION
PROCES
SING

Yes This
process is
used to
pick-up
accounts
matching
the
criteria for
evergreen
renewal,
waits for
maturity
date
based on
grace
days and
posts
Evergreen
Lease
transactio
n.

TPE CYCLE
BASED
COLLECT
ION LATE
FEE
PROCES
SING

TXNCBC
_BJ_100_
01

CYCLE
BASED
COLLECT
ION LATE
FEE
PROCES
SING

Yes Yes Yes Common This
process
facilitates
to
calculate
Cycle
based
Collectio
n Late
Fee at
account
level and
update
the
balances.

TPE CYCLE
BASED
LATE FEE
PROCES
SING

TXNCBL_
BJ_100_0
1

CYCLE
BASED
LATE FEE
PROCES
SING

Yes Yes Yes Common This
process
facilitates
to
calculate
Cycle
Based
Late Fee
at account
level and
update
the
balances.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

XPR DEALER
TRACK
PRODUC
ER LOAD

XPRPST_
EW_100_
01

DEALER
TRACK
PRODUC
ER LOAD

No Yes Yes Common This
process
dumps
producer
details
maintaine
d in the
system
into
Dealer
Track.

System
can either
use MDB
flow by
generatin
g
outbound
JMS
message
if system
parameter
OUTBOU
ND_
DLR_
TRACK_
Q is set to
Y or use
existing
flow by
making
database
synchrono
us
outbound
calls to
producer
data
dump web
service.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

XPR2 ROUTE
ONE
PRODUC
ER LOAD

XPRPST_
EW_100_
01

ROUTE
ONE
PRODUC
ER LOAD

No Yes Yes Common This
process
dumps
producer
details
maintaine
d in the
system
into
ROUTEO
NE.

System
can either
use MDB
flow by
generatin
g
outbound
JMS
message
if system
parameter
OUTBOU
ND_
ROUTEO
NE_ Q is
set to Y or
use
existing
flow by
making
database
synchrono
us
outbound
calls to
producer
data
dump web
service.

LTR CONDITI
ONAL
ADVERS
E
ACTION
LETTER

LORACO
_BJ_100_
01

CONDITI
ONAL
ADVERS
E
ACTION
LETTER
GENERA
TION

Yes No No Loan This
process
generates
the
adverse
action
letter for
relevant
applicatio
ns.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

LTR ADVERS
E
ACTION
LETTER

LORADV_
BJ_100_0
1

ADVERS
E
ACTION
LETTER
GENERA
TION

Yes No No Loan This
process
generates
the
adverse
action
letter for
relevant
applicatio
ns.

RPT ACCOUN
T LIST

ROPACC
_EM_100
_01

ACCOUN
T LIST

No Yes No Common

RPT ADVANC
E
POSTING
LIST

ROPADV_
EM_100_
01

ADVANC
E
POSTING
LIST

No Yes No Common

RPT ASSET
TRACKIN
G
DETAILS

ROPATK_
EM_100_
01

ASSET
TRACKIN
G
DETAILS

No Yes No Common

RPT BANKRU
PTCY
ACCOUN
T LIST

ROPBNK
_EM_100
_01

BANKRU
PTCY
ACCOUN
T LIST

No Yes No Common

RPT COLLECT
OR
ACTIVITY
DETAILS

ROPCOL
_EM_100
_01

COLLECT
OR
ACTIVITY
DETAILS

No Yes No Common

RPT DEFICIE
NCY
ACCOUN
T LIST

ROPDEF
_EM_100
_01

DEFICIE
NCY
ACCOUN
T LIST

No Yes No Common

RPT DELINQU
ENT
ACCOUN
T LIST

ROPDLQ
_EM_100
_01

DELINQU
ENT
ACCOUN
T LIST

No Yes No Common

RPT FUNDING
CONTRA
CT LIST

ROPFUN
_EM_100
_01

FUNDING
CONTRA
CT LIST

No Yes No Common

RPT GL TXN
DETAILS
LIST

ROPGLI_
EM_100_
01

GL TXN
DETAILS
LIST

No Yes No Common

RPT APPLICA
TIONS
LIST

ROPORG
_EM_100
_01

APPLICA
TIONS
LIST

No Yes No Common

RPT PAYMENT
ALLOCAT
ION
POSTING
DETAILS

ROPPAL_
EM_100_
01

PAYMENT
ALLOCAT
ION
POSTING
DETAILS

No Yes No Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT PAYMENT
POSTING
LIST

ROPPMT
_EM_100
_01

PAYMENT
POSTING
LIST

No Yes No Common

RPT PAYABLE
REQUISI
TION
LIST

ROPPRQ
_EM_100
_01

PAYABLE
REQUISI
TION
LIST

No Yes No Common

RPT REPOSS
SESION/
FORECL
OSURE
ACCOUN
T LIST

ROPREP
_EM_100
_01

REPOSS
SESION/
FORECL
OSURE
ACCOUN
T LIST

No Yes No Common

RPT SCHEDU
LE TO
CHARGE
OFF LIST

ROPSCH
_EM_100
_01

SCHEDU
LE TO
CHARGE
OFF LIST

No Yes No Common

RPT TERMINA
TION IN
PROGRE
SS LIST

ROPTIP_
EM_100_
01

TERMINA
TION IN
PROGRE
SS LIST

No Yes No Common

RPT NON
MONTET
ARY TXN
POSTING
LIST

ROPTNM
_EM_100
_01

NON
MONTET
ARY TXN
POSTING
LIST

No Yes No Common

RPT MONTET
ARY TXN
POSTING
LIST

ROPTXN
_EM_100
_01

MONTET
ARY TXN
POSTING
LIST

No Yes No Common

RPT BATCH
JOB
SETUP

CMNBJB
_EM_100
_01

BATCH
JOB
SETUP

No Yes No Common

RPT BATCH
JOB LOG

CMNBJB
_EM_100
_02

BATCH
JOB LOG

No Yes No Common

RPT NUMBER
OF
CREDIT
APPLICA
TIONS
ENTERE
D BY
USER

OUNADE
_EM_100
_01

NUMBER
OF
CREDIT
APPLICA
TIONS
ENTERE
D BY
USER

No Yes No Common

RPT CREDIT
APPLICA
TIONS
IMAGES
BY
STATUS

OUNADE
_EM_100
_02

CREDIT
APPLICA
TIONS
IMAGES
BY
STATUS

No Yes No Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT UNDERW
RITING
STATUS
BY
MONTH
AND
PRODUC
ER
(LOAN)

OUNUND
_EM_111
_11

UNDERW
RITING
STATUS
BY
MONTH
AND
PRODUC
ER
(LOAN)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
MONTH
AND
UNDERW
RITER
(LOAN)

OUNUND
_EM_111
_12

UNDERW
RITING
STATUS
BY
MONTH
AND
UNDERW
RITER
(LOAN)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
MONTH
(LOAN)

OUNUND
_EM_111
_13

UNDERW
RITING
STATUS
BY
MONTH
(LOAN)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
UNDERW
RITER
(LOAN)

OUNUND
_EM_111
_14

UNDERW
RITING
STATUS
BY
UNDERW
RITER
(LOAN)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
MONTH
AND
PRODUC
ER (LINE)

OUNUND
_EM_112
_11

UNDERW
RITING
STATUS
BY
MONTH
AND
PRODUC
ER (LINE)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
MONTH
AND
UNDERW
RITER
(LINE)

OUNUND
_EM_112
_12

UNDERW
RITING
STATUS
BY
MONTH
AND
UNDERW
RITER
(LINE)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
MONTH
(LINE)

OUNUND
_EM_112
_13

UNDERW
RITING
STATUS
BY
MONTH
(LINE)

No Yes No Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT UNDERW
RITING
STATUS
BY
UNDERW
RITER
(LINE)

OUNUND
_EM_112
_14

UNDERW
RITING
STATUS
BY
UNDERW
RITER
(LINE)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
MONTH
AND
PRODUC
ER
(LEASE)

OUNUND
_EM_121
_11

UNDERW
RITING
STATUS
BY
MONTH
AND
PRODUC
ER
(LEASE)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
MONTH
AND
UNDERW
RITER
(LEASE)

OUNUND
_EM_121
_12

UNDERW
RITING
STATUS
BY
MONTH
AND
UNDERW
RITER
(LEASE)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
MONTH
(LEASE)

OUNUND
_EM_121
_13

UNDERW
RITING
STATUS
BY
MONTH
(LEASE)

No Yes No Common

RPT UNDERW
RITING
STATUS
BY
UNDERW
RITER
(LOAN)

OUNUND
_EM_121
_14

UNDERW
RITING
STATUS
BY
UNDERW
RITER
(LOAN)

Yes No No Lease

RPT ACCOUN
T
PAYABLE
(ORIGINA
TION)

OFNAPY
_EM_100
_01

ACCOUN
T
PAYABLE
(ORIGINA
TION)

Yes No No Common

RPT ACCOUN
T
PAYABLE
(SERVICI
NG)

OFNAPY
_EM_100
_02

ACCOUN
T
PAYABLE
(SERVICI
NG)

No Yes No Common

RPT PRE-
FUNDING
CONTRA
CTS
(LOAN)

OFNFND
_EM_111
_01

PRE-
FUNDING
CONTRA
CTS
(LOAN)

Yes No No Loan
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT FUNDED
CONTRA
CTS
(LOAN)

OFNFND
_EM_111
_02

FUNDED
CONTRA
CTS
(LOAN)

Yes No No Loan

RPT PRE-
FUNDING
CONTRA
CTS
(LINE)

OFNFND
_EM_112
_01

PRE-
FUNDING
CONTRA
CTS
(LINE)

Yes No No Loan

RPT FUNDED
CONTRA
CTS
(LINE)

OFNFND
_EM_112
_02

FUNDED
CONTRA
CTS
(LINE)

Yes No No Common

RPT PRE-
FUNDING
CONTRA
CTS
(LEASE)

OFNFND
_EM_121
_01

PRE-
FUNDING
CONTRA
CTS
(LEASE)

Yes No No Common

RPT FUNDED
CONTRA
CTS
(LEASE)

OFNFND
_EM_121
_02

FUNDED
CONTRA
CTS
(LEASE)

Yes No No Loan

RPT ACCOUN
T
PAYABLE
LOG BY
PRODUC
ER

OCSAPP
_EM_100
_01

ACCOUN
T
PAYABLE
LOG BY
PRODUC
ER

Yes No No Loan

RPT ACCOUN
T
PAYABLE
LOG BY
VENDOR

OCSAPV
_EM_100
_01

ACCOUN
T
PAYABLE
LOG BY
VENDOR

Yes No No Loan

RPT COLLATE
RAL
TRACKIN
G LOG

OCSAST
_EM_100
_01

COLLATE
RAL
TRACKIN
G LOG

Yes No No Common

RPT GL
POSTING
LOG

OCSGLI_
EM_100_
01

GL
POSTING
LOG

Yes No No Common

RPT PAYMENT
POSTING
(DAILY
CASH)
LOG

OCSPMT
_EM_100
_01

PAYMENT
POSTING
(DAILY
CASH)
LOG

Yes No No Common

RPT PAYMENT
POSTING
ERROR
LOG

OCSPMT
_EM_100
_02

PAYMENT
POSTING
ERROR
LOG

Yes No No Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT ACCOUN
T
LISTING
(LOAN)

OCSACC
_EM_111
_01

ACCOUN
T
LISTING
(LOAN)

Yes No No Loan

RPT EXCESS
PAYMENT
(REFUND
) LOG
(LOAN)

OCSPMT
_EM_111
_03

EXCESS
PAYMENT
(REFUND
) LOG
(LOAN)

Yes No No Loan

RPT PAYMENT
HISTORY
(LOAN)

OCSPMT
_EM_111
_04

PAYMENT
HISTORY
(LOAN)

Yes No No Loan

RPT PAYMENT
ALLOCAT
IONS
LOG
(LOAN)

OCSPMT
_EM_111
_05

PAYMENT
ALLOCAT
IONS
LOG
(LOAN)

Yes No No Loan

RPT PAYMENT
ALLOCAT
IONS
LOG BY
GL POST
DT
(LOAN)

OCSPMT
_EM_111
_06

PAYMENT
ALLOCAT
IONS
LOG BY
GL POST
DT
(LOAN)

Yes No No Loan

RPT PRODUC
ER
STATEME
NT
(LOAN)

OCSPSM
_EM_111
_01

PRODUC
ER
STATEME
NT
(LOAN)

Yes No No Loan

RPT PRODUC
ER
MONETA
RY TXNS
LOG BY
GL POST
DT
(LOAN)

OCSPTX
_EM_111
_01

PRODUC
ER
MONETA
RY TXNS
LOG BY
GL POST
DT
(LOAN)

Yes No No Loan

RPT SCHEDU
LED FOR
CHARGE
OFF
ACCOUN
TS LOG
(LOAN)

OCSSCH
_EM_111
_01

SCHEDU
LED FOR
CHARGE
OFF
ACCOUN
TS LOG
(LOAN)

Yes No No Loan

RPT AMORTIZ
ED TXNS
LOG BY
GL POST
DT
(LOAN)

OCSTAM
_EM_111
_01

AMORTIZ
ED TXNS
LOG BY
GL POST
DT
(LOAN)

Yes No No Loan
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT SCHEDU
LED FOR
TERMINA
TION
ACCOUN
TS LOG
(LOAN)

OCSTER
_EM_111
_01

SCHEDU
LED FOR
TERMINA
TION
ACCOUN
TS LOG
(LOAN)

Yes No No Loan

RPT MONETA
RY TXNS
LOG BY
GL POST
DT
(LOAN)

OCSTXN
_EM_111
_01

MONETA
RY TXNS
LOG BY
GL POST
DT
(LOAN)

Yes No No Loan

RPT ACCOUN
T
LISTING
(LINE)

OCSACC
_EM_112
_01

ACCOUN
T
LISTING
(LINE)

Yes No No Loan

RPT ADVANC
E
POSTING
LOG
(LINE)

OCSADV
_EM_112
_01

ADVANC
E
POSTING
LOG
(LINE)

Yes No No Loan

RPT ADVANC
E
POSTING
ERROR
LOG
(LINE)

OCSADV
_EM_112
_02

ADVANC
E
POSTING
ERROR
LOG
(LINE)

Yes No No Loan

RPT PAYMENT
HISTORY
(LINE)

OCSPMT
_EM_112
_04

PAYMENT
HISTORY
(LINE)

Yes No No Loan

RPT PAYMENT
ALLOCAT
IONS
LOG
(LINE)

OCSPMT
_EM_112
_05

PAYMENT
ALLOCAT
IONS
LOG
(LINE)

Yes No No Common

RPT PAYMENT
ALLOCAT
IONS
LOG BY
GL POST
DT (LINE)

OCSPMT
_EM_112
_06

PAYMENT
ALLOCAT
IONS
LOG BY
GL POST
DT (LINE)

Yes No No Common

RPT SCHEDU
LED FOR
CHARGE
OFF
ACCOUN
TS LOG
(LINE)

OCSSCH
_EM_112
_01

SCHEDU
LED FOR
CHARGE
OFF
ACCOUN
TS LOG
(LINE)

Yes No No Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT AMORTIZ
ED TXNS
LOG BY
GL POST
DT (LINE)

OCSTAM
_EM_112
_01

AMORTIZ
ED TXNS
LOG BY
GL POST
DT (LINE)

Yes No No Common

RPT SCHEDU
LED FOR
TERMINA
TION
ACCOUN
TS LOG
(LINE)

OCSTER
_EM_112
_01

SCHEDU
LED FOR
TERMINA
TION
ACCOUN
TS LOG
(LINE)

Yes No No Common

RPT MONETA
RY TXNS
LOG BY
GL POST
DT (LINE)

OCSTXN
_EM_112
_01

MONETA
RY TXNS
LOG BY
GL POST
DT (LINE)

Yes No No Common

RPT ACCOUN
T
LISTING
(LEASE)

OCSACC
_EM_121
_01

ACCOUN
T
LISTING
(LEASE)

Yes No No Common

RPT PAYMENT
HISTORY
(LEASE)

OCSPMT
_EM_121
_04

PAYMENT
HISTORY
(LEASE)

Yes No No Common

RPT PAYMENT
ALLOCAT
IONS
LOG
(LEASE)

OCSPMT
_EM_121
_05

PAYMENT
ALLOCAT
IONS
LOG
(LEASE)

Yes No No Common

RPT PAYMENT
ALLOCAT
IONS
LOG BY
GL POST
DT
(LEASE)

OCSPMT
_EM_121
_06

PAYMENT
ALLOCAT
IONS
LOG BY
GL POST
DT
(LEASE)

Yes No No Common

RPT SCHEDU
LED FOR
CHARGE
OFF
ACCOUN
TS LOG
(LEASE)

OCSSCH
_EM_121
_01

SCHEDU
LED FOR
CHARGE
OFF
ACCOUN
TS LOG
(LEASE)

Yes No No Common

RPT AMORTIZ
ED TXNS
LOG BY
GL POST
DT
(LEASE)

OCSTAM
_EM_121
_01

AMORTIZ
ED TXNS
LOG BY
GL POST
DT
(LEASE)

Yes No No Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT SCHEDU
LED FOR
TERMINA
TION
ACCOUN
TS LOG
(LEASE)

OCSTER
_EM_121
_01

SCHEDU
LED FOR
TERMINA
TION
ACCOUN
TS LOG
(LEASE)

Yes No No Common

RPT MONETA
RY TXNS
LOG BY
GL POST
DT
(LEASE)

OCSTXN
_EM_121
_01

MONETA
RY TXNS
LOG BY
GL POST
DT
(LEASE)

Yes No No Common

RPT BANKRU
PTCY
LOG

OCOBNK
_EM_100
_01

BANKRU
PTCY
LOG

Yes No No Common

RPT COLLECT
OR
ACTIVITY
(DETAILE
D) LOG

OCOCOL
_EM_100
_01

COLLECT
OR
ACTIVITY
(DETAILE
D) LOG

No No Yes Common

RPT COLLECT
OR
PRODUC
TIVITY
BY
QUEUE

OCOCOL
_EM_100
_02

COLLECT
OR
PRODUC
TIVITY
BY
QUEUE

No No Yes Common

RPT DELINQU
ENCY
ANALYSI
S BY
PRODUC
ER

OCOCOL
_EM_100
_03

DELINQU
ENCY
ANALYSI
S BY
PRODUC
ER

No No Yes Common

RPT DELINQU
ENCY
ANALYSI
S BY
CREDIT
GRADE

OCOCOL
_EM_100
_04

DELINQU
ENCY
ANALYSI
S BY
CREDIT
GRADE

No No Yes Common

RPT DELINQU
ENCY
ANALYSI
S BY
STATE

OCOCOL
_EM_100
_05

DELINQU
ENCY
ANALYSI
S BY
STATE

No No Yes Common

RPT PAYMENT
PROMISE
LOG

OCOCOL
_EM_100
_06

PAYMENT
PROMISE
LOG

No No Yes Common

RPT COLLECT
OR
ACTIVITY
LOG

OCOCOL
_EM_100
_07

COLLECT
OR
ACTIVITY
LOG

No No Yes Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT DEFICIE
NCY LOG

OCODEF
_EM_100
_01

DEFICIE
NCY LOG

No No Yes Common

RPT DELINQU
ENCY
LOG

OCODLQ
_EM_100
_01

DELINQU
ENCY
LOG

No No Yes Common

RPT REPOSS
ESSION/
FORECL
OSURE
LOG

OCOREP
_EM_100
_01

REPOSS
ESSION/
FORECL
OSURE
LOG

No No Yes Common

RPT NON
MONETA
RY TXNS
LOG

OCOTNM
_EM_100
_01

NON
MONETA
RY TXNS
LOG

No No Yes Common

RPT VENDOR
INVOICE
LOG

OCOVIN_
EM_100_
01

VENDOR
INVOICE
LOG

No No Yes Common

RPT VENDOR
WORK
ORDER
LOG

OCOVNA
_EM_100
_01

VENDOR
WORK
ORDER
LOG

No No Yes Common

RPT POOL
DELINQU
ENCY
SUMMAR
Y (LOAN)

OCSSEC
_EM_111
_01

POOL
DELINQU
ENCY
SUMMAR
Y (LOAN)

No Yes No Common

RPT POOL
DEFAULT
S (NON
LIQUIDAT
ED)
(LOAN)

OCSSEC
_EM_111
_02

POOL
DEFAULT
S (NON
LIQUIDAT
ED)
(LOAN)

No Yes No Common

RPT POOL
PAYOFFS
(LOAN)

OCSSEC
_EM_111
_03

POOL
PAYOFFS
(LOAN)

No Yes No Common

RPT POOL
RECOVE
RY
(LOAN)

OCSSEC
_EM_111
_04

POOL
RECOVE
RY
(LOAN)

No Yes No Common

RPT POOL
DELINQU
ENCY
(LOAN)

OCSSEC
_EM_111
_05

POOL
DELINQU
ENCY
(LOAN)

No Yes No Common

RPT POOL
REPURC
HASED
ACCOUN
TS
(LOAN)

OCSSEC
_EM_111
_06

POOL
REPURC
HASED
ACCOUN
TS
(LOAN)

No Yes No Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RPT POOL
MONTHL
Y
ACTIVITY
(LOAN)

OCSSEC
_EM_111
_07

POOL
MONTHL
Y
ACTIVITY
(LOAN)

No Yes No Common

RPT POOL
LIQUIDAT
ED
CONTRA
CTS
(LOAN)

OCSSEC
_EM_111
_08

POOL
LIQUIDAT
ED
CONTRA
CTS
(LOAN)

No Yes No Common

RPT POOL
TXNS
LOG BY
GL POST
DT
(LOAN)

OCSSEC
_EM_111
_09

POOL
TXNS
LOG BY
GL POST
DT
(LOAN)

No Yes No Common

SETQRT Real time
Queues
processin
g

QCSPRC
_BJ_100_
02

Real time
Queues
processin
g

No Yes Yes Common This batch
job
processes
queues
marked
as real
time
based on
refresh
frequency
setup in
the job
set.

TAM MONTH
END
COMPEN
SATION
DISBURS
EMENT
PROCES
SING

TPRCOM
_BJ_100_
01

MONTH
END
COMPEN
SATION
DISBURS
EMENT
PROCES
SING

No Yes No Common

TAM PRODUC
ER
STATEME
NTS

TPRPSG
_BJ_100_
01

PRODUC
ER
STATEME
NTS

No Yes No Common

TAM PRODUC
ER
STATUS
CHANGE

TPRSTA_
BJ_100_0
1

PRODUC
ER
STATUS
CHANGE

No Yes No Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TAM Depreciati
on
calculator
batch job

TAMDEP_
BJ_121_0
1

DEPRECI
ATION
RATE
PROCES
SING

Yes Yes Yes Lease This
process is
used to
calculate
the delta
depreciati
on value
of the
asset
from
previous
to current
period
(current
indicator
is set as Y
by
default).

TAM Amortizati
on
schedule
batch job

TAMIMP_
BJ_100_0
1

IMPUTED
INTERES
T
AMORTIZ
ATION
TRANSA
CTIONS
PROCES
SING

Yes Yes Yes Common This
process is
used to
generate
Amortizati
on
schedule
based on
imputed
interest
rate for
loan
contracts
with
Imputed
Interest

TPE Escrow
Analysis
&
Disburse
ments

TXNCHG
_BJ_100_
02

CHARGE
OFF
PROCES
SING
FOR
ACTIVE
ACCOUN
TS

No Yes No Common This
package
contains
procedure
s related
to Batch
Job for
chargeoff
processin
g

ESC ESCROW
ANALYSI
S
POSTING

TESANL_
BJ_100_0
1

ESCROW
ANALYSI
S
POSTING

No Yrs No Common This
package
contains
procedure
s related
to Batch
Job for
escrow
analysis
processin
g
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ESC CREATE
BATCHES
FOR
CUSTOM
ER
REFUND
REQUES
T

TESANL_
BJ_100_0
2

CREATE
BATCHES
FOR
CUSTOM
ER
REFUND
REQUES
TS

No Yes No Common This
package
contains
procedure
s related
to Batch
Job for
escrow
analysis
processin
g

ESC COMPUT
E
CONTRO
LS FOR
CUSTOM
ER
REFUND
REQUES
T
BATCHES

TESANL_
BJ_100_0
4

COMPUT
E
CONTRO
LS FOR
CUSTOM
ER
REFUND
REQUES
T
BATCHES

No Yes No Common

ESC ESCROW
COMPLIA
NCE
CHECKIN
G

TESANL_
BJ_100_0
5

ESCROW
COMPLIA
NCE
CHECKIN
G

No Yes No Common

ESC CREATE
PAYABLE
REQUISI
TIONS
FROM
APPROV
ED
DISBURS
EMENT
REQUES
TS

TESDSB_
BJ_100_0
1

CREATE
PAYABLE
REQUISI
TIONS
FROM
APPROV
ED
DISBURS
EMENT
REQUES
TS

No Yes No Common

PUR ARCHIVE
ACCOUN
T DATA
TO
OTABLES

PACARC_
BJ_100_0
1

ARCHIVE
ACCOUN
T DATA
TO
OTABLES

No Yes No Common

EVE BATCH
EVENTS
FOR
ACCOUN
TS

EVBACC
_BJ_100_
01

BATCH
EVENTS
FOR
ACCOUN
TS

Yes

EVE BATCH
EVENTS
FOR
APPLICA
TIONS

EVBAPP_
BJ_100_0
1

BATCH
EVENTS
FOR
APPLICA
TIONS

Yes
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

EVE MAIN
BATCH
JOB FOR
BATCH
EVENTS
PROCES
SING

EVBPRC
_BJ_100_
01

MAIN
BATCH
JOB FOR
BATCH
EVENTS
PROCES
SING

Yes

ODD2 BATCH
JOB TO
GENERA
TE
METRO 2
DATA

CBUUTL_
BJ_100_0
2

BATCH
JOB TO
GENERA
TE
METRO 2
DATA

Yes

ODD2 BATCH
JOB FOR
CREATIN
G
METRO 2
DATA
FILE

CBUUTL_
BJ_100_0
3

BATCH
JOB FOR
CREATIN
G
METRO 2
DATA
FILE

Yes

ODD2 THIRD
PARTY
ACH
PROCES
SING

ACTPRC_
BJ_100_0
1

THIRD
PARTY
ACH
PROCES
SING

Yes

ODD2 THIRD
PARTY
OUTPUT
DATA
DUMP
SERVICI
NG

ACTPRC_
BJ_100_0
1

CREATE
THIRD
PARTY
CUSTOM
ER FILE

Yes This
process
pulls the
customer
account
details
shared in
input data
files for
processin
g.

ESC JOB TO
GENERA
TE
ESCROW
DISCLOS
URE
STATEME
NT

OEDPRC
_BJ_100_
01

JOB TO
GENERA
TE
ESCROW
DISCLOS
URE
STATEME
NT

Yes

EDF ADR FILE EDFADR_
BJ_100_0
1

ADR FILE Yes

EDF IVR FILE EDFIVR_
BJ_100_0
1

IVR FILE Yes
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

CRD CREDIT
CARD
PAYMENT
BATCH

CRDPMT
_BJ_10_0
1

CREDIT
CARD
PAYMENT
BATCH
CREATIO
N

Yes

CRD RECURRI
NG
CREDIT
CARD
PAYMENT
PROCES
SING

TNMCRD
_BJ_100_
01

RECURRI
NG
CREDIT
CARD
PAYMENT
PROCES
SING

Yes

TPE CONTRA
CTUAL
PROMOTI
ON
CANCEL
PROCES
SING

TXNPRM
_BJ_100_
04

CONTRA
CTUAL
PROMOTI
ON
CANCEL
PROCES
SING

Yes

TPE RATE
CHANGE
PROCES
SING
FOR
BACKDAT
ED
INDEXES

TXNRAT_
BJ_100_0
2

RATE
CHANGE
PROCES
SING
FOR
BACKDAT
ED
INDEXES

Yes

RDB1 LOAD
ACCOUN
T
RELATED
DATA
INTO T
TABLES

RACDMP
_BJ_100_
01

LOAD
ACCOUN
T
RELATED
DATA
INTO T
TABLES

Yes

TPE EXPIRED
INSURAN
CE
PROCES
SING

TXNINS_
BJ_100_0
1

EXPIRED
INSURAN
CE
PROCES
SING

Yes

ADT UPDATE
ROWID
IN AUDIT
TABLE
(RUN
THIS JOB
AFTER
EXPORTI
MPORT
OF
TABLES)

ADTPRC
_BJ_100_
01

UPDATE
ROWID
IN AUDIT
TABLE
(RUN
THIS JOB
AFTER
EXPORTI
MPORT
OF
TABLES)

Yes
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

RDB1 LOAD
INSURAN
CE DATA
TO T
TABLES

RINDMP_
BJ_100_0
1

LOAD
INSURAN
CE DATA
TO T
TABLES

Yes

AGS SALE
LEAD
AGING

AGSSAL_
BJ_100_0
1

SALE
LEAD
AGING

Yes

BOD PROCES
S
PARKED
TRANSA
CTIONS

JOBBOD
_BJ_000_
02

PROCES
S
PARKED
TRANSA
CTIONS

Yes

BOD MARK
SYSTEM
FOR
BEGININ
G OF
DAY

JOBBOD
_BJ_000_
01

MARK
SYSTEM
FOR
BEGININ
G OF
DAY

Yes

EOD SET
SYSTEM
MODE TO
END-OF-
DAY

JOBEOD
_BJ_000_
01

SET
SYSTEM
MODE TO
END-OF-
DAY

Yes

ACR DAILY
TRIAL
BALANC
E DATA

TABACC_
BJ_100_0
1

DAILY
TRIAL
BALANC
E DATA
GENERA
TION

Yes

LTR2 RATE
CHANGE
PRE-
INTIMATI
ON
LETTER

LCSRAT_
BJ_100_0
1

RATE
CHANGE
PRE-
INTIMATI
ON
LETTER

Yes

BLK BULK
UPLOAD
FOR
PRICING
SETUP

BLKPRP_
BJ_100_0
1

BULK
UPLOAD
FOR
PRICING
SETUP

Yes

BLK BULK
UPLOAD
FOR GL
ATTRIBU
TES

BLKGLS_
BJ_100_0
1

BULK
UPLOAD
FOR GL
ATTRIBU
TES

Common

BLK BULK
UPLOAD
FOR GL
TRANSLA
TION

BLKGLS_
BJ_100_0
2

BULK
UPLOAD
FOR GL
TRANSLA
TION
DEFINITI
ON

Common
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

BLK BULK
UPLOAD
FOR GL
TRANSA
CTION
TYPES

BLKGLS_
BJ_100_0
3

BULK
UPLOAD
FOR GL
TRANSA
CTION
TYPES
DETAILS

Common

BLK BULK
UPLOAD
FOR GL
TRANSA
CTION
LINKS

BLKGLS_
BJ_100_0
4

BULK
UPLOAD
FOR GL
TRANSA
CTION
LINKS

Common

ODD2 RATE
CHANGE
LETTER
FILE

OLSRAT_
BJ_100_0
1

RATE
CHANGE
LETTER
FILE
CREATIO
N

Yes

TPE EXPIRED
DRAW
PERIOD
PROCES
SING
(STAGE
FUNDED
LOANS)

TXNDRW
_BJ_111_
01

EXPIRED
DRAW
PERIOD
PROCES
SING
(STAGE
FUNDED
LOANS)

Yes

ODD2 DEALER
SUBVEN
TION
STATEME
NTS

OPSSBV
_BJ_100_
01

DEALER
SUBVEN
TION
STATEME
NTS
GENERA
TION

Common

TAM SUBVEN
TION
RECEIVA
BLE
PROCES
SING
(PAY AS
GO)

TPRSBV_
BJ_100_0
1

SUBVEN
TION
RECEIVA
BLE
PROCES
SING
(PAY AS
GO)

Common

ODD2 PRODUC
ER
CHECK
PRINT

OPCPRC
_BJ_100_
01

PRODUC
ER
CHECK
PRINT
GENERA
TION

Common

BSR BEHAVIO
RAL
SCORIN
G

BSRPRC
_BJ_100_
01

BEHAVIO
RAL
SCORIN
G

Yes
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

AGE TRANSA
CTION IN
WAITING
FOR
APPROV
AL
AGING

TXNAGE
_BJ_100_
01

TRANSA
CTION IN
WAITING
FOR
APPROV
AL
AGING
PROCES
S

Yes

ACR PREPAR
E BATCH
DATA
FOR
INTERES
T
ACCRUA
L AND
DELINQU
ENCY

TXNACR_
BJ_100_0
2

PREPAR
E BATCH
DATA
FOR
INTERES
T
ACCRUA
L AND
DELINQU
ENCY
PROCES
SING

Yes

PDC POST
DATED
CHECKS

PDCPRC
_BJ_100_
01

POST
DATED
CHECKS

Yes

PDC PENDING
PDC

PDCPND
_BJ_100_
01

PENDING
PDC
PROCES
SING

Yes

LTR2 PDC
RENEWA
L
LETTER

LCSPDC_
BJ_100_0
1

PDC
RENEWA
L
LETTER
GENERA
TION

Yes

DOT APPLICA
TION
DOCUME
NT LOAD

DOLPRC
_BJ_000_
02

APPLICA
TION
DOCUME
NT LOAD

Yes

ODD2 ONE
TIME
ACH
POST
DATED
PAYMENT
LETTER

OLSPDP_
BJ_100_0
1

ONE
TIME
ACH
POST
DATED
PAYMENT
LETTER
PROCES
SING

Yes

Chapter 2
Batch Jobs

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 141 of 207



Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ODD2 OUTPUT
DATA
DUMP
SERVICI
NG

OSTPRC
_BJ_100_
02

MASTER
CUSTOM
ER
STATEME
NT
GENERA
TION

Yes This
process is
used to
generate
consolidat
ed
Account
statement
s
associate
d for each
Master
Account.

WFP BILLING WTXBIL_
BJ_132_0
1

BILLING
PROCES
SING

Yes

WFP DELINQU
ENCY

WTXDLQ
_BJ_132_
01

DELINQU
ENCY
PROCES
SING

Yes

WFP LATE
CHARGE

WTXLTC_
BJ_132_0
1

LATE
CHARGE
ASSESS
MENT

Yes

WFP STATEME
NT

WTXPSG
_BJ_132_
01

STATEME
NT
GENERA
TION

Yes

WFP RATE
CHANGE

WTXRAT
_BJ_132_
01

RATE
CHANGE
PROCES
SING

Yes

WFP TERMINA
TION

WTXTIP_
BJ_132_0
1

TERMINA
TION
PROCES
SING

Yes

TPE PERIODI
C
MAINTAI
NENCE
FEE

TXNPMF
_BJ_100_
01

PERIODI
C
MAINTAI
NENCE
FEE
PROCES
SING

CRR CREDIT
CARD
PAYMENT
BATCH

CRDPMT
_BJ_100_
01

CREDIT
CARD
PAYMENT
BATCH
CREATIO
N

Yes
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

CRR CHASE
RETURN
CREDIT
CARD
FILE

TNMCRR
_BJ_100_
01

CHASE
RETURN
CREDIT
CARD
FILE
PROCES
SING

Yes

WFP UNIT
UPLOAD

WUPPRC
_BJ_132_
01

UNIT
UPLOAD

Common

ODD2 BATCH
JOB FOR
MONTHL
Y
HANDSO
FF FILE
FOR
SIMAH

CBUUTL_
BJ_100_0
4

BATCH
JOB FOR
MONTHL
Y
HANDSO
FF FILE
FOR
SIMAH

PUR PURGE
ALL PTT
TABLES

PTTPRC_
BJ_100_0
1

PURGE
ALL PTT
TABLES

Common

TPE BATCH
JOB FOR
SETTING
MATURE
D
ACCOUN
T
CONDITI
ON

TXNMAC
_BJ_100_
01

BATCH
JOB FOR
SETTING
MATURE
D
ACCOUN
T
CONDITI
ON

Yes

TPE NON
REFUND
GL

TXNRFD_
BJ_100_0
1

NON
REFUND
GL
PROCES
SING

Common

TPE PAYMENT
ARRANG
EMENT

TXNPAP_
BJ_100_0
1

PAYMENT
ARRANG
EMENT
PROCES
SING

Yes

TPE DELAY
FEE

TXNDLY_
BJ_100_0
1

DELAY
FEE
PROCES
SING

Yes

TPE STATEME
NT PAST
MATURIT
Y

TXNSTM
_BJ_100_
01

STATEME
NT PAST
MATURIT
Y
PROCES
SING

Yes
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

TPE BLACK
BOOK
INTERFA
CE

VEVBBK_
BJ_100_0
1

BLACK
BOOK
INTERFA
CE

Common

LBT BULK
NSF
PAYMENT
REVERS
ALS

TXNNSF_
BJ_100_0
1

BULK
NSF
PAYMENT
REVERS
ALS

CRR CREDIT
CARD
PAYMENT
BATCH

CRDPMT
_BJ_100_
01

CREDIT
CARD
PAYMENT
BATCH
CREATIO
N

CRR CHASE
RETURN
CREDIT
CARD
FILE

TNMCRR
_BJ_100_
01

CHASE
RETURN
CREDIT
CARD
FILE
PROCES
SING

Yes

ACR STOP
INTERES
T
ACCRUA
L

TXNACR_
BJ_100_0
3

STOP
INTERES
T
ACCRUA
L
PROCES
SING

Yes

QRT CUSTOM
ER
SERVICE
REAL
TIME
QUEUE

QCSPRC
_BJ_100_
02

CUSTOM
ER
SERVICE
REAL
TIME
QUEUE
PROCES
SING

Yes
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ODD2 OUTBOU
ND
CUSTOM
ER
EXTRACT
S TO
PAYMENT
AGENCIE
S

OCPPRC
_BJ_100_
01

OUTBOU
ND
CUSTOM
ER
EXTRACT
S TO
PAYMENT
AGENCIE
S

Yes This
process
generates
Custome
r
Payment
File
Extract
file with
individual
account
dues or
consolidat
ed dues
at Master
account
level in
column
definitions
.

ODD2 MASTER
ACCOUN
T
CUSTOM
ER
MOCK
STATEME
NT
GENERA
TION

OMSPRC
_BJ_100_
01

MASTER
ACCOUN
T
CUSTOM
ER
MOCK
STATEME
NT
GENERA
TION

Yes Yes Yes Common This
process
generates
Asset
billing
Mock
Statement
s based
on
preferenc
es defined
in
Contract.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ODD2 Output
Data
Dump File

OACPRC
_BJ_100_
01

ACCOUN
T DATA
EXTRACT
ION FILE
GENERA
TION

Yes Yes Yes Common This
process
generates
an
outbound
file with
required
data for
external
systems
to
process.
The
output file
data
generated
is based
on
accounts
selected
in
OACPRC
_BJ_100_
02
process.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ODD2 Output
Data
Dump File

OACPRC
_BJ_100_
02

PREPAR
E BATCH
DATA
FOR
ACCOUN
T DATA
EXTRACT
ION FILE
GENERA
TION

Yes Yes Yes Common This
process
decides
the data
or
accounts
to be
picked up
for file
generatio
n and can
be
controlled
using the
lookups
OAC_AC
C_STATU
S_CD
(account
statuses)
and
OAC_AC
C_CONDI
TION_CD
(account
conditions
). During
the batch
processin
g, system
checks
the
Account
Status &
Condition
s set
maintaine
d in the
lookups
and only
those
accounts
will be
part of the
output file.

IFP OFFLINE
CALL
ACTIVITY
POSTING

ICAPRC_
BJ_100_0
1

OFFLINE
CALL
ACTIVITY
POSTING

Yes

ACR RE-
START
INTERES
T
ACCRUA
L

TXNACR_
BJ_100_0
4

RE-
START
INTERES
T
ACCRUA
L

Yes
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

IFP UPLOAD
TRANSA
CTIONS

ITUPRC_
BJ_100_0
1

UPLOAD
TRANSA
CTIONS

Yes

IFP POST
UPLOAD
ED
TRANSA
CTIONS

ITUPRC_
BJ_100_0
2

POST
UPLOAD
ED
TRANSA
CTIONS

Yes

IFP INPUT
FILE
PROCES
SING -
CURREN
CY
EXCHAN
GE RATE
FILE
UPLOAD

ICEPRC_
BJ_100_0
1

CURREN
CY
EXCHAN
GE RATE
FILE
UPLOAD

Yes Yes Yes Common This
process
extracts
currency
exchange
rates from
desired
source at
scheduled
intervals.

IFP INPUT
FILE
PROCES
SING -
INPUT
DATA
INSERTI
ON

IDDPRC_
BJ_000_0
1

INPUT
DATA
INSERTI
ON

Yes This
process
updates
customer
account
informatio
n
correspon
ding to
the details
received
from
external
system.
Ex:
Bankruptc
y details
in
External
Interface
screen or
Cure
Letter
details in
Account
Informatio
n screen.

IFP INPUT
FILE
PROCES
SING

IPIPRC_B
J_100_01

PI
INFORMA
TION
FILE
UPLOAD
PROCES
SING

Yes Yes Yes Common This
process
uploads
input file
with PII
data into
the data
masking
screen.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

IFP INPUT
FILE
PROCES
SING

IUHPRC_
BJ_100_0
1

ASSET
USAGE
HISTORY
FILE
UPLOAD

Yes Yes Yes Common This
process
uploads
asset
usage
details
into the
system.

Driven
through
Setup >
Data File
tab, when
placed in
correspon
ding
folder and
batch job
is run,
system
processes
the file
and loads
in
External
Interface
s tab.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

IFP INPUT
FILE
PROCES
SING

ICPPRC_
BJ_100_0
1

CUSTOM
ER
PAYMENT
FILE
UPLOAD

Yes Yes Yes Common This
process
uploads
customer/
business
based
payment
details
and are
displayed
in
Payment
Entry
screen
with Multi
Account
check box
selected.

The
status of
Payment
batch is
updated
based on
the value
of system
parameter
PMT_BAT
CH_PO
STING
(PAYMEN
T BATCH
POSTING
PREFER
ENCE).

If the
value is
set to P
(POSTED
),
payment
job
request is
submitted
and
payment
is posted.
On
successfu
l posting,
the
payment
record is
available
in
Payment
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

Maintena
nce
screen.

IFP INPUT
FILE
PROCES
SING

ISCPRC_
BJ_100_0
1

SECURIT
IZATION
POOL
FILE
UPLOAD

Yes This
process
reads the
Securitiza
tion
upload file
and either
attach or
detach
the
accounts
of the
Pool.

IFP INPUT
FILE
PROCES
SING

IADPRC_
BJ_100_0
1

ACCOUN
T DUES
FILE
UPLOAD

Yes This
process
reads the
input file
to derive
future
prorated
due on a
particular
account.
For more
informatio
n refer to
Proration
of Future
Account
Dues
section in
Dashboar
d >
Process
Files.

PUR ARCHIVE
PURGE
JOB SET

PJRPAC_
BJ_100_0
1

PURGE
ACCOUN
TS DATA

Yes Yes Yes Common This
process
purges
accounts
data in
archival
tables
based on
the days
defined in
system
parameter
PAC_PUR
GE_DAYS
.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR ARCHIVE
PURGE
JOB SET

PJRPAP_
BJ_100_0
1

PURGE
APPLICA
TION
DATA

Yes Yes Yes Common This
process
purges
applicatio
n data in
archival
tables
based on
the days
defined in
system
parameter
PAP_PUR
GE_DAYS

PUR ARCHIVE
PURGE
JOB SET

PJRPGL_
BJ_100_0
1

PURGE
GL TXNS
DATA

Yes Yes Yes Common This
process
purges
general
ledger
transactio
n data in
archival
tables
based on
the days
defined in
system
parameter
PGL_PU
RGE_DA
YS.

PUR ARCHIVE
PURGE
JOB SET

PJRPPA_
BJ_100_0
1

PURGE
POOLS
DATA

Yes Yes Yes Common This
process
purges
pools and
its
transactio
ns data in
archival
tables
based on
the days
defined in
system
parameter
PPA_PUR
GE_DAYS
.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

PUR ARCHIVE
PURGE
JOB SET

PJRPPX_
BJ_100_0
1

PURGE
PRODUC
ER TXNS
DATA

Yes Yes Yes Common This
process
purges
producer
transactio
n data in
archival
tables
based on
the days
defined in
system
parameter
PPX_PU
RGE_DA
YS.

PUR ARCHIVE
PURGE
JOB SET

PJRPTX_
BJ_100_0
1

PURGE
TXNS
DATA

Yes Yes Yes Common This
process
purges
account
transactio
n data in
archival
tables
based on
the days
defined in
system
parameter
PTX_PUR
GE_DAYS
.

PUR ARCHIVE
PURGE
JOB SET

PJRPVA_
BJ_100_0
1

PURGE
VENDOR
ASSIGNM
ENTS
DATA

Yes Yes Yes Common This
process
purges
vendor
assignme
nt data in
archival
tables
based on
the days
defined in
system
parameter
PVA_PUR
GE_DAYS
.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

REV1 Revenue
Recogniti
on job set

REVREC
_BJ_100_
01

DAILY
REVENU
E
RECOGN
ITION
PROCES
SING

Yes Yes Yes Common This
process is
used to
validate if
Account
Revenue
Recogniti
on Equity
is greater
than or
equal to
Target
Revenue
Recogniti
on Equity
and
update
the
Current
Qualificati
on
Indicator.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

REV2 Revenue
Recogniti
on job set

REVREC
_BJ_100_
02

MONTH
END
REVENU
E
RECOGN
ITION
PROCES
SING

Yes Yes Yes Common This
process is
used to
validate
the status
of
Account
Revenue
Recogniti
on
Qualifier
indicator
and
update
the
following
fields:
• Acco

unt
Reve
nue
Reco
gnitio
n
Qualif
ier
Mont
h End
indica
tor
(after
mont
h end
proce
ssing
)

• Acco
unt
Reve
nue
Reco
gnitio
n
Qualif
ier
Date

• Last
Acco
unt
Reve
nue
Reco
gnitio
n
Qualif
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

ier
Date

SETEVE BATCH
EVENTS
PROCES
SING

EVEPRC
_BJ_100_
01

BATCH
EVENTS
PROCES
SING

Yes Yes Yes Common This
process is
used for
BATCH
EVENTS
PROCES
SING for
the
Entities
Account/
Applicatio
n/Assets.

SETEVE2 EVENTS
PROCES
SING
FOR
CUSTOM
ER AND
BUSINES
S

EVEPRC
_BJ_100_
03

BATCH
EVENTS
PROCES
SING
(CUSTOM
ER AND
BUSINES
S
ENTITIES
)

Yes Yes Yes Common This
process is
used for
BATCH
EVENTS
PROCES
SING for
the
Entities
Customer/
Business/
Vendors/
Producers
.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-RTP REAL
TIME
PROCES
SING

IRTPRC_
BJ_100_0
1

INCOMIN
G FILE
PROCES
SING

Yes Yes Yes Common This
process
reads the
processed
data from
external
system
loaded in
the
inbound_r
equests
and
inbound_r
equest_d
etails
table with
the status
‘R’.
Required
actions
like Call
Activity,
Transactio
n Posting
and so on
are
updated
in the
system
and after
processin
g the
status is
changed
to ‘P’ or
‘F’.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-
ODD2

OUTPUT
DATA
DUMP
SERVICI
NG

OACPRC
_BJ_100_
01

ACCOUN
T DATA
EXTRACT
ION FILE
GENERA
TION

No Yes No Common This
process
generates
an
Account
details
data
dump
outbound
file with
the data
required
by any
external
system for
processin
g. Data
for output
file
generatio
n is
created
by
OACPRC
_BJ_100_
02 batch
job.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-
ODD2

OUTPUT
DATA
DUMP
SERVICI
NG

OACPRC
_BJ_100_
02

PREPAR
E BATCH
DATA
FOR
ACCOUN
T DATA
EXTRACT
ION FILE
GENERA
TION

No Yes No Common This
process
generates
the batch
data
needed
for
OACPRC
_BJ_100_
01 batch
job. The
batch
consists
of account
details
based on
the
Account
Status
and
Account
Condition
that is
configure
d in the
lookups -
OAC_AC
C_STATU
S_CD
(ACCOUN
T STATUS
FOR
ACCOUN
T
DETAILS
FILE
GENERA
TION)
and
OAC_AC
C_CONDI
TION_CD
(ACCOUN
T
CONDITI
ON FOR
ACCOUN
T
DETAILS
FILE
GENERA
TION).
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-CUP USER
DEFINED
TARGET
PARAME
TERS
CALCUAT
OR

CUPACC_
BJ_111_0
1

LOAN
USER
DEFINED
ACCOUN
T
TARGET
PARAME
TER
CALCULA
TOR

No Yes No Common This
process
generates
a batch of
LOAN
accounts
for target
parameter
calculatio
n. The
accounts
are picked
based on
the status
maintaine
d in
lookup
code
CUP_AC
C_STATU
S_CD and
if 'Skip
User
Parameter
s
Calculatio
n' is
disabled
in Setup >
Products.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-CUP USER
DEFINED
TARGET
PARAME
TERS
CALCUAT
OR

CUPACC_
BJ_112_0
1

LINE
USER
DEFINED
ACCOUN
T
TARGET
PARAME
TER
CALCULA
TOR

No Yes No Common This
process
generates
a batch of
LINE OF
CREDIT
accounts
for target
parameter
calculatio
n. The
accounts
are picked
based on
the status
maintaine
d in
lookup
code
CUP_AC
C_STATU
S_CD and
if 'Skip
User
Parameter
s
Calculatio
n' is
disabled
in Setup >
Products.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-CUP USER
DEFINED
TARGET
PARAME
TERS
CALCUAT
OR

CUPACC_
BJ_121_0
1

LEASE
USER
DEFINED
ACCOUN
T
TARGET
PARAME
TER
CALCULA
TOR

No Yes No Common This
process
generates
a batch of
LEASE
accounts
for target
parameter
calculatio
n. The
accounts
are picked
based on
the status
maintaine
d in
lookup
code
CUP_AC
C_STATU
S_CD and
if 'Skip
User
Parameter
s
Calculatio
n' is
disabled
in Setup >
Products.

SET-PUR ARCHIVE
PURGE
JOB SET

PODODH
_BJ_100_
02

ARCHIVE
OUPUT
DATA
DUMP TO
OOTABLE
S

Yes Yes Yes Common This
process
archives
data in
ODD
tables
based on
the days
defined in
system
parameter
POD_OA
RCHIVE_
DAYS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-PUR ARCHIVE
PURGE
JOB SET

PJRPOD_
BJ_100_0
1

PURGE
OUTPUT
DATA
DUMP
DATA

Yes Yes Yes Common This
process
purges
data in
ODD
tables
based on
the days
defined in
system
parameter
POD_PU
RGE_DA
YS.

SET-PUR ARCHIVE
PURGE
JOB SET

PIDIDH_B
J_100_01

ARCHIVI
NG
INPUT
DATA
DUMP
TABLES

Yes Yes Yes Common This
process
archives
data in
input data
dump
tables
based on
the days
defined in
system
parameter
PID_ARC
HIVE_DA
YS.

SET-PUR ARCHIVE
PURGE
JOB SET

PIDIDH_B
J_100_02

ARCHIVI
NG O
INPUT
DATA
DUMP
TABLES

Yes Yes Yes Common This
process
archives
data in 'o'
input data
dump
tables
based on
the days
defined in
system
parameter
PID_OAR
CHIVE_D
AYS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-PUR ARCHIVE
PURGE
JOB SET

PJRPID_
BJ_100_0
1

PURGE
INPUT
DATA
DUMP
DATA

Yes Yes Yes Common This
process
purges
data in
input data
dump
tables
based on
the days
defined in
system
parameter
PID_PUR
GE_DAYS
.

SET-PUR ARCHIVE
PURGE
JOB SET

PJRPIP_
BJ_100_0
1

PURGE
INPUT
FILE
PROCES
SING
DATA

Yes Yes Yes Common This
process
purges
data in
input file
processin
g tables
based on
the days
defined in
system
parameter
PIP_PUR
GE_DAYS
.

SET-PUR ARCHIVE
PURGE
JOB SET

PJRPOF_
BJ_100_0
1

PURGE
OUTPUT
FILE
PROCES
SING
DATA

Yes Yes Yes Common This
process
purges
data in
output file
processin
g tables
based on
the days
defined in
system
parameter
POF_PU
RGE_DA
YS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-PUR ARCHIVE
PURGE
JOB SET

PJRPOM
_BJ_100_
01

PURGE
OUTBOU
ND
MESSAG
ES
TABLE
DATA

Yes Yes Yes Common This
process
purges
data in
outbound
messages
tables
based on
the days
defined in
system
parameter
POM_PU
RGE_DA
YS.

SET-PUR ARCHIVE
PURGE
JOB SET

PIPIPF_B
J_100_01

ARCHIVI
NG
INPUT
FILE
PROCES
SING
TABLES

Yes Yes Yes Common This
process
archives
data in
input file
processin
g tables
based on
the days
defined in
system
parameter
PIP_ARC
HIVE_DA
YS.

SET-PUR ARCHIVE
PURGE
JOB SET

PIPIPF_B
J_100_02

ARCHIVI
NG O
INPUT
FILE
PROCES
SING
TABLES

Yes Yes Yes Common This
process
archives
data in 'o'
input file
processin
g tables
based on
the days
defined in
system
parameter
PIP_OAR
CHIVE_D
AYS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-PUR ARCHIVE
PURGE
JOB SET

POFOPF
_BJ_100_
01

ARCHIVI
NG
OUTPUT
FILE
PROCES
SING
TABLES

Yes Yes Yes Common This
process
archives
data in
output file
processin
g tables
based on
the days
defined in
system
parameter
POF_AR
CHIVE_D
AYS.

SET-PUR ARCHIVE
PURGE
JOB SET

POFOPF
_BJ_100_
02

ARCHIVI
NG O
OUTPUT
FILE
PROCES
SING
TABLES

Yes Yes Yes Common This
process
archives
data in 'o'
output file
processin
g tables
based on
the days
defined in
system
parameter
POF_OA
RCHIVE_
DAYS.

SET-PUR ARCHIVE
PURGE
JOB SET

POMOBM
_BJ_100_
01

ARCHIVI
NG
OUTBOU
ND
MESSAG
ES
TABLES

Yes Yes Yes Common This
process
archives
data in
outbound
messages
tables
based on
the days
defined in
system
parameter
POM_AR
CHIVE_D
AYS.
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Table 2-61    (Cont.) Batch Jobs Available

Engine
Type

Descripti
on

Batch
Job

Descripti
on

Originati
on

Servicing Collectio
n

Product Commen
t

SET-PUR ARCHIVE
PURGE
JOB SET

POMOBM
_BJ_100_
02

ARCHIVI
NG O
OUTBOU
ND
MESSAG
ES
TABLES

Yes Yes Yes Common This
process
archives
data in 'o'
outbound
messages
tables
based on
the days
defined in
system
parameter
POM_OA
RCHIVE_
DAYS.

2.13 Producer Cycles
The Producer setup screen enables you to define the dealer or producer status cycle. This tells
the system which status a producer can cycle through. (This information is recorded in the
Status field on the Producers section of the Producer setup screen.

For example,

Figure 2-34    Producer Cycle

The Producer Setup screen also defines the user responsibilities capable of changing the
producer status.
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Note

The system enables only producers/dealers with a status of ACTIVE to fund contracts.

To set up Producer Cycles

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Producer Cycles.

2. The system displays the Producer Cycles screen. The producer cycle screen contains
three section:

• Cycle Definition

• Current/Next Status

• Status Change Responsibilities

Figure 2-35    Producer Cycles

3. In the Cycle Definitions section, you can view the following information.

Table 2-62    Cycle Definitions

Field View This

Cycle Displays the cycle name.

Type Displays the cycle type.

4. In the Cycle/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 2-63    Cycle/Next Status

Field Do this

Current Code Select the current code from which you need to
perform transition, from the drop-down list.

Next Code Select the code to which you need to perform
transition, from the drop-down list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Status Change Responsibilitiess section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 2-64    Status Change Responsibilities

Field Do this

Responsibility Code Select the responsibility that will be capable of
executing this transition, from the drop-down list.

Allowed Indicator Check this box to enable the responsibility to
execute the transition.

2.14 Vendors
During the life of an account, a financial institution might require the use of specialized services
of a vendor for various purposes; for example, repossessing a vehicle, retaining an attorney for
bankruptcy court proceedings, or making field calls. With the system’s Vendors screen, you
can define the following:

• Cycles Tab

• Vendor Services Tab

• Vendor Fees Tab

• Invoice Rules tab

2.14.1 Cycles Tab
The Cycle link allows you to define the various vendor cycles and the responsibilities that can
gain access to the various transactions in each cycle. The different categories are:

• You can define vendor status cycle and restrict the status change based on responsibility.

Figure 2-36    Vendor Status Cycle

• You can define vendor invoice status cycle and restrict the status change based on
responsibility.
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Figure 2-37    Vendor invoice status cycle

• You can define vendor assignment status cycle and restrict the status change based on
responsibility.

Figure 2-38    Vendor assignment status cycle

• You can define vendor invoice payment status cycle and restrict the status change based
on responsibility.

Figure 2-39    Vendor invoice payment status cycle

To set up the vendor cycles

1. Click Setup > Setup > Administration > System > Vendors > Cycles. The screen
contains three sections:

• Status Cycle

• Current/Next Status

• Status Change Responsibilities

Figure 2-40    Vendor cycles
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2. In the Status Cycle section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields are given below:

Table 2-65    Status Cycle

Field View this

Cycle Specify the status cycle for the vendor.

Type Displays the type of vendor assignment status
cycle.

Order Type Select the work order type for the vendor from
the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Current/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-66    Vendor cycles

Field Do this

Current Code Select the current code from which you need to
transition, from the drop-down list

Next Code Select the Next status code to which you need to
transition, from the drop-down list

Action Code Select the call activity action code from the drop
down list.

Result Code Depending on the call activity action code, you
can select the result code from the drop down
list.

Note

When there is a change in status from Current to Next, system posts respective
call activity on the account based on selected Action and Result code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Status Change Responsibilities section, perform any of the Basic Operations
mentioned in Navigation chapter:
A brief description of the fields is given below:

Table 2-67    Status Change Responsibilities

Field Do this

Allowed Select Yes to enable the responsibility to execute
the transition and No to disable

Responsibility Select the responsibility that will be capable of
executing this transition (from current code to the
next code), from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.14.2 Vendor Services Tab
The Vendor Service screen enables you to establish the links between the service type, vendor
group, and the work order type. It records which vendor groups can provide which type of
services and which service type belongs to which work order types.

For each service type (Service Type field), there can be multiple vendor groups and/or multiple
work order type(s).Each vendor (Group field) can belong to one or multiple vendor group(s).

1. Click Setup > Setup > Administration > System > Vendors > Vendor Services. The
screen contains three sections:

• Services

• Vendor Groups

• Work Order Types

Figure 2-41    Vendor Services

2. In the Services section, you can view the following information:

Table 2-68    Services

Field View this

Service Type Displays the service type.

Enabled Displays if the service is enabled or not.

3. In the Vendor Groups section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-69    Vendor Groups

Field Do this

Group Select the vendor group from the drop-down list.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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5. In the Work Order Types section, perform any of the Basic Operations mentioned in
Navigation chapter:
A brief description of the fields is given below:

Table 2-70    Work Order Types

Field Do this

Work Order Type Select the work order type from the drop-down
list.

Transaction Select the associated transaction for the service
type from the drop-down list.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14.3 Vendor Fees Tab
The Vendor Fees tab allows you to define fee structure (with specific amount) for each service
offered by specific vendor. The defined fees is auto populated as the estimated cost of the
assignment when a specific vendor and service is selected during work order creation.

To define vendor fees

1. Click Setup > Setup > Administration > System > Vendors > Vendor Fees. The screen
consists of Vendor Service Fee Definition section with option to define vendor fees.

Figure 2-42    Vendor Fees

2. In the Vendor Service Fee Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 2-71    Vendor Service Fee Definition

Field Do this

Start Dt System defaults the current date as the start
date. You can modify the same to a future date
using the adjoining calendar.

End Dt Specify the end date from the adjoining
Calendar.

Enabled Select the check box to enable the fee structure.

Amt Specify the amount charged by the vendor for a
specific service.

Selection Criteria

Vendor Group Select the vendor group from the drop-down list.
You can also select ALL (default option) if the fee
structure is applicable across vendor groups.

Vendor Select the vendor from the drop-down list. You
can also select ALL if you have selected the
Vendor Group as ALL. The list is sorted
depending on the vendor group selected.

Services Select the service from the drop-down list. The
list is sorted depending on the services offered
by the selected Vendor.

Company System defaults this value based on the vendor
selected. You can also select the required
company from the drop-down list.

Branch System defaults this value based on the vendor
selected. You can also select the required branch
from the drop-down list.

Vendor Channel System defaults this value based on the vendor
selected. You can also select the required vendor
channel from the drop-down list.

State System defaults the state in which the vendor
operates. You can also select the state from the
drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14.4 Invoice Rules tab
The Invoice Rules tab allows you to define state specific rules with a combination of service
and work order status. This helps to decide if a particular service fees in a work order is
Collectable or Not from the customer.

When the same combination of service, work order status and state is detected during auto
invoice validation, the Collectible check box in Vendors > Invoice tab > Invoice Details section
is selected. Further, the collectible amount is posted as an expense on the customer account.

To define invoice rules

1. Click Setup > Setup > Administration > System > Vendors > Invoice Rules.

2. In the Invoice Rules section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:
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Table 2-72    Invoice Rules

Field Do this

Service Select the service from the drop-down list. The
list consists of services offered by Vendors which
can be associated with a work order.

Work Order Status Select the work order status from the drop-down
list.

Close Reason Select the close reason from the drop-down list.
This field is enabled only if the work order status
is selected as CLOSE.

State Select the state from the drop-down list. The
selection here indicates that the state rules allow
to collect the service fee for selected service
from the customer.

Enabled Select the check box to enable the invoice rule.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.15 Collection Cycles
The Collection Cycles screen allows you to setup the collection workflow cycles.

To set up collection cycles

1. Click Setup > Setup > Administration > System > Collection Cycles link. The system
displays the Collection Cycles screen. The details are grouped into two:

• Status Cycle

• Current/Next Status

• Status Change Responsibilities

Chapter 2
Collection Cycles

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 175 of 207



Figure 2-43    Collection Cycles

In the Collection Cycles section, you can view the following details:

Table 2-73    Collection Cycles

Field Do this

Cycle The system displays the status cycle.

Type The system displays the type of status cycle.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. In the Current/Next Status section,perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-74    Current/Next Status

Field Do this

Current Code Select the current code from the drop-down list.

Next Code Select the next code from the drop-down list.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Status Change Responsibilities section, perform any of the Basic Operations
mentioned in Navigation chapter.
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Table 2-75    Status Change Responsibilities

Field Do this

Responsibility Select the responsibility from the drop-down list.

Allowed Ind Check this box to allow a record

6. Perform any of the Basic Actions mentioned in Navigation chapter.

2.16 Reports
The Reports screen allows you to setup reports in the system.

To set up the Reports

1. Click Setup > Setup > Administration > System > Reports link. The system displays the
Report screen. The details are grouped into two:

• Reports

• Report Parameters

2. In the Reports section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 2-44    Reports

A brief description of the fields is given below:
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Table 2-76    Reports

Field Do this

Code Specify the code of the report.

Description Specify the description of the report.

Package Specify the package.

Module Select the code of the report from the drop-down
list.

System Defined Yes/ No Select Yes, if you wish to maintain the Report as
system defined and No, if you do not want to
maintain it as system defined. System defined
entries cannot be modified. If the entry is not
system defined, then it can be modified.

Enabled Check this box to enable the report definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Report Parameters section,perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-77    Report Parameters

Field Do this

Parameter Specify the parameter code of the report.

Description Specify the description of the parameter.

Parameter Type Select the parameter type of the report from the
drop-down list.

Parameter Sub Type Select the parameter sub type of the report from
the drop-down list.

Default Specify the default value for the report parameter
(value to initially populate, or used if no value is
supplied) (optional).

Sort Specify the sort order for the look up code. This
determines the order these report parameters
are displayed or processed.

Enabled Check this box to enable the report definition.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.17 Error Messages
In the Error Messages Setup screen, you can translate or modify the text of error messages.
the system displays all messages as they appear to the system users in the Error Message
section’s Message field.

New messages created with the Error Messages screen can then be translated with the Setup
> Setup > Administration > System > Translation > Message Translation screen.

To set up the Error Messages Setup screen

1. Click Setup > Setup > Administration > System > Error Messages. The system
displays the Error Message screen.
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2. On the Error Messages Setup screen’s Error Type section, use the Error Type field to
select the error type. These are the categories of error messages available for creating or
editing.

3. The error messages associated with the error type you selected appear in the Error
Message section.

4. In the Error Messages section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-45    Error Messages

A brief description of the fields is given below:

Table 2-78    Error Messages

Field Do this

Region Specify the region code.

Country Specify the country code.

Customer Specify the customer code.

Engine Specify the engine code.

Error Code Specify the error code.

System Defined Displays whether the record is system defined or
not.

Enabled Check this box to enable the data error message.

Error Message Specify the error message.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.18 Translation
You can setup translation properties.

Navigating to Translation

1. Click Setup > Setup > Administration > System > Translation. The system displays the
Translation screen.

2. In this screen you can Setup Translation and Translate Error Messages in the following
tabs:

• Setup Translation

• Message Translation Setup

2.18.1 Setup Translation
In the Setup Translation tab, you can translate the contents of a predefined list of setup
description fields into a different language.

After you translate an entry in the Translation Data section, the system adds the new data to
the setup form.

To set up the Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Setup Translation.

2. In the Language section, you can select the language for which you need to setup the
translation.

Figure 2-46    Translation Setup
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Note

For more information, refer Language setup at the end of this chapter.

3. In the Source Type section, you can select the source (or location in the system) of the
item you want to translate.

4. Click Populate All in the Source Type section and the system loads the setup data
descriptions in the Translation section screen for the selected source type.
If you have new entries and are unsure as to which setup items have been updated since
the last translation, click Populate All, the system loads the additional data for all items
with no impact to the previously translated data for any of the entries.

5. In the Translation Data section, Select:

• All – to view all the records (both translated and un-translated) in the Translation Data
section.

• Translated – to view all the translated records in the Translation Data section.

• Un Translated – to view all the un-translated records in the Translation Data section.

6. In the Translation Data section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

You cannot add a new record.

A brief description of the fields is given below:

Table 2-79    Translation Data

Field Do this

Key 1 Displays the first reference key value.

Key 2 Displays the second reference key value.

Key 3 Displays the third reference key value.

Key 4 Displays the fourth reference key value.

Key 5 Displays the fifth reference key value.

Key 6 Displays the sixth reference key value.

System Defined Select Yes, if you wish to maintain the data as
system defined and No, if you do not want to
maintain it as system defined.

Enabled Check this box to indicate that the record is
active.

Desc 1 Translation 1 Specify the first translated description.

Desc 2 Translation 2 Specify the second translated description.

Desc 3 Translation 3 Specify the third translated description.

Desc 4 Translation 4 Specify the fourth translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.18.2 Message Translation Setup
In the Message Translation tab, you can translate the contents of a predefined list of error
messages into a different language.

After you translate an entry in the Error Message section, the system adds the new data to the
error message.

To set up the Message Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Message Translation.

2. In the Language section, you can select the language for which the translation needs to
be done.

Figure 2-47    Message Translation Setup

Note

For more information, refer Language setup at the end of this chapter.

3. In the Error Type, you can select the type of error message you want to translate.

4. Click Populate All in the Error Type section and the system loads the error messages in
the Error Message section for the selected error type.
If you have new entries and are unsure as to which error messages have been updated
since the last translation, click Populate All, the system loads the additional data for all
items with no impact to the previously translated data for any of the entries.

5. In the Error Message section, select:
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• All – to view all the records (both translated and un-translated) in the Error Message
section.

• Translated – to view all the translated records in the Error Message section.

• Untranslated – to view all the un-translated records in the Error Message section.

6. In the Error Message section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

You cannot add a new record.

A brief description of the fields is given below:

Table 2-80    Error Message

Field Do this

Region Displays the region code.

Country Displays the country code.

Customer Displays the customer code.

Engine Displays the engine name.

Error Code Displays the error code.

System Defined Check this box to indicate that the record is
system defined.

Enabled Check this box to indicate that the record is
active.

Message Specify the error message.

English Translation Specify the English translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Language setup

On the Lookup master tab’s Lookup Types screen, you can add other languages to the
TRD_LANGUAGE_CD lookup type and perform translations for those languages.

However, translated data only appears in one language, which is defined by the User
Language parameter. This parameter can be defined in the system configuration file, typically
named DBKWEB.CFG, which defines the parameter as:

Parameter: otherparams=ORA_USER=<schema_name> USR_LANG=<native language>

Note

<native language> should match lookup codes in the TRD_LANGUAGE_CD lookup
type on the Administration form’s Lookups screen.

The system supports the following pre-defined list of setup items for translation:

1. Asset Sub Types

2. Asset Types
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3. Assignments

4. Audit Table Columns

5. Audit Tables

6. Call Action Result Types

7. Call Action Types

8. Checklist Action Types

9. Checklist Types

10. Commission Plans

11. Companies

12. Company Branch Departments

13. Company Branches

14. Compensation Plans

15. Credit Bureau Score Reasons

16. Credit Models

17. Credit Scoring Parameters

18. Edits

19. Escrow Disburse Rules

20. Escrow Sub Types

21. Flex Table Attributes

22. Flex Tables

23. GL Transaction Types

24. GL Translators

25. Job Sets

26. Jobs

27. Lookup Codes

28. Lookup Types

29. Portfolio Companies

30. Portfolio Company Branches

31. Producers

32. Product Instruments

33. Product Insurances

34. Product Pricings

35. Products

36. Promotions

37. Spreads

38. Standard Correspondences

39. Standard Document Definitions

40. Standard Element Definitions
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41. Standard Function Definitions

42. Transaction Codes

43. Error Messages

44. Org. Fees

2.19 Label Configuration
The Label Configuration screen facilitates for field label customizations to modify the default
field’s label which are provided as part of seed data during product installation / upgrade. Using
this screen, you can modify the field’s User Defined Label, update Tool tip, set Default Value (if
required), set display (Y/N) option and enable / disable the field. The changes done here are
populated to respective screen in the application.

Note

• Label configuration is controlled by the value defined for system parameter
UIX_CUSTOM_LABEL_ENABLED_IND and indicates whether configurable option
is enabled or not.

• Also the Update button in Label Configuration screen is enabled only if
UIX_CUSTOM_ LABEL_ENABLED_IND is set to Y.

Field in the UI are categorized into two types:

• Base fields - these are default fields in the UI consisting of both mandatory and non-
mandatory fields.

• User Defined Fields - these are additional fields provided in disabled status which can be
enabled and customized as required.

Note the following:

• Configuring field details is only an optional functionality and has to be used sensitively.

• Field customizations are to be done cautiously and is recommended to be performed by
someone who is well-versed with the product. For example, label change of a particular
field is to be done at both Section and Header block to avoid inconsistency.

• Field customizations are to be performed at your sole discretion and OFSLL is not
responsible for any impact/damage/mismatch in the data being represented or resulting
out of this change.

The Label Configuration screen displays all the Base and User defined fields provided for the
below listed screens and its sub tabs. Apart from base fields, there are additional User
Defined Fields provided with the below combination in disabled status.

• 10 free text fields - User Defined Field Char

• 30 numeric fields - User Defined Field Num

• 10 date fields - User Defined Field Date

List of screens enabled with the above User Defined Fields for configuration:

• Producer Screen

• Customer Service > Checklists > Checklist Types, Action - Regular sub tab, and Action -
Document sub tab.
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• Customer Service > Correspondence > Correspondences sub tab, Documents sub tab,
and Document Elements sub tab.

• Customer Service > Letters

• Customer Service > Collateral

• Customer Service > Account Details

• Servicing > Collateral Management > Collateral Details

• Conversion Accounts > Account Boarding > Collateral and Account Details sub tab

• Origination > Underwriting > Bureau > Report Header sub tab and all 10 sub tabs

Note

The corresponding web services are also enhanced to include the User Defined
Fields. Refer to swagger web service release documentation available in OTN library
(https:// docs.oracle.com/cd/F22291_01/webservice.htm).

Ensure that the field(s) for which label changes are to be done is enabled in the UI from
Access setup screen. For more information, refer to Field Access Definition section.

You can update the field properties for all the user defined fields. For Base -non mandatory
fields, you can set the display (Y/N) option, define as mandatory / non mandatory and enable
or disable the same in UI.

The below table indicates the supported field update options based on field type.

Table 2-81    The supported field update options based on field type

Parameter Base Field User Defined Field Comment

Label change Allowed to modify Allowed to modify

Data Type Not allowed to modify -
Display only

Not allowed to modify -
Display only

Default data type
supported by the field

Default Value Allowed to modify Allowed to modify No default value

Required Not allowed to modify Allowed to modify

Display (Yes/ No) Allowed to modify for
non-mandatory fields

Allowed to modify for
non-mandatory fields

Cannot modify
mandatory Base field

The Label Configuration screen displays the field records based on specific combination of
Language and Division. By default the combination is set to ALL and can further be filtered
by selecting required combination from respective drop-down list.

Note that the Label Configuration done for a specific division (for example US01) is displayed
to those users who are mapped to the same division (US01). Else, the default labels defined
for ALL division is displayed.

After updating the required changes in Label Configuration screen, you need to logout and
relogin for changes to appear in respective UI. This is basically to refresh session cache and
fetch the updated field information from database server. Though, there is Update option,
clicking on the same only refreshes the cache and reloads the record.

To customize Label Configuration

1. Click Setup > Setup > Administration > System > Label Configuration.
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Figure 2-48    Label Configuration

2. To filter the records in Label Configuration section, select the required combination of
Language and Division from the drop-down list and click Load.

3. Select the required record and click Edit. You can also perform any of the Basic
Operations mentioned in Navigation chapter.
While looking for a specific field to customize, you might notice multiple records with similar
data since one record is populated in section and other on header. Carefully differentiate
and select the required record for update.

A brief description of the fields is given below:

Table 2-82    Label Configuration

Field Do this

Language View the language category of the field.

Division View the division category of the field.

Object Type View the type of object category of the field such
as Tab / Field / Button / Header / Sub header.

Object Name View the object name maintained in database.

Field Name View the field name maintained in database.

User Defined Label Specify the field label name to be updated in the
UI.

Tooltip Enter the tooltip indicating the type of value to be
populated for the field. The same is displayed on
mouse over.

Default Value Specify the default value to be populated in UI.

Based on field type, the default value set to
UNDEFINED for varchar, 0 for Number, and
system date for Date.

Required Check this box to mark the field as mandatory for
input in UI.
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Table 2-82    (Cont.) Label Configuration

Field Do this

Display (Yes /No) Check this box to display the field in UI. By
default, the same checked for Base - non
mandatory fields.

Note: Option defined here takes precedence with
the display (Y/ N) option selected in Setup >
Administration > Access > Screen > Field Access
Configuration tab.

System Required Y indicates the field is system required and other
parameters such as Required, Display, and
Enabled options are disabled.

N indicates the field is user configurable.

Enabled Check this box to enable the field and apply the
label configuration changes on save.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Click Update. System refreshes the cache automatically and fetches the updated field
details from database server to display in header section.

2.20 Seed Data
Seed data in general is referred to as any data delivered with the standard product installation
and is required to be present in the production environment for application to work properly.
Seed data basically consists of Table with its associated data that are uploaded into the system
through DAT files.

Seed Data screen in Oracle Financial Services Lending and Leasing displays the seed data
details maintained in the system along with the updated seed data provided with the latest
release or patch installation.

Note that, when you upgrade OFSLL from an existing version to higher version,

• New seed data provided as part of that release is automatically updated into the system.

• Seed data which are modified from previous release to current release needs to be
manually accepted and updated into the system.

The modified seed data can have updates on base tables and/or its associated data and the
changes can either be updated or skipped depending on the need.

Navigating to Seed Data screen

1. Click Setup > Setup > Administration > System > Seed Data. The system displays the
Seed Data screen.

2. On this screen you can do the following:

• View the factory shipped seed data and update/skip the seed data differences between
existing and updated seed data in Factory Data tab.

• View the customized (i.e. changed or configured) seed data as part of implementation
in Current Data tab.

• View the differences between Factory data and Current data in Comparison Data tab

• Download all or only the required table specific seed data in Download Data tab.

This section consists of the following topics:
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• Factory Data

• Current Data

• Comparison Data

• Download Data

2.20.1 Factory Data
The Factory Data tab displays the list of both existing and updated seed data which are
provided though release/patch installation. In the Factory Data tab you can select and update
only the required seed data changes into the respective seed data tables. During update, you
can also skip the seed data changes for later updates (if required).

Accordingly, you can sort the view in Factory Data tab by selecting Skipped, Update or All
options to display the list of corresponding seed data.

In the Patch # drop-down list, you can further sort the list to display ALL the seed data or only
the additions or updates available as part of latest patch which has seed data changes.

To View Factory Data

Click Setup > Setup > Administration > System > Seed Data > Factory Data tab.

Figure 2-49    Seed Data_Factory

The Factory Data section displays the list of seed data with the following details:

Table 2-83    Factory Data

Field View this

Table Displays the seed data table name.

Type Displays the category of seed data as either
System or Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Chapter 2
Seed Data

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 189 of 207



Table 2-83    (Cont.) Factory Data

Field View this

Other Column Types Displays the non unique identifier column data
types.

Count Displays the total count of updated records in the
seed data table.

The Factory Data Details section displays the associated data of the selected seed data table
along with the following details:

Table 2-84    Factory Data Details

Field View this

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

Patch # Displays the patch number with which the seed
data changes are identified.

Status Displays the current status of seed data as one of
the following:

INSERT: This status indicates new seed data.

UPDATE: This status indicates if there are changes
in the record when compared to the seed data
released in previous patch.

POSTED: This status indicates that the seed data
changes are updated into the main tables and is
subsequently updated from previous status -
SKIPPED OR UPDATE OR INSERT.

SKIPPED: This status indicates that the seed data
is not updated into the main tables

DEPRECATED - This status indicates that the seed
data is no longer used.

In the Factory Data tab, you can click  (refresh) to fetch the latest details and click View to
display the detailed information of the selected record.

This section consists of the following topic:

• Update/Skip Seed Data

2.20.1.1 Update/Skip Seed Data
The Update option in the Factory Data tab allows you to replace the existing seed data with
the current update. However, ensure to double check the details before performing Update
operation since the same can have significant impact on system behaviour.

To Update/Skip Data

1. In the Factory Data tab, select Update. System displays those records which can be
updated to the existing seed data tables.

2. Inspect the required record in Factory Data section with the Factory Data Details in
subsequent section.
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3. Select the required record to be updated by clicking on the adjacent check box. You can
also click Select All to select all the records.

4. Do one of the following:

• Click Update Data. This action updates the existing seed data with the updated seed
data provided as part of the current patch release.

• Click Skip Data. This action skips the seed data changes received as a part of the
patch release. The skipped records can be viewed by selecting Skipped option in
Factory Data tab. However, the same can further be updated into the system, by
selecting Update Data.

5. Click Yes in confirmation dialog to confirm the setup data changes.
On successful update, system does the following:

• When individual records are selected and updated, the same is removed from Factory
Data Details section and the Count column in Factory Data section is updated with the
remaining number of records.

• In case of Bulk update, the record is removed from Factory Data tab.

2.20.2 Current Data
The Current data tab displays the customized seed data which are changed or configured as
part of implementation. In the Current Data tab, you can click  (refresh) to fetch the latest
details and click View to display the detailed information of the selected record.

Additionally you can click Refresh Data to pull the seed data details from the production
system and update the current seed data tables.

To View Current Data

Click Setup > Setup > Administration > System > Seed Data > Current Data tab.

Figure 2-50    Seed Data_Current

The Current Data section displays the following details:
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Table 2-85    Current Data

Field View this

Table Displays the current seed data table name.

Type Displays the category of seed data as either
System or Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data
types.

Count Displays the total count of records in the seed data
table.

Last Refreshed Dt Displays the date and time when seed data for the
selected table was last updated in the system.

The subsequent Current Data Details section displays the associated data of the selected
seed data table along with the following details:

Table 2-86    Current Data Details

Field View this

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

2.20.3 Comparison Data
The Comparison Data tab displays the differences between factory shipped seed data and
current customized seed data.

To View Comparison Data

Click Setup > Setup > Administration > System > Seed Data > Comparison Data tab.

Figure 2-51    Seed Data_Comparison
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The Comparison Data section displays the list of seed data records with the following details:

Table 2-87    Comparison Data

Field View this

Table Displays the seed data table name to be inserted
or updated.

Type Displays the category of seed data as either
System or Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data
types.

Count Displays the total count of records in the seed data
table.

The subsequent Comparison Data Details section displays the associated data of the
selected seed data table along with the following details:

Table 2-88    Comparison Data Details

Field View this

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

Patch # Displays the patch release version with which the
seed data was inserted/updated.

In the Comparison Data tab, you can click  (refresh) to fetch the latest details and click
View to display the detailed information of the selected record.

2.20.4 Download Data
The Download Data tab allows you to download table specific seed data available in the
system in .dat format. While migrating from one environment to other, you can use the
Download Data tab to download the existing seed data and perform a bulk upload of all/
required files.

Similar to other file download process, based on the value defined for the system parameter
CMN_FILE_PROCESS_TO_LOB, the seed data download file can be accessed from the
Process Files interface (if value is Y) or Database Files system (if value is N). For more
information on handling Incoming/Outgoing process files, refer to Dashboard section in User
Guides.

To Download Data

1. Click Setup > Setup > Administration > System > Seed Data > Download Data tab.
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Figure 2-52    Seed Data_Download

The Download Data section displays the list of tables maintained in the system with Table
Name and Table Type. Click  (refresh) to fetch the latest details.

2. Select the check box adjacent to the required table in the list. You can choose Select All
check box to select all the tables with seed data maintained in the system.

3. Click Submit For Download button. System displays an information message in the
header indicating that the request has been submitted along with a reference number. The
reference number is generated in format - useridDDMMHHMISS# followed by table name
with .dat extension. For example, (USER1230603121517#lookups.dat)

4. (Optional) If CMN_FILE_PROCESS_TO_LOB is set to Y, navigate to DashBoard > Process
Files screen > Outgoing Process File tab to download the selected seed data file which will
be listed with the same reference number. The file can be downloaded to Application
server.

2.21 Sales Tax
The Sales Tax screen facilitates to define state and county-wise Lease Sales and Usage Tax
rules which are used in Origination and Customer Service modules to calculate the taxes on
lease asset sales.

For information about this screen, refer to Sales Tax Setup section in Appendix chapter.

For detailed information on how lease sales tax calculation is supported in OFSLL, refer to
Lease Sales and Usage Tax Appendix chapter.

2.22 Data Masking
Data masking screen in Oracle Financial Services Lending and Leasing facilitates to mask
Personally Identifiable Information (PII) displayed in the application to safeguard the sensitive
and confidential information while protecting them from offenders.

As part of the product installation, standard set of identified fields (seed data) which is likely to
contain either organization / customer PI information are provided for data masking in disabled
status. Based on need, the required fields can be enabled and masked for specific user
responsibility in the Data Masking screen. Also if there are additional PII fields identified for
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masking, the same can be pooled into the system using input file processing method and
masked using Data Masking screen.

The data masking process involves the following steps:

• Identify and enable field(s) (seed data) to be masked

• Select user responsibility for whom the data has to be masked

• Execute batch job to create data redaction policy

• Compile the data redaction policy

• (Optional) Process user identified PII data for masking.

The following table indicates the standard pre-defined fields (seed data) identified in respective
screens/tabs which can be readily masked using the Data Masking screen.

Table 2-89    Data Masking

Tab Name Field Names

Origination

Applicant First Name, MI, Last Name, Family Name, Birth Dt,
Nationality, National ID, Visa #, Passport #, License
#, Marital status, Mother's maiden name, Passport
number, Gender, Language, Dependents, Ethnicity,
Disability, Email, Race, and Education.

Applicant > FATCA Birth Place, Birth Country, and Permanent US
Resident Status.

Applicant > Power of Attorney Holder Name, Address, Country, Nationality, and
Telephone Number.

Applicant Active Military Duty, Military Effective Date, Duty
Order Number, and Active Military duty Release
date.

Addresses Country, Postal Address Type, Address #, Street
Pre, Street Name, Street Type, Street Post, Apt #,
Address 1, Address 2, Address 3, Zip, Zip Extn,
City, State, and Phone.

Telecoms Phone and Extn

Employments Employer, Country, Address #, Address 1, Address
2, Zip, Zip Extn, City, State, Phone, Extn, Income
Amt - Stated, Income Amt - Actual, Salary - Stated,
Salary - Actual, and Title.

Applicant > Financials Type, Source, Account #, and Currency.

Existing Accounts Account # and Title.

Servicing

Customer Name, Birth Dt, Nationality, National ID, Visa #,
Passport #, License #, Marital status, Mother's
maiden name, Passport #, Language, Disability,
Email, and Education.

Customer > FATCA Birth Place, Birth Country, and Permanent US
Resident Status.

Customer > Power of Attorney Holder Name, Address, Country, Nationality, and
Telephone Number.

Customer Active Military Duty, Military Effective Date, Duty
Order Number, and Active Military duty Release
date.
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Table 2-89    (Cont.) Data Masking

Tab Name Field Names

Addresses Country, Postal Address Type, Address #, Street
Pre, Street Name, Street Type, Street Post, Apt #,
Address 1, Address 2, Address 3, Zip, Zip Extn,
City, State, Phone, and Address.

Employments Employer, Country, Address #, Address 1, Address
2, Zip, Zip Extn, City, State, Phone, Extn, and Title.

Assets tab

Assets Identification #, Lien Status, Lien Event Date,
Second Lien Holder, Comments, Lien Release
Entity, and Entity Name.

Masking Format

Oracle Financial Services Lending and Leasing supports only complete masking (not partial) of
both factory shipped and user identified PII data. On masking, the masked data is presented in
same structural format to facilitate internal validations. The below table indicates the default
values used for masking fields based on data type:

Table 2-90    Masking Format

Data Type Masking Value

NUMBER 9

VARCHAR X

DATE 31/12/9999

Phone number For UI represented format - 000-000-0009 (Masked
with 0’s and last digit as 9) and for generic, masked
as 9999999999

Email xxxxx.xxx@<domain>.com

Note

It is recommended to avoid modifying masked data for user(s) with masked
responsibility. However, while editing masked data (if permitted) requires to input full
data replacing the masked characters. For example, editing a masked SSN
(xxx.xx.xxxx) requires to specify all nine digits of SSN and not just the last four digits.

This section consists of the following topics:

• Setup Data Masking

• Create data redaction policy

• Masking User defined data

2.22.1 Setup Data Masking
1. Click Setup > Administration > System > Data Masking.

2. Define the parameters available in following tabs.
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• Data Masking Details

• User Access Details

2.22.1.1 Data Masking Details
On clicking Data Masking link, the Data Masking Details tab is displayed by default and allows
you to enable the required fields for masking.

Figure 2-53    Data Masking Details

1. In the Data Masking Details section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields are given below:

Table 2-91    Data Masking Details

Field Do this

Table Name View the table name which contains the selected
field details.

Field Name View the selected field name.

Enabled Check this box to enable masking of the selected
field.

System Defined View the type of seed data maintained in the
system. Y indicates factory shipped seed data
and N indicates user defined seed data.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.22.1.2 User Access Details
The User Access Details tab facilitates to define the user responsibility to whom the PII data
should be masked. By default, all the selected PII data in Data Masking Details tab appears as
masked for one or more user(s) selected in this tab.
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1. Click Setup > Administration > System > Data Masking > User Access Details.

Figure 2-54    User Access Details

2. In the User Access Details section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields are given below:

Table 2-92    User Access Details

Field Do this

Responsibility Select the user responsibility from the drop-down
list.

Masked Check this box to enable masking for the
selected user.

Note: Defining a user and not selecting the
masked check box will only create the record and
masking rules are not applied.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.22.2 Create data redaction policy
Once the data masking details are defined and stored in the database, you need to create a
data redaction policy which facilitates for field level masking while displaying the details to the
respective user. A data redaction policy file contains the policies on the columns enabled in the
Data Masking Details screen.

To create data redaction policy

Click Setup > Administration > System > Batch Jobs and execute the following batch job (in
single thread mode only):

Table 2-93    Create data redaction policy

Set Code Description Job Code

SET-RED POLICY CREATION FOR
PERSONAL IDENTIFIABLE
INFORMATION DATA

REDPRC_BJ_100_01
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This batch job can either be scheduled for regular run or executed on-demand and facilitates to
generate data redaction policy picking only the enabled data masking field information from
database. On every run, the batch job drops and re-creates new set of policies in the file based
on the details updated in Data Masking Details screen.

The generated policy is either written into CLOB or sql file depending on the following option:

• if the value of system parameter CMN_FILE_PROCESS_TO_LOB is set to Y, the policy file
is generated in CLOB and can be accessed by navigating to DashBoard > Process Files
screen. For more information on handling Incoming/Outgoing process files, refer to
Dashboard section in User Guides.

• If the value of system parameter CMN_FILE_PROCESS_TO_LOB is N, the policy is
generated as an sql file and stored in the repository path as defined in the system
parameter - CMN_SERVER_HOME. For example, /scratch/OFSLL/<release>/sql.

Further, the policy file needs to be manually compiled into database schema to apply the
masking rules for respective fields for that particular user. Either a system administrator or any
other user having administration privileges needs to compile the policies in the database.

Note

For every change in the data masking details such as masking additional fields or
unmasking / disabling masked fields, a new policy is to be created by executing the
batch job.

2.22.3 Masking User defined data
Apart from factory shipped seed data, additional user identified PII data can be masked by
uploading an input file with field details and processing it in Data Masking screen using input
file processing method.

1. On identifying the fields, create an input file (in text file format) with table name, column
name, and enabled indicator (Y/N) for each field level record. If enabled indicator is N, the
record is not processed for data masking.
For example, BUSINESS_APPL_DETAILS,BSD_LEGAL_NAME,N

2. Place the input file to the path as defined in system parameter IPI_DIRECTORY. For
example, $OFSLL_HOME/input/ipi

3. Navigate to Setup > Administration > System > Batch Jobs screen and execute the
following batch job:

Table 2-94    Masking User defined data

Set Code Description Job Code

SET-IFP PI INFROMATION FILE
UPLOAD PROCESSING

IPIPRC_BJ_100_01

On execution, the batch job picks the file from the location, processes it and loads the seed
data into Data Masking screen. By default, all the user identified PII data from input file is
categorized separately in Data Masking screen by assigning the value of System Defined
property as N.

Once the data is available in Data Masking screen, enable the required fields, assign user
responsibility and run the processing batch job - redprc_bj_100_01 to generate a redaction
policy. For more details, refer Create data redaction policy section.
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Note

In addition, an xml sample file with PII fields data is provided in the installation bundle
(docs folder). The same is generated through Application Data Model (ADM) and can
be imported to view the details of PII masked fields. However to do so, you need to
have Oracle Cloud 13c installed.

2.23 Webhook
Webhook in OFSLL provides a facility to integrate with third-party external applications by
sending REST API based notifications of changes through system generated Webhook event
actions.

In the Webhook screen, you can register third-party applications to which you can notify the
changes that are done in OFSLL by triggering Webhook request as an event action.

In this type of integration, the server which is OFSLL propagates the information to the
dependant third-party applications (client) when a specific type of change has happened in
OFSLL. For example, when customer details are updated in OFSLL. For detailed information,
refer to Appendix : Webhooks chapter.

In the Webhook screen, you can maintain Webhook definition details and associate Event
Details along with Authentication Attributes.

Figure 2-55    Webhook

This section consists of the following topics:

• Webhook Definition
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• Event Details

• Authentication Attributes

• Monitoring Webhook Events

2.23.1 Webhook Definition
In a Webhook definition, you can create a Channel with specific third party authentication
mode, provide test and service url and generate secret key.

To setup Webhook Definition

1. Select Setup > Administration > System > Webhook.

2. In the Webhook section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields are given below:

Table 2-95    Webhook Definition

Field Do this

Channel Specify the channel name of interfaced third-
party application for identification. The same will
be added into weblogic Key Store.

Client Secret Key The client secret key is auto generated by the
system on clicking Generate button after defining
the details. If already generated, the same can
be used to regenerate

Service URL Specify the context path of third-party
application’s Webhook Service URL used for
communication where POST request is to be
provided. You can define multiple service end-
point URLs for the same channel.

Test Service URL Specify the GET web service Webhook URL of
third-party application to check service
availability.

Click Test button to generate sample test call.
The status, either success or error of the test call
is displayed on the screen as SERVICE URL
TEST SUCCESFUL/FAILED. Refer step 4 below
for more information.

Enabled Check this box to enable the Webhook definition.
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Table 2-95    (Cont.) Webhook Definition

Field Do this

Authentication mode Select the authentication mode of third-party
application from the drop-down list. The list is
displayed based on lookup code
WHK_AUTH_MODE_CD. System supports the
following options:

BASIC - On selecting this option, you need to
define User Name and Password to authenticate.

OAUTH2.0 - On selecting this option, you need
to define additional enabled fields such as Grant
Type, Client Id, Client Secret, Identity Domain,
Token and Header Key.

ORACLE BANKING ROUTING HUB - On
selecting this option, you need to define User
Name, Password, Token Header Key, Response
Token Key, and Request Authorization Header
Prefix to authenticate.

Note: Based on the above selection, additional
Webhook definition fields are enabled and need
to be populated accordingly.

The following additional fields are available for BASIC type of Authentication mode:

User Name Specify the Basic Authentication User Name.

Password Specify the Basic Authentication User Password.

The following additional fields are enabled for OAUTH2.0 type of Authentication mode:

Token URL Specify the third-party OAUTH 2.0 token
generation URL.

Grant Type Select the OAUTH 2.0 grant type from the drop-
down list. The list is populated based on lookup
code WHK_GRANT_TYPE_CD.

Client Id Specify the identification name of third-party
OAUTH 2.0 client.

Client Secret Specify the secret code of third-party OAUTH 2.0
client.

Identity Domain Specify the domain name of the third-party
OAUTH 2.0 client.

Token Header Key Specify the token header key of third-party
OAUTH 2.0 client.

Response Token Key Specify the Response Token Key of third-party
OAUTH 2.0 client which is the key name of
Authentication Response Header. The same is
used to identify token value used as input for
subsequent calls.

Note: If value is not provided, system defaults to
access_token.

Request Authorization Header Prefix Specify the Request Authorization Header Prefix
of third-party OAUTH 2.0 client This is the prefix
used to Request Authorization Header based on
token generation mechanism like Basic, Bearer,
JWT and so on.

Note: If value is not provided, system defaults to
Bearer.
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Table 2-95    (Cont.) Webhook Definition

Field Do this

User Name If Authentication mode is selected as OAUTH2.0
and Grant Type as Resource Owner Password,
specify the third-party OAUTH 2.0 Resource
Owner User Name.

Password If Authentication mode is selected as OAUTH2.0
and Grant Type as Resource Owner Password,
specify the third-party OAUTH 2.0 Resource
Owner User Password.

The following additional fields are enabled for ORACLE BANKING ROUTING HUB (OBRH) type of
Authentication mode:

User Name Specify the third-party OBRH Resource Owner
User Name.

Password Specify the third-party OBRH Resource Owner
Password.

Token Header Key Specify the token header key of third-party
OBRH client.

Response Token Key Specify the Response Token Key of third-party
OBRH client which is the key name of
Authentication Response Header. The same is
used to identify token value used as input for
subsequent calls.

Note: If value is not provided, system defaults to
access_token. An example is indicated below
where token element is the key name:
 

 

Request Authorization Header Prefix Specify the Request Authorization Header Prefix
of third-party OBRH client This is the prefix used
to Request Authorization Header based on token
generation mechanism like Basic, Bearer, JWT
and so on.

Note: If value is not provided, system defaults to
Bearer. An example is indicated below:
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Table 2-95    (Cont.) Webhook Definition

Field Do this

Bureau <Check if required> Select the Credit Bureau from the drop-down list.
This is required if the Credit Bureau report format
is to be processed externally as defined in Setup
> Administration > User > Credit Bureau screen.

The list is populated with credit bureau details
maintained in CRB_SOURCE_CD lookup. This
field is enabled only during ADD process and is
Read-Only during EDIT.

Ensure that the selected Bureau is not already
selected for the enabled record. Else, system
displays an error indicating Record already
exist with same bureau and need to disable the
existing record and enable the new record with
the new Bureau.

Note: The Event Details section is not displayed
if the Credit Bureau report format is to be
processed externally.

Verified This check box is auto selected on verifying the
channel data by clicking TEST button and if the
test server connection is successful.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Test button to verify the configuration details of third-party application.

• Th external system generates base 64 X-Hmac header using HMAC SHA 256 and
propagate this as part of response header to OFSLL.

• Channel name is used in HMAC digest as given below. This will be passed to the
external interface using HTTP Header Key ChannelName. This value will be in base
64 encoded format.

• System will validate this response and update the Verified indicator. Only HTTP status
code 200 is considered as success.

Format: "OFSLL": Base64 Encoded [HMAC SHA 256 of ["Http Method Types":"Base64
Encoded Channel Name": "Service URL"] with Client Secret Key]

For example:

Client Secret Key

ZXlKMGVYQWlPaUpLVjFRaUxDSmhiR2NpT2lKSVV6VXhNaUo5LmV5SnpkV0lp
T2lKWFJVSklUMDlMSWl3aVEwaEJUazVGVENJNklrVllWRVZTVGtGTVNVNVVS
VkpHUVVORkxVOUJWVlJJTWpBaUxDSnBjM01pT2lKUFJsTk1URjlYUlVKSVQw
OUxJaXdpWlhod0lqb3hOVFUxTmpnMU1qSXpMQ0pwWVhRaU9qRTFOVFUyT0
RRNU1qTjkuemxMb0lzdWduek1FRnhyblcxYXJIeXNMSFliSmVQd0R5SUxvdDdU
aXZDMEFVUktEbm5WcDJpWmRiT1pJald5aHNfSWxNaG1lV1dWZUF0YmZRUnl
1X2c=

Cipher Text for HMAC SHA 256

GET:RVhURVJOQUxJTlRFUkZBQ0UtT0FVVEgyMA==:application/json:https://
Hostname:Port/webhook_oauthqa/service/api/resources/webhook/test
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Generated Sample X-Hmac header

OFSLL:F/jj07qhgM3g5z91EHU/rdxYbaJ266SRnXsBRoUxgUc=

Note

Configuration details for OBRH application cannot be verified using Test option
since OBRH currently does not support return of customizing HTTP header [X-
Hmac].

5. Clicking Generate button OFSLL generates Client Secret Key. This key is used in
generation of X-HMAC header that is sent to the third-party channel to validate origination
of the request.
System generated X-HMAC header uses base 64 encoded HMAC SHA 256 algorithm.
This algorithm uses below logic:

Format: "OFSLL": Base64 Encoded [HMAC SHA 256 of ["Http Method Types":"Base64
Encoded Payload":" Http Content Types": "Service URL"] with Client Secret Key]

For example.

Client Secret Key

T0ZTTExfQjJCX1RFU1RfQ0xJRU5UOndlbGNvbWUx

Cipher Text for HMAC SHA 256

POST:ewogICAgIlJlcXVlc3RUeXBlIjogIk9VVEJPVU5EIgp9:application/json:http://
Hostname:Port/webhook/service/api/resources/webhook/basic

Generated Sample X-Hmac header

OFSLL:q6xCpZrnudfB8owvYEi2+Aac4clM3b/XFVTVrChdQKA=

2.23.2 Event Details
The Event Details section acts as a single point of entry to define and update required
Webhook Events in the system. In Event Details, you can define service end points of
thirdparty application which accepts the communicated changes. Multiple end points can be
defined to a single channel for each Event Criteria. These details are displayed as Webhook
Event Action in Setup > Administration > System > Events screen.

To define Event Details

1. Select Setup > Administration > System > Webhook.

2. Select the required definition in Webhook section.

3. In the Event Details section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields are given below:
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Table 2-96    Event Details

Field Do this

Event Select the event code from the drop-down list.
The list is populated based on the enabled event
codes maintained in Events setup screen.

Event Criteria Select the event criteria from the drop-down list.
The list is populated based on the enabled event
criteria maintained for the selected event in
Events setup screen.

Service End Point Specify the third-party application end point URL
which is propagated to Event Definition as an
Event Action Parameter.

Event Message Specify the event message which is propagated
to Event Definition as an Event Action Parameter.

Enabled Select this check box to enable the event details
in the system.

4. Click  button and add the event details to the list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.23.3 Authentication Attributes
For connecting to some of the third-party applications, addition Authentication attributes and
Request Header is required to be sent from OFSLL. In the Authentication Attributes, you can
define those specific attributes required for authentication. Multiple authentication attributes
can be defined to a Webhook definition.

To define Authentication Attributes

1. Select Setup > Administration > System > Webhook.

2. Select the required definition in Webhook section and click Authentication Attributes
sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields are given below:

Table 2-97    Authentication Attributes

Field Do this

Attribute Type Select the required Attribute Type which is used
to record HTTP header type from the drop-down
list:
• TOKEN REQUEST HEADER: This is used

to add Authentication request header details.
• REQUEST HEADER: This is used to add

Request header details.

Attribute Key Specify the HTTP header key.

Attribute Value Specify the HTTP header value.

Enabled Select this check box to enable the
Authentication Attributes details in the system.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.23.4 Monitoring Webhook Events
You can verify the status of all Webhook Event Actions on the JMS Queues screen of the
System Monitor screen.

To monitor Webhook events

1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor > JMS Queues.
The Messages tab displays the Status for all outbound Webhook events processed to
third-party applications and their request in Response Message Details section.

For more details, refer to Dashboard > System Monitor section in any of the User Guides.
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3
Administration User

In the Administration > User, you can record setup data that define your organization
structure and its users. Information in this link is more data related, whereas the information
stored on the System drop-down link functions more like switches that control system behavior.

Navigating to Administration User

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User.

The User drop-down link records the following data:

• Organization

• Companies

• Access

• Users

• Credit Bureau

• Correspondence

• General Ledger

• Queues

• Printers

• Intelligent Segmentation

• Bank Details

• Standard Payees

• Check Details

• Currencies

• Zip Codes

• Payment Hierarchy

• Number Generation

3.1 Organization
The Organization screen records the operational hierarchy of your business in terms of people.
It groups the human resources of your business in three categories: organization, division, and
department. The system uses this data to control access of users to applicationsaccounts.
(The Companies screen allows you to setup the location of these applicationsaccounts.)

Note

You can have only one active organization, so use the Organization field to define your
organization at its highest level.
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Divisions are groups within your organization that will have access to the same
applicationsaccounts. Larger organizations often define their divisions by region. Smaller
organizations may define division as branch offices or even departments, and might only have
one division defined.

Departments are smaller units within a division. They expand on who is in the corresponding
Division field. The system uses this sub screen, for example, when setting up the Services
screen on the Utility form. At least one department must be defined for each division.

Figure 3-1    Organization Flowchart 1

As an example of an organization setup, Oracle Corp. might be defined as:

Organization: O-0001Oracle Corp.ORA

Division: OD-001Central RegionC01

Department: ODD-01OriginationORG

Department: ODD-02FundingFUN

Department: ODD-03ServicingSER

Division: OD-002Eastern RegionE01

Department: ODD-11ServicingSER

Department: ODD-12CollectionCOL
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Figure 3-2    Organization Flowchart 2

Note

The Short Name field on the Organization screen allows you to create the ID that
Oracle Financial Services Lending and Leasing will use when referring to the
organization, division, and department throughout the system.

To setup the Organization screen

1. Click Setup > Setup > Administration > User > Organization.

2. In the Organization Definition section, there can be only one active entry, so use this
screen to define your organization at its highest level. Perform any of the Basic Operations
mentioned in Navigation chapter.
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Figure 3-3    Organization Definition

A brief description of the fields is given below:

Table 3-1    Organization Definition

Field Do this

Organization Specify the organization ID (the ID is the unique
identifier used internally by Oracle Financial
Services Lending and Leasing to represent your
organization).

Note: Do not edit this field.

Organization Name Specify the organization name.

Short Name Specify the short name for the organization.

Note: This ID represents this organization
throughout the system.

Enabled Check this box to enable the organization.

Note: Only one enabled organization is currently
allowed by Oracle Financial Services Lending
and Leasing.

Country Select the country where the organization is
located from the drop-down list.

City Specify the city where the organization is
located.

State Select the state where the organization is located
from the drop-down list.

Address Line 1 Specify the address line 1 for the organization.

Address Line 2 Specify the address line 2 for the organization.
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Table 3-1    (Cont.) Organization Definition

Field Do this

Zip Select the zip code of the location where the
organization is located from the drop-down list.

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the
organization.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the alternate phone number for the
organization.

Extn 2 Specify the phone extension for the alternate
phone number, if specified.

Fax 1 Specify the primary fax number for the
organization.

Fax 2 Specify the alternate fax number for the
organization.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Division Definition section, you can setup the information for the groups within your
organization that will have access to the same applications and accounts. Perform any of
the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-2    Division Definition

Field Do this

Division Specify the division ID. The ID is the unique
identifier used internally by the system to
represent the division within the organization.

Note: Once specified, do not edit this field.

Division Name Specify the division name.

Short Name Specify the short name for the division.

Note: This ID represents this division throughout
the system (required).

Enabled Check this box to enable the division.

Country Select the country where the division is located
from the dropdown list.

City Specify the city where the division is located.

State Select the state where the division is located
from the drop-down list.

Address Line 1 Specify the address line 1 for the division.

Address Line 2 (unlabeled) Specify the address line 2 for the division.

Zip Select the zip code of the location where the
division is located from the drop-down list.

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the
division.

Extn 1 Specify the extension for the primary phone
number.
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Table 3-2    (Cont.) Division Definition

Field Do this

Phone 2 Specify the alternate phone number for the
division.

Extn 2 Specify the extension for the alternate phone
number.

Fax 1 Specify the primary fax number for the division.

Fax 2 Specify the alternate fax number for the division.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click Setup > Setup > Administration > User > Organization > Department Definition.

7. On the Department Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-3    Department Definition

Field Do this

Department Specify the department ID.

Note: The ID is the unique identifier used
internally by the system to represent the
department within the division.

Department Name Specify the department name.

Short Name Specify the short name for the department.

Note: This is the ID that appears throughout the
system to represent this department.

Enabled Check this box to enable the department.

Country Select the country where the department is
located from the drop-down list.

City Specify the city where the department is located.

State Select the state where the department is located
from the dropdown list.

Address Line 1 Specify the address line 1 for the department.

Address Line 2 Specify the address line 2 for the department.

Zip Select the zip code where the department is
located from the drop-down list.

Extn Specify the zip extension where the department
is located.

Phone 1 Specify the primary phone number for the
department.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the alternate phone number for the
department.

Extn 2 Specify the phone extension for the alternate
phone number.

Fax 1 Specify the primary fax number for the
department.

Fax 2 Specify the alternate fax number for the
department.
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8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. In the Display Formats section, you can setup various display formats such as Date
Format, Time Format, National ID Format and Time Zone. Click Setup > Setup >
Administration > User > Organization > Display Formats.

Note

During the Date Format setup, note that this is a one-time setup before starting to
use the product. These date-format changes will result in data issues, so changing
is not recommended.

10. On the Display Format section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-4    Display Format

Field Do this

Format Type Select the type of format from the drop-down list.

Format Sub Type Select the sub type of the format from the drop-
down list. The format sub type will be displayed
based on the format type selected.

Format Specify or select the format based on the format
type and format sub type selected. For Date and
Time Zone format, select the required option
from the drop-down list.

Note

If Format Type = Date Format, system
does not limit the date format as
MM/DD/YYYY but supports different
date formats which are dependent on
'Flex Table' attributes maintained in
Date Format Sub Type lookup code
FORMAT_SUB_TYPE_CD.

Format Mask Specify the format mask.

Format Filler Specify the format filler.

Special Data Specify the special data, if any.

Enabled Check this box to enable the display format.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

3.2 Companies
The Companies screen records the hierarchical structure of your portfolio companies and their
branches. Just as Oracle Financial Services Lending and Leasing uses the Organization
screen to determine the location of people, it uses the information on the Companies screen to
determine the location of applicationsaccounts. In completing the Companies screen, there can
be more than one company, and each company can have more than one branch.
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Accounting is performed at the company level. applications accounts can be sorted down to
the branch level. For this reason, branches are set up to reflect different business practices.
You would set up different branches if, for example:

• The General Ledger (GL) differs between branches

• The branches work with different accounts

• There is a difference between branches in terms of the tasks they perform (origination,
servicing, collections, and so on).

Figure 3-4    Company Flowchart 1

As an example of the companies setup, Oracle Corp. might have the following companies
and branches defined as:

Company: C-0001TrustOne Financial CorpTOFC

Branch: CB-01TOFC - HeadquartersHQ

Branch: CB-02Kennedy Plaza KP

Company: C-0002Credtyme Credit CorpCCC

Branch: CB-11CCC - HeadquartersHQ

Branch: CB-12CCC - MissoulaMT
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Figure 3-5    Company Flowchart 2

Note

– The system does not limit the number of companies or associated branches
with the company you can enter.

– The Short Name field on the Companies screen allows you to create the ID
that the system will use while referring to the company and branch.

KEY CONCEPT: Note the difference between the Company screen and the Organization
screen:

– On the Organization screen, Oracle Financial Services Lending and Leasing users
belong to an organization and division.

– On the Companies screen, credit applications and accounts belong to a company and
branch.

As you can see in the following Access screen section, the information on the Organization
and Companies screens define the operational hierarchy of your companies in terms of
which Oracle Financial Services Lending and Leasing users will have access to which
applications accounts.

To setup the Companies

1. Click Setup > Setup > Administration > User > Companies. The Companies screen
defines entities within your organization that originate and/or service LoansLeasesLine
of Credit.

2. In the Company Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-6    Company Definition

A brief description of the fields is given below:

Table 3-5    Company Definition

Field Do this

Company Specify the portfolio company ID. (This ID is
the unique identifier used internally by the
system to represent the company).

Name Specify the name of the portfolio company
(required).

Short Name Specify the short name for the portfolio
company (ID displayed to represent the
company).

Currency Select the currency of the portfolio company
from the drop-down list. The system displays
the default value as US DOLLAR.

Enabled Check this box to enable the portfolio
company.

Country Select the country where the portfolio
company is located from the drop-down list.
The system displays the default value as
UNITED STATES.

Address Line 1 Specify the address line 1 for the portfolio
company.

Address Line 2 Specify the address line 2 for the portfolio
company.

Zip Select the zip code of the location where the
portfolio company is located from the drop-
down list.

Extn Specify the extension of the zip code where
the portfolio company is located.

City Specify the city where the portfolio company is
located.
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Table 3-5    (Cont.) Company Definition

Field Do this

State Select the state where the portfolio company is
located from the drop-down list.

Company Time Zone Select the time zone in which the company
operates using the drop down list. This time
zone is considered if system is setup to
process GL at Company level. For more
information, refer to Appendix -
Configuration at Company Level chapter.

Remittance Address section

Country Select the remittance address country from the
drop-down list. The system displays the default
value as UNITED STATES.

Remittance Address 1 Specify the remittance address line 1, if it is
different from the company address. This
address is included as the remittance address
on statements.

Remittance Address 2 Specify the remittance address line 2.

Zip Select the zip code of the remittance address
line 1 from the drop down list.

Extn Specify the extension of the remittance
address zip code.

City Specify the remittance address city.

State Select the remittance address state from the
drop-down list.

Phone 1 Specify the primary phone number for the
portfolio company.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the alternate phone number for the
portfolio company.

Extn 2 Specify the phone extension for the alternate
phone number.

Fax 1 Specify the primary fax number for the portfolio
company.

Fax 2 Specify the alternate fax number for the
portfolio company.

Tax ID # Specify the tax identification number for the
portfolio company.

TCC Specify the transmitter control code for the
portfolio company (1098 Electronic Filing).

Contact Specify the contact information about the
portfolio company.

Coupon Order Code If you are using coupons, Specify the coupon
order code to be used by a third party printing
the coupons for billing statements.

HMDA Select the HMDA agency (Home Mortgage
Disclosure Act reporting agency for the
company).

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4. On the Branch Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-6    Branch Definition

Field Do this

Branch Specify the portfolio branch ID. (This ID is the
unique identifier used internally by the system
to represent the branch within your company).

Name Specify the name of the portfolio branch
(required).

Short Name Specify the short name for the portfolio branch
(ID displayed to represent the branch)
(required).

Enabled Check this box to enable the portfolio branch.

Sub Unit Select the Sub Unit from the drop-down list.

Sub Unit refers the entity which is the source
of funds for the credit application/Account.

System associates the selected sub unit with
the particular company/ branch combination
and displays by default when the same is
selected during an application/Account
creation.

Country Select the country from the drop-down list. The
system displays the default value as UNITED
STATES.

City Specify the city where the portfolio branch is
located.

State Select the state from the drop-down list.

Address Line 1 Specify the address line 1 for the portfolio
branch.

Address Line 2 Specify the address line 2 for the portfolio
branch.

Zip Select the zip code of the location where the
portfolio branch is located.

Zip Extn Specify the extension of the zip code, where
the portfolio branch is located.

Phone 1 Specify the primary phone number for the
portfolio branch.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the alternate phone number for the
portfolio branch.

Extn 2 Specify the phone extension for the alternate
phone number.

Fax 1 Specify the primary fax number for the portfolio
branch.

Fax 2 Specify the alternate fax number for the
portfolio branch.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
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3.3 Access
Using the organizations, divisions, companies, and branches created on the Organization and
Companies screens, you can control the access privileges of applications accounts. On the
Access screen, you define which organization/division (users) can gain access to which
company/branch (applications accounts) locations.

Normally, for each division within an organization, you would define a record with Company
value of ALL and a Branch value of ALL, then select the Allowed box. You then define other
records for the same Organization and Division for other Company and Branch combinations
with the Allowed box cleared to restrict access.

Figure 3-7    Access Flowchart

To setup the Access

1. Click Setup > Setup > Administration > User > Access. The system displays the Access
screen.
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2. In this screen, you can control the access privileges of the user for the following
categories:

• Data

• Screen

• Reports

• Correspondence

• Transaction

• Webservice

3.3.1 Data
The Data screen allows you to restrict access to different data.

To setup the Data

1. Click Setup > Setup > Administration > User > Access > Data.

2. In the Access Grid section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 3-8    Access Grid

A brief description of the fields is given below:
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Table 3-7    Access Grid

Field Do this

Organization Select the organization for which you are defining
access privileges from the drop-down list.

Division Select the division within the organization for
which you are defining Access privileges from
the drop-down list.

Company Select the portfolio company to which you are
defining access privileges for the organization
and division specified from the drop-down list.

Branch Select the portfolio branch of the company to
which you are defining access privileges for the
organization and division specified from the drop-
down list.

Allowed Check this box to provide access to the data
pertaining to the company and branch, for the
organization and division specified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.2 Screen
In the screen, you can control the access to the following:

1. Menu – Control access at the application menu level. For example, for Setup menu you
can provide access only to an Administrator.

2. Screens – Control access to the screens available in the application.

3. Buttons – Control access based on the stage.
For example, Add and Edit buttons can be disabled once an application is funded. If you
want to restrict updating the Applicant details, then edit button has to be disabled for the
stage.

4. Fields - Control access to base and user defined fields.
The screen allows you to restrict access to different screens and fields using the following
tabs:

• Security Access Definition

• Field Access Definition

• Security User Access Definition Details

3.3.2.1 Security Access Definition
To set the Screen Security

1. Click Setup > Setup > Administration > User > Access > Screen.

2. In the Security Super Group section, you can view the details of the super group you
want to work with.
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Figure 3-9    Security Super Group

3. In the Security Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

Note

You can not add a new record.

A brief description of the fields is given below:

Table 3-8    Security Access Definition

Field Do this

Access Code The system displays the selected access code.

Description Modify the description of the access code.

Type The system displays the type of security access
definition.

System Defined If Yes is selected, the security access definition
entry is system defined.

If No is selected, the security access definition
entry is manually defined.

Enabled Check this box to enable the security access
definition entry is enabled.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 3-9    Security User Access Details

Field Do this

Access Type Select the access type of the user who will have
access to this screen from the drop-down list.

Active Value Select the active value of the user who will have
access to this screen from the drop-down list.

Allowed Select Yes to allow access to this screen or No
to deny access to this screen.

System Defined Select Yes, if the screen user access definition
entry is system defined.

Select No, if the screen user access definition
entry is manually defined.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.2.2 Field Access Definition
The Field Access Definition tab facilitates for field customization in the User Interface (UI)
screen. In this tab, you can do the following:

• Enable User Defined Fields (UDFs) to be displayed in respective UI which are provided as
part of product installation/upgrade

• Allow or restrict user access to base non-mandatory fields and UDFs maintained in the
system

• Regroup base fields to another section in UI

Figure 3-10    AccessGrid_field

Note the following:

– The Field Access Definition tab displays User defined Fields maintained in the system
for which you can specifically define access permissions based on user responsibility.
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– The base mandatory fields are loaded automatically and Access Responsibility is set
to ALL by default during product installation/upgrade. The same cannot be modified
and hence are not displayed in this tab.

– Field access and customizations are to be performed at your sole discretion and
OFSLL is not responsible for any impact/damage/mismatch in the data being
represented or resulting out of this change.

– Field labels can further be customized in Administration > System > Label
Configuration screen.

Before defining field access, refer to the table below which indicates the possible
combinations of a particular field being displayed and allowed to edit in UI.

Table 3-10    Field Definition

View Type Access Result

VIEW NO NON VIEWABLE

VIEW YES VIEWABLE AND EDITABLE

LOCK NO READONLY

LOCK YES VIEWABLE AND EDITABLE

To add/enable new User Defined Fields

1. In the Field Access Definition section, click Add and populate the following details:

Table 3-11    Field Access Definition

Field Do this

Language Select the language of the user(s) who will
have access to this field from the drop-down
list.

Division Select the division or group within the
organization to which the user belongs from
the drop-down list.

Object Name Select the Object Name from the drop-down
list. You can use the search option to query
based on specific name. The list is populated
based on the combination of Language and
Division selected above.

Field Name Select the field to be updated from the drop-
down list. The list is displayed based on the
object selected.

Access Type Select the access type as one of the following
from the drop-down list.

View - to display and make the field editable.

Lock - to only display the field.

Note: Option defined here takes precedence
with the display (Y/N) option selected in Setup
> Administration > System > Label
Configuration tab.

System Defined Select Yes, if the field access definition is
system defined.

Select No, if the field access definition is
manually defined.
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Table 3-11    (Cont.) Field Access Definition

Field Do this

Enabled Check this box to enable the field access
definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. Click Update. System refreshes the cache and automatically updates the Field Access
Details from database to display in header section.
After updating the required changes in screen, you need to logout and re-login for
changes to be effective. This is basically to refresh session cache and update Field
Access information from database server. Though, there is Update option, clicking on
the same only refreshes the cache and reloads the record.

To enable/disable Base fields

1. In the Field Access Definition section, click Edit and populate the following details:

Table 3-12    Field Access Definition

Field Do this

Access Code View the access code defined for the field.

Description View the access code description. You can
modify the details if required.

Type By default, system displays the name of the
group inside which the field is displayed in UI.
To move the field to a different group, select
the required type from the drop-down list.

System Defined Select Yes, if the screen field access definition
is system defined.

Select No, if the screen field access definition
is manually defined.

Enabled Check this box to enable the field access
definition.

3.3.2.3 Security User Access Definition Details
The Security User Access Definition Details sub tab is available only for base - non
mandatory fields and user defined fields. In the Security User Access Definition Details sub
tab you can defined field access and set restrictions to specific user responsibility.

1. In the Security User Access Definition Details section, perform any of the Basic
Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-13    Security User Access Definition Details

Field Do this

Access Type Select RESPONSIBILTY as the access type from
the drop-down list since access to field is based
on responsibility by default. This field is disabled
during edit.

Active Value Select the user role who needs to have access to
this field from the drop-down list.
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Table 3-13    (Cont.) Security User Access Definition Details

Field Do this

Allowed Select Yes to allow access to this field or No to
deny access to this field.

System Defined Select Yes, if the field user access definition is
system defined.

Select No, if the field user access definition is
manually defined.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.3 Reports
In the Reports screen you can control access to generate certain reports.

To set up Reports

1. Click Setup > Setup > Administration > User > Access > Reports.

2. In the Reports section, you can view the following information:

Figure 3-11    Reports

A brief description of the fields is given below:
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Table 3-14    Reports

Field View this

Code Displays the code of the report.

Module Displays the code of the report from the drop-
down list.

Description Displays the description of the report.

Enabled Displays whether the report definition is enabled
or not.

3. In the Reports User Access Definition section, you can set the access rights for the
report selected in the Reports section. Perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-15    Reports User Access Definition

Field Do this

Access Type Select the access grid function type from the
drop-down list.

Access Value Select the access function grid value from the
drop-down list.

Allowed Select Yes to allow access or No to restrict
access to the entry based on the access type
and value.

System Defined Yes/No Select Yes, if the report user access definition
entry is system defined.

Select No, If the report user access definition
entry is manually defined.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.4 Correspondence
The Correspondence screen allows you to restrict access to different correspondence
commands on the Letters menu, thus restricting your ability to generate certain
correspondence.

If you do not have the responsibility to create a type of correspondence, the corresponding
command on the Letters menu is unavailable (dimmed).

To setup the Correspondence

1. Click Setup > Setup > Administration > User > Access > Correspondence.

2. In the Correspondence Codes section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-12    Correspondence Codes

A brief description of the fields is given below:

Table 3-16    Correspondence Codes

Field Do this

Code The system displays the correspondence code
name you want to work with.

Description The system displays the description for the
correspondence code (display only).

Enabled Check this box to enable the selected
correspondence code entry.

3. In the Correspondence User Access Definition section, perform any of the Basic
Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-17    Correspondence User Access Definition

Field Do this

Access Type Select the access grid function type from the
drop-down list.

Access Value Select the access function grid value from the
drop-down list.

Allowed Select Yes to allow access or No to restrict
access to the entry based on the access type
and value.
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Table 3-17    (Cont.) Correspondence User Access Definition

Field Do this

System Defined Yes/No Select Yes, if the correspondence user access
definition entry is system defined.

Select No, if the correspondence user access
definition entry is manually defined.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.5 Transaction
The transaction screen allows you to view and restrict access to the following account
transactions maintained in the system.

• ACCOUNT MONETARY TXN

• ACCOUNT NON MONETARY TXN

• PRODUCER MONETARY TXN

• ACCOUNT CONDITION TXN

• SECURITIZATION TXN

• ESCROW MONETARY TRANSACTIONS

• ESCROW NON MONETARY TRANSACTIONS

• FEE ASSESSMENTS

• ESCROW ANALYSIS AND DISBURSEMENTS

Along with restricting access, you can also define authorization permissions for monetary
transactions. While defining authorization permissions, you can allow transactions to Authorize
through assigned Maker/Check responsibilities with/without having specific authorization
criteria defined. However, authorization criteria can be defined only for monetary transactions
which needs authorization.

To define access/authorization rights for Transaction

1. Click Setup > Setup > Administration > User > Access > Transaction.

2. In the Transaction Super Group section, select the super group you want to work with.
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Figure 3-13    Transaction Super Group

3. In the Transaction Codes section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-18    Transaction Codes

Field Do this

Code The system displays the transaction code you
want to work with.

Description Specify/Edit the description for the transaction.

Authorize Check this box to enable authorization by
another user. Such transactions can be
authorized on the Authorization tab of
Transaction Authorization screen in Servicing
Module.

Note: For monetary transactions, system allows
you to define both Maker and Checker
authorization in the Maker and Checker
Responsibility tabs respectively. For non-
monetary transactions, you can define maker
responsibility for authorization.

When the Authorization check box is not
selected, any new transactions posted will not go
for authorization.

For more information, please refer the
Transaction Authorization (Maker-Checker)
chapter in the Oracle Financial Services
Lending and Leasing User Guide.

Enabled Select this box to enable the transaction.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
You can define the authorization restrictions using the following sub tab:

• Maker Responsibility

• Checker Responsibility
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• Authorization Criteria

Note

Checker Responsibility and Authorization Criteria tabs are available only for
monetary transactions (i.e. Authorize flag set to Y).

To define Maker Responsibility

1. Click Setup > Setup > Administration > User > Access > Transaction.

2. In the Transaction Super Group section, select the super group you want to work with.

3. In the Maker Responsibility section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-19    Maker Responsibility

Field Do this

Access Type Select RESPONSIBILITY as the access type
from the drop-down list.

Access Value Select the user responsibility from the drop-down
list.

Allowed Select Yes to allow access or No to restrict
access to the entry in the Transaction Codes
section, based on the access type and value.

System Defined Select Yes, if the transaction user access
definition entry is system defined.

Select No, if the transaction user access
definition entry is manually defined.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

To define Checker Responsibility

When a particular monetary transaction needs checker authorization you can define the same
in Checker Responsibility tab and also specify the Authorization Criteria for the transaction.

1. Click Setup > Setup > Administration > User > Access > Transaction.

2. In the Transaction Super Group section, select the super group you want to work with.

3. In the Transaction Codes section, select the monetary transaction with the Authorize flag
as Y.

4. In the Checker Responsibility section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-20    Checker Responsibility

Field Do this

Access Type Select CHECKER RESPONSIBILITY as the
access type from the drop-down list.

Access Value Select the user responsibility from the drop-down
list.
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Table 3-20    (Cont.) Checker Responsibility

Field Do this

Allowed Select Yes to allow access or No to restrict
access to the entry in the Transaction Codes
section, based on the access type and value.

System Defined Select Yes, if the transaction user access
definition entry is system defined.

Select No, if the transaction user access
definition entry is manually defined.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

To define Authorization Criteria

You can define conditional authorization by creating a sql statement based on required criteria.
For example, you can define a condition to allow transaction authorization in an account for
amount greater than 500.

1. Click Setup > Setup > Administration > User > Access > Transaction.

2. In the Transaction Super Group section, select the super group you want to work with.

3. In the Transaction Codes section, select the monetary transaction with the Authorize flag
as Y.

4. In the Authorization Criteria section, you can add/edit the following details in the Criteria
Name and Criteria Details section.

5. In the Criteria Name section perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 3-21    Criteria Name

Field Do this

Name Specify a name for the criteria.

Description Specify a description for the criteria.

Authorization Level Specify the level of authorization responsibility in
numeric value.

Note: You will need to specify the same value as
defined for each user within Checker
Responsibility Lookup Type (CHECKER_
RESPONSIBILITY_CD) in Setup >
Administration > System > Lookups screen.

Enabled Select this box to enable the criteria.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Criteria Details section perform any of the Basic Operations mentioned in
Navigation chapter.
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Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 3-22    Criteria Details

Field Do this

Seq Specify a sequence number.

( Specify the open/entry criteria.

Parameter Select the transaction parameter from the drop-
down list.

The list displays transaction parameters for the
selected transaction and the parameters in user
defined table INP_BMP_ACC.

Comparison Operator Select the comparison operator from the drop-
down list.

Criteria Value Specify the required criteria value for validation.

) Specify the close/exit criteria.

Logical Expression Select the logical operator from drop-down list.

Enabled Select this box to enable the criteria.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Click Check Criteria to validate the correctness of the statement and to resolve errors, if
any.
You can add multiple checker responsibility and define multiple selection criteria for each
checker responsibility.

3.3.6 Webservice
The Webservice screen in Access setup allows you to configure access to the available
RESTful webservices in the system. The associated seed data for all the RESTful webservices
are loaded during product installation and process of installing the same is detailed in the
Installation guide.

As an administrator/superuser, you can Enable/Disable Web Service access to users based on
their responsibility and ensure that only authorized user have access to specific type of data in
the system. Following list indicates some of the available RESTful webservices in the system
and the complete list is made available in swagger JSON file shared in OTN library.

• Generic Post Transaction Service

• Call Activity Service

• Scheduler Service

• Account Search Service

• Account Boarding Service
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• Payment Posting Service

• Account Detail Service

• Calculator Service

• Application Search Service

• Get Scenario Analysis Service

• Post Scenario Analysis Service

• Lookup Service

• Dialer Integration Service

• Application GET Service

• Application Entry service

• Application Update Service

• Application Status Change

• Application Checklist

• Application ACH GET Service

• Application ACH POST Service

• Application Comment GET Service

• Application Comment POST Service

• Application Document GET Service

• Application Document POST Service

• Account Comment GET Service

• Account Comment POST Service

• Account Document GET Service

• Account Document POST Service

• Process File Upload Service

• Process File Download Service

• Process File List Service

• Product Service

• Asset Service

• Asset Sub-Type Service

• Scheduler Force ReSubmit

• Remarketing GET Service

• Remarketing POST Service

• Invoice GET Service

• Invoice POST Service

To setup the Webservice access

1. Click Setup > Setup > Administration > User > Access > Webservice. The screen
consists of the following tabs:

• Security Super Group
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• Security Access Definition

• Security User Access Definition Details

• Security Access Definition Details (This sub tab is available only for SERVICING AND
COLLECTION Super Group.

Figure 3-14    Webservice

2. The Security Super Group section, contains the following super group categories for
selection:

• COMMOM

• INTERFACES

• ORIGINATION

• SERVICING and COLLECTIONS

• SETUP

• WHOLESALE FLOOR PLANNING

3. Select the required Super Group and the associated data in sub tabs are categorized
accordingly.

4. In the Security Access Definition section, you can view the following field details and edit
only the Description and Enabled status of selected Security Access Definition.

Table 3-23    Security Access Definition

Field Do this

Access Code The system displays the webservice access
code.

Description The system displays the description of the
associated webservice access code and can be
edited for required changes.

Type The system displays the type of security access
definition.
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Table 3-23    (Cont.) Security Access Definition

Field Do this

System Defined If selected as Yes, the security access definition
entry is system defined. If selected as No, the
security access definition entry is manually
defined.

Enabled Check this box to enable the selected
webservice access code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields are given below:

Table 3-24    Security User Access Details

Field Do this

Access Type Select Responsibility (default) as the access
type from the dropdown list. For this access type
to be available in the drop-down list, ensure that
the Lookup Type ACCESS_GRID_TYPE_CD is
maintained in the system.

Access Value This field is Read-only for System Defined
Security Access Definitions which are loaded as
part of seed data during installation.

For non-system defined Security Access
Definitions, select the access value which is the
user responsibility who needs to have access to
this webservice from the drop-down list.

For user responsibilities to be populated in the
drop-down list, ensure that the Lookup Type
RESPONSIBILITY_CD is maintained in the
system.

Allowed Select Yes to allow user access to this
webservice or No to deny access. By default, No
is selected.

System Defined Select Yes, if the webservice user access
definition entry is system defined.

Select No, if the webservice user access
definition entry is manually defined.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Security Access Definition Details

If you have selected the Security Super Group as SERVICING and COLLECTIONS, there is
an additional sub section Security Access Definition Details enabled. This sub tab facilitates
you to further restrict and control access to specific type of data within the accessible RESTful
web services. The restriction can be defined based on specific Account Condition or
Account Status.

For example, out of all the account types maintained in the system you can restrict data access
to only delinquent account(s) to a particular user responsibility by selecting Access Type as
Account Condition and Access Value as Delinquent.
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Controlling web service data access to permitted user(s)

For any user to access web service data, you need to define atleast one positive (allowed)
definition defined in Security Access Definition Details section. Else, webserivce data is not
displayed for that particular user even if that user responsibility has permissions to access web
service.

OFSLL supports multiple user conditions on an Account and system requires to have atleast
one account condition defined as Allowed in setup to display the data. In case, even if any one
of the account condition is defined as Not Allowed in setup, then system does not allow to
access the data.

During the following scenarios, data is either displayed/not displayed in Webservice screen:

Table 3-25    Data in Webservice screen

Scenario Data displayed

No condition is available on the account and also
no condition defined in setup

Data is displayed since there is no restriction.

Condition is available on the account but not
defined in setup

Data is not displayed since restriction is applied

Multiple conditions are available on the account
and one condition is defined in setup as Allowed

Data is displayed

Multiple conditions are available on the account
and one condition is defined in setup as Not
Allowed

Data is not displayed

Whenever user with specific responsibility tries to access the restricted data, following type of
error messages are displayed:

• For POST/PUT service, system displays error as Access denied with HTTP Error Code
401.

• For GET service with single account record, system displays error message as No data
found with http error code 400.

• For GET service with multiple account records, of which some have access restriction and
other don’t, then system displays only the unrestricted records and does not display the
restricted records. In such a case, error message is not displayed.

Note

When multiple user access definitions are defined in the system, while processing
the data access request to a web service OFSLL first validates for any access
restrictions on the user responsibility. If not, then validates the same against ALL
responsibility before displaying the data in Webservice screen.

For example, if data access restriction is defined for ALL and SUPERUSER responsibilities.
when logged in with SUPERUSER responsibility, the data restriction of SUPERUSER is
applied. In case, if the user logs in with any other responsibility other than SUPERUSER, then
restriction defined for ALL is applied.

To define Security Access Definition Details

1. Click Setup > Setup > Administration > User > Access > Webservice tab.

2. Select the module in Security Super section as SERVICING and COLLECTIONS.
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3. Select the user responsibility in Security User Access Definition Details section.

4. In the Security Access Definition Details section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields are given below:

Table 3-26    Security Access Definition Details

Field Do this

Access Type Select the access function type (as either
ACCOUNT CONDITION OR ACCOUNT
STATUS) that is being used to control the user
access from the drop-down list.

Access Value Select the access value from the drop-down list.
The list is sorted based on the Access Type
selected. Also, based on a lookup associated
with the Access Type multiple entries for each
access type can be created as long as each has
a different access value.

Allowed? Yes/No Select Yes if the access is allowed and No if the
access is not allowed. This indicates whether the
selected combination of Access Type and
Access Value is allowed to access the data.

System Defined Yes/ No Select Yes, if you wish to maintain access type
as system defined and No, if you do not want to
maintain it as system defined. However, system
defined entries cannot be modified.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

3.4 Users
The Users screen allows you to create and set up an user. In the User Definition section, you
can assign a user an identification name and password to log on to the system. You can also
assign the organization, division, and department where each user is located. Additional fields
allow you to record information for contacting the user. You can also define the time frame
within which a user has access to the system to ensure compliance to the company’s
schedule. This is a very useful feature to prevent logins during scheduled maintenance.

The Responsibility field records the job function of the user and defines the level of access that
user has within the system; in particular:

• What menu items does the user have access to?

• What transactions can the user perform on the Maintenance screen on the Customer
Service screen?

• What edits can the user perform on the Verification link during origination?

Note

The system’s SUPERUSER responsibility grants access to the entire system. Give
careful consideration to the number and type of users who receive this
responsibility.

To set up the Users screen
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1. Click Setup > Setup > Administration > User > Users. The system displays the Users
screen.

2. In the User Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-15    User Definition

A brief description of the fields is given below:

Table 3-27    User Definition

Field Do this

User Specify the user ID.

Note: This field is a unique indicator and cannot
be updated, edited, or deleted once saved.

Organization Select the organization to which the user
belongs, from the dropdown list.

Division Select the division to which the user belongs,
from the drop-down list.

Department Select the department to which the user belongs,
from the dropdown list.

Start Dt Specify the start date for the user. You can also
select from the adjoining calender icon.

End Dt Specify the end date for the user. You can also
select from the adjoining calender icon.

System Defined Select Yes, if the entry is system defined.
System defined entries cannot be modified.

Select No, if the entry is not system defined and
it can be modified.

Enabled Check this box to enable the user.

First Name Specify the first name of the user.
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Table 3-27    (Cont.) User Definition

Field Do this

MI Specify the middle initial of the user.

Last Name Specify the last name of the user.

Responsibility Select the responsibility for the user from the
drop-down list.

Note: The users mapped to the role
Responsibility can only view the screens.

Review Request Supervisor Select the supervisor responsibility who can also
review and respond to review requests from the
drop-down list.

The list displays the corresponding Review
Request Supervisors who are either one or more
levels higher from the above selected user
Responsibility as maintained in
RESPONSIBILITY_CD lookup code.

Phone 1 Specify the user’s primary phone number.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the user’s alternate phone number.

Extn 2 Specify the phone extension for the alternate
phone number.

Fax 1 Specify the user’s primary fax number.

Fax 2 Specify the user’s alternate fax number.

Replacement User Select the user ID of the replacement user from
the drop-down list.

Dt Specify the date from when the replacement is
effective. You can also select from the adjoining
calender icon.

Note: These two fields allow you to create a
replacement user for the current user. This is
particularly useful when a new employee
assumes the duties of a former. By completing
the Replacement User and Replacement Dt field,
the system recognizes the replacement user as
the current user on the effective date. For more
information, refer the section, Replacement
Users.

Type Select the user type from the drop-down list.

Reference # Specify the reference number for the user from
the drop-down list.

Email Specify user’s email address.

Default language Select the default language from the drop-down
list.

Time Zone Select the required Time Zone from the drop-
down list, The specified time zone would be
applicable at company level.

Time Zone Level Select the time zone level (Organization,
Company or User) that would apply by default,
when specific time zone is not specified at
Company and User level.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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This section consists of the following topics:

• Replacement users

• Application and Oracle Identity Manager Synchronization

3.4.1 Replacement users
By completing the Replacement User and Dt fields on the Users screen, you can replace an
existing user with a new user. The system assigns all responsibilities of the original user to the
new user as of the date of the replacement.

The Replacement User and Dt fields allow you to designate a replacement for the current
user in the User ID field. When you complete the Replacement User and Dt fields, save your
entry, and then enable the record, the system replaces the original user. The system changes
the End Dt field to the date when the original user was replaced (the same date in the Dt field).

The system assigns the queues of the original user to only those replacement users who have
the same user responsibilities (or Super User responsibility) as set in the system.

The system updates the following when replacing users:

1. Assigns all applications in the replaced user’s underwriting queue with the status NEW to
the replacement user’s queue.

2. Assigns all applications in the replaced user’s funding queue with a status other than
FUNDED to the replacement user’s queue. The system currently stores the collector name
in the back end tables, which are updated with the replacement users ID in the case of the
replacement of any user.

3. Also updates the Producer Management screen with the replacement user in the
Underwriter and Collector fields. The system assigns all applications routed to the
original user to the replacement user. This also includes any future applications for the
replaced user.

4. The system automatically updates the Collector ID field in all accounts to the replacement
user and routes all accounts assigned to the original user to the replacement user.

Note

The system will not update the replacement user ID for accounts that are closed.

5. On the queue setup of Customer Service screen’s Responsibilities sub screen, the record
for the original user will be disabled and a new record will be created for the replacement
user. If the replacement user already exists in the setup, The system will not create a new
record. It updates the user ID and routes all accounts that were assigned to the original
user, based on the account condition, to the replacement user.

3.4.2 Application and Oracle Identity Manager Synchronization
Oracle Identity Manager is for user administration. Oracle Financial Services Lending and
Leasing has been developed in such a way that it can be implemented with or without Oracle
Identity Manager. In case OID has been employed, the user definition is done in OID and then
synchronized to the Oracle Financial Services Lending and Leasing Users table using a utility
JAR called OID Synchronization JAR. In OID, users are defined across various groups
belonging to a realm which is nothing but the directory structure in OID. A user can be
configured to belong to multiple groups in a realm. Every time the user tries to login to Oracle
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Financial Services Lending and Leasing or OBIEE, the system validates the login ID and the
password with OID and provides access to those applications.

3.5 Credit Bureau
In the system, an important part of the origination process is pulling a credit report from a credit
bureau and scoring that information against a user-defined risk model. These credit reports
can be pulled both automatically and manually.

After you enter an application, the system compares its contents against pre-screen criteria. If
the application passes a pre-screen edits check, the system advances the status of the
application and automatically pulls a credit report.

You can manually request a credit report for an applicant or any other party included on the
application, such as co-signers and spouses by selecting the bureau from which you want to
pull the report. If more than one report type is defined for the selected bureau, then you can
indicate the type of report you want to pull.

The following are few additional Credit Bureau Setup details:

• The credit bureau from which the report is pulled is determined by the applicant’s zip code.
The credit bureau interface searches the information in the Credit Bureau Zip Matrix tab
and matches the applicant’s zip code to determine the bureau(s) from which to request a
report.

• The number of credit reports automatically pulled per applicant is controlled through the
credit request parameter CRB_MAX_BUREAU_PULL. If this parameter is set to 1, a credit
bureau request will be made for the Bureau1 credit bureau from the zip code matrix.
Likewise, if this parameter is set to 2, a credit bureau request will be made for the Bureau1
and the Bureau2 credit bureaus from the zip code matrix.

• The system automatically pulls credit reports for only the primary applicant and the primary
applicant's spouse (for joint applications) unless the CRB_ALL_APL_BUREAU_PULL
credit request parameter is set to Y. However, if the parameter is set to Y, the system pulls
credit reports for all of the applicants on the LoanLine of creditLease, regardless of their
relationship to the primary borrower.

• Passwords, default report formats, and other required information from the credit bureaus
are set up in the Report Formats screen.

• For identity scan data to flow into Equifax ACRO/ACRO Plus credit reports, the add-on has
to be enabled at contract level. Please speak to your representative for enabling the add-
on.

Member codes and passwords when switching credit bureau access methods (moving from
dial-up to Net Connect). The member codes and passwords are not dependent on the
connection method used to access the bureau.

Frame relay access is from the database server to the Experian host though a TCP/IP socket
connection. The connection is outbound only and it is to a specific port (699 or 700) on the
Experian host.

The credit bureau service will be accessing Experian Net Connect service through HTTP to the
ECALS URL supplied by Experian as well as by the HTTPS to the URL returned as a response
to the ECALS URL inquiry (the credit request URL). This access is from the database server
access.

This section consists of the following topics:

• Credit Bureau
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• Special Metro II Code reporting

• Oracle Wallet Manager setup

• Oracle JVM Security setup

• Importing a trusted certificate into an Oracle Wallet

• Importing the Certificates into an Oracle Wallet

• De-duping Credit Bureau data

3.5.1 Credit Bureau
Navigating to Credit Bureau

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Credit Bureau.

The setup for Credit Bureau spans across the following links:

• Report Formats

• Connections

• Zip Matrix

• Parameters

• Score Reasons

• Reporting

3.5.1.1 Report Formats
The Reports Formats screen captures and tracks the attributes related to the multiple types of
reports offered by the credit bureau agencies. When a company enlists the service of a credit
bureau, the credit bureau provides a membership code and password. This information needs
to be entered on the Reports Formats screen before you can request a credit report. You must
define at least one report for each credit bureau from which you want to pull reports.

The information on the Report Formats screen is location-specific. If the business requires
different membership codes for each location, be it a company or branch, then individual
records must be set up.

The Score Type, Additional Product, and Inquiry Limit fields on the Credit Report Setup section
are optional. They may not apply to all credit bureau types and even if they do apply, you may
want to leave them blank and rely on a default value set up at the credit bureau.

Note

For more information, refer to the application Installation Guides.

To setup Report Formats

1. Click Setup > Setup > Administration > User > Credit Bureau > Report Formats.

2. In the Credit Bureau section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-16    Credit Bureau Report Formats

A brief description of the fields is given below:

Table 3-28    Credit Bureau Report Formats

Field Do this

Bureau Name Specify the name of the credit bureau company.

Short Name Specify the abbreviated or short name for the
bureau.

Source Select the credit bureau source from the drop-
down list.

Country Select the country of the credit bureau address
from the drop-down list.

City Specify the city for the credit bureau address.

State Select the state of the credit bureau address
from the drop-down list.

Address Line 1 Specify the address line 1 for the credit bureau.

Address Line 2 Specify the address line 2 for the credit bureau.

Zip Select the zip code for the credit bureau address
from the dropdown list.

Extn Specify the extension of the zip code for the
credit bureau address.

Phone 1 Specify the primary phone number for the credit
bureau.

Extn 1 Specify the extension for the primary phone
number.

Phone 2 Specify the secondary phone number for the
credit bureau.

Extn 2 Specify the extension for the secondary phone
number.

Fax 1 Specify the primary fax number for the credit
bureau.
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Table 3-28    (Cont.) Credit Bureau Report Formats

Field Do this

Fax 2 Specify the alternative fax number for the credit
bureau.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Credit Bureau Report Formats section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-29    Credit Bureau Report Formats

Field Do this

Company Select the portfolio company that will be using
the above credit bureau from the drop-down list.

Branch Select the portfolio branch from the company
that will be using the above credit bureau from
the drop-down list.

Description Specify the credit report format description.

Member Code Specify the credit bureau member code
(assigned by bureau).

Password Specify the credit bureau password.

Customer Code Specify the customer code.

Auth Password Change Dt Display the last authorization password change
date. The Experian Net Connect product requires
that the Auth Password (or SSP Password in
Experian jargon) be changed every 90 days (or
sooner). Equifax may have similar requirements,
but they were not known at the time of this
writing. Use the date displayed in this field to
identify when the password needs to be
changed.

Note: The password needs to be changed both
in the system and at the credit bureau. Changing
the password does not initiate or perform a
change at the bureau. Changing the password at
the bureau must be done outside the system.
Contact the credit bureau for the procedure for
changing the password (display only).

Auth User ID Displays the authorization user ID (display only).

Auth Password Displays the authorization password (display
only).

Note: This field is not displayed to the user and
is also encrypted before being stored in the
database (display only).

Change Authorization User Id/Password section

New Auth User Id Specify the authorization user ID.

New Auth User Password Specify the authorization user password.

TransUnion Details section
(Note: This is only applicable for TransUnion.)

Market Specify the TransUnion market id.

Sub Market Specify the TransUnion Sub Market id.
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Table 3-29    (Cont.) Credit Bureau Report Formats

Field Do this

Industry Specify the TransUnion Industry code.

Experian Details section
(Note: This is only applicable for Experian.)

Preamble Specify the Experian preamble code.

Host Code Specify the Experian host ID.

UIC Specify the Experian UIC.

Equifax Details section
(Note: This is only applicable for Equifax.)

Service Name Specify the equifax service name. The service
name will be provided to you by Equifax when
your company's Internet System to System
account is created. Possible values for pulling
credit reports are acrotest (for access to the test
system) and acro (for access to the production
system).

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Report Format Details section, you can choose the various parameters of report
format and also indicate if the report is to be processed internally or externally.
To support geography specific Credit Bureau integration, external interface is also
supported in OFSLL. In such case, a webhook request for Credit Bureau Onboarding
report is initiated from OFSLL. The same is processed in external bureau service
depending on the endpoint configuration (type of bureau to be used as defined in Setup >
Administration > System > Webhook screen).

Based on the response received the Credit Bureau Put web service is triggered to update
the details. Also on processing CREDIT_REQUEST_DETAILS the Status of the request
received in CRL_CRB_REP_STATUS_CD is updated in Bureau tab of Origination and
Servicing screens in the following combination:

Table 3-30    Report Format Details

CRL_CRB_REP_STATUS_CD Bureau Details > Status

Primary Secondary

Completed Completed Completed

Completed Failed Failed

Failed Completed Failed

Failed Failed Failed

Submitted Completed Submitted

Completed Submitted Submitted

7. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 3-31    Report Formats

Field Do this

Report Specify the report name to be accessed from the
credit bureau.

Report Type Select the report type of the credit bureau report
from the drop-down list.

Report Class Select the report class as either Consumer or
Business from the dropdown list.

Multi Request Allowed Check this box to allow report request from
multiple bureaus.

Score Type Select the credit score type from the drop-down
list.

Addl Product Select the product code from the drop-down list.

Inquiry Limit Select the inquiry limit for the credit report from
the drop-down list.

Default Check this box set this as default report format.

External Report Check this box if the Credit Bureau Onboarding
report request format is to be processed from
external system. If selected, the encoding and
decoding of request details and pooling of data
into report is handled externally.

By default, this check box is not selected and
Credit Bureau Onboarding report request is
processed within the system.

8. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-32    Report Output

Field Do this:

Report Specify the report name to be accessed from the
credit bureau.

Report Type Select the report type of the credit bureau report
from the drop-down list.

Score Type Select the credit score type from the drop-down
list.

Addl Product Select the product code from the drop-down list.

Inquiry Limit Select the inquiry limit for the credit report from
the drop-down list.

Enabled Check this box to enable the report as default.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.2 Connections
The Connections screen records and supports various connections to the credit bureau to
receive reports from the agencies. The system supports connections to the bureaus through
one or more modems attached to the database server, network accessed modem server, or
direct network connection (usually frame relay).
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For modem-based connections, multiple credit bureaus can be accessed over the same
modem. If there are multiple requests in the queue, the order in which the bureaus are listed
determines the order in which the requests are processed.

For example,

If the credit bureau service checks the submitted credit requests and finds three Experian, one
Equifax, and two TransUnion credit requests and the connections setup is Bureau1=TUC,
Bureau2=EFX, and Bureau3=EXP, the two TransUnion requests will be processed first, the
Equifax request next, and then the three Experian requests.

Note

For this above example, adding two more modems and assigning a specific bureau to
each one would help to avoid the delay caused by queuing all requests through a
single modem.

IMPORTANT: Direct network connections must be set up for only one bureau.

Like the Credit Bureau section on the Report Formats screen, the data fields used on the
Connections screen are generic and not all fields are used for all access methods. The
following table summarizes the data needed for each access method:

Figure 3-17    Credit Bureau_Methods Table

For frame relay access, specify the IP address provided by the bureau followed by a space
and then the port number (for example, 192.168.36.2.700).

Experian Net Connect
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At the time of this writing, the Experian product ECALS URL is:

http://www.experian.com/lookupServlet1?lookupService
Name=AccessPoint&lookupServiceVersion=1.0&serviceName=Net
Connect&serviceVersion=2.0&responseType=text/plain

Note

The URL given above is one continuous string. This can be verified by entering the
URL with a browser. The displayed value will be an HTTPS URL.

Enter the entire ECALS URL provided by Experian into the Device field. Notice that this URL
does not start with https. The ECALS URL is a URL used by the credit bureau service to
request the HTTPS URL. The HTTPS URL is not displayed on any setup screen and is only
known to the credit bureau interface at runtime.

Equifax Internet System to System

At the time of this writing, the Equifax Internet System to System URL is:

https://transport5.ec.equifax.com/servlet/stspost

CSC Tri-Merge

At the time of this writing, the CSC URL is:

https://www.emortgage.Equifax.com/cgi-bin/emspop.exe

To setup the Connections

1. Click Setup > Setup > Administration > User > Credit Bureau > Connections.

2. In the Credit Bureau Connections section, perform any of the Basic Operations
mentioned in Navigation chapter.
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Figure 3-18    Credit Bureau Connections

A brief description of the fields is given below:

Table 3-33    Credit Bureau Connections

Field Do this

Name Specify connection name.

Bureau 1 Select first credit bureau from the drop-down list.

Bureau 2 Select 2nd credit bureau from the drop-down list.

Bureau 3 Select 3rd credit bureau from the drop-down list.

Note: The Bureau1, Bureau2, and Bureau3 fields
in the Credit Bureau Connections section specify
which bureau types can be accessed over the
connection.

Device Specify the connection device name. The Device
field lists the physical device name for a modem,
or the IP address for a network accessed
connection.

Device Speed Select the connection device speed. The Device
Speed field is only applicable to server-attached
modems. It is used to specify the
communications speed between the server and
the modem.

Enabled Check this box to enable the connection.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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3.5.1.3 Zip Matrix
The system uses the zip code of the applicant’s current home address to determine which
credit bureau to use when automatically pulling a report. The Zip Matrix screen allows you to
record the credit bureau from which a report is pulled based on a range of zip codes, as well as
the company, branch and country of the account.

When searching for a zip code match, the system:

1. Reads the first credit bureau defined in the matrix

2. Reads the credit report format to get the appropriate membership code and password for
the user’s location

3. Requests a credit report.

If the system cannot pull a report from the first bureau, it pulls one from the second. If the zip
code you entered does not fall in the matrix setup, then the system uses a default zip matrix
(0000000000 to 0000000000) to select the required bureau.

To set up the Zip Matrix

1. Click Setup > Setup > Administration > User > Credit Bureau > Zip Matrix

2. In the Credit Bureau Zip Code Matrix section, perform any of the Basic Operations
mentioned in Navigation chapter.

Figure 3-19    Credit Bureau Zip Code Matrix

A brief description of the fields is given below:
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Table 3-34    Credit Bureau Zip Code Matrix

Field Do this

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down
list. The branch will be displayed based on the
company selected.

Country Select the country from the drop-down list.

From Zip Specify the starting zip code (From).

To Zip Specify the ending zip code (To).

Bureau 1 Select the preferred bureau #1 (first bureau
pulled), from the drop-down list. You must enter
at least one credit bureau in the Bureau 1 field
for each zip code range. The bureau entered in
the Bureau 1 field for each range is the primary
bureau. For any given range, do not list the same
credit bureau in more than one field.

Bureau 2 Select the preferred bureau #2 (second bureau
pulled) from the dropdown list.

Bureau 3 Select the preferred bureau 3 (third bureau
pulled) from the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.4 Parameters
The Parameters screen records parameters specifically dealing with credit bureau information.
These parameters are divided into three groups:

• Parsing parameters

• Request parameters

• Configuration parameters

Parameters can be defined at the company or branch level. The following credit bureau
parameters are configured during the installation:

PARSING PARAMETERS FOR CREDIT BUREAU SERVICE

CONFIGURATION PARAMETERS FOR CREDIT BUREAU SERVICE

The following credit bureau parameters are configured during implementation:

REQUEST PARAMETERS FOR CREDIT BUREAU SERVICE

To setup the Parameters

1. Click Setup > Setup > Administration > User > Credit Bureau > Parameters.

2. In the Credit Bureau Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.
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Figure 3-20    Credit Bureau Parameters

A brief description of the fields is given below:

Table 3-35    Credit Bureau Parameters

Field Do this

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down
list. The branch will be displayed based on the
company selected.

Parameter Group Select the credit bureau parameter group from
the drop-down list.

Parameter Select the credit bureau parameter from the
drop-down list

Parameter Value Specify the credit bureau parameter value.

Enabled Check this box to enable the credit bureau
parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.5 Score Reasons
The Score Reasons screen allows you to define or modify the scoring reason codes and
descriptions for the predefined scoring models used by the credit bureau agencies.
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Note

This information is not associated with the user-defined scores determined by the
internal Oracle Financial Services Lending and Leasing model during product setup.

To setup the Score Reasons

1. Click Setup > Setup > Administration > User > Credit Bureau > Score Reasons.

2. In the Score Models section, you can view the following information.

Figure 3-21    Score Models

A brief description of the fields is given below:

Table 3-36    Score Models

Field Do this

Score Model Displays the credit bureau score model (display
only).

Enabled Displays if the credit bureau score model is
enabled or not.

3. On the Score Reasons sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 3-37    Score Reasons

Field Do this

Reason Code Specify the reason code.

Description Specify the description.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.6 Reporting
The system reports to the credit bureau agencies in the Metro 2 format with the payment and
account status information of each account holder. The Credit Bureau Reporting screen
contains the program identifier to be reported to the bureaus.

To setup the Reporting

1. Click Setup > Setup > Administration > User > Credit Bureau > Reporting.

2. In the Credit Bureau Reporting section, perform any of the Basic Operations mentioned
in Navigation chapter.

Figure 3-22    Credit Bureau Reporting

A brief description of the fields is given below:
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Table 3-38    Credit Bureau Reporting

Field Do this

Company Select the portfolio company from the drop-down
list.

Bureau Select the bureau from the drop-down list.

Program Identifier Specify the program identifier. The customer
receives this from the bureau and uses it to
identify itself to that bureau. You will need to
update this information.

Enabled Check this box to enable the program.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.2 Special Metro II Code reporting
The system allows you to report the following special Metro II segments to the credit bureau
output file:

• Consumer Information Indicator Code (CIIC)

• Compliance Condition Code (CCCD)

• Special Comment Code (SPCC).

The system users will need to use call Action/Results and Reason fields on the Call Activities
sub screen of the Customer Service form (Lending > Customer Service > Customer Service (2)
master tab > Account Details tab > Call Activities sub tab) to place specific account conditions
where these Metro II segments are to be reported. The specific segment reported for a given
condition will be based on the account condition and call activity reason codes.

Note

It is the responsibility of the Administrator or individual user to setup Special Metro II
Code reporting functionality.

When users open one of the following conditions:

Table 3-39    Special Metro II Code reporting

Code Description

CIIC CONSUMER INFORMATION INDICATOR CODE
(METRO2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METRO2)

SPCC SPECIAL COMMENT CODE (METRO2)

The system recognizes the condition, processes the selected Metro II reporting call activity
reason code, and generates the Metro II reporting segment in the Metro II reporting output file.
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Note

• You are responsible for selecting the correct Metro II reporting segment reason
code to be reported. If you do not select a Metro II reporting segment reason code,
the system will not generate information to Metro II output file. If you select an
incorrect Metro II reporting segment reason code, the system will report the
selected Metro II reporting segment. the system does not validate the contents of
the Reason field with the contents of the Condition field.

• To end the reported Special Metro II Special Code, close the open Special Metro II
Condition (no reason code needed). The system recognizes the closing of the
open Special Metro II Condition and will not create a Metro II reporting segment in
the output file.

• The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system
parameter determines if output file is generated and created daily or output file is
written with daily data and output monthly.

To setup Metro II Code reporting

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Queues > Call Action Results to open and close the
following system defined condition codes:

Table 3-40    Metro II Code reporting

Action Code Description

CIIC CONSUMER INFORMATION INDICATOR CODE
(METRO2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METRO2)

SPCC SPECIAL COMMENT CODE (METRO2)

When setup is completed, you can open and close Special Metro II code conditions.

Note

Opening and closing Special Metro II Code reporting is a manual process.

The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system
parameter determines, if output file is generated and created daily or output file is written
with daily data and output monthly.

3.5.3 Oracle Wallet Manager setup
The Experian Net Connect, Equifax Internet System to System, and CSC interfaces within the
system credit bureau service use functionality provided by the Oracle Wallet feature. Use the
Oracle Wallet Manager on the database server to create and export a wallet for use by the
credit bureau service.
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Note

All of the above mentioned interfaces use the same Oracle wallet. If a wallet already
exists and is in use by one of the credit bureau interfaces, there is no need to create
another wallet. Due to differing certificate requirements, there may be a need to import
additional trusted certificates into the wallet, but there will not be a need to create a
new one. The credit bureau parameter ORA_WALLET_PATH contains the location of
the Oracle Wallet used by the credit bureau service.

To create and export a wallet suitable for use by the credit bureau

Refer to the Oracle documentation for more detailed instructions on how to use the Oracle
Wallet Manager to create and manage a wallet:

1. If a wallet does not already exist, create one somewhere on the database server. The
location must be readable and writable by the Oracle user. Make a note of the full path
where the wallet is stored (for example, /etc/ORACLE/WALLETS/oracle or
C:\oracle\WALLETS).
For Transunion credit bureau, a separate wallet file is needed under transunion folder
inside the main wallet path (for example: /etc/ORACLE/WALLETS/oracle/
transunion or C:\oracle\WALLETS\transunion).

2. The wallet needs to contain the public key for the certificate authority that issued the server
certificate for each HTTPS web site that will be connected to by the credit bureau interface.
At the time of this document, those sites are:

Table 3-41    Credit Bureau Location

Location Credit Bureau

Experian Credit Bureau (https://
dm1.experian.com/netconnect2_0Demo/servlets/
NetConnectServlet)

Experian

Equifax Credit Bureau (https://
api.uat.equifax.com/business/sts-reports/v1/
report)

Equifax

CSC Credit Bureau (https://emsws.equifax.com/
emsws/services/post/MergeCreditWWW)

CSC

Transunion Credit Bureau (https://netaccess-
test.transunion.com)

TUC

This list may change. Use the URL provided to you by the credit bureau when they set up your
service. To get the proper Experian HTTPS URL, enter the ECALS URL that was provided by
Experian into a web browser. The response returned to the browser is the HTTPS URL that will
be used to communicate with Experian.

1. Import the necessary certificate authority’s certificate files into the Oracle wallet that was
created in Step 1. See the appendix of this chapter for detailed instructions of how to
download and install a trusted certificate.

2. Test the wallet by connecting to each web site with a simple command issued from
SQLPlus.

SQL> select utl_http.request('https://ss1.experian.com', NULL,
'file:/etc/ORACLE/WALLETS/oracle', 'password') from dual;
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Replace the URL in the above command with each HTTPS URL given to you for use by
the credit bureaus. Also replace the wallet path with the path to your wallet and your wallet
password. The output from the command is not important, what is important is that it runs
without displaying an Oracle error. If there is an Oracle error, then something is wrong with
the contents of the wallet, the path to the wallet, and/or the wallet password.

3. When the wallet contains all of the required trusted certificates, export the wallet to a text
file. On the Operations menu of the Oracle Wallet Manager, choose Export All Trusted
Certificates. The text file MUST be located in the same directory as the wallet and the
filename MUST be default.txt. Anytime a change is made to the trusted certificates in
the wallet, the wallet must be re-exported to the same text file.

4. In the Setup > Setup > Credit Bureau > Parameters set the ORA_WALLET_PATH and
ORA_WALLET_PASSWORD parameters.

3.5.4 Oracle JVM Security setup
The Experian Net Connect interface within the credit bureau service requires the use of the
Oracle Java Virtual Machine (JVM) that is resident in the Oracle database. Furthermore,
specific permissions must be granted to the Java classes used by the credit bureau service.
These permissions have been added to the set_java_perms.sql script that is part of the
distribution. This script (as well as many other useful SQL scripts) is available from the Oracle
Financial Services Software technical support Oracle Financial Services Lending and Leasing
patches web site.

The set_java_perms.sql script needs to run as the SYS user (or a user with SYS privileges).
The script will prompt for SYS user id and password. Be prepared to provide it when prompted.
Also, the script will select the value of the ORA_WALLET_PATH parameter from the credit
bureau parameters table. Make sure that it has been updated with the proper wallet path
before running the set_java_perms.sql script (although the script can be safely run again if
necessary).

Credit Bureau Service operation

The basic operation of the credit bureau service has not changed. Once setup, there is no
operational difference between accessing the credit bureaus via dial-up, frame relay, or the
Internet.

3.5.5 Importing a trusted certificate into an Oracle Wallet
The HTTPS servers used by Experian, Equifax, and CSC for their Internet based credit report
services (as well as all HTTPS servers) contain a site certificate signed by a trusted Certificate
Authority (CA). The CA is an entity that guarantees the identity of the HTTPS server. If the
client trusts the CA, and the CA says that the HTTPS server is who they say they are, then the
client inherently trusts the HTTPS server. Normally, a client tool such as Microsoft Internet
Explorer has a large store of trusted CA certificates which makes secure communication
between a client and a trusted HTTPS server relatively seamless and uneventful.
Unfortunately, the store of CA certificates in the default Oracle wallet is rather small and it is
likely that it will not contain the certificate of the CA that is certifying one or more of the credit
bureau web sites. This means that the CA certificate must be imported into the wallet. To do
this, the certificates must first be exported from a browser and then imported into the Oracle
wallet using the Oracle Wallet Manager.

Using Microsoft Internet Explorer to Export a Certificate

1. Use Microsoft Internet Explorer and connect to one of the HTTPS URLs referenced in the
Oracle Wallet Manager Setup section of this document.
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If the web site asks for a user id and password, cancel the dialog box and remain on the
top-level HTTPS screen.

2. Once connected, from the browser’s File menu, choose Properties.

3. Click the Certificates button.

4. Click the Certification Path tab. The bottom-most certificate is the one generated by the
host itself. The one or more certificates above the bottom-most one are of greater
importance to this task. The screen shot below displays a web site with two CAs (an
intermediate, and a primary). Whether it is an intermediate CA or a primary one, the steps
are the same for saving the certificate as a text file.

Figure 3-23    CreditBureau_Certificate

5. Click the first certificate above the bottom-most certificate (it may be the only certificate
above the bottom-most certificate).

6. Click the View Certificate button.

7. Click the Details tab.

8. Click the Copy to File button.

9. Click the Next button.

10. Choose the Base 64 encoded format.
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11. Click the Next button.

12. Enter a filename and location for the file.

13. Click the Next button.

14. Click the Finish button.

15. Repeat steps 5 through 14 for the next certificate in the certification path, if any.

3.5.6 Importing the Certificates into an Oracle Wallet
1. Copy the certificates exported and saved during the process described above onto the

database server (not the iAS server).

2. As the Oracle user (or Administrator on Windows), start the Oracle Wallet Manager.

3. Open the wallet that will be used by the credit bureau service. Create a new wallet if one
does not already exist.

4. View the list of Trusted Certificates in the wallet.

5. Check the list of certificates against the list of certificates that are in use on the HTTPS
servers used by the credit bureaus (and that were exported and saved during the export
process described above).

6. Click the Trusted Certificates heading in the left list box of the Oracle Wallet Manager.
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Figure 3-24    Oracle Wallet Manager

7. Use Microsoft Internet Explorer to view the certificate details for the HTTPS web sites (File
> Properties > Certificates > Certification Path > View Certificate > General) that will
be contacted by the credit bureau service. Look through the list of certificates shown in the
right panel of the Oracle Wallet Manager and look for a match between the Issued To and
Valid To dates shown in the Internet Explorer View Certificate screen.
The screen shot below shows a certificate that is already in the wallet’s list of trusted
certificates (see the last entry for the www.verisign.com/CPS certificate).
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Figure 3-25    Certificate

8. On the Operations menu, choose Import Trusted Certificate and follow the prompts for
locating and loading the files that were copied onto the database server in step 1 for any
certificate not already stored in the wallet.

9. On the Wallet menu, choose Save when finished loading certificates.

3.5.7 De-duping Credit Bureau data
Oracle Financial Services Lending and Leasing allows you to remove duplicate (de-dupe)
liabilities data from the credit bureau information.

De-duping logic

The de-duping logic is based on a number of parameters that the system compares among
tradelines (only) to determine if they are duplicates. The following fields are used to determine
if two tradelines are duplicates:

Table 3-42    De-duping logic

Field Description

Account # The account number of the consumer with the
lender for the particular account.
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Table 3-42    (Cont.) De-duping logic

Field Description

Open Date The date the account was opened.

Member Code The subscriber code of the lender with the
respective credit bureau.

Note: Since member codes for the same lender
differ across bureaus, this field is used only for
tradelines reported by the same bureau. Since
reports obtained from CSC can have tradelines
from different bureaus, this field is only for reports
pulled from the credit bureaus.

All available bureau reports pulled later than DEDUP_CRB_EXPIRATION_DAYS days old will
be used.

The following system parameters will be set up to provide switches to allow the functionality to
be turned on and off:

Figure 3-26    System Parameters

Whenever two (or more) items are identified as duplicates, Oracle Financial Services Lending
and Leasing uses the following hierarchy to pick one of the items as the correct one:

1. Last Reported Date: The row that has been reported most recently is used.

2. Owner: In case of a tie on the last reported date, one of the tradelines is picked in the
descending order of priority depending on who the tradeline belongs to: Primary, Spouse,
then Secondary.

Debt Ratio combination

Oracle Financial Services Lending and Leasing uses the system parameter
DBR_JOINT_INC_DEBT_WITH_SPOUSE to decide whether to combine debt ratios of the
spouse with the primary applicant. The DBR_JOINT_INC_DEBT_WITH_COAPP parameter
decides whether to do the same on a non-spousal joint application.

When this indicator is checked, all liabilities in the Liability section on the Summary sub screen
of the Applicant (2) master tab with the Include box selected will be used in the debt ratio
calculation.

The following system parameter will be set up to provide switches to allow the functionality to
be turned on and off:

De-duping process

The de-duping logic will be integrated into the system decision-making process in the following
manner:
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Initial credit pulls on new applications

• If the JOINT_DEDUP_SPOUSE_LIABILITIES/ JOINT_DEDUP_ALLAPL_LIABILITIES
system parameters are set to Y, uses the de-duping logic described above to uncheck the
duplicate liabilities in the spouse's/co-applicant’s liabilities.

• If the DBR_JOINT_INC_DEBT_WITH_SPOUSE/
DBR_JOINT_INC_DEBT_WITH_ALLAPL parameters are set to Y, the system includes the
liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary
applicant.

• The system will use all available credit reports at the time.

Subsequent credit pulls (manual)

• To remove duplicate liabilities from the calculation, choose the Dedup Liabilities button on
the Underwriting form (Applicants master tab > Summary sub screen > Liability
section). (Potential record locking situations force the action to remain manual versus the
system automatically doing it).

• If the Populate Debt and Include Debt boxes are selected in the Applicant/Customer
Detail section on the Bureau master tab on the Underwriting form for the credit request
and the JOINT_DEDUP_SPOUSE_LIABILITIES/ JOINT_DEDUP_ALLAPL_LIABILITIES
system parameters are set to Y, the system will use the de-duping logic described above
to uncheck the duplicate liabilities in the spouse's/co-applicant's liabilities.

• If the DBR_JOINT_INC_DEBT_WITH_SPOUSE/ DBR_JOINT_INC_DEBT_WITH_COAPL
parameters are set to Y, the system will include the liabilities of the spouse/ co-applicant
while calculating the debt ratio of the primary applicant.

• The system will use all available credit reports at the time of the request that have been
requested within the number of days specified in the DEDUP_CRB_EXPIRATION_DAYS
parameter.

Restrictions

The de-duping logic will be limited based upon the discussion above. If the system cannot
identify two tradelines as duplicates based upon the logic mentioned above, the individual
tradelines will be retained. In such circumstances, both tradelines will be used in the debt ratio
calculation and it will be the user’s responsibility to disregard one of them by clearing the
Include check box.

3.6 Correspondence
The Correspondence screen enables you to setup the system’s correspondence.

The system provides two types of correspondence: predefined and ad hoc. The following chart
provides a quick summary of both:

Figure 3-27    Correspondence Types
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This chapter explains how to setup ad hoc correspondence with the Correspondence form.

The Correspondence screens provide a cost-effective and easy to use method to build custom
documents that draw information from the system’s database without additional programming.
You can choose what to include in a letter, create a template, and then use this template to
produce a letter.

The core of the Correspondence module is the document element -- the information stored in
the database merged into the correspondence. The system has document elements defined
for commonly used data elements in correspondence, such as account numbers, account
balances, customer addresses, telephone numbers, and due dates.

Correspondence consists of a document file with text of your choice and the document
elements from the system’s database.

You can create a correspondence set that consists of one or more documents. If a
correspondence set consists of more than one document, such as the account details letter
and a payment overdue letter, it prints both documents every time the system generates
correspondence for a customer.

The Correspondence module creates the following standard ad hoc correspondence:

• Microsoft Word (RTF)

• Adobe Acrobat (PDF/XFDF)

Note

In this document and in the system, the term BANKERS SYSTEM is synonymous with
Adobe Acrobat.

This section consists of the following topics:

• Correspondence

• Creating Correspondence

• Generating Correspondence

3.6.1 Correspondence
Navigating to Correspondence

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Correspondence.

The Correspondence screen contains the following sub screens:

• System Functions

• Elements

• E-Form Elements

• Documents

• Correspondence
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3.6.1.1 System Functions
The System Functions screen enables you to view the predefined functions for the appropriate
LoanLine of creditLease product in the system. These are attributes from the database.

Functions define how the system retrieves data to include in correspondence. The data is
retrieved as elements which are either specific database columns or calculated values.
Elements are recorded on the Elements screen.

To view the predefined system functions

1. Click Setup > Setup > Correspondence > LoanLine of creditLease > System
Functions.

2. In the Function Definition section, you can view the following information.

Figure 3-28    Correspondence - System Functions
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Figure 3-29    Correspondence - System Functions

Figure 3-30    Correspondence - System Functions

A brief description of the fields is given below:
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Table 3-43    Function Definition

Field View this

Function Name Displays the function name.

Description Displays the function description.

Function Type Displays the function type.

Source Program Displays the source program.

3. In the Functions Parameters section, you can view the following information.
A brief description of the fields is given below:

Table 3-44    Functions Parameters

Field View this

Position Displays the parameter position.

Parameter Displays the function parameter.

Description Displays the function parameter description.

3.6.1.2 Elements
The Elements screen displays the predefined document elements retrieved from the database
when the correspondence is generated.

In the Element Definitions section, you can update or edit only the Description field.

To view the Elements

1. Click Setup > Setup > Administration > User > Correspondence > LoanLine of
creditLease > Elements

2. On the Element Definitions screen, perform any of the Basic Operations mentioned in
Navigation chapter. You cannot add a new record.
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Figure 3-31    Correspondence_Loan_Elements

Figure 3-32    Correspondence_Line_Elements
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Figure 3-33    Correspondence_Lease_Elements

A brief description of the fields is given below:

Table 3-45    Element Definitions

Field Do this

Level0 Type Displays the element Level0 type.

Element Name Displays the element name.

Element Type Displays the element type.

Description Specify the element description.

Data Type Displays the element data type.

Source Function Displays the element function.

Enabled Displays if the element is enabled or not.

Default Value Displays the default value.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.1.3 E-Form Elements
The E-forms Elements screen defines elements included when the system generates online
correspondence with a browser. The E-forms screen is set up only for PDF elements using the
XFDF format. These definitions translate the external element required by the vendor to a
systems correspondence element.

For example,
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Table 3-46    E-Form Elements

Type Details

Vendor Element AllBorrowers.FullNameStreetCityStateZip

(Contains names of all borrowers with address of
primary customer)

The system’s Elements PRIM_APL_NAME

SPOUSE_APL_NAME

PRIM_APA_ADDRESS1

PRIM_APA_ADDRESS2

PRIM_APA_ADDRESS3

Translation PRIM_APL_NAME || ', ' || SPOUSE_APL_NAME ||
', ' || PRIM_APA_ADDRESS1 || '; ' ||
PRIM_APA_ADDRESS2 || '; ' ||
PRIM_APA_ADDRESS3

To setup the E-forms Elements

1. Click Setup > Setup > Administration > User > Correspondence > LoanLine of
creditLease > E-Form Elements.

2. In the E-form Elements Definitions section, perform any of the Basic Operations
mentioned in Navigation chapter.

Figure 3-34    Correspondence - E-Form Elements
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Figure 3-35    Correspondence - E-Form Elements

Figure 3-36    Correspondence - E-Form Elements

A brief description of the fields is given below:
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Table 3-47    E-form Elements Definitions

Field Do this

Level0 Type Select the element Level0 type from the drop-
down list.

Source Code Select the element e-form source code from the
drop-down list.

Element Name Specify the element name (the name used in the
external form).

Description Specify the element description.

Data Type Code Select the element data type code from the drop-
down list.

Translation Select the translation for the e-form element
(SQL statement fragment defining the element
data), from the drop-down list.

Enabled Check this box to enable the e-form element.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.1.4 Documents
The Documents screen enables you to set up the various documents and the data fields that
the system compiles together when creating a correspondence. The system provides two
different document formats: Word or XFDF: XML-based form.

Note

Oracle Financial Services Software assumes that the user is familiar with Word and
the Merge Document command. If the user is creating e-form documents with XFDF,
then Oracle Financial Services Software assumes that person is familiar with Adobe
forms.

To setup documents to be compiled in correspondence

1. Click Setup > Setup > Administration > User > Correspondence > LoanLine of
creditLease > Documents.

2. In the Document Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-37    Correspondence - Documents

Figure 3-38    Correspondence - Documents
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Figure 3-39    Correspondence - Documents

A brief description of the fields is given below:

Table 3-48    Document Definition

Field Do this

Code Specify the document code to define the name
for the new document.

Description Specify the document description for the new
document. This entry appears in the
Correspondence section on the Request
screen, when you generate an ad hoc
correspondence.

File Name Specify the document file name for the resulting
file (Word or XFDF document).

Ensure that the name specified here is same as
the BIP Template name since system refers to
this file name for generating the correspondence.

Level0 Type Select the level0 type from the drop-down list.

E-form Source Select the element e-form source from the drop-
down list.

Product Select the document product from the drop-down
list.

Source Select the document source type from the drop-
down list.

Enabled Check this box to enable the document definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4. In the Document Elements section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-49    Document Elements

Field Do this

Seq Specify the sequence number to order the
document elements.

Type Select element type from the following from the
drop-down list. This list provides the following
options:

System-defined – If you select, the value is
supplied by the system and cannot be changed
in the Correspondence Request screen.

Constant.
User Defined Element – If you select, you can
choose the value and change it in the
Correspondence Request screen.

User Defined Constant – If you choose, you
can choose the value, but you cannot change it
in the Correspondence Request screen.

Translated Element – If a document contains an
e-form element and you do not select this option,
then the value will not be translated.

Element Name Select the element name from the drop-down list.

Description Specify element description.

Notes:
1. Check that the element name does not have
blank spaces or special characters, such as the
forward slash “/” or backward slash “\”.

2. If the element is system-defined, then the
system will automatically complete this field.

Data Type Select the element data type from the drop-down
list.

Format Mask Select the element format mask from the drop-
down list.

Default Value Specify the element default value.

Enabled Check this box to include the element in the
document.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Document Template section, you can set the information about the template which
is attached to the correspondence documents. The template thus saved is similar to the
template functionality available in MS word. Perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-50    Document Template

Field Do this

File Name Specify the file name to define the name for the
new template.
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Table 3-50    (Cont.) Document Template

Field Do this

Product Select the product for which the template is valid,
from the dropdown list.

Customer State Select the customer state for which the product
is valid, from the drop-down list.

Producer State Select the Producer state for which the product is
valid, from the drop-down list.

App/Acc St Select the Applicant/Account state for which the
product is valid, from the drop-down list.

New Template Check this box to load the template as a new
template.

Loaded Check this box to indicate that the template is
loaded.

Enabled Check this box to enable the template.

Note

You can define multiple templates for each document and the template file name
(BIP template) is picked based on following criteria – Product and Producer /
Account / Customer State.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
The Document Elements sub screen records the system’s application or account
information that appears in the ad hoc correspondence.

To generate a data file for a document

1. In the Document Definition section of Setup > Setup > Administration > User >
Correspondence > LoanLine of creditLease > Documents, select the record for which
you want to generate a data file.

2. Click Gen. Data File button.
The system displays a new screen with the following options:
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Figure 3-40    Generate a data file

• Open with – Select to view the data file in the format you want. The adjacent drop-
down list provides a list of formats compatible with the system. The system downloads
the file and displays it.

• Save File – Select to save the data file on your system.

3. Check the box Do this automatically for files like this from now on to apply selected
properties for the files which are similar to the current one.

3.6.1.5 Correspondence
The Correspondence screen enables you to define who will receive the documents you
created on the Document Definition screen by creating correspondence sets. Each document
must belong to a set, and a set can have more than one document.

To set up a correspondence set

1. Click Setup > Setup > Administration > User > Correspondence > LoanLine of
creditLease > Correspondence. The correspondence setup is classified into two:

• Documents

• Functions

2. In the Correspondence section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-41    Correspondence

Figure 3-42    Correspondence
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Figure 3-43    Correspondence

A brief description of the fields is given below:

Table 3-51    Set up a correspondence set

Field Do this

Code Specify the correspondence code.

Description Specify the correspondence description
(required).

Print Schedule Select the correspondence output schedule type
from the dropdown list.

Level Select the correspondence level type from the
drop-down list.

Group Select correspondence group from the drop-
down list.

Company Select the correspondence company from the
drop-down list.

Branch Select the correspondence branch from the drop-
down list.

Product Select the correspondence product from the
drop-down list.

Enabled Check this box to enable the correspondence.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Setup > Setup > Administration > User > Correspondence > LoanLine of
creditLease > Correspondence > Documents.
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5. In the Documents section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 3-52    Documents

Field Do this

Document Select the correspondence document from the
drop-down list.

Recipients Select the recipients for the document from the
drop-down list.

Enabled Check this box to enable the recipient selected.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Click Setup > Setup > Correspondence > LoanLine of creditLease > Correspondence
> Functions.

8. In the Functions sub screen, you can define the functions that should be executed before
or after correspondence is generated. Perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-53    Functions

Field Do this

Function Select the correspondence functions from the
drop-down list.

Execute When? Select when to execute the correspondence
function from the drop-down list.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.2 Creating Correspondence
1. To create a correspondence add a record in the document definition block. For example:

SAMPLE_LOAN_APP

2. In the Document Elements section, add the elements required in the correspondence.

3. Click on Gen.Data File to generate PDF file of the report.
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Figure 3-44    To generate PDF file of the report

4. Copy and save the content in the pdf file as an xml file. The saved xml file should have the
same name as entered in the Code column of Document Definition section. For Example:
SAMPLE_LOAN_APP.xml.

5. Open MS Word.

Note

Oracle Financial Services Software assumes that BIP Desktop Tool is installed
and the user is familiar with the BIP Report Tool.

6. In BI Publisher Tab in MS Word, click on Sample XML and import the saved xml file. For
Example: SAMPLE_LOAN_APP.xml.

7. Create the template by inserting required elements tag.
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Figure 3-45    Creating Template

8. The template created in MS Word should be saved with .rtf extension. For Example:
SAMPLE_LOAN_APP.rtf

Note

The .xml and .rtf file should be saved with the same name as entered in the
Code column of Document Definition section.

9. Upload the rtf template in the BIP and create the data model with SQL query as select
CDO_XML_DOCUMENT from correspondence_docs where cdo_id = :docId.

10. After the data model creation, launch the correspondence screen and click
Correspondence tab.

11. You can setup a correspondence with the created doc.

3.6.3 Generating Correspondence
1. To generate a correspondence open the application for which the correspondence should

be generated.

2. Click Correspondence tab. In the Correspondence section, click on Add.

3. Select the created Correspondence. Click Save and Add to save and add a new record.
Click Save and Return to save and return to main screen. Click Return to return to main
screen without modifications.
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Figure 3-46    Correspondence

4. Click Generate to generate the selected correspondence and View Correspondence to
view the Correspondence in PDF format.
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Figure 3-47    Generated Correspondence

3.7 General Ledger
The application’s General Ledger Setup screen can generate and transfer transactions to the
accounting software your company uses. It is the interface that transfers all financial
transactions to the accounting system. It provides your accounting software with an ASCII data
file containing the GL (general ledger) entries for the process date.

This chapter explains the General Ledger form - the system interface that enables you to:

• Map system transactions to your GL transactions.
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• Define the requirements for header and derived segments

The system supports the bulk uploading of general ledger setup data. This enables you to
upload multiple setup data, avoid reentering setup data, and more importantly, reduce data
entry mistakes. The system currently supports uploading using a fixed-length format only,
where each data is at a pre-fixed position only. You can run batch jobs with the Set Code
SETBLK to upload pricing and GL data.

Accounting Company Definition

The accounting company is the entity for which the financial statements are prepared for
legal reporting. You must define your accounting company when implementing Oracle
Financial Services Lending and Leasing GL Interface. The accounting company is based upon
the portfolio company set up in the system. For example, if there are two companies set up
within one organization, the two portfolio companies will be used as accounting companies.
Each of these companies will have its own GL set up.

• General Ledger

3.7.1 General Ledger
In Setup > Setup > Administration > User > General LedgerWfpGeneral Ledger, you can
setup data that needs to be setup in the system to export transactions to the user’s general
ledger application.

The system uses segments to create the complete GL account to which the amount is to be
posted. The defined segments are linked together to create the GL account. One of the
segments is bound to be the natural account. The other segments could be direct values (like
the natural account) or derived values. The segment is grouped into four categories:

1. Translation Definition

2. Attribute Definitions

3. Transaction Definition

4. Transaction Links

Navigating to General Ledger

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > General LedgerWfpGeneral Ledger.

2. In the Company section of the General Ledger screen, select the portfolio company you
want to work with.

This section consists of the following topics:

• Translation Definition

• Attribute Definitions

• Transaction Definition

• Transaction Links

3.7.1.1 Translation Definition
GL segment values are defined on the Translation Definition.

To setup the Translation Definition
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1. Click Setup > Setup > Administration > User > General LedgerWfpGeneral Ledger >
Translation Definition.

2. In the Segment Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-48    General Ledger

Figure 3-49    Wfp General Ledger
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A brief description of the fields is given below:

Table 3-54    Segment Definitions

Field Do this

Segment # Select the segment number. the system can
support up to 10 segments, from the drop-down
list. Valid values range from 01 to 10.

Source Specify the Source to record a direct value or
translated value.

Direct Value: In case the segment value is not a
derived value (more on derived segments later),
the Source field contains the same value as the
Translated Value field. This would contain a list
of all the valid values for each segment (for
example, GL account number).

Translated Value: In case the segment value is
a derived value, the Source field is used to store
the value of the condition string that will be
applicable for the particular segment. For
example, if the value 02 value in the Segment #
field is derived using the branch of the customer
as a source criteria, then the entry would read
as:

Segment #: 02

Source: CB-001

Translated Value: HQ

Description: HEADQUARTERS

Therefore, for all accounts in branch CB-001 for
segment 02, the translated value of HQ will be
used in the GL account number (required).

CAUTION: Use of derived value segment
requires additional programming by SSC. You
should not add derived value segments without
consulting SSC.

Translated Value Specify the actual segment value. All valid
segment values for all segments are defined
here.

Description Specify the description of the segment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.2 Attribute Definitions
The General Ledger interface uses two types of segments:

• Header segment types

• Detail segment types

The Attributes Definitions screen records the Header and Detail segments. Both are recorded
on the Attribute Definitions screen in the Segment Type field.
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Note

The Header and Detail segment attributes that you configure should be part of
accounts or transactions table as configured in the following views - TXN_ACC_EVW
and TXN_TXN_ EVW.

Header segment types

The header segment types are the account attributes used as selection criteria to map a
transaction to GL segments. The system supports 10 configurable header segments. For each
header segment, you can defined specific Account and Transaction attributes which are used
as the criteria to categorize the transactions to GL segment. However, note that a header
segment must be an account attribute.

By default, the first five header segments (1 to 5) are updated with sample data provided as
part of seed data during the base installation / upgrade.

The first five sample segments are:

Table 3-55    Sample segments

Segment # Attribute Name Description

01 ACC_PRODUCT_TYPE_CD Product Type

02 TXN_BACKDATE_IND Backdated Transaction

03 ACC_PRD_PRODUCT Product Code

04 ACC_STATUS_CD Account Status

05 ACC_NON_PERFORM_TYPE_C
D

Account Non-performing Indicator

This means that the system will allow the account attributes listed above to be used as criteria
for categorizing the transactions. Here header segment name defined can be either from
Accounts/Transactions table (TXN_ACC_EVW/TXN_TXN_EVW). Segment selections depend
on the values in the header segment fields. You can define all the 10 header segments.

Detail segment types

Detail segment types allow you to set up components of the GL account number. A GL account
number can be composed of multiple segments that are combined to create the composite GL
account number. The detail segments can be configured to direct values (like the natural
account) or derived values. Natural account here can be a constant value which is not part of
any existing Account or Transaction table.

By default, the first four detail segments (1 to 4) are updated with sample data provided as part
of seed data during the base installation / upgrade. Following are the sample detail segments
provided in the system:

Table 3-56    Detail segment types

Segment # Attribute Name Description

01 ACC_CONSTANT_ GL_ATTR The natural account number in
the GL for the transaction

02 ACC_PCB_BRANCH Customer Branch

03 ACC_POO_POOL Account Pool
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Table 3-56    (Cont.) Detail segment types

Segment # Attribute Name Description

04 ACC_SUBUNIT_CD Account Sub Unit

All the 10 available detail segments can be defined. One of the segments can be the natural
account. (A natural account is an account from the client’s master listing of all general ledger
accounts, or chart of accounts) The Details segment Attribute name defined can be either
from Accounts/Transactions table or a constant value (ACC_CONSTANT_GL_ATTR).

Note

Ensure to have careful consideration while adding a header or detail segment. For any
additional programming support, consult Oracle Financial Services Software.

To setup the Attribute Definitions

1. Click Setup > Setup > Administration > User > General Ledger > Attribute Definitions.

2. In the Attribute Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-57    Attribute Definitions

Field Do this

Segment Type Select the segment type from the drop-down list.

Segment # Select the required segment out of 10 segments
from the drop-down list.

Attribute Name Select the attribute name from the drop-down list
to indicate the value is to be populated in
attributes.

The list is populated with only ‘Enabled’
attributes and based on account parameters
maintained in User Defined Table GL
ATTRIBUTES available in Setup > Administration
> System > User Defined Tables screen. The
same is configurable and you add/update
account parameters.

Description View the attribute description maintained in GL
ATTRIBUTES User Defined Table.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.3 Transaction Definition
The Transaction Definition screen enables you to define GL transactions and to associate the
Debit and Credit segments for each GL Transaction.

In GL Transactions sub screen, the Transaction Code column contains GL transactions defined
by the client team. The Segments section contains a Debt and Credit section. These are both
detail segments.
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To setup Transaction Definition

1. Click Setup > Setup > Administration > User > General LedgerWfpGeneral Ledger >
Transaction Definition.

2. In the GL Transactions section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-58    GL Transactions

Field Do this

Transaction Code Specify unique GL transaction code.

Description Specify description for the GL transaction.

Product Type Specify the product type.

Backdated Txn Specify the back dated transactions.

Product Specify the product.

Status Specify the status.

Enabled Check this box to enable the transaction.

Attribute 5 Specify the header attribute 5.

Attribute 6 Specify the header attribute 6.

Attribute 7 Specify the header attribute 7.

Attribute 8 Specify the header attribute 8.

Attribute 9 Specify the header attribute 9.

Attribute 10 Specify the header attribute 10.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Segments section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 3-59    Segments

Field Do this

Sort Seq Specify the sort sequence (optional).

Enabled Check this box to enable the segment.

Debit section

Debit ACC # Select the segment value from the drop-down
list.

Branch Select the segment value from the drop-down
list.

Segment #3 Select the segment value from the drop-down
list.

Segment #4 Select the segment value from the drop-down
list.

Segment #5 Select the segment value from the drop-down
list.

Segment #6 Select the segment value from the drop-down
list.

Segment #7 Select the segment value from the drop-down
list.
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Table 3-59    (Cont.) Segments

Field Do this

Segment #8 Select the segment value from the drop-down
list.

Segment #9 Select the segment value from the drop-down
list.

Segment #10 Select the segment value from the drop-down
list.

Credit section

Credit ACC # Select the segment value from the drop-down
list.

Branch Select the segment value from the drop-down
list.

Segment #3 Select the segment value from the drop-down
list.

Segment #4 Select the segment value from the drop-down
list.

Segment #5 Select the segment value from the drop-down
list.

Segment #6 Select the segment value from the drop-down
list.

Segment #7 Select the segment value from the drop-down
list.

Segment #8 Select the segment value from the drop-down
list.

Segment #9 Select the segment value from the drop-down
list.

Segment #10 Select the segment value from the drop-down
list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
As mentioned in the Attributes Definitions screen section, the system can support up to
10 header segments.

Each transaction can be mapped to one or more GL accounts using the segment mapping
section. A segment number can be a natural account or can be a derived segment. In case
of a natural account, you need to select the segment value (from the list of predefined
segments).

Entering DERIVED in the Segment Number field instructs the system to look for the
derived value from the segments defined in the Segments Definition section on the
Translation Definition screen.

Let’s take an example:

Company: ABC BANK

Transaction Code: ADV

Description: ADVANCE

Product Type: FUNDING TRANSACTION

Branch: CB-001

Segment #1: 200000

Segment #2: DERIVED
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Let’s assume segment #2 is derived from the branch where the account belongs. While
calculating the account number, the system interprets segment #2 as follows:

The system will look for a segment value for segment #2 for the account in question using
the branch of the account (CB-001). It will use the segment value it finds, say HQ. This will
be segment value for segment #2.

IMPORTANT: The derived segment logic can be used for all segments except for the one
designated as the natural account segment.

CAUTION: Please note that the logic for calculation of the derived segments is customized
for each client. You will need to contact Oracle Financial Services Software inc. in case you
want to change the logic or add new derived segments.

“Best Match Feature” for General Ledger (GL) Transactions

The system provides the functionality wherein for each monetary transaction, you can
generate entries in the General Ledger (GL) based on the setup. For a single transaction
(for example, a late charge), the system allows GL entries to be generated based on
different criteria regarding the loan line of credit lease account (for example, product type,
product, status, and so on). A late charge entry for one product type can differ from a late
charge entry for a different product type.

For example,

Assume you have set up the following four late charge fee GL transactions based on
product and status.

Table 3-60    GL Transactions section

Transaction Code Description PRODUCT STATUS

FLC_A LATE CHARGE Product 1

FLC_AA LATE CHARGE Product 1 ACTIVE

FLC_B LATE CHARGE Product 2

FLC_BB LATE CHARGE Product 2 ACTIVE

For a late fee for an ACTIVE account for a Product 1, Oracle Financial Services Lending
and Leasing will process the GL Transaction FLC_AA. However, if the late fee is for a
CHARGED OFF account for a Product 2, Oracle Financial Services Lending and Leasing
will process the GL Transaction FLC_B.

3.7.1.4 Transaction Links
The system enables you to map the various transactions to your General Ledger transaction
types with the Transaction Links screen. The list of transactions available in the Transaction
Code will be derived from the transactions setup on the Transaction Definition screen.

To setup the Transaction Links

1. Click Setup > Setup > Administration > User > General LedgerWfpGeneral Ledger >
Transaction Links.

2. In the Transaction Links section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 3-61    Transaction Links

Field Do this

Transaction Code Specify the transaction code.

Description Select the transaction description from the drop-
down list.

GL Transaction Code Specify the corresponding GL transaction code.

Description Select the GL transaction description from the
drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
You can have more than one transaction mapped to a user-defined GL transaction. In that
case, the system summarizes all the transactions to the GL transaction. For example, the
system uses separate transaction codes for fees, such as LATE_FEE and
SERVICING_FEE. If a client site would rather have all fees go into one debt and one credit
account, they would define a GL transaction and link all transactions to that defined
transaction.

You could also have one transaction linked to more than one GL transaction. The system
will use the setup on the header segments to identify the correct GL transaction setup to
use.

For example, if the FLC (Late Charge) transaction is mapped to the CHG_LC and
CHGR_LC transactions, then the system will look at the header segment definitions to
identify the correct GL transaction. Let’s say the header segment used is Account status
and that CHG_LC is used for active accounts and CHGR_LC is used for charged off
accounts. In this case, the system will identify the correct GL transaction depending on the
account status.

3.8 Queues
When processing an application, various users might work on the application to complete
different tasks. A data entry person might complete the Application Entry screen before an
underwriter works on the application using the Applications screen. Later, another user might
use the Applications screen to fund the application.

The application processing workflow facilitates the movement of the application from one
person to another with queues. Queues create a work section of accounts waiting for a
particular and common task to be performed, such as application entry or verification. The
system’s powerful queuing module automates this otherwise manual process.

In the Queues setup screen, you can setup and manage workflow and work assignments on a
daily basis to ensure that all applications are in the queues of the appropriate users at all
times.

Any time an application’s status is changed, the system checks whether the application is in
the right queue.

The system will sort queues based on an application’s status and sub status.

When processing an account, various users might work on the accounts to complete different
tasks.

The account processing workflow facilitates the movement of the account from one person to
another with queues. Queues create a work section of accounts waiting for a particular and
common task to be performed. The system’s powerful queuing module automates this
otherwise manual process.
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In the Queues setup screen, you can setup and manage workflow and work assignments on a
daily basis to ensure that the appropriate queues are available for users at all times.

Any time an account’s status is changed, the system checks whether the account is in the right
queue.

The system will sort queues based on an account’s status and condition. A condition is the
state of an account at a particular time, such as a delinquent, which determines the action a
user needs to take.

Queues in the system are distinguished to two types of queues:

1. Origination Queues

2. Customer Service Queues.

Customer service queues

In the Customer Service screen, queues create a work list of accounts waiting for a particular
and common task to be performed, such as collecting on a delinquency. The system’s powerful
queuing module automates this otherwise manual process. The Queue Setup form allows you
to manage workflow and work assignments and ensure that all accounts are in the queues of
the appropriate users at all times.

Customer Service queues distribute and route accounts that require some particular action to
be performed to specific users or departments. The system sorts customer service queues
based on an account’s status and condition.

Accounts become available for queue assignment when an account receives a condition.
Conditions can be applied automatically by the system or manually by users. For example,
during nightly processing, the system recognizes an account as delinquent and automatically
assigns it a condition of DELQ (Delinquent). The users can manually change an account’s
condition using combination of Action and Result field entries on the Servicing > Servicing >
Customer Service > Customer Service > Customer Service > Call Activities.

These Action and Result field entry combinations are set up on Setup > Setup >
Administration > User > Queues >Call Actions Results.

The system associates an account with one or more queues based on multiple parameters,
including user-defined criteria and the follow-up date. For example, customer service queues
might be configured so accounts are parsed to users according to:

• Due date changes

• Deferment requests

• Title and insurance follow-up dates

Collections queues are included in the Customer Service queue. These queues focus on:

• General collections

• Bankruptcy

• Foreclosure

• Repossession

• Deficiency

Customer Service queues can be built online or in a nightly batch job. Within each queue, the
order of the accounts can be sorted based on user-defined criteria.
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Note

• Although, the system allows you to define your own selection criteria in creating
queues, the system’s performance depends on how the selection criterion is
defined. The application highly recommends that you get approval from your
database administrator before using any queue selection criteria. Also, avoid using
user-defined tables and columns in the selection criteria.

• You can use these same methods for creating and closing queues in the case of
repossession, foreclosure and deficiency.

The Call Actions Results screen allows you to define the contents of the Action and Result
fields on the Customer Service screen’s Add Call Activities section. The system uses this
information to allow users to manually change the condition of an account, and thus assign or
remove the account to a queue.

Depending on how you set up call action result codes on the Call Actions screen, conditions
and queues are created or closed. You can also restrict the use of certain call activities based
on responsibility.

The lookup type ACC_CONDITION_CD defines which account conditions can be created. The
application’s queuing engine determines, if queues need to be created based on the
information in the Lookups sub screen for this lookup type.

The following table displays the possible combinations of condition and queue.

Figure 3-50    Combinations of condition and queue

1. Condition: Open, Queue: Open

• In this state, both the account condition and queue are created or opened at the same
time.

• The system’s transaction-processing engine automatically creates DELQ, TIP,
SCHGOFF conditions and queues; therefore, you need not setup any call action result
with these conditions.

• CHGOFF is an account status, so no queues are created. To follow-up on charged-off
accounts, create DEFICIENCY condition with this option.

• BKRP (Bankruptcy), REPO (Repossession), FORC (Foreclosure) account conditions
and queues can be opened with this option. Also, account level indicators (for
reporting purpose) are set.
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Note

– An account is moved to the condition, when a Call activity is posted;
however, the Queue is moved only when you click Update queue
manually or in the EOD batch.

– Accounts are automatically moved based on the system parameter set up.

2. Condition: Open, Queue: NA

• In this state, only the account condition is created or opened.

• This option should be used only if queuing is not necessary on this account condition.

3. Condition: NA, Queue: Close

• In this state, the queue associated to the account condition is closed.

• This is a bankruptcy condition and delinquency follow-up is not necessary. In such
case, DELQ queue can be closed while the condition is still open.This option should
only be used if an existing queue on this account condition should be closed. For
example, for accounts with bankruptcy condition, delinquency follow-up is not
necessary. In such case, DELQ queue can be closed while the condition is still open.

• DELQ, TIP, SCHGOFF queues can be closed by using this option.

4. Condition: Close, Queue: Close

• In this state, both the account condition and queue are closed.

• The system’s transaction-processing engine automatically closes DELQ, TIP,
SCHGOFF conditions and queues; therefore, don’t setup any call action result with
these conditions.

• BKRP (Bankruptcy), REPO (Repossession), FORC (Foreclosure) account conditions
and queues can be closed with this option. Also, account level indicators (for reporting
purposes) are set.

Note

Condition will be removed from the Summary conditions section.

Navigating to Queues screen

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Queues.

2. The system displays the Queue Setup screen. You can setup queues related to:

• Customer Service

• Call Action Results

• Criteria Based Condition

• Customer Service Tab

• Call Action Results tab

• Origination Tab

• Activity Tracking

• User Groups Tab
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3.8.1 Criteria Based Condition
OFSLL supports various conditions on an Account with the ability for users to open and close
required account conditions. A condition can either be posted automatically by the system
(like updating DELQ delinquency condition on account) or manually through a transaction or
call activity.

The Criteria Based Condition screen facilitates to automate the manual process of opening or
closing conditions on account by defining criteria which helps to categorize specific accounts
and post conditions on to those accounts in bulk.

For example,

• You can define specific conditions to Send Letters, Post Transaction and so on if Account
Maturity date is less than 90 days from current system date.

• You can post a condition to allow Extension transactions on an account if 50% of financed
amount is received.

• When there is a natural calamity, you can post a condition to allow Extension transactions
on Accounts belonging to that particular zip code.

However, note that the following conditions are controlled only by the system and cannot be
defined to process automatically.

• DELINQUENT

• SCHEDULE FOR CHARGEOFF

• PAYOFF/TERMINATION IN PROGRESS

• NON ACCRUAL

• BANKRUPTCY

• DEFICIENCY

• REPOSSESSION

• FORECLOSURE

In the Criteria Based Condition screen, you can setup Criteria Definitions and define Actions to
Open or Close a condition on account. This in-turn is processed during the execution of
automated batch job QCCPRC_BJ_100_01 (CRITERIA BASED CONDITION POSTING) in
SET-QCS batch job set and while executing the batch job QCCPRC_BJ_100_02 in SET_QRT
batch job set.

At account level once the condition is opened/closed, system posts a comment with the
Criteria definition details.

Chapter 3
Queues

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 93 of 141



Figure 3-51    Criteria Definition details

This section consists of the following topics:

• Criteria Definition

• Criteria Details

• Conditions

3.8.1.1 Criteria Definition
In this section, you can define Criteria definition which can perform specific action on the
Accounts.

To Setup Criteria Definition

You can either define new Criteria Definition or specify a new name in the New Criteria field
and click Create Copy to create a copy of selected criteria with header and child tab details.

1. Click Setup > Administration > User > Queues > Criteria Based Condition tab.

Figure 3-52    Setup Criteria Definition
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2. In the Criteria Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-62    Criteria Definition

Field Do this

Name Specify an unique Criteria definition code.

Description Specify the description of the criteria.

Start Dt Select the start date from when the Criteria is to
be considered for execution using the adjoining
calendar.

End Dt Select the end date till when the Criteria is to be
considered for execution using the adjoining
calendar.

Company Select the company from the drop-down list.

Branch Select the branch drop-down list.

Seq Specify the sequence for criteria execution.
When there are multiple conditions to be posted
on account, the same is processed based on the
sequence defined here.

However, there cannot be more than one
enabled Criteria with same sequence and this
condition is auto validated by the system.

Enabled Check this box to enable the Criteria Definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.1.2 Criteria Details
The Criteria Details section helps you to define the account selection criteria.

1. Click the Setup > Setup > Administration > User > Queues > Criteria Based Condition
tab.

2. Select the required Criteria definition.

3. In the Criteria section, perform any of the Basic Operations mentioned in Navigation
chapter.

Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.

A brief description of the fields is given below:
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Table 3-63    Criteria Details

Field Do this

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator Select comparison operator from the drop-down
list.

Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Specify logical operator from the drop-down list.

Enabled Check this box to enable the selection criteria.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.1.3 Conditions
The Condition section determines whether the Condition in the selected Criteria Definition is to
be opened or closed on the matching accounts.

1. Click the Setup > Setup > Administration > User > Queues > Criteria Based Condition
tab.

2. Select the required Criteria definition, define Criteria and click Conditions tab.

3. In the Condition section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 3-64    Condition

Field Do this

Condition Select the Condition from the drop-down list.
This list is populated based on lookup code
ACC_CONDITION_CD which consists of all the
matching conditions associated with the selected
Criteria Definition.

Note that, some of the conditions like
Delinquency, Scheduled for Charge-Off and so
on (listed above) are automatically opened/
closed by system and is not available in this list
for selection.

Action Select the action as Open / Close by clicking on
the adjacent radio button.

Enabled Check this box to enable the Condition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.2 Customer Service Tab
The Customer Service section allows you to set up the customer service queues. The screen
includes a Hard Assigned box. When selected, the system assigns an equal amount of
accounts to each individual user working on a that queue. Also, an account that is hard
assigned will remain assigned to the individual who opens that account until that person is no
longer working that queue.
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Customer Service command buttons

The Customer Service screen contains following three command buttons:

Table 3-65    Customer Service command buttons

Command button Function

Update Queue Queues can be updated whenever selection criteria
has been updated. They may also be updated
manually, if the nightly batch fails.

Un-Assigned Depends on location of the cursor when you
choose this button.

Customer Service - Un-assigns all accounts in
this queue.

Responsibilities and Users > Responsibilities -
Un-assigns all accounts in this queue.

Responsibilities and Users > User - Un-assigns
all accounts assigned to the specific user.
Unassigned accounts may now be selected by
updating the queue and re-assigned.

Check Criteria Reviews the selection criteria for errors. The
system will not allow you to enable a queue with
invalid selection criteria.

To set up the Customer Service queues

You can either define new Customer Service Queue Definition or specify a new name in the
New Queue field and click Create Copy to create a copy of selected Queue Definition with
header and child tab details. The new Queue Definition created this way will be in disabled
state by default.

1. On the Queue Setup screen, click Setup > Setup > Administration > User > Queues >
Customer Service. Queues are further filtered based on the following criteria:

• Selection Criteria

• Sort

• Responsibilities and Users

• Data node assignments

• Group Assignment

2. In the Queue Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-53    Queues_Customer Service

A brief description of the fields is given below:

Table 3-66    Queue Definition

Field Do this

Queue Name Specify queue name.

Queue Desc Specify queue description.

Account Condition Select account condition from the drop-down list.

Priority Specify the priority.

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Hard Assigned Check this box to assign an equal amount of
accounts to each individual user working on a
that queue. Also, an account that is hard
assigned remains assigned to the individual who
opens that account until that person is longer
working that queue.

Group Follow-up Ind Check this box to enable the bank to indicate
whether the accounts belonging to the same
customer have to be followed-up in groups.

Near Real-Time Check this box to select the queues for the near
real time refresh. You can specify the time
interval and frequency to run this queue. When a
batch is run, it picks only customer service
queues marked as Real Time” queues for re-
assignment.
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Table 3-66    (Cont.) Queue Definition

Field Do this

Dialer Extract Check this box to indicate if the accounts
satisfying the selection criteria should be
extracted from the batch process or not. If the
user is hard-assigned, then user gets identified
by the dialer system as Permission to call user.
The extract will also have data pertaining to
customer time zone and privacy opt out indicator.

Enabled Check this box to activate the queue.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click the Setup > Setup > Administration > User > Queues > Customer Service >
Selection Criteria.

5. In the Selection Criteria section, you can define the account selection criteria with the
following fields. Perform any of the Basic Operations mentioned in Navigation chapter.

Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 3-67    Selection Criteria

Field Do this

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator Select comparison operator from the drop-down
list.

Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Specify logical operator from the drop-down list.

Enabled Check this box to enable the selection criteria.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Click the Setup > Setup > Administration > User > Queues > Customer Service > Sort.

8. In the Sort section, you can define the order to sort the account selection criteria with the
following fields. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 3-68    Sort section

Field Do this

Seq Specify sequence number.

AssAgpCode Select sort field from the drop-down list.

Order Select sort order from the drop-down list.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

10. Click Setup > Setup > Administration > User > Queues > Customer Service >
Responsibilities and Users.

11. In the Responsibilities section, you can define the responsibilities that are authorized to
work on the queue. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-69    Responsibilities

Field Do this

Responsibility Select the responsibility from the drop-down list.

Enabled Check this box to enable the responsibility.

12. Perform any of the Basic Actions mentioned in Navigation chapter.

13. In the Users section, you can define the users who are authorized to work on the queue.
Also, you can hard assign the queues to the user. Perform any of the Basic Operations
mentioned in Navigation chapter.

Note

The system allows the work queue list to be sorted by user-defined criteria.

A brief description of the fields is given below:

Table 3-70    Users

Field Do this

Name Select user name from the drop-down list.

# Assigned Specify number of accounts assigned.

Hard Assigned Check this box to hard assign. (For more
information, see the following section in this
chapter, Using the Hard Assigned Feature).

Enabled Check this box to enable.

14. Perform any of the Basic Actions mentioned in Navigation chapter.

15. Click Setup > Setup > Administration > User > Queues > Customer Service > Data
Node Assignments. You can enable the administrator to configure the User interface
nodes that should be made available for the applications that are being processed in that
particular origination queue.

16. In the Data Node Assignments section, perform any of the Basic Operations mentioned
in Navigation chapter.
A brief description of the fields is given below:
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Table 3-71    Data Node Assignments

Field Do this

Node Specify the node.

Enabled Check this box to enable the record.

17. Perform any of the Basic Actions mentioned in Navigation chapter.

18. Click Load Queue Nodes on the Node Assignments sub screen to display the respective
UI nodes in the origination module.

19. Click Setup > Administration > User > Queues > Origination > Group Assignment. In
the Group Assignment sub tab, you can add user groups to Customer Servicing Queue
and also if required, you can un-assign users from the user group.

Note

Modification of user details (adding or disabling users) within a user group which is
added to Group Assignment will implicitly be updated in Responsibilities and
Users tab also.

20. In the User Group section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-72    User Group

Field Do this

Group Name Select the user group name from the drop-down
list. The list displays the pre-defined user groups
available in the system.

Enabled Check this box to enable the user group.

21. Perform any of the Basic Actions mentioned in Navigation chapter.

22. (Optional) Click Un-Assigned button to un-assign all the users of the group in the queue.
Note the following:

• If the queue is Hard Assigned, then it implies that all users in the user group(s)
attached to that queue are not Hard Assigned. Hence all those Users should have to
be explicitly marked as hard assigned in the queue added through user group.

• User added directly to the queue should be disabled manually. For common users
present at Queue and User Group, you need to manually maintain the data in sync.

• Following table indicates various combinations for enabling and disabling Users and
User Group(s) from Queue and User group(s).

Table 3-73    Users and User Group(s)

Entity Added in Queue Added in User
Groups

Enabling and
Disabling options

User Yes No User should be
disabled /enabled only
in that particular
Queue.
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Table 3-73    (Cont.) Users and User Group(s)

Entity Added in Queue Added in User
Groups

Enabling and
Disabling options

No Yes User should be
disabled / enabled in
all the Queues where
the user group is
attached.

User Group Yes No User group should be
disabled /enabled only
in that particular
Queue.

No Yes User group should be
disabled / enabled in
all the Queues where
the user group is
attached.

Group Follow-up

The system enables lending institution to conduct one time only follow-up activity on the
Customer Service screen, if the customer has multiple accounts in various conditions or in
various queues. This avoids unnecessary confusions that arise when more than one user is
performing collection tasks on multiple accounts belonging to the same customer.

You can follow-up on multiple accounts in the same condition at the same time using the group
follow-up functionality. The system locks the accounts in the low priority queues and displays
the same in the high priority queues. You can perform the follow-up activity on all the accounts
when the account in the high priority queue becomes due for follow-up.

For example,

Suppose a customer holds three accounts, one that’s 30 days delinquent and in the
0_30_DAYS_DEL queue, one that’s 60 days delinquent and in the 30_60_DAYS_DEL queue
and one that’s 90 days delinquent and in the 90+_DAYS_DEL.

a) If each of the queues Group Followup Ind is unchecked on the Customer Service screen,
then no group follow-up will be performed.

b) If each of the queues Group Followup Ind is checked on the Customer Service screen, while
updating the follow-up date for the low priority days queue, then the system will use the 90
days follow-up date.

c) If the Group Followup Ind is checked on Customer Service screen for the 0_30_DAYS_DEL
and 30_60_DAYS_DEL queues and note the 90+_DAYS_DEL queue, and the customer has
accounts in each of the queue, then the system will use the follow-up date of 60 days for the
low priority account.

Using the Hard Assigned feature

The system’s Hard Assigned queues feature allows companies to evenly distribute accounts
between users. The following example explains how it works:

Let’s say there are 40 unassigned accounts in a queue. Three users are assigned to the
queue, Hard Assigned is checked for two.

When you select Update Queue on the Customer Service screen (or Oracle Financial Services
Lending and Leasing processes the CUSTOMER SERVICE QUEUE PROCESSING nightly
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batch) each of the two Hard Assigned users receives 20 accounts, while the one that isn’t
marked as Hard Assigned receives zero.

If users already have accounts assigned to them, the system attempts to balance the workload
when assigning new accounts. For example, let’s say there are three users in a queue. The
first has 15 accounts, the second has ten and the third has five. If there are ten new accounts,
the system would give the third user the first 5 accounts, thus bringing that user's total to ten.
The system splits the next five between the second and third, bringing their totals to 13 and 12,
respectively.

Note

The system randomly assigns these accounts.

To set up a user as Hard Assigned feature

1. Click Setup > Setup > Administration > User > Queues > Customer Service >
Responsibilities and Users.

2. In the Responsibilities section, select the level responsibility of the users you want to
hard assign in the queue.

3. In the Users section, check the Hard Assigned check box for each user you want to hard
assign.

4. On Setup > Setup > Administration > User > Queues > Customer Service, click
Update Queue to distribute the applications in the queue to the hard assigned users.
The system displays an Information section with the message as Queue creation
submitted in background.

5. Choose OK beneath the Error Message section box containing the words NO ERROR.
The system distributes and hard assigns the accounts in the queue to the selected users in
the Users section.

6. Perform any of the Basic Actions mentioned in Navigation chapter

To remove a user

1. In the Responsibilities section, select the responsibility of the user you want to remove.

2. In the Users section, select the user you want to work with.

• If you don’t want that user to be hard assigned any longer, uncheck the Hard
Assigned check box.

• If you don’t want that user to be assigned to that queue any longer, uncheck the
Enabled check box.

3. The system updates the number of accounts assigned to a user only after:

• Running the nightly batch job

• Clicking the Update Queue button.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Queue Activity

The queue Activity sub tab allows you to add specific activities which are defined in Queues >
Activity Tracking tab for the selected queue in Queue Definition section. These activities can
be tracked for updates in Customer Service > Queue Assignment tab.
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1. In the Queue Activity Definition section, Click Add. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields is given below:

Table 3-74    Queue Activity

Field Do this

Activity Code Select the Activity Code from the drop-down list.
The list displays only those activities which are
Enabled in Queues > Activity Tracking tab.

In case the same Activity is disabled in Queues
> Activity Tracking tab after adding it here, the
same needs to be manually disabled.

Enabled Check this box to enable the selected activity.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.3 Call Action Results tab
1. Click Setup > Setup > Administration > User > Queues > Call Action Results. The

screen contains two sections:

• Call Actions

• Call Results

2. In the Call Actions section, perform any of the Basic Operations mentioned in Navigation
chapter.
You can either define new Call Action details or specify a new action code in the New
Action field and click Create Copy to create a copy of selected call action with details.

Figure 3-54    Call Action Results

A brief description of the fields is given below:
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Table 3-75    Call Action Results

Field Do this

Action Code Specify the action type code.

Description Specify the description for the call action type.

Call Type Select the call type from the drop-down list.

Enabled Check this box to enable the call action.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Call Results section, you can define call action result codes and corresponding
descriptions. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-76    Call Results

Field Do this

Result Code Specify the result type code for the specified call
action type.

Description Specify the description for the result type.

Report Type Select the report type for the result type, from the
drop-down list.

Right Person Contact Check this box to indicate that result type is a
right person contact.

Follow-up Advance Unit Select the unit for advancing the follow-up date/
time from the dropdown list.

Value Specify the value for the follow-up advance unit.

Enabled Check this box to enable the result.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
Queues are further filtered based on the following criteria:

• Conditions

• Responsibilities

The Conditions section determines whether the selected action/result will cause the listed
conditions to be opened or closed. It also determines whether the queue will be opened or
closed.

6. In the Conditions section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 3-77    Conditions

Field Do this

Condition Select the account condition to be open/close for
the action from the drop-down list.

Condition Select Open to open the listed condition, Close
to open the listed condition, or NA, if the
condition is not applicable.

Queue Select Open to open the listed Queue, Close to
open the Queue, or NA, if the Queue is not
applicable.
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Table 3-77    (Cont.) Conditions

Field Do this

Enabled Check this box to enable the account condition.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

8. In the Responsibilities section, define the responsibilities that are authorized to use the
call action result combination.Perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 3-78    Responsibilities

Field Do this

Responsibility Select the responsibility that can perform the
action result from the drop-down list.

Allowed Select Yes if access is allowed.

Enabled Check this box to enable the responsibility.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.4 Origination Tab
The Origination screen on the Queue Setup form allows you to set up queues that direct
applications to users during the loanline of creditlease origination cycle. Origination queues are
based on an application’s status and sub status. Whenever an application changes its
status/sub status, the system moves the application to a queue based on the information on
this screen.

You can define the loanline of creditlease origination queues and the corresponding selection
criteria based on:

• Application status

• Application sub status

• Product type

• Funding type

• Product

• Underwriter

• State

• Channel

• Producer type

• Producer

With loanline of creditlease origination queues set up, the applications in your work queue
automatically appear on the Results screen when you open the Underwriting or Funding
screen. The queue to which you are assigned appears in the Queue Name field. You would
then begin processing the applications in the order of which they are listed, double-clicking the
application at the top of the list to load it.

On the Setup > Setup > Queues screen, you can determine the direction of the applications to
users who process then. Whenever there is a change in the status or sub status of the
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application, the system places the application in a appropriate queue based on the information
available in this screen.

Applications are further filtered based on the following criteria:

• Selection Criteria

• Sort Order

• Responsibilities and Users

• Data Node Assignments

• Group Assignment

To setup Origination Queues

You can either define new Queue Definition details or specify a new name in the New Queue
field and click Create Copy to create a copy of selected queue definition with header and child
tab details (except Group Assignment tab).

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Queues > Origination.

2. In the Origination Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-55    Origination Definition

A brief description of the fields is given below:

Table 3-79    Origination Definition

Field Do this

Queue Name Specify queue name.
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Table 3-79    (Cont.) Origination Definition

Field Do this

Queue Description Specify queue description.

Note: The system uses this entry when referring
to the queue on other forms.

Override Responsibility Select an override responsibility code from the
drop-down list.

The system uses this data to determine the User
who holds the override responsibility for the
specified queue, if an application triggers an
override edit.

Priority Specify the priority number.

The system sorts applications by the higher
number. For example, an application with a
priority # 5 is considered to have a higher priority
than the one with a priority # 3.

Company Select the company from the drop-down list.

Branch Select the branch drop-down list.

Enabled Check this box to enable the queue.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

This section consists of the following topics:

• Selection Criteria

• Sort

• Responsibilities and Users

• Data Node Assignments

• Group Assignment

3.8.4.1 Selection Criteria
Here, you can further filter the applications in a particular queue. This criteria is generally used
by organizations to categories and allocate large number of applications to different queues.

Note

If you want to execute search on like operators, then use %.

To setup Selection Criteria

1. Click Setup > Setup > Queues > Origination > Selection Criteria > Application Status.

2. In the Application Status section, use the Status and Sub Status fields to define the
credit application status/sub status combinations that should be considered for the queue.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Chapter 3
Queues

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 108 of 141



Table 3-80    Setup Selection Criteria

Field Do this

Status Select application status from drop-down list.

Sub Status Select application sub status drop-down list.

Enabled Select the check box to enable the application
status.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

All is the default value for each field.

5. Click Setup > Setup > Queues > Origination > Selection Criteria > Selection Criteria.
In the Selection Criteria section, use the fields to define the credit application that should
be considered for the queue.

6. To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-81    Selection Criteria

Field Do this

Product Type Select the product type as loanline of creditlease
from the drop-down list.

Funding Type Select funding type from the drop-down list.

Product Select product from the drop-down list.

State Select state from the drop-down list.

Channel Select channel from the drop-down list

Underwriter Select underwriter from the drop-down list.

Producer Type Select producer type from the drop-down list.

Producer Group Select producer Group from the drop-down list

Producer Select producer from the drop-down list.

Region Select region of the producer from the drop-down
list.

Territory Select territory of the producer from the drop-
down list.

Sales Agent Select sales agent for the producer from the
drop-down list.

Funder Select funder for the producer from the drop-
down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.4.2 Sort
In the Sort sub tab of Queue Definition, the new applications which are in origination queue are
displayed here based on sort criteria defined. In case of any overrides, applications would be
sorted automatically without the need of a setup definition. However, there is no impact if sort
is not defined for a queue.

To setup Sort Criteria
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1. Click Setup > Setup > Queues > Origination > Selection Criteria > Sort.

2. In the Sort section, use the Seq, Sort field, and Order to rearrange the queue.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-82    Setup Sort Criteria

Field Do this

Seq Specify the sequence number representing the
sorting priority.

Sort Field Select the sort criteria from the list of parameters
available in the dropdown list.

Order Select either ascending or descending as the
sort order.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.4.3 Responsibilities and Users
1. Click Setup > Setup > Queues > Origination > Responsibilities and Users.

2. In the Responsibilities section, use the Responsibilities field to define the
responsibilities roles which are authorized to work on the queues.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-83    Responsibilities and Users

Field Do this

Responsibility Select the responsibility from the drop-down list.

Enabled Check this box to enable the responsibility.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Users section, use the User field to define the users who are authorized to work on
the queue.

6. To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-84    Users

Field Do this

User Select user from the drop-down list.

Enabled Check this box to enable.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.4.4 Data Node Assignments
Data node Assignments provides user with the flexibility to view the tabs in origination. User
will have option to enable disable Tabs. All the enabled tabs will be displayed when application
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is in that particular queue. Disabled tabs for the tabs will not be shown when applications is in
respective queue.

For example: Application entry Queue

If summary tab to be disabled, the search for the ULN Summary tab and Disable. IN
application Entry summary will not be shown.

1. Click Setup > Setup > Queues > Origination > Node Assignments. You can enable the
administrator to configure the User interface nodes that should be made available for the
applications that are being processed in that particular origination queue.

2. In the Node Assignments section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-85    Node Assignments

Field Do this

Node Select the node from the drop-down list.

Enabled Check this box to enable the record.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Load Queue Nodes to display the respective UI nodes in the origination module.

3.8.4.5 Group Assignment
The Group Assignment sub tab allows you to add user groups to Origination Queue.

Note

Modification of user details (adding or disabling users) within a user group which is
added to Group Assignment will implicitly be updated in Responsibilities and Users tab
also.

To add User Group to Group Assignment

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > Origination > Group Assignment.

2. In the User Group section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-86    User Group

Field Do this

Group Name Select the user group name from the drop-down
list. The list displays the pre-defined user groups
available in the system.

Enabled Check this box to enable the user group.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Chapter 3
Queues

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 111 of 141



3.8.5 Activity Tracking
The Activity Tracking tab in Queues screen allows you to define 36 different activities at any
given time. You can define unique Action and Result for each activity and also set the activity
expiry duration beyond which new actions can be defined for the same activity.

The Activity defined in this tab is used in User > Queues > Customer Service > Queue Activity
tab to define activities for selected Queue Definition which in-turn is used in Customer Service
> Queue Assignments tab to track the updates from call activity results.

Figure 3-56    Activity Tracking

1. In the Activity Definition section, Click Add. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields is given below:

Table 3-87    Activity Definition

Field Do this

Activity Code Select the activity code from the drop-down list.
The list displays pre-defined activity codes which
are enabled as part of
QUEUE_ACTIVITY_TYPE_CD lookup code
maintained in the system.

Description View the description of activity code.

Action Select the Action for the activity from the drop-
down list. The list displays all the customer
service call actions available in the system.

Result Select the appropriate Result for the action from
the drop-down list. The list is sorted with results
based on the action selected.

Activity Expiry Days Specify the number of days after which the
activity has to expire (i.e. status set N). An
activity code in N status can be used to
associate new action for tracking.

Enabled Check this box to enable the activity.

Chapter 3
Queues

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 112 of 141



2. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8.6 User Groups Tab
The User Groups tab in Queues is a centralized repository which allows you to define user
groups, add and remove users from user groups.

The User Groups tab consists of User Group Definition section listing the defined User Groups
and User section below listing the associated users of the selected User Group.

Figure 3-57    User Groups

To define a User Group

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > User Groups.

2. In the User Groups section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-88    User Groups

Field Do this

Name Specify user group name.

Description Specify an appropriate user group description.
The same is used while referring this User Group
on other screens.

Responsibility Select the responsibility of the user group from
the drop-down list. You can later add only those
Users who have the selected responsibility into
the user group.

Enabled Check this box to enable the user group.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

To add Users to User Group
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1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > User Groups.

2. In the User Groups section, select the required User Group.

3. In the Users section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-89    Users

Field Do this

Name Select the user from the drop-down list, The list
displays the available users based on the
responsibility defined for the user group.

Enabled Check this box to enable the user.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.9 Printers
The Printers screen allows you to set up an unlimited number of network printers and fax
devices to be used with the system server. The system uses the information on this screen
while selecting a printer, when the printing process involves a batch job or uses a job
scheduler. Examples include printing reports and correspondence.

The printers and fax devices can be set up at each organization, division, or department to
promote efficient printing of documents, and reports. The system uses this information during
product setup and on the Letters screen in the Batch Printer field.

Special printer names

The following printer names are predefined and have specific functions within the system:

Table 3-90    Printer names

Name Description

UNDEFINED Indicates that the document to be printed is to be
previewed in your browser instead of actually
printing the document.

ARCHIVE Instead of sending an item to the printer, the
system generates a PDF document and saves it in
the archive directory on your server.

EMAIL For LoanLeaseLine of Credit origination
correspondences that can be faxed, the system e-
mails the document as a PDF attachment to the
consumer for direct LoanLeaseLine of Credit or to
the producer in the case of in-direct LoanLeaseLine
of Credit.

FAX For LoanLeaseLine of Credit origination
correspondences that can be faxed, the system
generates a PDF document and will send to the fax
server defined in System Parameters.
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Additionally, you may set up composite entries in the Printer Name field to perform two or more
functions at the same time. This can be done by defining a printer name with the following
format:

PRINTER NAME = <PRINTER_NAME1> + <PRINTER_NAME2>

For example, if a printer named JET4050 was previously defined, as were the special printer
names listed above, then the following additional printers could be defined:

Table 3-91    Additional printers

Name Description

JET4050+ARCHIVE Prints the document with the jet4050 printer and
archives the document.

FAX+ARCHIVE Faxes and archives the document.

EMAIL+ARCHIVE+JET4050 E-mails, archives, and prints the document with the
jet4050 printer.

To set up the Printers

1. Click Setup > Setup > Administration > User > Printers. The system displays the
Printers screen.

2. In the Printers section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 3-58    Printers

A brief description of the fields is given below:
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Table 3-92    Printers

Field Do this

Printer Name Specify the printer name. The name of the printer
as defined by the server. For a UNIX server, the
name might be JET4050, while to access the
same printer from a Windows server the name
would be: \\servername\jet4050.

Description Specify the description for the printer.

Organization Select the organization to which the printer
belongs, from the dropdown list.

Division Select the division to which the printer belongs,
from the drop-down list. The division will be
displayed based on the organization selected.

Department Select the department to which the printer
belongs, from the drop-down list. The
department will be displayed based on the
division selected.

IMPORTANT: When you select a printer to use,
the system searches for a best match using the
following attributes:

1. Organization

2. Division

3. Department

Hence, Oracle recommends creating a version of
each edit, where ALL is the value in these fields.

It is also recommended that, you define a default
printer for an Organization, Division and
Department.

Default Check this box to set the printer as a default
printer.

Enabled Check this box to enable the printer and that the
printer is active.

Note: Never disable the UNDEFINED printer

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.10 Intelligent Segmentation
OFSLL is equipped to leverage the Machine Learning (ML) feature of Oracle Database to
suggest and create Customer Servicing Queues by analysing the current system data. Using
this functionality, system automatically identifies the possible Queue/Segmentation for Account
data using the Machine Learning Algorithm thereby creating an Intelligent Segmentation.

This helps to automate the manual process of queue creation which is otherwise done by
identifying different segments of Accounts and assigning day to day Customer Service
Activities. Further queue processing workflow continues as detailed in Queues section.

• Machine Learning for Queue Creation

• Machine Learning Data visualization

• View Machine Learning Generated Queue

• Create ML Based Queue
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3.10.1 Machine Learning for Queue Creation
The Intelligent Segmentation screen in OFSLL is based on the Oracle JavaScript Extension
Toolkit (Oracle JET) framework. This facilitates to identify different clusters of data and create
queues.

In order to access the Intelligent Segmentation screen from the User Interface menu link, you
need to enable the system parameter FLL_SET_JET_INTELLIGENTSEG_URL (JET
INTELLIGENT SEGMENTATION URL). For more details on installing and deploying this
feature in OFSLL, refer to Installation Manual.

Note

The input data for Machine Learning (ML) data set cluster creation is provided by the
Batch Job QMLPRC_BJ_100_03 (ML DATASET CREATION FOR INTELLIGENT
SEGMENTA TION) available in batch job set SET-QCS.

In this screen, you do the following:

Figure 3-59    Intelligent Segmentation - Workflow

• Identify Cluster of Data for a given Account Condition.

• View hierarchy of cluster and list of accounts falling into different levels of cluster.

• Create a queue by selecting Cluster.

3.10.2 Machine Learning Data visualization
The data generated by the system is represented in the following view formats.

• Cluster view

• Segment View

• Insights View

• Selection Criteria Attributes
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3.10.2.1 Cluster view

Figure 3-60    Cluster view

3.10.2.2 Segment View

Figure 3-61    Segment View
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3.10.2.3 Insights View

Figure 3-62    Insights View

3.10.2.4 Selection Criteria Attributes
Clicking on any of the data segment system displays dynamic record details (Attribute Name
and Attribute Value) along with the option to create queue.

Figure 3-63    Selection Criteria Attributes

3.10.3 View Machine Learning Generated Queue
To view ML based queue
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1. Click Setup > Setup > Administration > User > Intelligent Segmentation. The following
screen is displayed:

Figure 3-64    View Machine Learning Based Queue

2. Select the following option:

Table 3-93    View Machine Learning Generated Queue

Field Do this

Company Select the company from the drop-down list. The
list is populated only with those Company
Definitions to which you have been provisioned
access.

Branch Select the branch within the company from the
drop-down list. This may be ALL or a specific
branch. This must be ALL, if you have selected
ALL in the Company field.

Account Conditions Select the required account conditions. There
are various Account Conditions which are either
posted automatically by the system (like
updating DELQ delinquency condition on
account) or manually through a transaction or
call activity.

3. Click Submit. System generates different data segments based on above selected
combination using a background job process. By default, the data is represented in
clusters and can be viewed on other view formats as detailed in Machine Learning Data
visualization section.

3.10.4 Create ML Based Queue
On generating the data segments in the Intelligent Segmentation screen, you can further drill
down to each cluster and view details with different selection criteria. However, the details of
each record is based on the data maintained in the system.
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Table 3-94    Create ML Based Queue

Button Action

Create Clicking on this option creates a Queue in OFSLL
and the selection criteria of the Queue is populated
with the Cluster Attributes. The queue sequence is
based on Queue name/Description and is
displayed as a confirmation message in the format
Queue ML <Account Condition > <Date
YYYYMMDD > <Time HHMMSS> created
successfully.
 

 

The newly created queue is available in Setup >
Administration > User > Queues screen.

Note that following with ML generated Queues:

• All Queues are created in Disabled status with Selection Criteria Enabled.

• Priority is defaulted to 0.

• Company/Branch is defaulted to selected combination.

• Hard Assigned/Group Follow-up/Near Real-Time/Dialler actions are marked as disabled.

3.11 Bank Details
The Banks screen defines the banks, a company/branch uses for processing Automatic
Clearing House (ACH) and lock box payments.

Note

This is behind the scenes information that the system uses for payments and does
not appear on any other forms.

To set up the Banks

1. Click Setup > Setup > Administration > User > Bank Details link. The system displays
the Bank Details screen.

2. In the Banks Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-65    Banks Definition

A brief description of the fields is given below:

Table 3-95    Banks Definition

Field Do this

Code Specify the bank code (ID used internally by
Oracle Financial Services Lending and Leasing
to represent the bank).

Name Specify the name for the bank.

Short Name Specify the short name for the bank (ID
displayed to represent the bank. This may be
included in any output files).

Enabled Check this box to enable and indicate this as an
active bank

Account # Specify the account number used for banking
transactions with the bank.

Note: If the organizational parameter
UIX_HIDE_RESTRICTED_- DATA is set to Y, this
appears as a masked number; for example,
XXXXX1234.

Routing # Specify the routing number of the bank.

BIC Select the Business Identifier Code from the
drop-down list. The list displays the BIC codes
defined in the system.
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Table 3-95    (Cont.) Banks Definition

Field Do this

IBAN Specify the IBAN (International Bank Account
Number). IBAN is used for identifying bank
accounts across national borders with a minimal
of risk of propagating transcription errors.

Ensure that value entered satisfies the check-
digit validation based on modulo 97. On save,
system automatically validates the IBAN number
length based on country code, characters, white
spaces, and checksum. Validation is also done
during posting non-monetary transaction (ACH
Maintenance).

You can maintain the IBAN length and other
details required as per the country code in the
user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for NL country code
(IBAN_FORMAT_NL) is defined by default with
length of IBAN as 18.

Country Select the country where the bank is located,
from the drop-down list.

City Specify the city where the bank is located.

State Select the state where the bank is located, from
the drop-down list.

Address Line 1 Specify the address line 1 for the bank.

Address Line 2 Specify the address line 2 for the bank.

Zip Specify the zip code where the bank is located,
from the drop-down list.

Extn Specify the extension of the zip code where the
bank is located.

Creditor Id Specify the creditor identification details.

Phone 1 Specify the primary phone number of the bank.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the alternate phone number for the bank.

Extn 2 Specify the phone extension for the alternate
phone number.

Fax 1 Specify the primary fax number for the bank.

Fax 2 Specify the alternate fax number for the bank.

ACH Format Select the ACH format accepted by this bank
from the drop-down list. The list displays the
following options:
• NACHA Format
• SEPA Format

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Setup > Setup > Administration > User > Bank Details > ACH.

5. On the ACH Definition sub screen, you can create ACH files for the bank listed in the
Banks section. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 3-96    ACH Definition

Field Do this

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down
list.

ACH Identifier Specify the lock box ID provided by the bank.
This field is used in the ACH files to identify the
bank.

Enabled Check this box to enable the ACH and indicate
this as an active ACH identifier.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Click Setup > Setup > Administration > User > Bank Details > Lock Box.

8. On the Lock Box sub screen, you can create lock box files for the bank listed in the Banks
screen. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-97    Lock Box

Field Do this

Lock Box Identifier Specify the lock box ID provided by bank. This
field is used in the lock box files to identify the
bank.

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down
list.

Enabled Check this box to enable the lock box.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.12 Standard Payees
The Standard Payees screen defines the third parties that are frequent payees for checks
issued within your organization. These payees are then available on the Consumer Lending
screen’s Advance Entry screen. When you select the Payee # in the Advance Allocation
section, the system completes the remaining fields in this screen with information from the
Standard Payees screen.

Note

The Payee # field on the Advance Payment forms is a non-validated field. This allows
you to select an entry or enter one of your own.

To set up the Standard Payees

1. Click Setup > Setup > Administration > User > Standard Payee. The system displays
the Standard Payees screen.
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2. In the Payee Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-66    Standard Payee

A brief description of the fields is given below:

Table 3-98    Payee Definition

Field Do this

Payee # Specify the payee number (Identifier for the
payee).

Name Specify the payee name.

Pmt Mode Select the payment method for the payee from
the drop-down list.

Enabled Check this box to enabled the payee.

Country Select the country where the payee is located
from the drop-down list.

City Specify the city where the payee is located.

State Select the state where the payee is located from
the drop-down list.

Address Line 1 Specify the address line 1 for the payee
(optional).

Address Line 2 Specify the address line 2 for the payee
(optional).

Zip Select the zip code where the payee is located
from the drop-down list.

Extn Specify the extension of the zip code where the
payee is located.

Phone 1 Specify the primary phone number for the payee.

Phone 2 Specify the alternate phone number for the
payee.
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Table 3-98    (Cont.) Payee Definition

Field Do this

Bank Name Specify the payee ACH bank name used by the
standard payee.

Routing # Specify the payee ACH bank routing number of
bank used by the standard payee.

Account Type Select the payee type of ACH bank account
maintained by the Standard Payee from the drop-
down list.

ACH Account # Specify the payee ACH bank account number.

Company Select the company from the drop-down list. The
list is populated with Company definitions based
on the Country selected.

Branch Select the branch drop-down list. The list is
populated with Company branch based on the
Country selected.

BIC Select the Business Identifier Code from the
drop-down list. The list displays the BIC codes
defined in the system.

IBAN Specify the IBAN (International Bank Account
Number). IBAN is used for identifying bank
accounts across national borders with a minimal
of risk of propagating transcription errors.

Ensure that value entered satisfies the check-
digit validation based on modulo 97. On save,
system automatically validates the IBAN number
length based on country code, characters, white
spaces, and checksum. Validation is also done
during posting non-monetary transaction (ACH
Maintenance).

You can maintain the IBAN length and other
details required as per the country code in the
user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for NL country code
(IBAN_FORMAT_NL) is defined by default with
length of IBAN as 18.

Start Dt Specify the payment mode start date, the date
the current payment method was implemented
(defaults on Pmt Mode change). you can also
select from the adjoining calendar icon.

Comment Specify a comment for this advance allocations.
This is the default comment to include with
payments to this Payee.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.13 Check Details
The Check Details screen allows you to set up check details.

To setup the Check Details

1. Click Setup > Setup > Administration > User > Check Details. The system displays the
Check Details screen.
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2. In the Check Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-67    Check Details

A brief description of the fields is given below:

Table 3-99    Check Definition

Field Do this

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Payee Type Select the payee type from the drop-down list.

Check # Specify the check number (required).

Printer Name Specify the printer name (required).

Enabled Check this box to enable the check details entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.14 Currencies
The Currencies link allows you to set up currency details.

Navigating to currencies

Click Setup > Setup > Administration > User > Currencies. The system displays the
Currencies screen. In this screen, you can set up:
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• Currency Definition

• Currency Pair link

3.14.1 Currency Definition
The Currency Definition screen allows you to set up currency details.

To set up the currency definition information

1. Click Setup > Setup > Administration > User > Currencies > Currency. The system
opens the Currency Definition tab by default.

2. In the Currency section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 3-68    Currencies

A brief description of the fields is given below:

Table 3-100    Currency Definition

Field Do this

Currency Select the currency you want to define, from the
drop-down list.

Currency Name The system displays the currency name based
on the currency selected.

Country Select the country for which the currency is
defined, from the dropdown list.
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Table 3-100    (Cont.) Currency Definition

Field Do this

Enabled Check this box to enable the currency entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.14.2 Currency Pair link
The Currency Pair Definition link allows you to set up currency pair details.

To set up the currency pair definition information:

1. Click Setup > Setup > Administration > User > Currencies > Currency Pair. The
system displays the Currency Pair Definition screen.

2. In the Currency Pair Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-69    Currency Pair

A brief description of the fields is given below:

Table 3-101    Currency Pair Definition

Field View this

Currency Code Select the currency code from the drop-down list.

Currency Pair Code Select the currency pair code from the drop-
down list.

Chapter 3
Currencies

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 129 of 141



Table 3-101    (Cont.) Currency Pair Definition

Field View this

Through Currency Check this box to set the selected currency as a
through currency.

Through Currency Code Select the through currency code from the drop-
down list.

Enabled Check this box to enable the currency pair entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.15 Zip Codes
The Zip Codes screen allows you to set up zip code details.

To set up the zip codes information

1. Click Setup > Setup > Administration > User > ZipCodes. The system displays the Zip
Codes screen.

2. In the Zip Codes section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 3-70    Zip Codes

A brief description of the fields is given below:
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Table 3-102    Zip Codes

Field View this

Country Select the country from the drop-down list.

State Select the state from the drop-down list.

Zip Code Specify the zip code (required).

City Specify the city.

County Specify the county.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.16 Payment Hierarchy
The Payment Hierarchy screen facilitates to define hierarchy definition along with payment
appropriation, excess payment handling, account selection criteria and sort order. These
details are required by the system to allocate payments to the matching accounts of a
customer, when customer based payments are being processed in Payment Entry screen.

Below is an illustration on how payment hierarchy is used to post customer based payments.

Figure 3-71    Payment Hierarchy - Illustration

Any Payment transaction generated in the system either from UI / Web Service Call or through
a Payment Batch (Generic Payment Upload) can be directly posted to an Account or at
Customer level.

• If payment is posted directly to an Account, the funds are allocated based on the defined
spread with funds appropriation sequence of balance type i.e. Charges, Interest, Principle
and so on.

• If payment is posted at Customer level having two accounts and if the payment amount is
less than the due, then appropriation sequence is required. Else, one of the account can
have a short fall with payment allocation.

In such case, the Payment Hierarchy determines the sequence of payment as to which
account is to be appropriated first and which is to be appropriate next. This is based on order
by clause and appropriation sequence defined.

Also the Balance Type determines the distribution type as one of the following:

• Equally to all the accounts
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• Prorated by Due amount (i.e. highest due or lowest due first)

• Prorated by Outstanding Amount.

Once the account is narrowed down and payment amount is decided, then based on spread
the payment is appropriated. This gives additional flexibility for defining payment modes at the
master account level.

If Payment Hierarchy is not defined while funding an application or needs correction, the same
can be done by posting MASTER ACCOUNT PAYMENT HIERARCHY MAINTENANCEnon-
monetary transaction in Servicing > Maintenance > Transaction Batch Information section. At
Customer level, Payment hierarchy can be updated by posting CUSTOMER MAINTENANCE
transaction.

This section consists of the following topics:

• Payment Appropriation Methods

• Excess Payment Appropriation

3.16.1 Payment Appropriation Methods
While creating Hierarchy definition in the Payment Hierarchy screen, you can use any of the
following payment appropriation methods available in Hierarchy Type field. On selecting the
specific Hierarchy definition at Application or Account level, the defined method is used to
allocate payments to corresponding accounts.

However in all the methods, the payment criteria is also used for identifying the due accounts
and careful consideration is required while defining the same.

Table 3-103    Payment Appropriation Methods

Method Description

EQUAL AMOUNT To allocate payment equally to all the accounts
picked.

This is traditional method of payment allocation in
which the total payment amount received is divided
and adjusted equally to all customer linked
accounts.
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Table 3-103    (Cont.) Payment Appropriation Methods

Method Description

DELQ DUE AMOUNT RATIO To allocate payment based on the ratio of amount
due on all accounts.

In this method, the due accounts are identified
based on the defined selection criteria and the
payment appropriation is done on the ratio of
amount due on each account using the below
formula.
 

 

Following is an illustration on payment allocation:
 

 

DUE AMOUNT RATIO (INCLUDING CURRENT
DUE)

To allocate payment by including the existing
unpaid delinquent due amount of pre-bill days on
all accounts.

This is calculated as: (Single Account Total Due
Amount Ratio (Including Current Due) * Payment
Amount) / All Accounts Total Due Amount Ratio
(Including Current Due)

The value is derived from lookup code
DUE_RATIO_CUR_DUE.

OUTSTANDING BALANCE RATIO To allocate payment based on the ratio of total
outstanding due on all accounts.

Similar to above, even in this method the due
accounts are identified based on the defined
selection criteria and the payment appropriation is
done on the ratio of outstanding amount due on
each account using the below formula.
 

 

This method can be selected if the received
payment amount is equal to total outstanding due
on all linked accounts indicated in Customer
Service > Transaction History > Balances screen.
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Table 3-103    (Cont.) Payment Appropriation Methods

Method Description

ACCOUNT COLUMN BASE To allocate payment based on hierarchy order.

In this method, the due accounts are identified
based on the defined selection criteria and the
payment appropriation is done as per the sequence
of due accounts defined either in ascending/
descending order.

During payment appropriation, system allocates the payment amount only up to the total of
resulted accounts and remaining amount (if any) are processed based on the excess payment
method value.

While onboarding accounts through web services, system considers the value of system
parameter PMT_HIERARCHY_CODE to default the payment allocation in Customer/ Business
Details screen after account activation.

Also while onboarding if the Payment Hierarchy is not passed as part of the request (Applicant/
Application), then system parameter value is considered.

3.16.2 Excess Payment Appropriation
During or after payment appropriation, there can be a residual amount pending for allocation.
For example, $0.01 remains when $100 is equally paid to 3 accounts. In such case the
residual amount is transferred to last account in the hierarchy sequence. However, note that
system performs this residual payment allocation only once.

In other case where there in an excess payment received which is more than account dues,
the same can be processed for payment allocation using any of the following Excess
Handling Method while defining the Hierarchy Definition.

Table 3-104    Excess Handling Method

Method Description

SUSPENSE To post the excess amount as suspense on
Customer or Master account.

HIERARCHY BASED To allocate the excess payment based on any of
the Hierarchy Definitions maintained in the system.

Based on the selection, system re-allocates the excess amount to corresponding accounts.

To set up payment hierarchy

1. Click Setup > Setup > Administration > User > Payment Hierarchy.

2. In the Hierarchy Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-72    Hierarchy Definition

A brief description of the fields is given below:

Table 3-105    Hierarchy Definition

Field View this

Name Specify an unique name for the hierarchy
definition.

Description Specify the description for the hierarchy
definition.

Hierarchy Type Select one of the following type of payment
allocation method from the drop-down list. The
list is populated based on the
PMT_HIERARCHY_TYPE_CD lookup.
• EQUAL AMOUNT
• DUE AMOUNT RATIO
• OUTSTANDING BALANCE RATIO
• ACCOUNT COLUMN BASED

For more information on the above methods,
refer to Payment Appropriation Methods section.

You can define multiple Hierarchy definitions with
same Hierarchy type.

Excess Handling Method Select one of the following type of excess
payment allocation method to be used with
payment hierarchy definition from the drop-down
list. The list is populated based on
PMT_HIERARCHY_EXCESS_METHOD_CD
lookup.
• SUSPENSE
• HIERARCHY BASED

For more information on the above methods,
refer to Excess Payment Appropriation section.
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Table 3-105    (Cont.) Hierarchy Definition

Field View this

Excess Hierarchy Name This field is enabled and is mandatory if the
Excess Handling Method is selected as
Hierarchy Based.

Select the Hierarchy Definition from the drop-
down list. This list is populated with all the pre-
defined and enabled hierarchy definitions
maintained in the system.

For more information on the above methods,
refer to Excess Payment Appropriation section.

Enabled By default this check box is enabled for new
hierarchy definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Account Selection Criteria

This sub tab facilitates to define the account selection criteria that is used to identify due
account for payment allocation. Atleast one valid account selection criteria is required for all
the Hierarchy Types.

1. In the Account Selection Criteriasection, perform any of the Basic Operations mentioned
in Navigation chapter.

Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 3-106    Account Selection Criteria

Field Do this

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.
The list is populated based on the values
maintained in CUSTOMER PAYMENT
HIERARCHY ORDER PARAMETERS user
defined table.

Comparison Operator Select comparison operator from the drop-down
list.

Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Select logical operator from the drop-down list.

Enabled Check this box to enable the selection criteria.
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2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. You can click Check Criteria for system to validate the query and display the results.

Hierarchy Order

This sub tab facilitates you to define hierarchy order that is used to sort the due account for
payment allocation. This sub tab is enabled only for ACCOUNT COLUMN BASED Hierarchy
type.

1. In the Hierarchy Order section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of the fields is given below:

Table 3-107    Hierarchy Order

Field Do this

Seq Specify sequence number.

Sort Field Select sort field from the drop-down list. The list
is populated based on values maintained in
CUSTOMER PAYMENT HIERARCHY ORDER
PARAMETERS user defined table.

Order Select sort order as either Ascending or
Descending from the drop-down list.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3.17 Number Generation
Users can create and manage custom auto number generation definitions on the Number
Generation screen, which can then be linked to applications, accounts, and other entities.

This topic contains the following subtopics:

• Overview

• Navigation

• Number Generation Definition

3.17.1 Overview
A Number Generation Definition includes the rules a system follows to create unique numbers
according to certain criteria. This ensures the production of unique, non-duplicate numbers that
validate the related entities and attributes, rather than producing random numbers..

3.17.2 Navigation
Number Generation sub menu link is available under Setup > Administrator > User in LHS
menu. Clicking on Number Generation link, the screen is as displayed:
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The Number Generation screen consists of the following:

1. Number Generation Definition

2. Number Sequence

3.17.3 Number Generation Definition
The Number Generation Definition section outlines the criteria for generating numbers for
specific entities like Account Number and Application Number, based on combinations of
Company, Branch, and Entity. However, please note that the system permits only one definition
for each unique combination of Company, Branch, and Entity.

In this section, user can do the following:

• Include a new definition and check the list of existing definitions stored in the system.

• Validate the number generation sequence based on the selected parameters.

• Enable or Disable a number generation definition.

Add Number Generation Definition

1. In the Number Generation Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 3-108    Number Generation Definition

Field Name Description

Entity Select the entity from drop-down list for which the
system should generate the number. The list is
populated with values maintained in
NUM_GEN_ENTITY user defined table.

Company Select the company from drop-down list for which
the system should generate the number.

Branch Select the branch for the selected company from
the drop-down list. If company is selected is ALL,
then all the Branches are populated.

Channel Select the channel from the drop-down list on
which the system should generate the Number.
This can be ALL or a specific channel. For entity
as Application or Account Number, system refers
to APP_SOURCE_CD lookup.

User Sequence Reset Freq Select the sequence reset frequency from the
drop-down list. This is the interval at which
system should reset the sequence and the same
can be used as a counter to the number of
record within that sequence duration.

The list is populated based on values maintained
in NUM_GEN_USR_ SEQ_RESET_FREQ_CD
lookup code.

Max Length Specify the value between 1 to 80 to indicate the
maximum length of the number to be generated.

Limit Length Select the limit length as either Variable or
Fixed. This indicates the system to generate
either fixed sequence number or variable
sequence number.

• If limit length is Fixed, system ensures that
the auto number generated is up to the Max
Length field. If it is shorter, zeros are
prefixed.

• If limit length is Variable, then auto number
is generated as per format.

However, system displays an error if the
sequence number generated exceeds the
specified Max length.

Checksum Digit Select the checkbox to indicate the system to
add a check sum digit at the end of the auto
number generated.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Specify a number sequence in the flow to show the order for the system to apply the number
generation logic. Additionally, you can add or modify entries in the Number Sequence section.

• Number Sequence

3.17.3.1 Number Sequence
This section displays the Number Sequence set for an entity and allows you to add and modify
the number sequence for an existing number generation definition. A number sequence must
be established for a Number Generation Definition. The system uses this sequence to perform
the number generation process and produce a number for a specific entity
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Add Number Sequence

1. In the Add Number Sequence section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-109    Number Sequence

Field Name Description

Sequence Specify the sequence number in which system
should use in the number generation logic. Once
specified, the same can be incremented or
decremented using the up or down arrow
buttons.

Units Select the Units using which system should
generate the number from the drop-down list.
This list is populated based on entity type and
values maintained in NUM_GEN_UNIT_CD
lookup code.

The available options are:
• Constant
• Record Creation Date (DD)
• Record Creation Month (MM)
• Random Number Length
• System Sequence Number Length
• User Sequence Number Length
• Record Creation Year (YY)
• Record Creation Year (YYYY)
• Record Creation Year/Month (YYYYMM)
It is mandatory to add and enable the System
Sequence Number Length. The length of the all
units plus the Check Digit (if enabled) together
should not be greater than the maximum length
specified in the Max Length field.

Note

If number generation definition does not
exist then you can autogenerate the
number using the system sequence
number alone. This can work as a
mechanism to identify if number should
be generated by system or as per user
defined logic in this screen.

Value Specify the value which can either be a Constant
or Index Number in reference to the unit
selected. Once specified, the same can be
incremented or decremented using the up or
down arrow buttons.

Enabled Select the check box to enable and use this
parameter in the number generation.

2. Click Validate Sequence in 'Number Generation Definition' to validate the number
generation sequence based on the selected parameters.
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a. On validation, system displays the errors if any duplicate sequence exist.

b. After successful validation, the system shows a popup with the sample number and an
option to Enable the record. Clicking Yes saves the record as Enabled. Clicking No
saves it as Disabled, which can be enabled later by clicking Validate Sequence in the
'Number Generation Definition' section.

c. If 'Xref/External Application number/Application Number' is enabled, then system
sequence is not mandatory.

d. Ensure that the Length of all units + Check Digit (if enabled) together should not be
greater than the Max Length at the parent record.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4
Product

Under the Setup master tab’s drop-down link bar, the product Setup link opens screens that
enable you to configure the basic business guidelines necessary to support one or more
products in the system. This includes defining the types of collateral your company supports,
creating lending instruments, and determining what is included in credit bureau reporting.
Setting up the Products screens requires a thorough understanding of the current rules of your
business and must be completed before you can use Oracle Financial Services Lending and
Leasing. The Products drop-down link opens screens to record data of all the products
supported by the system and contains the following links:

Navigating to Products

In the Setup > Setup > Products link enables you to setup the options related to the following
closed ended products that your company offers. Below sections explain how to setup the
screens associated with each one.

• Asset Types

• Index Rates

• Regulatory Rates

• Currency Exchange

• Scoring Parameters

• Products

• Pricings

• Contract

• Edits

• Cycles

• Scoring Models

• Fees

• Asset Billing Rate

• Origination Fees

• Compensation

• Commission

• Insurance

• Checklists

• Stipulations

• Spreads

• Statement Messages

• Letters

• Promotions
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• Subvention

• Escrow

4.1 Asset Types
In Assets types you can setup the asset types that can serve as an application or account’s
collateral. In addition, you can also define USAGE/RENTAL details along with USAGE/
RENTAL charge matrix to facilitate usage billing calculation for Leased/Rented asset types.

The information on the Assets screen is used by the system to automatically display the
appropriate collateral screen (Vehicle, Home, or Other) on the Application Entry screen.

The system recognizes the following four types of collateral:

Table 4-1    Collateral

Collateral Type Description

Home collateral Homes, manufactured housing, or any real estate
collateral.

Vehicle collateral All vehicle types, such as cars, trucks, and
motorcycles.

Household goods and other collateral All other collateral types not defined as home,
vehicle, or unsecured; for example, household
items such as water heaters, televisions, and
vacuums.

Unsecured collateral All unsecured lending instruments. (This collateral
type makes the collateral tabs on the system forms
unavailable.)

The Asset Sub Type section allows you to further categorize an asset; for example, the asset
type VEHICLE might be categorized as CAR, TRUCK, or VAN.

The Attributes/Addons and Makes and Models sub screens continue to further detail the asset
both in description and value. For example, a VEHICLE asset might include addons such as
LEATHER SEATS and CRUISE CONTROL.

Note

Neither asset types nor asset sub types can be deleted. As they may have been used
in the past, the display and processing of that data is still dependent on the existing
setup.

To set up the Asset Types

You can either define new Asset Type or specify a new name in the New Asset Type field and
click Create Copy to create a copy of selected asset with details.

1. Click Setup > Setup > Products > Asset Types.

2. In the Asset Type section, perform any of the Basic Operations mentioned in Navigation
chapter.
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Figure 4-1    Asset Type

A brief description of the fields is given below:

Table 4-2    Asset Type

Field Do this

Asset Type Specify the asset type.

Description Specify the description for the asset. (This is the
asset type which will appear throughout the
system).

Collateral Type Select the collateral type (the general category
that the asset type falls within) from the drop-
down list.

Note: There is no need to define an asset for
UNSECURED COLLATERAL, as by definition
there is no asset on such account.

Company Select the portfolio company to which the asset
type belongs, from the drop-down list. These are
the companies within your organization that can
make LoanLineLease using this asset type. This
may be ALL or a specific company.
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Table 4-2    (Cont.) Asset Type

Field Do this

Branch Select the portfolio branch to which the asset
type belongs, from the drop-down list. This is the
branch within the selected company that can
make LoanLineLease using this asset type. This
may be ALL or a specific branch. This must be
ALL if in the Company field you selected ALL.

IMPORTANT: By selecting which asset type to
use, the system searches for a best match using
the following attributes:

1. Company

2. Branch

Hence, the system recommends creating one
version of each asset type where ALL is the
value in these fields.

Enabled Check this box to enable the asset type and
indicate that the asset type is currently in use.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Asset Sub Type section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-3    Asset Sub Type

Field Do this

Asset Sub Type Specify the asset sub type.

Description Specify the description for the asset subtype.

Asset Property Type Select the type of property from the drop-down
list.

Enabled Check this box to enable the asset sub type.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click Setup > Setup > Products > Assets > Attributes/Addons.

7. In the Attributes/Addons section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-4    Attributes/Addons

Field Do this

Attribute/Addon Displays the asset attribute or addon name for
the selected asset).

Description Select the description for the asset attribute/
addon from the dropdown list.

Default Specify the default text to be copied or displayed
when the asset attributes and addons fields are
completed on an application for this asset.
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Table 4-4    (Cont.) Attributes/Addons

Field Do this

Value Specify the default monetary value to be copied
or displayed when the asset attributes and
addons fields are completed on an application for
this asset.

Enabled Check this box to enable the asset attribute/
Addon and indicate that it is available for this
type of asset.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Click the Setup > Setup > Products > Assets > Makes and Models.

10. In the Makes and Models section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-5    Makes and Models

Field Do this

Make Specify asset make.

Model Specify asset model.

Style Specify asset style type.

Model Year Specify asset model year.

Enabled Check this box to enable the asset make and
model and indicate that it is included on fields for
this asset type.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

This section consists of the following topics:

• Usage/Rental Details

• Usage Charge Matrix

• Rental Charge Matrix

4.1.1 Usage/Rental Details
The Usage / Rental Details sub tab allows you to define Usage/Rental definition details to
categorize the incoming asset usage/rental data based on different parameters. The details
maintained here are populated in Origination screen for billing calculation and can also be
modified based on requirement.

For more information on how OFSLL handles Usage based leasing, refer to #unique_222
chapter and for Rental based leasing, refer to Rental Agreement section in Lease
OriginationServicingCollections User Guide.

1. In the Usage/Rental Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

2. A brief description of the fields is given below:
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Table 4-6    Usage/Rental Details

Field Do this

Agreement Type Select the agreement type as one of the
following from the drop-down list. The selected
Agreement Type defines the criteria for pricing
selection during billing calculation.
• USAGE
• RENTAL
• USAGE RENTAL

Note: Based on the above selected option, the
other fields are either enabled or disabled for
selection as indicated below:

For Usage Agreement Type, the following fields
are editable:
• Calc Method
• Usage Cycle
• Min Usage
• Max Usage
• Discount %
• Usage Rollover / Advance
• Usage Term Calc Method

For Rental Agreement Type, the following fields
are editable:
• Discount %
• Discount Amount
• Security Deposit

For Usage Rental Agreement Type, the following
fields are editable:
• Usage Cycle
• Max Usage
• Discount %
• Discount Amount
• Security Deposit

Calc Method Select the calculation method as one of the
following from the dropdown list.
• TIERED (billing is based on the defined

Usage/Rental Charge Matrix)
• NON-TIERED (system automatically

chooses the applicable slab based on the
final usage value)

Usage Cycle Select the frequency of billing the asset usage
from the drop-down list. This field is disabled for
RENTAL agreement type.

Min Usage Specify the minimum usage value of the allowed
range. This field is disabled for RENTAL
agreement type.

Max Usage Specify the maximum usage value of the allowed
range. This field is disabled for RENTAL
agreement type.

Discount % Specify the percentage of discount exempted
from final billing.
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Table 4-6    (Cont.) Usage/Rental Details

Field Do this

Usage Rollover / Advance Select the type of asset usage calculation as one
of the following:
• ROLLOVER (remaining usage balance is

carried forward to next cycle)
• NO-ROLLOVER (remaining usage balance

is not carried forward)
• ROLLOVER AND ADVANCE (remaining

usage balance is carried forward to next
cycle + total usage limit for current cycle can
be utilized upfront)

• ADVANCE (total usage limit for current cycle
can be utilized upfront)

Note: This field is disabled for RENTAL and
USAGE RENTAL agreement type and NO-
ROLLOVER option is applicable by default.

Reset Frequency Specify the reset frequency of the billing cycle.
This field is disabled for RENTAL and USAGE
RENTAL agreement types and is available for
ROLLOVER, ADVANCE and ROLLOVER AND
ADVANCE methods of asset usage billing.

Usage Term Calc Method Select the type of asset usage term for billing
calculation as one of the following from the drop-
down list:
• ACTUAL - here the current details updated/

received is treated as the final record for
usage term calculation.

• AVERAGE - here system takes the average
of usage details received in previous cycles
for usage term calculation.

The calculation method selected here is
populated to Elastic Term Calc Method field in
Origination/Servicing Collateral screen. This field
is disabled for RENTAL and USAGE RENTAL
agreement type.

Discount Amount If you are defining Usage/Rental Details for
RENTAL or USAGE RENTAL type of
agreements, specify the discount amount
allowed upfront from the final billing. This field is
disabled for USAGE agreement type.

Security Deposit If you are defining Usage/Rental Details for
RENTAL or USAGE RENTAL type of
agreements, specify the security deposit amount
paid upfront for the term. This field is disabled for
USAGE agreement type.

Excess Rent Collection Method If you have selected the Agreement Type as
USAGE RENTAL, select one of the following type
of Charge Matrix to be used to derive the Excess
Rent Collection Method from the drop-down list.
• USING USAGE MATRIX
• USING RENTAL MATRIX

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.1.2 Usage Charge Matrix
The Usage Charge Matrix sub tab allows you to define and maintain different chargeable slabs
based on the combination of Billing Cycle and Charge Type. The details maintained here are
used for billing calculation based on a particular asset usage.

For more information on how OFSLL handles Usage based leasing, refer to #unique_222
chapter and for Rental based leasing, refer to Rental Agreement section in Lease
OriginationServicingCollections User Guide.

1. In the Usage Charge Matrix section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-7    Usage Charge Matrix

Field Do this

Billing Cycle Select the frequency of the billing cycle for the
asset from the drop-down list.

Units From Specify the minimum number of units from which
the current usage charge matrix is applicable.

Charge Per Unit Specify the amount to be charged for every unit.

Charge Type Select the Charge Type as one of the following
from the drop-down list. The list is displayed
based on CHARGE_TYPE_CD lookup.
• BASE (Units considered as base and

chargeable at base rate)
• EXCESS CYCLE (Units beyond base units

and chargeable considering excess cycle)
• EXCESS LIFE (Units exceeding the total

contracted units and chargeable considering
excess life cycle)

Excess life is not applicable for Rental agreement
type.

Enabled Check this box to enable the charge matrix for
usage calculation.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

4.1.3 Rental Charge Matrix
The Rental Charge Matrix sub tab allows you to define and maintain different chargeable slabs
based on the combination of Billing Cycle, Rental Duration, Charge Per Cycle and Charge
Type. The details maintained here are used for billing calculation based on a particular asset
usage.

For more information on how OFSLL handles Usage based leasing, refer to #unique_222
chapter and for Rental based leasing, refer to Rental Agreement section in Lease
OriginationServicingCollections User Guide.

1. In the Rental Charge Matrix section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 4-8    Rental Charge Matrix

Field Do this

Billing Cycle Select the frequency of the billing cycle for the
asset from the drop-down list.

Rental Duration From Specify the minimum duration for which the
rental charge is applicable.

Charge Per Cycle Specify the amount to be charged for every
rental cycle.

Charge Type Select the Charge Type as one of the following
from the drop-down list. The list is displayed
based on CHARGE_TYPE_CD lookup.
• BASE (Chargeable units exceeding from

base units allowed)
• EXCESS CYCLE (Chargeable units

exceeding from billing cycle units)
• EXCESS LIFE (Chargeable units exceeding

the total contract term)

Excess life is not applicable for Rental / Usage,
Rental agreement types.

Enabled Check this box to enable the charge matrix for
usage calculation.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

4.2 Index Rates
The Index Rates screen maintains your organization’s history of periodic changes in index
rates. It allows you to define index rates to support variable rate lines of credit. The index rate
provides the base rate for a credit line where:

interest rate = index rate + margin rate.

The Index section displays the currently defined indexes on the Lookups screen. You may
create additional user-defined lookup codes for this lookup type as needed.

Note

You cannot tie an index rate to a product rate.

You can also record any index rate change on the Index Rates screen. During nightly batch
processing, all the accounts with that index type are included when posting the RATE
CHANGE transaction. After the system processes the batch, the interest rate of the account is
changed. The system will use this new interest rate when computing all future interest
calculations.

To set up Index Rates

1. Click Setup > Setup > Products > Index Rates.

2. In the Index section, perform any of the Basic Operations mentioned in Navigation
chapter.:
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Figure 4-2    Index Rates

3. A brief description of the fields is given below:

Table 4-9    Index

Field Do this

Index Type Select the type of index from the drop-down list.

Short Description Specify a short description of the index.

Description Specify the index description.

Enabled Check this box to activate the index type.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
The Index Details section allows you to define multiple index values using the Start Dt and
Rate fields.

Note

The history appears in descending order, with the most current record at the top.

5. In the Index Details section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 4-10    Index Details

Field Do this

Start Dt Specify the effective start date for the index rate.
You can even select the date from the adjoining
Calendar icon.

Rate Specify the new index rate effective from above
mentioned date as a percentage.

Note: For the FLAT RATE index there should be
only one entry with a Start Dt. = 01/01/1900 and
a RATE = 0.0000.
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Table 4-10    (Cont.) Index Details

Field Do this

Enabled Check this box to activate the index rate effective
from start date mentioned above.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Variable rate functionality is not extended to pre-compute accounts.

4.3 Regulatory Rates
Regulatory rate is the interest rate offered while funding a loan contract which may or may not
vary from the contract rate (market rate). The regulatory rates tab allows you to maintain
various regulatory rate definitions with specific interest rates and criteria which are used in
Origination > Contract screen while defining a loan contract with imputed interest. For more
information, refer to Imputed Interest section in Loan Origination User guide.

To set up Regulatory Rates

1. Click Setup > Setup > Products > Regulatory Rates.

2. In the Regulatory Rates Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

Figure 4-3    Regulatory Rates Definition

3. A brief description of the fields is given below:

Table 4-11    Regulatory Rates Definition

Field Do this

Regulatory section
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Table 4-11    (Cont.) Regulatory Rates Definition

Field Do this

Name Specify an unique name for the regulatory rate
definition. This field is not editable once you save
the record.

Description Specify a description for the regulatory rate
definition.

Start Dt Select the start date from when the regulatory
rate definition is effective using the adjoining
calendar.

End Dt Select the end date up to when the regulatory
rate definition is effective using the adjoining
calendar.

Enabled Check this box to enable the regulatory rate
definition.

Rate Specify the regulatory interest rate to be used for
calculation. The rate specified here is populated
to Origination > Contract screen while defining
loan contract with imputed interest.

Selection Criteria section

Company Select the company for the instrument from the
drop-down list. This may be ALL or a specific
company.

Branch Select the branch within the company for the
instrument from the drop-down list. This may be
ALL or a specific branch. This must be ALL, if
you have selected ALL in the Company field.

Billing Cycle Select the billing cycle frequency for the
instrument as one of the following from the drop-
down list.
• MONTHLY (Default)
• WEEKLY
• BI WEEKLY
• QUARTERLY
• SEMI ANNUAL
• ANNUAL

Product Select the product for the instrument from the
drop-down list. This may be ALL or a specific
product defined in the system.

Asset Class Select the asset class for the instrument from the
drop-down list. This may be ALL or a specific
asset class. The list is populated based on Class
setup defined in the system.

Asset Type Select asset type for the instrument from the
drop-down list. This may be ALL or a specific
asset type. The list is populated based on Asset
Types setup defined in the system.

Sub Type Select the asset sub type for the instrument from
the drop-down list. This may be ALL or a specific
asset sub type. The list is populated based on
Asset Types setup defined in the system.

Asset Make Specify the asset make from the drop-down list.
If ALL was selected for either Asset Type or
Asset Sub Type, then ALL will be the only
available option for selection.
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Table 4-11    (Cont.) Regulatory Rates Definition

Field Do this

Asset Model Specify the asset model from the drop-down list.
If ALL was selected for either Asset Type or
Asset Sub Type, then ALL will be the only
available option for selection.

State Select the state for the instrument from the drop-
down list. This may be ALL or a specific state.

Currency Select the currency for the instrument from the
drop-down list. This may be ALL or a specific
currency.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

4.4 Currency Exchange
The Currency Exchange screen maintains currency exchange rates. You can define the
currency exchange details and schedule a batch job (SET-IFP- ICEPRC_BJ_100_01 -
CURRENCY EXCHANGE RATE FILE UPLOAD) which in-turn pulls the currency exchange
rates from desired source at scheduled intervals through input file processing.

To set up the Currency Exchange

1. Click Setup > Setup > Products > Currency Exchange.

2. In the Currency Exchange Rates section, perform any of the Basic Operations mentioned
in Navigation chapter.

Figure 4-4    Currency Exchange Rates

A brief description of the fields is given below:

Chapter 4
Currency Exchange

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 13 of 174



Table 4-12    Currency Exchange Rates

Field Do this

Currency Select the currency being exchanged from the
drop-down list.

Currency Pair Select the currency to be paired with from the
drop-down list.

Effective Date and Time Specify date and time of the exchange rate. You
can even select the date from the adjoining
Calendar icon.

Rate Specify the exchange rate (required).

Enabled Check this box to activate the currency exchange
rate.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.5 Scoring Parameters
With the Scoring Parameters, you can define the scoring parameters of a company’s credit
scorecard and behavioral scoring.

The system’s pricing scores apply to applications and are based on information recorded
during origination.

The behavioral scoring applies to accounts and is based on account history attributes and
performed on a monthly basis.

Behavioral scoring

Behavioral scoring examines the repayment trends during the life of the account and provides
a current analysis of the customer. This logical and systematic method identifies which
accounts are more likely to perform favorably versus accounts where poorer performance is
probable. This is useful when determining which other LoanLines of creditLease products a
customer may qualify for. However note that, Behavioral scoring applies to all the three
products: loans, lines of credit and leases.

This information appears on the Customer Service screen in the Account Details screen’s
Activities section.

Credit Scoring

Parameters define the factors that can be used when scoring an application during
underwriting and generating an initial decision on whether you wish to fund an amount. The
combination of the flexible definition of these parameters, along with the scoring set up on the
Scoring Models screen, allows you to automate much of the initial decision process in
underwriting accounts.

The Formula Definition section on the Scoring Parameters screen allows you to build a
mathematical expression to express the scoring parameter, test its validity, and locate specific
information with the resulting scoring parameters. The system calculates scoring parameters
using application data, credit bureau information, and applicant details.

To set up the Scoring Parameters

You can either define new Scoring Parameters or specify a new name in the New Parameter
field and click Create Copy to create a copy of selected parameter with details.

1. Click Setup > Setup > Products > Scoring Parameters.
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2. In the Parameters section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 4-5    Parameters

A brief description of the fields is given below:

Table 4-13    Parameters

Field Do this

Parameter Specify the name of the scoring parameter. The
system recommends entering a name that in
some way reflects how the parameter is used; for
example, use FICO_SCORE instead of
PARAMETER_1.

Description Specify a description of the parameter. Again,
Specify a name that reflects how the parameter
is used; for example, use FICO SCORE and
WEIGHTED FICO SCORE instead of FICO
SCORE NUMBER 1 and FICO SCORE
NUMBER 2.

Data Type Select the data type of the scoring parameter
being defined from the drop-down list. This
determines how the system handles the values.
(While DATE and CHARACTER are available
data types, generally only NUMBER should be
used when defining a scoring parameter.

Scoring Type Select the scoring type from the drop-down list:
CREDIT SCORING or BEHAVIORAL SCORING.

Enabled Check this box to enable and indicate that the
scoring parameter is available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The Formula Definition section allows you to define a mathematical expression of the
scoring parameter you want to define. The expression may consist of one or more
sequenced entries. All arithmetic rules apply to the formula definition. If errors exist in the
formula definition, the system displays an error message in this section when you choose
Show Expression.

Chapter 4
Scoring Parameters

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 15 of 174



4. In the Formula Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-14    Formula Definition

Field Do this

Seq Specify the sequence number (the order in which
the formula definition variable will be assembled
and evaluated).

( Specify a left bracket, if you need to group part of
your formula definition.

Variable Select the variable from a validated field based
on the user-defined table
SCR_CRED_SUMMARY: SCORING
PARAMETERS, from the drop-down list.

Constant Value Specify the constant value (optional).

You can specify varchar values which includes
Numbers, Alphabets/ letters, special character/
symbols.

Mathematical Operator Select the math operator to be used on the
adjacent formula definition rows, from the drop-
down list.

) Specify a right bracket, if you are grouping part
of your formula definition.

Enabled Check this box to enable the formula and
indicate that it is included when building a
definition for the scoring parameter.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Parameters section, click Show Expression.
The mathematical expression appears in the Formula Expression section (in sequential
order) in the Expression field.

4.6 Products
The Product screen defines the closed ended products your organization offers. This screen is
enhanced to support Islamic along with the conventional.

A product is based on the following attributes:

• The collateral type and sub type

• The billing cycle

• Whether the amount is paid directly or indirectly to the customer

The Product Definition section records details about the product such as the description, start
and end dates, collateral type and sub type, credit bureau reporting attributes, billing cycle,
index and rate calculation attributes.

System supports Biennial (once every 2 years) and Triennial (once every 3 years) type of
billing cycles. Based on the following lookups, the billing cycle frequency can be defined:

• BILL_CYCLE_CD

• LEASE_BILL_CYCLE_CD - For lease accounts, the Biennial and Triennial billing cycles
are applicable only for Interest Rate type of Calculation Method and for both Advance and
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Arrears type of Rent Collection Methods. However, these billing cycles are allowed for
Balloon Method - N+1 and not allowed for Flexible repayment > Skip Months and for
Agreement type, Usage, Rental, Rental Usage types.

• LOAN_BILL_CYCLE_CD - For Loan accounts, the Biennial and Triennial billing cycles are
applicable only for Standard Product Category and for both Advance and Arrears type of
Rent Collection Methods - Advance (if First Payment Date is equal to Contract Date) and
Arrears (if First Payment Date is greater than Contract Date). However, these billing cycles
are allowed for Balloon Methods N and N+1 and not allowed for Flexible repayment >
Skip Months.

• LOC_BILL_CYCLE_CD - for Line of Credit accounts.

For a lease product definition, the calculation is based on either Rent Factor or Interest Rate
and Contract and Pricing definition will be driven depending on one of the above option
selected.

The Product Itemization section is used to define itemized entries for a product. This
information is used on the Itemization sub screens of the Application Entry and Application
screens.

The Rate Adjustments section is used to define the frequency of rate change allowed during
interest rate calculations.

To set up the Product

You can either define new Product details or specify a new product code in the New Product
field and click Create Copy to create a copy of selected product with details.

1. On the Oracle Financial Services Lending and Leasing home screen, Setup > Setup >
Administration > User > Products > Products > LoanLineLease.

2. In the Product Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-6    Product Definition
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Figure 4-7    Product Definition

Figure 4-8    Product Definition

A brief description of the fields is given below:

Table 4-15    Product Definition

Field Do this

Product Specify the product code as defined by your
organization (in other words, how you want to
differentiate the products). For example, products
can be differentiated according to asset. The
product code, or name, is unique.
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Table 4-15    (Cont.) Product Definition

Field Do this

Description Specify the description of the product. (This is
the product description as it appears throughout
the system).

Start Dt Specify the start date for the product. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for the product. You can
even select the date from the adjoining Calendar
icon.

Direct Check this box, if you need the product to be
originated directly to customer. (In this case, the
compliance state is the state listed in the
customer’s current mailing address.) If
unchecked, the product is an indirect lending
product; that is, payment is made to the
producer. (In this case, the compliance state is
the state listed in the producer’s address.)

Flexible Repayment Check this box to allow flexible repayment for the
Product. When you check this check box, the
Flexible Repayment Allowed box of Repayment
Options section available under Funding tab >
Contract sub tab > Replacement sub tab of
Funding screen.

Note: On the Repayment sub screen of Contract
link on Funding screen, you may only enter the
desired repayment schedule type in the
Repayment section’s Type field if the Flexible
Repayment Allowed is selected.

Close Account After Paid- Off Check this box to allow the account to be closed
once the account is paid off i.e. system closes
the account after the number of days specified in
the system parameter has elapsed. This option is
selected by default.

If not selected, system ignores the system
parameter and does not close the account even
if the account is paid off i.e. system keeps the
accounts active so that the equity can be traded
with other accounts. For information on accounts
trading, refer to Appendix - Trading of
Accounts chapter.

Note: If the business practice of a financial
institution is not to close the accounts then this
Indicator need to be unchecked. Mainly in the
Vacation Ownership where a Timeshare product
can be traded anytime even if the account is
paid-off, this feature is used.

Customer Credit Limit Check this box to enable Customer Credit Limit
tab in Origination module. Using the Customer
Credit Limit tab, an underwriter can define a
specific credit limit for the customer while funding
the first application and based on that credit limit,
subsequent applications can be funded.

For more information, refer to Customer Credit
Limit details in User Guide.
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Table 4-15    (Cont.) Product Definition

Field Do this

Same Billing Cycle Check this box to set the same billing cycle
(supported only billing cycles Monthly and
Weekly) for all the future applications funded for
an existing customer.

Enabled Check this box to activate the product.

Note: You can check this box only when Rate
adjustment schedule is maintained, i.e., All the
products should be variable rate products.

Skip Credit Bureau Reporting Check this box to skip credit bureau reporting of
all Accounts funded with this product type - i.e.
on funding an application, that particular account
is enabled with this parameter and is excluded
when the metro II batch job is run for credit
bureau reporting.

This option can also be enabled/disabled at
individual account level in Servicing by posting
Skip Credit Bureau Reporting Maintenance
nonmonetary transaction.

However note that existing behaviour of Stop
Bureau Account condition would still be
applicable.

Collateral Type Select the collateral type for the product, from the
drop-down list. This field identifies what type of
collateral is associated with the and assists the
system in identifying the correct screen(s) to
display.

Collateral Sub Type Select the collateral sub type for the product,
from the drop-down list.

Credit Bureau Portfolio Type* Select the credit bureau portfolio type for the
product, from the dropdown list.

Credit Bureau Account Type* Select the account type for the product, from the
drop-down list.

*Note: The Credit Bureau Portfolio Type and
Credit Bureau Account Type fields determine
how the portfolio is reported back to the credit
bureaus.

Billing Cycle Select the billing cycle for the product, from the
drop-down list.

Note: This field is not editable and the billing
cycle is selected as MONTHLY by default if the
lease calculation method is selected as RENT
FACTOR.

Category Select the category as Standard for the
conventional product and Islamic for the Islamic
product, from the drop-down list. This serves to
group products for reporting purposes. By default
the category of the product is selected as
STANDARD and is not editable.

Calculation Parameters: This section allows you to define the parameters for lease calculation
starting from choosing the calculation method.
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Table 4-15    (Cont.) Product Definition

Field Do this

Calculation Method Select the type of lease calculation method as
one of the following:
• RENT FACTOR (selected by default)
• INTEREST RATE

If the lease calculation method is selected as
Interest Rate, the following fields are enabled in
the screen and also the Rate Adjustments sub
tab is available to specify the details:
• Flexible Repayment
• Index Rounding
• Reschedule Method
• Reschedule Value

Flexible Repayment Check this box to allow flexible repayment for the
Product. When you check this check box, the
Flexible Repayment Allowed box of Repayment
Options section available under Funding tab >
Contract sub tab > Replacement sub tab of
Funding screen.

Note: On the Repayment sub screen of Contract
link on Funding screen, you may only enter the
desired repayment schedule type in the
Repayment section’s Type field if the Flexible
Repayment Allowed is selected.

Index Rounding Select the index rate rounding factor for the
product, from the drop-down list.

Note: For more information, refer Appendix C:
Rounding Amounts and Rate Attributes.

Reschedule Method Select the rate change reschedule method for
the variable rate product, from the drop-down list.
Select CHANGE PAYMENT, if you want to
automatically recalculate the repayment amounts
on the interest rate change. Select UNDEFINED
(the default value), if you do not want to take any
action on interest rate change.

Reschedule Value Specify the value in percent (%) to decide the
repayment change. For example, if you enter 10,
then the periodic repayment amount will change
only if the newly computed repayment amount is
higher by 10% of the previous repayment
amount. Specify 0 if you want to change
repayment amounts with every index rate
change.
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Table 4-15    (Cont.) Product Definition

Field Do this

Agreement Type If you have selected the Collateral Type as
either VEHICLE COLLATERAL or HOUSEHOLD
GOODS AND OTHER COLLATERAL, you can
select one of the following types of lease
agreement from the drop-down list for further
calculation:
• USAGE
• RENTAL
• USAGE RENTAL

Note: For each Usage or Rental details defined
in Asset Type screen, you can define only one
record for each asset type (i.e. one for Usage
and one for Rental).

Based on the selected option, OFSLL handles
the lease calculation and billing. For more
information on Usage based leasing, refer to 
#unique_222 chapter and for Rental based
leasing, refer to Rental Agreement section in
Lease Origination User Guide.

Skip User Parameters Calculation Select this check box to exclude accounts from
target parameter calculation.

If unchecked, system picks-up the account
during the processing of following batch jobs:
• CUPACC_BJ_111_01 (LOAN)
• CUPACC_BJ_112_01 (LINE)
• CUPACC_BJ_121_01 (LEASE)

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

The 'Reschedule Method' and 'Reschedule Value' fields allows you to define and
control the changes in loan paymentlease amount for Variable and Fixed rate
loanslease during originating, funding, and servicing. For more information, refer 
#unique_223.

This section consists of the following topics:

• Product Itemizations

• Rate Adjustments

4.6.1 Product Itemizations
1. Click Setup > Setup > Administration > User > Products > Products > LoanLineLease

> Product Itemizations.

2. In the Product Itemization sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 4-16    Product Itemization

Field Do this

Itemization Select the itemization type for the product
selected in product definition section, from the
drop-down list.

Discount Rate Specify the discount rate.

Sort Specify the sort order.

Sign Select +ve for a positive number and -ve for a
negative number.

Note: The +ve and -ve buttons determine
whether the values will increase or decrease the
itemization total for the product based on the
selected product. Together the contents of the
Product Itemization sub screen, positive and
negative, add up to the amount.

Enabled Check this box to indicate that this product
itemization is currently available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.6.2 Rate Adjustments
The Rate Adjustment sub tab is enabled for lease calculation based on Interest Rate.

1. Click Setup > Setup > Administration > User > Products > Products > LoanLease >
Rate Adjustments.

2. On the Rate Adjustments sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-17    Rate Adjustments

Field Do this

Seq Specify the sequence number of the rate change
adjustments. Consider 1 as the initial (first) rate
change adjustment frequency. All subsequent
frequencies will be considered for rate change
adjustments according to their sequence
number.

Adjustment Frequency Select the frequency value for adjustments, from
the drop-down list. Currently, the following values
are available in the system:

RATE CHANGE OCCURS EVERY X YEARS

RATE CHANGE OCCURS EVERY X MONTHS

RATE CHANGE OCCURS EVERY X DAYS

RATE CHANGE OCCURS EVERY BILLING
DATE

RATE CHANGE OCCURS EVERY DUE DATE

RATE CHANGE OCCURS AT MATURITY
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Table 4-17    (Cont.) Rate Adjustments

Field Do this

Period Specify the period associated to adjustment
frequency. For example, if you select the
adjustment frequency as RATE CHANGE
OCCURS EVERY X YEARS and enter 5, the
rate change occurs every five years.

# of Adjustments Enter the number of adjustments associated with
the adjustment frequency. For example, in above
example, if you enter the value as 2, then rate
payment adjustment occurs on the product every
five years and will happens 2 times before
switching to the next adjustment frequency.

Enabled Check this box to indicate that this rate
adjustment is currently available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.7 Pricings
The Pricing screen records pricing information related to your products. the system uses the
information in the Pricing Definition section to identify the correct pricing for an application,
depending upon the product and the specific application parameters. the system will always
search for a unique match.

When you choose the Select Pricing while making a decision on the Underwriting window,
the system displays the best match and completes the Pricing and Approved sections under
Summary sub tab. The information in the Approved section cite the minimum amounts for the
selected product, though the user can edit these figures.

The system determines the best match by looking at all enabled pricing strings on the Pricing
screen that meet the following criteria:

• Exactly match the application values for the Promotion and Billing Cycle fields.

• Are less than or equal to the application values for the Term, Amount, Age, and Start Date
fields.

• Match either the application value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches of ALL. The returned
rows are then ranked based on the weighted values and the hierarchical position of the field
(see above). They are then ranked by start date. The system recognizes the first row returned
as the best match.
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Note

• You should set up a default pricing for each billing cycle and pricing that the
system can select to ensure error-free performance. Oracle Financial Services
Software recommends creating a single version of each edit type, where ALL is
the value in the selection criteria fields listed above. If the system cannot find a
pricing match, it will display an error message.

• The system supports the bulk uploading of product pricing setup data. This allows
you to upload multiple setup data, avoid re-entering setup data, and more
importantly, reduce data entry mistakes. The system currently supports uploading
using a fixed-length format only, where each data is at a pre-fixed position. You
can run batch jobs with the Set Code SET-BLK to upload pricing and GL data.

System supports Biennial (once every 2 years) and Triennial (once every 3 years) type of
billing cycles. Based on the following lookups, the billing cycle frequency can be defined:

• BILL_CYCLE_CD

• LEASE_BILL_CYCLE_CD - For lease accounts, the Biennial and Triennial billing cycles
are applicable only for Interest Rate type of Calculation Method and for both Advance and
Arrears type of Rent Collection Methods. However, these billing cycles are allowed for
Balloon Method - N+1 and not allowed for Flexible repayment > Skip Months and for
Agreement type, Usage, Rental, Rental Usage types.

• LOAN_BILL_CYCLE_CD - For Loan accounts, the Biennial and Triennial billing cycles are
applicable only for Standard Product Category and for both Advance and Arrears type of
Rent Collection Methods - Advance (if First Payment Date is equal to Contract Date) and
Arrears (if First Payment Date is greater than Contract Date). However, these billing cycles
are allowed for Balloon Methods N and N+1 and not allowed for Flexible repayment >
Skip Months.

• LOC_BILL_CYCLE_CD - for Line of Credit accounts

To set up the Pricing

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Pricings > LoanLineLease.

2. In the Pricing Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-9    Pricings

Figure 4-10    Pricings
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Figure 4-11    Pricings

A brief description of the fields is given below:

Table 4-18    Pricing Definition

Field Do this

Pricing* Specify the code for the pricing.

Description* Specify the description for the pricing.

* Together these two fields define the name of the pricing.

Start Dt Specify the start date for this pricing. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for this pricing. You can
even select the date from the adjoining Calendar
icon.

Enabled Check this box to enable the pricing.

Result section - You can create edits during implementation to note when amounts in applications
are outside the range of tolerance.

Max Loan Amt Specify the maximum amount financed for this
rate pricing.

Max Term Specify the maximum term financed for this rate
pricing.

Buy Rate Specify the buy rate.

Index Select the index type associated with this rate
pricing from the drop-down list.

Rate From Specify the minimum rate allowed for loans using
this rate pricing.

Rate To Specify the maximum rate allowed for using this
variable rate pricing.

Maturity Index Select the maturity index type associated with
this variable rate pricing from the drop-down list.
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Table 4-18    (Cont.) Pricing Definition

Field Do this

Maturity From Specify the lowest maturity rate allowed for loans
using this variable rate pricing. Maturity rate is
the rate to be charged on the product if it
remains unpaid after its last term has been billed.

Maturity To Specify the maximum maturity rate allowed for
products using this pricing.

Profit Rate From Specify the minimum profit rate allowed for the
product using this pricing.

Note: This field will be displayed only if you
select the category as Islamic in the Product
screen.

Profit Rate To Specify the maximum profit rate allowed for the
loan using this pricing.

Note: This field will be displayed only if you
select the category as the Islamic in the Product
screen.

Selection Criteria - allows you to specify pricing at different levels and determine how the system
matches specific pricing to the applicant’s request.

Company Select the portfolio company for this pricing, from
the dropdown list. This may be ALL or a specific
company.

Branch Select the portfolio branch for this pricing. This
may be ALL or a specific branch. (This must be
ALL if in the Company field you selected ALL),
from the drop-down list.

Billing Cycle Select the billing cycle for this pricing, from the
drop-down list.

Product Select the product for this pricing, from the drop-
down list. This may be ALL or a specific product.
The available values come from a validated field
based on the selected billing cycle and the
product setup.

State Select the state for this pricing, from the drop-
down list. This may be ALL or a specific state.

Pro Group Select the producer group for this pricing, from
the drop-down list. This may be ALL or a specific
producer group.

Pro Type Select the producer type for this pricing, , from
the drop-down list. This may be ALL or a specific
producer type.

Producer Region Select the region of the producer.

Producer Territory Select the territory of the producer.

Producer Select the producer from the drop-down list. This
may be ALL or a specific producer. The available
values come from a validated field based on the
product group and product type.

Grade Select the credit grade for this pricing, from the
drop-down list. This may be ALL or a specific
grade.

Amt Specify the minimum amount financed for this
pricing.
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Table 4-18    (Cont.) Pricing Definition

Field Do this

Loan Term Specify the minimum term for this pricing.

Asset Class Select the asset class from the drop-down list.
This may be ALL or a specific asset class. The
available values come from a validated field
based on the collateral type. You may create
additional user-defined lookup codes for these
lookup types as needed.

Asset Type Select the asset type from the drop-down list.
This may be ALL or a specific asset type. The
available values come from a validated field
based your assets setup.

SubType Select the asset sub type from the drop-down
list. This may be ALL or a specific asset sub
type. The available values come from a validated
field based your assets setup, and is linked to the
selected asset type.

Asset Make Select the asset make from the drop-down list.
The available values come from a validated field
based your assets setup and is restricted based
on the selected Asset Type and Asset Sub Type.
For example, If ALL was selected for either Asset
Type or Asset Sub Type, then ALL will be the
only available selection for the asset make.

Asset Model Select the asset model from the drop-down list.
The available values come from a validated field
based your assets setup, and is restricted based
on the selected Asset Type and Asset Sub Type.
If ALL was selected for either Asset Type or
Asset Sub Type, then ALL will be the only
available selection for the asset model.

Age Specify the asset age (the minimum age for the
selected pricing).

Note: If your entry in this field is based on the
number of years of age of the asset and not the
actual year of make, you must update this entry
annually to ensure that the proper pricing is
available.

Trade-In Specify if there is a trade in of an asset by
selecting Yes/No.

Mileage If there is a Trade-In of an existing asset, then
specify its mileage in km.

Currency Select the currency for this pricing, from the
drop-down list.

Promotion Select the promotion applicable to this pricing
from the dropdown list. The available values
come from a validated field based on the
promotions setup.

Subvention Select the subvention plan from the drop-down
list, if pricing is specific for any subvention plan.

Down Pmt Specify the down payment for the pricing.

Asset Value Specify the asset value.

LTV Specify the loan to value ratio.
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Table 4-18    (Cont.) Pricing Definition

Field Do this

Existing Customer Select one of the following options from the drop-
down list to define the applicability of the current
pricing definition:

ALL - Applicable to both existing and new
customers

YES - Applicable to existing customer only

NO - Applicable to new customer only.

Note: This field refers to the Primary applicant
Existing Customer flag.

Existing Customer Since (In Years) Specify the duration from when customer was
created in the system up to the current date in
years.

Selection Criteria : Business - allows you to specify number of years in business and determines
how the system matches specific pricing to the business applicant's request.

Years In Business Specify the total number of years in business.

Table 4-19    Pricing Definition

Field Do this

Pricing* Specify the code for the pricing.

Description* Specify the description for the pricing.

* Together these two fields define the name of the pricing.

Start Dt Specify the start date for this pricing. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for this pricing. You can
even select the date from the adjoining Calendar
icon.

Enabled Check this box to enable the pricing.

Result section

Draw Period Specify the draw term for which this pricing is
valid.

Repmt Period Specify the repayment term for which this pricing
is valid.

Max Credit Specify the maximum credit Limit for this pricing.

Index Select the index type associated as FLAT/PRIME
RATE from the drop-down list.

Margin From Specify the minimum margin rate for the selected
index type.

Margin To Specify the maximum margin rate for the
selected index type.

Maturity Index Select the maturity index type associated as
FLAT/PRIME RATE from the drop-down list.

Maturity Margin Rt From Specify the minimum margin rate for the selected
maturity index type.

Maturity Margin To Specify the maximum margin rate for the
selected maturity index type.

Selection Criteria
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Table 4-19    (Cont.) Pricing Definition

Field Do this

Company Select the portfolio company for this pricing, from
the drop-down list. This may be ALL or a specific
company.

Branch Select the portfolio branch for this pricing. This
may be ALL or a specific branch. (This must be
ALL if in the Company field you selected ALL),
from the drop-down list.

Billing Cycle Select the billing cycle for this pricing, from the
drop-down list.

Product Select the product for this pricing, from the drop-
down list. This may be ALL or a specific product.
The available values come from a validated field
based on the selected billing cycle and the
product setup.

State Select the state for this pricing, from the drop-
down list. This may be ALL or a specific state.

Pro Group Select the producer group for this pricing, from
the drop-down list. This may be ALL or a specific
producer group.

Pro Type Select the producer type for this pricing, , from
the drop-down list. This may be ALL or a specific
producer type.

Producer Region Select the region of the producer.

Producer Territory Select the territory of the producer.

Producer Select the producer from the drop-down list. This
may be ALL or a specific producer. The available
values come from a validated field based on the
product group and product type.

Grade Select the credit grade for this pricing, from the
drop-down list. This may be ALL or a specific
grade.

Credit Limit Specify the minimum credit limit for which this
pricing is valid.

Asset Class Select the asset class from the drop-down list.
This may be ALL or a specific asset class. The
available values come from a validated field
based on the collateral type. You may create
additional user-defined lookup codes for these
lookup types as needed.

Asset Type Select the asset type from the drop-down list.
This may be ALL or a specific asset type. The
available values come from a validated field
based your assets setup.

SubType Select the asset sub type from the drop-down
list. This may be ALL or a specific asset sub
type. The available values come from a validated
field based your assets setup, and is linked to the
selected asset type.

Chapter 4
Pricings

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 31 of 174



Table 4-19    (Cont.) Pricing Definition

Field Do this

Asset Make Select the asset make from the drop-down list.
The available values come from a validated field
based your assets setup and is restricted based
on the selected Asset Type and Asset Sub Type.
For example, If ALL was selected for either Asset
Type or Asset Sub Type, then ALL will be the
only available selection for the asset make.

Asset Model Select the asset model from the drop-down list.
The available values come from a validated field
based your assets setup, and is restricted based
on the selected Asset Type and Asset Sub Type.
If ALL was selected for either Asset Type or
Asset Sub Type, then ALL will be the only
available selection for the asset model.

Age Specify the asset age (the minimum age for the
selected pricing).

Note: If your entry in this field is based on the
number of years of age of the asset and not the
actual year of make, you must update this entry
annually to ensure that the proper pricing is
available.

Trade-In Specify if there is a trade in of an asset by
selecting Yes/No.

Mileage If there is a Trade-In of an existing asset, then
specify its mileage in km.

Currency Select the currency for this pricing, from the
drop-down list.

Promotion Select the promotion applicable to this pricing
from the dropdown list. The available values
come from a validated field based on the
promotions setup.

Asset Value Specify the asset value.

LTV Specify the loan to value ratio.

Existing Customer Select one of the following options from the drop-
down list to define the applicability of the current
pricing definition:

ALL - Applicable to both existing and new
customers

YES - Applicable to existing customer only

NO - Applicable to new customer only.

Based on the selection criteria, system defaults
the first pricing for applications with Existing
customer flag = Y at primary applicant details.

Existing Customer Since (In Years) Specify the duration from when customer
account was created in the system up to the
current date in years.

Selection Criteria : Business - allows you to indicate the age of business by evaluating the total
number of years elapsed.

Years In Business Specify the total number of years in business.
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Table 4-20    Pricing Definition

Field Do this

Pricing* Specify the code for the pricing.

Description* Specify the description for the pricing.

* Together these two fields define the name of the pricing.

Start Dt Specify the start date for this pricing. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for this pricing. You can
even select the date from the adjoining Calendar
icon.

Enabled Check this box to enable the pricing.

Result section

Residual % From Specify the minimum residual percentage valid
with this pricing.

Residual % To Specify the maximum residual percentage
applicable with this pricing.

Index The index type associated with this rate pricing is
autopopulated based on lease calculation
method selected in Selection Criteria section.
The same is derived from INDEX_TYPE_CD
lookup.

Note: For RENT FACTOR calculation method,
only FLAT RATE index is applicable and is
selected by default.

Rate From Specify the minimum applicable rate.

Rate To Specify the maximum applicable rate.

Buy Rate Specify the buying rate.

Rent Factor From Specify the minimum money factor valid with this
pricing.

Note: This field is disabled if the lease calculation
method is selected as Interest Rate in Selection
Criteria section.

Rent Factor To Specify the maximum money factor valid with this
pricing.

Note: This field is disabled if the lease calculation
method is selected as Interest Rate in Selection
Criteria section.

Buy Rent Factor Specify the ratio of buy rent factor.

Note: This field is disabled if the lease calculation
method is selected as Interest Rate in Selection
Criteria section.

Maturity Index Select the maturity index type associated with
this variable rate pricing from the drop-down list.

Note: This field is disabled if the lease calculation
method is selected as Rent Factor in Selection
Criteria section.
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Table 4-20    (Cont.) Pricing Definition

Field Do this

Maturity From Specify the lowest maturity rate allowed using
this variable rate pricing. Maturity rate is the rate
to be charged on the product if it remains unpaid
after its last term has been billed.

Note: This field is disabled if the lease calculation
method is selected as Rent Factor in Selection
Criteria section.

Maturity To Specify the maximum maturity rate allowed for
products using this pricing.

Note: This field is disabled if the lease calculation
method is selected as Rent Factor in Selection
Criteria section.

Maximum Capital Cost Specify the maximum capital cost valid for this
pricing.

Maximum Term Specify the maximum term financed for this
pricing.

Selection Criteria

Company Select the portfolio company for this pricing, from
the drop-down list. This may be ALL or a specific
company.

Branch Select the portfolio branch for this pricing. This
may be ALL or a specific branch. (This must be
ALL if in the Company field you selected ALL),
from the drop-down list.

Calculation Method Select the type of lease calculation method for
this pricing as one of the following:
• RENT FACTOR (selected by default)
• INTEREST RATE
• AMORTIZED

Billing Cycle Select the billing cycle for this pricing, from the
drop-down list.

Note: The billing cycle is defaulted as Monthly if
the lease calculation method is selected as Rent
Factor.

Agreement Type Select the lease agreement type as one of the
following from the drop-down list. The selected
Agreement Type defines the criteria for pricing
selection during further calculation.
• USAGE
• RENTAL
• USAGE RENTAL

For more information on how OFSLL handles
Usage based leasing, refer to #unique_222
chapter and for Rental based leasing, refer to
Rental Agreement section in Lease Origination
User Guide.
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Table 4-20    (Cont.) Pricing Definition

Field Do this

Product Select the product for this pricing, from the drop-
down list. This may be ALL or a specific product.
The available values are filtered and displayed
based on the lease calculation method selected.

Note: Selecting ALL here refers to all the
products associated with the calculation method
and not to the total list of products maintained in
the system.

State Select the state for this pricing, from the drop-
down list. This may be ALL or a specific state.

Pro Group Select the producer group for this pricing, from
the drop-down list. This may be ALL or a specific
producer group.

Pro Type Select the producer type for this pricing, from the
drop-down list. This may be ALL or a specific
producer type.

Producer Region Select the region of the producer.

Producer Territory Select the territory of the producer.

Producer Select the producer from the drop-down list. This
may be ALL or a specific producer. The available
values come from a validated field based on the
product group and product type.

Grade Select the credit grade for this pricing, from the
drop-down list. This may be ALL or a specific
grade.

Gross Capital Cost Specify the minimum gross capital cost which is
valid for this pricing.

Lease Term Specify the minimum lease term for which this
pricing is valid.

Asset Class Select the asset class from the drop-down list.
This may be ALL or a specific asset class. The
available values come from a validated field
based on the collateral type. You may create
additional user-defined lookup codes for these
lookup types as needed.

Asset Type Select the asset type from the drop-down list.
This may be ALL or a specific asset type. The
available values come from a validated field
based your assets setup.

SubType Select the asset sub type from the drop-down
list. This may be ALL or a specific asset sub
type. The available values come from a validated
field based your assets setup, and is linked to the
selected asset type.

Asset Make Select the asset make from the drop-down list.
The available values come from a validated field
based your assets setup and is restricted based
on the selected Asset Type and Asset Sub Type.
For example, If ALL was selected for either Asset
Type or Asset Sub Type, then ALL will be the
only available selection for the asset make.
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Table 4-20    (Cont.) Pricing Definition

Field Do this

Asset Model Select the asset model from the drop-down list.
The available values come from a validated field
based your assets setup, and is restricted based
on the selected Asset Type and Asset Sub Type.
If ALL was selected for either Asset Type or
Asset Sub Type, then ALL will be the only
available selection for the asset model.

Age Specify the asset age (the minimum age for the
selected pricing).

Note: If your entry in this field is based on the
number of years of age of the asset and not the
actual year of make, you must update this entry
annually to ensure that the proper pricing is
available.

Trade-In Specify if there is a trade in of an asset by
selecting Yes/No.

Mileage If there is a Trade-In of an existing asset, then
specify its mileage in km.

Currency Select the currency for this pricing, from the
drop-down list.

Promotion Select the promotion applicable for this pricing
from the dropdown list. The list is populated
based on the promotions setup.

Subvention Select the subvention plan from the drop-down
list, if pricing is specific for any subvention plan.

Down Pmt Specify the down payment for the pricing.

Asset Value Specify the asset value.

LTV Specify the loan to value ratio.

Existing Customer Select one of the following options from the drop-
down list to define the applicability of the current
pricing definition:

ALL - Applicable to both existing and new
customers

YES - Applicable to existing customer only

NO - Applicable to new customer only.

Based on the selection criteria, system defaults
the first pricing for applications with Existing
customer flag = Y at primary applicant details.

Existing Customer Since (In Years) Specify the duration from when customer
account was created in the system up to the
current date in years.

Selection Criteria: Business - allows you to indicate the age of business by evaluating the total
number of years elapsed.

Years In Business Specify the total number of years in business.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8 Contract
The Contract screen allows you to define the instruments used within your system. A
instrument is a contract used by a financial organization with specific rules tied to it. When
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processing an application, an instrument associated with the application informs the system of
the type of contract being used for the approved product. This ensures that all parameters tied
to the instrument are setup for the account as it is booked - without requiring you to do it.

Instruments can be setup at different levels:

• Company

• Branch

• Product

• Application state

• Currency

The following groups of parameters are setup at the instrument level (Each has its own section
on the Contract screen):

• Selection Criteria

• Accrual

• Rebate

• Imputed Interest

• Capitalization

• Scheduled Dues

• Billing

• Delinquency

• Lease Contract

• Tax

• Early Termination

• Ever Green Details

• Residual Details

• Payment Caps

• Extension

• Advance Details

• Rate Cap And Adjustments

• Other

Items defined in the contract are locked in when you choose Select Instrument on the Funding
form’s Contract link.

The Contract screen’s Instrument and Description fields allow you to enter the financial
instrument’s name and description, for example; INS-LOAN: VEHICLE.

System supports Biennial (once every 2 years) and Triennial (once every 3 years) type of
billing cycles. Based on the following lookups, the billing cycle frequency can be defined:

• BILL_CYCLE_CD

• LEASE_BILL_CYCLE_CD - For lease accounts, the Biennial and Triennial billing cycles
are applicable only for Interest Rate type of Calculation Method and for both Advance and
Arrears type of Rent Collection Methods. However, these billing cycles are allowed for
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Balloon Method - N+1 and not allowed for Flexible repayment > Skip Months and for
Agreement type, Usage, Rental, Rental Usage types.

• LOAN_BILL_CYCLE_CD - For Loan accounts, the Biennial and Triennial billing cycles are
applicable only for Standard Product Category and for both Advance and Arrears type of
Rent Collection Methods - Advance (if First Payment Date is equal to Contract Date) and
Arrears (if First Payment Date is greater than Contract Date). However, these billing cycles
are allowed for Balloon Methods N and N+1 and not allowed for Flexible repayment >
Skip Months.

• LOC_BILL_CYCLE_CD - for Line of Credit accounts

To set up the Contract

You can either define new Contract Definition details or specify a new name in the New
Instrument field and click Create Copy to create a copy of selected contract with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > Products > Contract > LoanLineLease.

2. On the Contract Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-12    Contract
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Figure 4-13    Contract

Figure 4-14    Contract

A brief description of the fields is given below:

Table 4-21    Contract Definition

Field Do this

Instruments section

Instrument Specify the code identifying the instrument.
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Table 4-21    (Cont.) Contract Definition

Field Do this

Description Specify the description of the instrument being
defined.

Start Dt Specify the start date for the instrument. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for the instrument. You can
even select the date from the adjoining Calendar
icon.

Enabled If you check this box, the system will consider
this contract definition when selecting a
instrument for an application.

Note: Once the field is enabled load balances
button in balances sub tab will be disabled.

Selection Criteria section

Company Select the company for the instrument from the
drop-down list. This may be ALL or a specific
company.

Branch Select the branch within the company for the
instrument from the drop-down list. This may be
ALL or a specific branch. This must be ALL, if
you have selected ALL in the Company field.

Billing Cycle Select the billing cycle selected from the drop-
down list.

Product Select the product for the instrument from the
drop-down list. This may be ALL or a specific
product.

State Select the state in which the instrument is used
from the drop-down list. This may be ALL or a
specific state.

Currency Select the currency for the instrument from the
drop-down list.

IMPORTANT: By selecting which type to use, the
system searches for a best match using the
following attributes:

a. Billing Cycle

b. Start Date

c. Company

d. Branch

e. Product

f. State

Hence, Oracle Financial Services Software
recommends creating one version of each type,
where ALL is the value in these fields.

Pricing Select the pricing in which the instrument is used
from the drop-down list. This may be ALL or a
specific pricing.

Accrual section
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Table 4-21    (Cont.) Contract Definition

Field Do this

Accrual Method Select the accrual method used to calculate
interest accrual for this instrument from the drop-
down list.

Base Method Select the base method used to calculate
interest accrual for this instrument from the drop-
down list.

Start Dt Basis Select to define the start date from when the
interest accrual is to be calculated for this
instrument from the drop-down list.

Note:
If you select the Effective Date, then the interest
is calculated from the Contract date + Start Days
(indicated below).

If you select the Payment Date, then the interest
is calculated based on (first payment date + Start
Days (indicated below) minus one billing cycle).

Start Days Specify the number of grace days after which the
interest accrual is to be calculated. Ensure that
the number of grace days is less than first
payment date.

Time Counting Method Select the time counting method used to
calculate interest accrual for this instrument from
the drop-down list.

Installment Method Select the payment installment method from the
drop-down list.

Note: the system supports an amortized
repayment schedule with the final payment
potentially differing from the regular payment
amount in the other billing cycles. You may
choose:

Whether the equal installments for each billing
cycle includes any minute final payment
differences (EQUAL PAYMENTS)

-or-

If the final payment amount may be slightly
different (FINAL PAYMENT DIFFERS).
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Table 4-21    (Cont.) Contract Definition

Field Do this

Int Amortization Freq Select one of the following interest amortization
frequency from the drop-down list:
• DAILY - if selected, the interest amortization

(TAM) GL entries hand-over happens every
day.

• EVERY BILLING CYCLE MONTH END - if
selected, the interest amortization (TAM) GL
entries hand-over happens on month end of
the account billing cycle. For example, if
account billing cycle is quarterly, the GL
handover happens on month end of the
quarter.

• EVERY MONTH END - if selected, the
interest amortization (TAM) GL entries hand-
over happens on month end of every
calendar month. For example, even if the
account billing cycle is quarterly, the GL
handover happens on the calendar month.

Imputed Interest
This section allows you to enable/disable the imputed interest calculation options in Origination >
Contract screen. These options are required while funding a loan application with imputed interest
for system to calculate Imputed Interest Amortization Schedule. For more information, refer to
Imputed Interest section in Loan Origination User guide.

Imputed Interest Check this box to enable imputed interest related
fields in Origination >Contract screen. By default,
this option is un-checked.

Capitalization section
This section allows you to define capitalization parameters which helps to capitalize the
corresponding account balances to the principal balance of the account based on specific
frequency. For example, you can capitalize the accumulated Interest or Late Fees to principal
balance of the account.

You can either capitalize all the balances based on same frequency or define different frequency for
each type of balance. Balance capitalization is processed during the execution of batch job
TXNCPT_BJ_100_01 (CAPITALIZATION PROCESSING) which is executed after running the billing
batch job.

Note: Capitalization parameters can also be updated by posting CAPITALIZATION
MAINTENANCE monetary transaction.

Capitalize Check this box to enable capitalization
parameters for the contract. By default, this
option is un-checked.

The option is available only for Interest Bearing
Loans and Mortgage Loans.
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Frequency Select the required capitalization frequency from
the drop-down list. The list contains the following
types of frequency to either capitalize all the
balances based on same frequency or define
different frequency for each type of balance.
• Based on specific intervals such as Monthly,

Quarterly, Annual and so on.
• Based on contract Billing Frequency, Billing

Date, or Due date.
• Specifically on every Month End.

-Or-
• Based on Balance Frequency to define

different capitalization frequency for each
balance. This can further be defined in
Balances sub tab.

Capitalization Start Basis Select the capitalization start date from the drop-
down list as either Contract Date or First
Payment Date to calculate the capitalization
frequency accordingly.

However, this field is not enabled for Billing date
or Due Date type of capitalization frequency.

Grace Days Specify the grace days allowed in the frequency
(minimum 0, maximum 31) before capitalizing the
balances to account. This is also the deciding
factor for executing the capitalization batch job
which is based on Capitalization Frequency +
Grace Days.

However, note that Grace Days are not
accounted for Month End type of capitalization
frequency and is ignored even if specified.

Cap Tolerance Amt Specify the capitalization tolerance amount
which is the minimum amount to qualify for
capitalization. Any amount less than this is not
considered for capitalization of balances.

This helps to avoid capitalization of nominal or
decimal amounts.

Note: There is no specific accounting maintained
for non-capitalized decimals with reference to
setup.

Rebate section

Pre Compute Check this box to indicate that this is a
precomputed loan.

Rebate Method Select the rebate calculation method from the
drop-down list.

Rebate Term Method Select the rebate term method from the drop-
down list.

Rebate Min Fin Chg Mthd Select the rebate minimum finance charge
calculation method from the drop-down list.

Min Finance Charge Specify the minimum finance charge value.

Acquisition Charge Amt Specify the acquisition charge amount.

Scheduled Dues section
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Due Day Min Specify the minimum value allowed for the due
day for this instrument.

Due Day Max Specify the maximum value allowed for the due
day for this instrument.

Note: If billing cycle is selected as weekly, then
Due Day Max field value cannot be greater than
7.

Max Due Day Change / Year Specify the maximum number of due day
changes allowed within a given year for this
instrument.

Max Due Day Change / Life Specify the maximum number of due day
changes allowed over the life of a product funded
with this instrument.

Max Due Day Change Days Specify the maximum number of days a due date
can be moved.

Pmt Tolerance Amt* Specify the payment tolerance amount. This is
the threshold amount that must be achieved
before a due amount is considered PAID or
DELINQUENT. If (Payment Received + Pmt
Tolerance: $Value) >= Standard Monthly
Payment, the Due Date will be considered as
satisfied in terms of delinquency. The amount
unpaid is still owed.

Pmt Tolerance%* Specify the payment tolerance percentage. This
is the threshold percentage that must be
achieved before a due amount is considered
PAID or DELINQUENT. If Payment Received >=
(Standard Monthly Payment * Pmt Tolerance% /
100), the due date will be considered satisfied in
terms of delinquency. The amount unpaid is still
owed.

The system uses the greater of these two values.

Promise Tolerance Amt* Specify the promise tolerance amount. This is
the threshold amount that must be achieved
before a due amount is considered KEPT or
BROKEN. If (Payment Received + Promise
Tolerance: $Value) >= Promise Amount, the Due
Date will be considered KEPT (satisfied).

Promise Tolerance %* Specify the promise tolerance percentage. This
is the threshold percentage that must be
achieved before a due amount is considered
KEPT or BROKEN. If Payment Received >=
(Promised Amt * Promise Tolerance%), the due
date will be considered KEPT (satisfied).

The system uses the greater of these two values.

Billing section
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Prebill Days Specify the prebill days. This is the number of
days, before the first payment due, that accounts
funded with this instrument will be billed for the
first payment. Thereafter, the accounts will be
billed on the same day every month. If an
account has a first payment date of 10/ 25/2003
and Pre Bill Days is 21, then the account will bill
on 10/04/ 2003, and then bill on the 4th of every
month.

Billing Type Select the billing type for accounts funded using
this instrument from the drop-down list.

Billing Method Select the billing method for accounts funded
using this instrument from the drop-down list.

Balloon Method Select the balloon payment method for accounts
funded using this instrument from the drop-down
list.

Multiple Billing Asset Rate Check this box to indicate if multiple asset rates
are applicable for one billing period.

System considers billing period from current due
date to the next due date. Multiple rates are
fetched only when rate end date (rate start date
+ rate frequency) ends one or more cycle(s)
before the next due date i.e. current rate record
does not cover the entire billing period.

Delinquency section

Late Charge Grace Days Specify the number of grace days allowed for the
payment of a due date before a late charge is
assessed on the account.

Stop Accrual Days Specify the number of days a contract can be in
delinquent state, after which the interest accrual
must stop for an account.

A Batch Job is run daily to select accounts in
delinquent status for a pre-defined number of
days and post No Accrual transaction for such
accounts on current date. When the account
recovers from Delinquency, the system will then
post a Start Accrual Transaction on the date
the account is recovered from delinquency.

Delq Grace Days Specify the number of grace days allowed for the
payment of a due date before an account is
considered delinquent. This affects DELQ
Queues, the system reporting, and the
generation of collection letters.

Time Bar Years Specify the total number of years allowed to
contact the customer starting from the first
payment date and beyond which the account is
considered delinquent. You can specify any value
between 0-999.

Cure Letter Gen Days Specify the number of delinquency days to
initiate cure letter generation.
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Cure Letter Valid Days Specify the number of days during which the
issued cure letter is valid. Usually financial
institutions will start the collection activities after
the lapse of cure letter validity date.

Delq Category Method Select the delinquency category method to
determine how the system populates
delinquency counters on the Customer Service
form.

Note: This value does not affect credit bureau
reporting.

Accrual Post Maturity Check this box to indicate that this is the post
maturity default rate.

Extensions allow you to extend the maturity of
the contract by one or more terms by allowing
the customer to skip one or more payments. The
skipped terms are added to the end of the
contract.

Cycle Based Fees - This section allows to define the parameters for calculating cycle based fees at
individual account level. Using the below parameters, system derives the Cycle Base Fees and
updates the account balances on processing the following batch jobs - TXNCBC_BJ_100_01
(CYCLE BASED COLLECTION LATE FEE PROCESSING) and TXNCBL_BJ_100_01 (CYCLE
BASED LATE FEE PROCESSING). For more information, refer to ‘Fee Consolidation Maintenance’
section in Appendix chapter.

System calculates the below type of fee in combination of associated and master account and is
assessed only when total due crosses Threshold amount (that is defined in Setup > Products >
Contract > Fees tab and Setup > Products > Fees screen):

Fee Late Charge (FLC)
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount

Cycle Based Collection Late Fee
• Flat amount
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount
• Percentage of payment due
• Percentage of standard payment
• Percentage of billed amount
• Percentage of total due amount
• Percentage of sum of total due amount

Cycle Based Late Fee
• Flat amount
• Percentage of sum of total due amount
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount
• Percentage of total due amount
• Percentage of payment due
• Percentage of standard payment
• Percentage of billed amount
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Cycle Based Collection Late Fee Check this box to enable cycle based collection
late fee assessment on the account.

If selected, the balance type CYCLE BASED
COLLECTION LATE FEE is made available in
the Balances tab which further allows to define
how system should derive the balances when an
account is booked and funded.

If unchecked (default), system does not display
the Cycle based Collection Late Fee balance in
Contract >Balances tab on clicking Load
Balances button.

Cycle Based Late Fee Check this box to enable cycle based late fee
assessment on the account.

If selected, the balance type CYCLE BASED
LATE FEE is made available in the Balances tab
which further allows to define how system should
derive the balances when an account is booked
and funded.

If unchecked (default), system does not display
the Cycle Based Late Fee balance in Contract
>Balances tab on clicking Load Balances
button.

Cycle Based Collection Late Fee Grace Days Specify the number of grace days allowed before
cycle based collection late fee is assessed on
the account. This field is enabled only if the
Cycle Based Collection Late Fee option is
checked above.

Cycle Based Late Fee Grace Days Specify the number of grace days allowed before
cycle based late fee is assessed on the account.
This field is enabled only if the Cycle Based Late
Fee option is checked above.

Fee Consolidation - If Cycle Based Late Fee is assessed based on above parameters, this section
allows to enable/disable the option to consolidate the late fee at Master Account level.

Late Charge at Master Account Check this box to allow system to consolidate the
late charge assessment at master account level.

Cycle Based Collection Late Fee at Master
Account

Check this box to allow system to consolidate the
cycle based collection late fee assessment at
master account level.

Ensure that, the option Cycle Based Collection
Late Fee is also checked for fee consolidation at
Master Account level.

Cycle Based Late Fee at Master Account Check this box to allow system to consolidate
cycle based late fee assessment at master
account level.

Ensure that, the option Cycle Based Late Fee is
also checked for fee consolidation at Master
Account level.

Extension section

Max Extn Period / Year Specify the maximum number of terms that the
contract may be extended, within a given rolling
calendar year.
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Max Extn Period / Life Specify the maximum number of terms that the
contract may be extended, within the life of the
loan.

Max # Extn / Year Specify the maximum number of extensions that
may be granted within a given rolling calendar
year.

Max # of Extn / Life Specify the maximum number of extensions that
may be granted within the life of the loan.

Minimum # Payments Specify the minimum number of payments that
must be made before extension.

Extension Gap in Months Specify the gap between previous extension
provided in the account and current one as
specific number of months.

Advance Details section

Multi Disbursements Allowed Check this box, if this contract allows
disbursement of funds to customers through
multiple advances or draws up to the approved
amount within a specified draw period. If you
select the Multiple Disbursements Permitted box,
complete the Advance Details section on the
Contract section. (For more information, see the
Stages Funding section in this chapter.)

Min Initial Advance Specify the minimum initial advance amount
allowed. This is the smallest possible initial
advance that can be disbursed to the borrower
after funding.

Max Initial Advance Specify the maximum initial advance amount
allowed. This is the largest possible initial
advance that can be disbursed to the borrower
after funding.

Late Charge Allowed Check this box to allow disbursement period late
charge.

Min Advance Specify the minimum advance amount. This is
the smallest advance amount that a borrower
may subsequently request after the initial
advance.

Max Advance Specify the maximum advance amount. This is
the largest advance amount that a borrower may
subsequently request after the initial advance.

Billing Allowed Check this box to allow stage funding with draw
period billing.

Draw Period Billing Method Select the method for billing during the draw
period from the drop-down list.

Reschedule Ind Select this check box to indicate that the
rescheduling is allowed at the draw period.

Rate Cap & Adjustments section

Max Rate Inc / Year Specify the maximum rate increase allowed in a
year.

Max Rate Inc / Life Specify the maximum rate increase allowed in
the life of the loan.

Max Rate Dec / Year Specify the maximum rate decrease allowed in a
year.
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Max Rate Dec / Life Specify the maximum rate decrease allowed
during the life of the loan.

Max # Adjust / Year Specify the maximum number of rate changes
allowed in a year.

Max # Adjust / Life Specify the maximum number of rate changes
allowed during the life of the loan.

Min Int Rate (Floor) Specify the minimum rate.

Max Int Rate (Ceiling) Specify the maximum rate.

Payment Caps section

Max Pmt Inc / Year Specify the maximum payment increase allowed
in a year.

Max Pmt Inc / Life Specify the maximum payment increase allowed
in the life of the loan.

Statement section
This section allows to define the preferences for Mock Statement generation at Master Account
level. Generating a Mock Statement helps to mock the asset billing process with a future date and
to get an upfront statement indicating future dues of Master and Associated Accounts. In Vacation
Ownership industry, such statements are required to forecast future dues based on current
Timeshare holdings.

The selected preference here are propagated to Application > Contract screen when the instrument
is loaded.

Mock Statement Req Select this check box to indicate if the account is
to be include in Mock statement Generation.

Note: Based on this selection, others fields
related to Mock Statement below are enabled
and becomes mandatory for providing details.

Mock Start Month Select the start month of Mock Statements
period from the dropdown list.

Note: During the Mock Statement Next Run
Date validation if next run date is less than
Contract Date or GL Date, system moves the
Mock Start Month to same month of next year.
For more information, refer to Mock Statement
Maintenance in Appendix - Non Monetary
transactions sections.

Mock Statement Cycles Select the total number of billings (between 1-12)
that are to be generated post Mock Statement
Start Date.

Mock Pre Statement Days Specify the number of Pre bill days for Mock
Statements generation.

Stmt Preference Mode Select the account statement preference mode
as either Email or PHYSICAL from the drop-
down list.

The selected preference will be propagated to
Application > Contract screen when the
instrument is loaded.

Other section

1st Pmt Deduction Allowed Check this box to indicate that the first payment
for fixed rate loans using this instrument may be
deducted from the producer's proceeds.
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1st Pmt Refund Allowed Check this box to indicate that refunding first
payment deductions to the producer is allowed.

1st Pmt Deduction Days Specify the first payment deduction days. If the
first payment for fixed rate loans using this
instrument is less than this number of days from
funding, the first payment will be deducted from
the producer’s proceeds if 1st Pmt Deduction.

1st Pmt Refund Days Specify the first payment refund days. If the first
payment for fixed rate loans using this instrument
is received within this number of days from the
first payment date, the first payment deduction
will be refunded to the producer if 1st Pmt
Refund.

Refund Allowed Check this box to indicate that refunding of
customer over payments are allowed.

Refund Tolerance Amt Specify the refund tolerance amount. If the
amount owed to the customer is greater than the
refund tolerance, the over payment amount will
be refunded if Refund Allowed box is selected.

Anniversary Period Specify the anniversary term that define the
anniversary period. This is based on billing cycle,
so normally for MONTHLY the value is 12 and for
WEEKLY the value is 52.

WriteOff Tolerance Amt Specify the write off tolerance amount. If the
remaining outstanding receivables for accounts
funded using this instrument is less or equal to
the write off tolerance amount, the remaining
balance on the account will be waived.

Pre Pmt Penalty Check this box, if there is a prepayment penalty
charged for accounts funded using this
instrument.

% of Term for Penalty Specify percentage of term for prepayment
penalty. If the (remaining terms / total terms)
expressed as a percentage exceeds this amount,
a prepayment penalty will be assessed if the Pre-
Pmt Penalty box was selected.

Recourse Check this box if recourse is allowed. This
indicates whether the unpaid balance may be
collected from the producer if the consumer fails
to perform on the loan.

Max Recourse% Specify the maximum percentage of the
outstanding receivables that may be collected
from the producer if the Recourse Allowed box
was selected.

Pay Off Fee Allowed Check this box to allow for a payoff quote fee to
be assessed to the account attached to this
contract.

Note: This will require you to set up a payoff fee
at the contract (Fees sub screen) or state (Fee
screen) level. For more information, see the
following Contract screen (Loan)’s Fees sub
screen or Fee screen (Loan) sections in this
chapter.
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Escrow Allowed Check this box, if this contract can do escrow of
tax and insurances. (For more information, see
the Escrow Setup Form chapter.)

Repmt Currency Select the designated repayment currency for
this contract from the drop-down list.

PDC Security Check Check this box to indicate that post dated checks
are the method of repayment for this contract.

Default Pmt Spread Select the default payment spread to be used
when receiving payments for this account if one
is not explicitly chosen, from the drop-down list.

Calendar Method Select the required calendar method for this
contract from the dropdown list. The calendar
method Hijri should be selected, if the product
category is selected as Standard in the Products
screen. For Islamic product category, the
calendar method can be either Gregorian or Hijri.

ACH Fee Ind Check this box to indicate that direct debit fee is
included.

Note: The ACH Fee/Direct Debit Fee balance will
be displayed in Balances sub tab only when this
checkbox is selected.

Track Down Payment Balance Select this check box for system to validate if
Down Payment Balance is loaded. This helps to
record the Down Payment balance Agreed and
Paid by the customer.

If selected, system validates if Down Payment
Balance is loaded in the contract setup. However,
system does not validate Down Payment
Balance if unchecked. This check box is available
only for Loan contracts.

Table 4-22    Contract Definition

Field Do this

Instruments section

Instrument Specify the code identifying the instrument.

Description Specify the description of the instrument being
defined.

Start Dt Specify the start date for the instrument. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for the instrument. You can
even select the date from the adjoining Calendar
icon.

Enabled If you check this box, the system will consider
this contract definition when selecting a
instrument for an application.

Note: Once the field is enabled load balances
button in balances sub tab will be disabled.

Selection Criteria section
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Company Select the company for the instrument from the
drop-down list. This may be ALL or a specific
company.

Branch Select the branch within the company for the
instrument from the drop-down list. This may be
ALL or a specific branch. This must be ALL, if
you have selected ALL in the Company field.

Billing Cycle Select the billing cycle selected from the drop-
down list.

Product Select the product for the instrument from the
drop-down list. This may be ALL or a specific
product.

State Select the state in which the instrument is used
from the drop-down list. This may be ALL or a
specific state.

Currency Select the currency for the instrument from the
drop-down list.

IMPORTANT: By selecting which type to use, the
system searches for a best match using the
following attributes:

a. Billing Cycle

b. Start Date

c. Company

d. Branch

e. Product

f. State

Hence, Oracle Financial Services Software
recommends creating one version of each type,
where ALL is the value in these fields.

Pricing Select the pricing in which the instrument is used
from the dropdown list. This may be ALL or a
specific pricing.

Accrual section

Accrual Post Maturity Check this box to indicate that this is the post
maturity default rate.

Extensions allow you to extend the maturity of
the contract by one or more terms by allowing
the customer to skip one or more payments. The
skipped terms are added to the end of the
contract.

Accrual Method Select the accrual method used to calculate
interest accrual for this instrument from the drop-
down list.
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Start Dt Basis Select to define the start date from when the
interest accrual is to be calculated for this
instrument from the drop-down list.

Note:
If you select the Effective Date, then the interest
is calculated from the Contract date.

If you select the Payment Date, then the interest
is calculated based on (first payment date minus
one billing cycle).

Base Method Select the base method used to calculate
interest accrual for this instrument from the drop-
down list.

Accrual Start Days Specify the number of days for which the interest
accrual is to be calculated.

Int Amortization Freq Select one of the following interest amortization
frequency from the drop-down list:
• DAILY - if selected, the interest amortization

(TAM) GL entries hand-over happens every
day.

• EVERY BILLING CYCLE MONTH END - if
selected, the interest amortization (TAM) GL
entries hand-over happens on month end of
the account billing cycle. For example, if
account billing cycle is quarterly, the GL
handover happens on month end of the
quarter.

• EVERY MONTH END - if selected, the
interest amortization (TAM) GL entries hand-
over happens on month end of every
calendar month. For example, even if the
account billing cycle is quarterly, the GL
handover happens on the calendar month.

Capitalization section
This section allows you to define capitalization parameters which helps to capitalize the
corresponding account balances to the principal balance of the account based on specific
frequency. For example, you can capitalize the accumulated Interest or Late Fees to principal
balance of the account.

You can either capitalize all the balances based on same frequency or define different frequency for
each type of balance.

Note: Capitalization parameters can also be updated by posting CAPITALIZATION
MAINTENANCE monetary transaction.

Capitalize Check this box to enable capitalization
parameters for the contract. By default, this
option is un-checked.

The option is available only for Average daily
balance Method Line of Credit.
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Frequency Select the required capitalization frequency from
the drop-down list. The list contains the following
types of frequency to either capitalize all the
balances based on same frequency or define
different frequency for each type of balance.
• Based on specific intervals such as Monthly,

Quarterly, Annual and so on.
• Based on contract Billing Frequency, Billing

Date, or Due date.
• Specifically on every Month End.

-Or-
• Based on Balance Frequency to define

different capitalization frequency for each
balance. This can further be defined in
Balances sub tab.

Capitalization Start Basis Select the capitalization start date from the drop-
down list as either Contract Date or First
Payment Date to calculate the capitalization
frequency accordingly.

However, this field is not enabled for Billing date
or Due Date type of capitalization frequency.

Grace Days Specify the grace days allowed in the frequency
(minimum 0, maximum 31) before capitalizing the
balances to account. This is also the deciding
factor for executing the capitalization batch job
which is based on Capitalization Frequency +
Grace Days.

However, note that Grace Days are not
accounted for Month End type of capitalization
frequency and is ignored even if specified.

Cap Tolerance Amt Specify the capitalization tolerance amount
which is the minimum amount to qualify for
capitalization. Any amount less than this is not
considered for capitalization of balances.

This helps to avoid capitalization of nominal or
decimal amounts.

Note: There is no specific accounting maintained
for non-capitalized decimals with reference to
setup.

Scheduled Dues section

Max Due Day Change Days Specify the maximum number of days a due date
can be moved.

Due Day Min Specify the minimum value allowed for the due
day for this instrument.

Due Day Max Specify the maximum value allowed for the due
day for this instrument.

Note: If billing cycle is selected as weekly, then
Due Day Max field value cannot be greater than
7.

Max Due Day Change / Year Specify the maximum number of due day
changes allowed within a given year for this
instrument.
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Max Due Day Change / Life Specify the maximum number of due day
changes allowed over the life of a product funded
with this instrument.

Billing section

Pre Bill Days Specify the prebill days. This is the number of
days, before the first payment due, that accounts
funded with this instrument will be billed for the
first payment. Thereafter, the accounts will be
billed on the same day every month. If an
account has a first payment date of 10/ 25/2003
and Pre Bill Days is 21, then the account will bill
on 10/04/ 2003, and then bill on the 4th of every
month.

Billing Type Select the billing type for accounts funded using
this instrument from the drop-down list.

Draw Period Billing Method Select the draw period billing method for
accounts funded using this instrument from the
drop-down list.

Repmt Billing Method Select the billing method for the repayment
period from the dropdown list.

Draw Billing % Enter the payment percentage for the draw
period.

Repmt Term Payment % Enter the payment percentage for the repayment
draw period.

Multiple Billing Asset Rate Check this box to indicate if multiple asset rates
are applicable for one billing period.

System considers billing period from current due
date to the next due date. Multiple rates are
fetched only when rate end date (rate start date
+ rate frequency) ends one or more cycle(s)
before the next due date i.e. current rate record
does not cover the entire billing period.

Delinquency section

Late Charge Grace Days Specify the number of grace days allowed for the
payment of a due date before a late charge is
assessed on the account.

Stop Accrual Days Specify the number of days a contract can be in
delinquent state, after which the interest accrual
must stop for an account.

A Batch Job is run daily to select accounts in
delinquent status for a pre-defined number of
days and post No Accrual transaction for such
accounts on current date. When the account
recovers from Delinquency, the system will then
post a Start Accrual Transaction on the date
the account is recovered from delinquency.

Delq Grace Days Specify the number of grace days allowed for the
payment of a due date before an account is
considered delinquent. This affects DELQ
Queues, the system reporting, and the
generation of collection letters.
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Time Bar Years Specify the total number of years allowed to
contact the customer starting from the first
payment date and beyond which the account is
considered delinquent. You can specify any value
between 0-999.

Cure Letter Gen Days Specify the number of delinquency days to
initiate cure letter generation.

Cure Letter Valid Days Specify the number of days during which the
issued cure letter is valid. Usually financial
institutions will start the collection activities after
the lapse of cure letter validity date.

Delq Category Method Select the delinquency category method to
determine how the system populates
delinquency counters on the Customer Service
form.

Note: This value does not affect credit bureau
reporting.

Cycle Based Fees - This section allows to define the parameters for calculating cycle based fees at
individual account level. Using the below parameters, system derives the Cycle Base Fees and
updates the account balances on processing the following batch jobs - TXNCBC_BJ_100_01
(CYCLE BASED COLLECTION LATE FEE PROCESSING) and TXNCBL_BJ_100_01 (CYCLE
BASED LATE FEE PROCESSING). For more information, refer to Fee Consolidation
Maintenance section in Appendix chapter.

System calculates the below type of fee in combination of associated and master account and is
assessed only when total due crosses Threshold amount (that is defined in Setup > Products >
Contract > Fees tab and Setup > Products > Fees screen):

Fee Late Charge (FLC)
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount

Cycle Based Collection Late Fee
• Flat amount
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount
• Percentage of payment due
• Percentage of standard payment
• Percentage of billed amount
• Percentage of total due amount
• Percentage of sum of total due amount

Cycle Based Late Fee
• Flat amount
• Percentage of sum of total due amount
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount
• Percentage of total due amount
• Percentage of payment due
• Percentage of standard payment
• Percentage of billed amount
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Field Do this

Cycle Based Collection Late Fee Check this box to enable cycle based collection
late fee assessment on the account.

If selected, the balance type CYCLE BASED
COLLECTION LATE FEE is made available in
the Balances tab which further allows to define
how system should derive the balances when an
account is booked and funded.

If unchecked (default), system does not display
the Cycle based Collection Late Fee balance in
Contract >Balances tab on clicking Load
Balances button.

Cycle Based Late Fee Check this box to enable cycle based late fee
assessment on the account.

If selected, the balance type CYCLE BASED
LATE FEE is made available in the Balances tab
which further allows to define how system should
derive the balances when an account is booked
and funded.

If unchecked (default), system does not display
the Cycle Based Late Fee balance in Contract
>Balances tab on clicking Load Balances
button.

Cycle Based Collection Late Fee Grace Days Specify the number of grace days allowed before
cycle based collection late fee is assessed on
the account. This field is enabled only if the
Cycle Based Collection Late Fee option is
checked above.

Cycle Based Late Fee Grace Days Specify the number of grace days allowed before
cycle based late fee is assessed on the account.
This field is enabled only if the Cycle Based Late
Fee option is checked above.

Fee Consolidation - If Cycle Based Late Fee is assessed based on above parameters, this section
allows to enable/disable the option to consolidate the late fee at Master Account level.

Late Charge at Master Account Check this box to allow system to consolidate the
late charge assessment at master account level.

Cycle Based Collection Late Fee at Master
Account

Check this box to allow system to consolidate the
cycle based collection late fee assessment at
master account level.

Ensure that, the option Cycle Based Collection
Late Fee is also checked for fee consolidation at
Master Account level.

Cycle Based Late Fee at Master Account Check this box to allow system to consolidate
cycle based late fee assessment at master
account level.

Ensure that, the option Cycle Based Late Fee is
also checked for fee consolidation at Master
Account level.

Extension section

Max Extn Period / Year Specify the maximum number of terms that the
contract may be extended, within a given rolling
calendar year.
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Max Extn Period / Life Specify the maximum number of terms that the
contract may be extended, within the life of the
line of credit.

Max # Extn / Year Specify the maximum number of extensions that
may be granted within a given rolling calendar
year.

Max # of Extn / Life Specify the maximum number of extensions that
may be granted within the life of the line of credit.

Minimum # Payments Specify the minimum number of payments that
must be made before extension.

Extension Gap in Months Specify the gap between previous extension
provided in the account and current one as
specific number of months.

Advance Details section

Min Initial Advance Specify the minimum initial advance amount
allowed. This is the smallest possible initial
advance that can be disbursed to the borrower
after funding.

Max Initial Advance Specify the maximum initial advance amount
allowed. This is the largest possible initial
advance that can be disbursed to the borrower
after funding.

Min Advance Specify the minimum advance amount. This is
the smallest advance amount that a borrower
may subsequently request after the initial
advance.

Max Advance Specify the maximum advance amount. This is
the largest advance amount that a borrower may
subsequently request after the initial advance.

Rate Cap & Adjustments section

Max Rate Increase / Year Specify the maximum rate increase allowed in a
year.

Max Rate Increase / Life Specify the maximum rate increase allowed in
the life of the line of credit.

Max Rate Decrease / Year Specify the maximum rate decrease allowed in a
year.

Max Rate Decrease / Life Specify the maximum rate decrease allowed
during the life of the line of credit.

Max # Adjustments / Year Specify the maximum number of rate changes
allowed in a year.

Max # Adjustments / Life Specify the maximum number of rate changes
allowed during the life of the line of credit.

Min Interest Rate (Floor) Specify the minimum rate.

Max Interest Rate (Ceiling) Specify the maximum rate.
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Statement section
This section allows to define the preferences for Mock Statement generation at Master Account
level. Generating a Mock Statement helps to mock the asset billing process with a future date and
to get an upfront statement indicating future dues of Master and Associated Accounts. In Vacation
Ownership industry, such statements are required to forecast future dues based on current
Timeshare holdings.

The selected preference here are propagated to Application > Contract screen when the instrument
is loaded.

Mock Statement Req Select this check box to indicate if the account is
to be include in Mock statement Generation.

Note: Based on this selection, others fields
related to Mock Statement below are enabled
and becomes mandatory for providing details.

Mock Start Month Select the start month of Mock Statements
period from the dropdown list.

Note: During the Mock Statement Next Run
Date validation if next run date is less than
Contract Date or GL Date, system moves the
Mock Start Month to same month of next year.
For more information, refer to Mock Statement
Maintenance in Appendix - Non Monetary
transactions sections.

Mock Statement Cycles Select the total number of billings (between 1-12)
that are to be generated post Mock Statement
Start Date.

Mock Pre Statement Days Specify the number of Pre bill days for Mock
Statements generation.

Other section

Refund Allowed Check this box to indicate that refunding of
customer over payments are allowed.

Refund Tolerance Specify the refund tolerance amount. If the
amount owed to the customer is greater than the
refund tolerance, the over payment amount will
be refunded if Refund Allowed box is selected.

WriteOff Tolerance Amt Specify the write off tolerance amount. If the
remaining outstanding receivables for accounts
funded using this instrument is less or equal to
the write off tolerance amount, the remaining
balance on the account will be waived.

Pmt Tolerance Amt* Specify the payment tolerance amount. This is
the threshold amount that must be achieved
before a due amount is considered PAID or
DELINQUENT. If (Payment Received + Pmt
Tolerance: $Value) >= Standard Monthly
Payment, the Due Date will be considered as
satisfied in terms of delinquency. The amount
unpaid is still owed.
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Pmt Tolerance%* Specify the payment tolerance percentage. This
is the threshold percentage that must be
achieved before a due amount is considered
PAID or DELINQUENT. If Payment Received >=
(Standard Monthly Payment * Pmt Tolerance% /
100), the due date will be considered satisfied in
terms of delinquency. The amount unpaid is still
owed.

The system uses the greater of these two values.

Promise Tolerance Amt* Specify the promise tolerance amount. This is
the threshold amount that must be achieved
before a due amount is considered KEPT or
BROKEN. If (Payment Received + Promise
Tolerance: $Value) >= Promise Amount, the Due
Date will be considered KEPT (satisfied).

Promise Tolerance %* Specify the promise tolerance percentage. This
is the threshold percentage that must be
achieved before a due amount is considered
KEPT or BROKEN. If Payment Received >=
(Promised Amt * Promise Tolerance%), the due
date will be considered KEPT (satisfied).

The system uses the greater of these two values.

Adv Tolerance Enter the advance tolerance amount.

Adv Tolerance % Enter the advance tolerance percentage

Default Pmt Spread Select the default payment spread to be used
when receiving payments for this account if one
is not explicitly chosen, from the drop-down list.

Min Finance Charge Enter the minimum finance charge amount.

Minimum Pmt Enter the minimum billed amount.

Anniversary Period Enter the anniversary term.

Repmt Currency Select the currency from the drop-down list.

PDC Security Check Check this box to indicate that post dated checks
are the method of repayment for this contract.

ACH Fee Ind Check this box to indicate that direct debit fee is
included.

Note: The ACH Fee/Direct Debit Fee balance will
be displayed in Balances sub tab only when this
checkbox is selected.

Table 4-23    Contract Definition

Field Do this

Instruments section

Instrument Specify the code identifying the instrument.

Description Specify the description of the instrument being
defined.

Start Dt Specify the start date for the instrument. You can
even select the date from the adjoining Calendar
icon.

Chapter 4
Contract

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 60 of 174



Table 4-23    (Cont.) Contract Definition

Field Do this

End Dt Specify the end date for the instrument. You can
even select the date from the adjoining Calendar
icon.

Enabled If you check this box, the system will consider
this contract definition when selecting a
instrument for an application.

Note: Once the field is enabled load balances
button in balances sub tab will be disabled

Selection Criteria section

Company Select the company for the instrument from the
drop-down list. This may be ALL or a specific
company.

Branch Select the branch within the company for the
instrument from the drop-down list. This may be
ALL or a specific branch. This must be ALL, if
you have selected ALL in the Company field.

Calculation Method Select the type of lease calculation method for
the contract as one of the following:
• RENT FACTOR (selected by default)
• INTEREST RATE
• AMORTIZED

Note: Based on the above selection, some of the
fields in lease contract definition screen are
either disabled or is displayed in view only mode
with default supported option. The same is
detailed in respective fields.

Billing Cycle Select the billing cycle frequency for the contract
as one of the following from the drop-down list.
• MONTHLY (Default)
• WEEKLY
• BI WEEKLY
• QUARTERLY
• SEMI ANNUAL
• ANNUAL

Note: The billing cycle is selected as Monthly by
default and is not editable if the lease calculation
method is selected as Rent Factor.

Agreement Type Select the lease agreement type as one of the
following from the drop-down list for further
calculation:
• USAGE
• RENTAL
• USAGE RENTAL

For more information on how OFSLL handles
Usage based leasing, refer to #unique_222
chapter and for Rental based leasing, refer to
Rental Agreement section in Lease Origination
User Guide.
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Product Select the product for the instrument from the
drop-down list. This may be ALL or a specific
product. If the Agreement Type is selected as
either USAGE or RENTAL, then the drop-down
list displays only those products associated with
USAGE or RENTAL type of lease.

State Select the state in which the instrument is used
from the drop-down list. This may be ALL or a
specific state.

Currency Select the currency for the instrument from the
drop-down list.

By selecting which type to use, the system
searches for a best match using the following
attributes:

a. Billing Cycle

b. Start Date

c. Company

d. Branch

e. Product

f. State

Hence, Oracle Financial Services Software
recommends creating one version of each type,
where ALL is the value in these fields.

Pricing Select the pricing in which the instrument is used
from the dropdown list. This may be ALL or a
specific pricing.

Accrual section

Rent Accrual Method Depending on the lease calculation method
selected, the applicable rent accrual method
which is used to calculate interest accrual for this
instrument is defaulted from the drop-down list.
• For Rent Factor calculation method,

ACTUARIAL - MONTHLY method is selected
by default.

• For Interest Rate calculation method,
INTEREST BEARING method is selected by
default.

• For Amortized Rent Accrual Method, the
Calculation Method also has to be selected
as AMORTIZED which is the fixed
repayment schedule method. Here the
repayment schedule of lease is predefined /
fixed at the beginning of the lease and no
subsequent changes are allowed to lease
payment until the maturity date and/or no
further extension of lease at the end of lease
period.

Note: System displays an error on save if any of
the above default options are interchanged.
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Base Method Select the base method used to calculate
interest accrual for this instrument from the drop-
down list. The list is populates with the values
defined in ACCRUAL_BASE_METHOD_CD
lookup code.

Note: The base method is selected as 30/360 by
default if the lease calculation method is selected
as Rent Factor.

Start Dt Basis If the lease calculation method is selected as
Interest Rate, select to define the start date from
when the interest accrual is to be calculated for
this instrument from the drop-down list.
• If you select the Effective Date, then the

interest is calculated from the Contract date
+ Start Days (indicated below).

• If you select the Payment Date, then the
interest is calculated based on (first payment
date + Start Days (indicated below) minus
one billing cycle).

If the lease calculation method is selected as
Rent Factor or Amortized, this field is disabled
since it is not applicable.

Start Days Specify the number of grace days after which the
interest accrual is to be calculated. Ensure that
the number of grace days is less than first
payment date.

Note: If the lease calculation method is selected
as Rent Factor or Amortized, this field is disabled
since it is not applicable.

Maturity Dt Basis This field is enabled only for 'Amortized' Lease
calculation method.

Select the basis of maturity date which is the
'Lease Closing Date' as either Payment Date or
Effective Date from the drop-down list. The
selection decides the basis of calculating the
maturity date i.e. contract date or first payment
date.

Note

Stub/Broken periods can be at the start
and end of the Contract.
• If maturity date basis is 'Payment

Date', then last bill will always have
full payment days in the cycle, and
no stub is applicable.

• If maturity date basis is 'Effective
Date', then first and last bills will
have stub days included.
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Time Counting Method Select the time counting method used to
calculate interest accrual for this instrument from
the drop-down list.

Note: If the lease calculation method is selected
as Rent Factor, this field is disabled since it is not
applicable.

Installment Method System supports an amortized repayment
schedule with the final payment potentially
differing from the regular payment amount in the
other billing cycles.

If the lease calculation method is selected as
Interest Rate, then the installment method by
default is EQUATED PAYMENTS where-in the
equal installments for each billing cycle includes
any minute final payment differences.

If the lease calculation method is selected as
Rent Factor, this field is disabled since it is not
applicable.

Int Amortization Freq Select one of the following interest amortization
frequency from the drop-down list:
• DAILY - if selected, the interest amortization

(TAM) GL entries hand-over happens every
day.

• EVERY BILLING CYCLE MONTH END - if
selected, the interest amortization (TAM) GL
entries hand-over happens on month end of
the account billing cycle. For example, if
account billing cycle is quarterly, the GL
handover happens on month end of the
quarter.

• EVERY MONTH END - if selected, the
interest amortization (TAM) GL entries hand-
over happens on month end of every
calendar month. For example, even if the
account billing cycle is quarterly, the GL
handover happens on the calendar month.

Note

Lease amortization for accounting of
accrued interest can be calculated on a
monthly basis, irrespective of the billing
cycle of the account using Scheduled
Based amounts. While processing the
batch job TAMPRC_BJ_100_01
(AMORTIZATION TRANSACTIONS
PROCESSING) if Amortize Balance
Type = Rent + Amortization Method =
Scheduled Based (Month End) + Int
Amortization Freq = EVERY MONTH
END, then Amortization will happen for
the whole month, on month end date
from the subsequent months.
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Capitalization section
This section allows you to define capitalization parameters which helps to capitalize the
corresponding account balances to the principal balance of the account based on specific
frequency. For example, you can capitalize the accumulated Interest or Late Fees to principal
balance of the account.

You can either capitalize all the balances based on same frequency or define different frequency for
each type of balance.

Note: Capitalization parameters can also be updated by posting CAPITALIZATION
MAINTENANCE monetary transaction.

Capitalize Check this box to enable capitalization
parameters for the contract. By default, this
option is un-checked.

The option is available only for Interest Rate
Method Lease.

Frequency Select the required capitalization frequency from
the drop-down list. The list contains the following
types of frequency to either capitalize all the
balances based on same frequency or define
different frequency for each type of balance.
• Based on specific intervals such as Monthly,

Quarterly, Annual and so on.
• Based on contract Billing Frequency, Billing

Date, or Due date.
• Specifically on every Month End.

-Or-
• Based on Balance Frequency to define

different capitalization frequency for each
balance. This can further be defined in
Balances sub tab.

Capitalization Start Basis Select the capitalization start date from the drop-
down list as either Contract Date or First
Payment Date to calculate the capitalization
frequency accordingly.

However, this field is not enabled for Billing date
or Due Date type of capitalization frequency.

Grace Days Specify the grace days allowed in the frequency
(minimum 0, maximum 31) before capitalizing the
balances to account. This is also the deciding
factor for executing the capitalization batch job
which is based on Capitalization Frequency +
Grace Days.

However, note that Grace Days are not
accounted for Month End type of capitalization
frequency and is ignored even if specified.

Cap Tolerance Amt Specify the capitalization tolerance amount
which is the minimum amount to qualify for
capitalization. Any amount less than this is not
considered for capitalization of balances.

This helps to avoid capitalization of nominal or
decimal amounts.

Note: There is no specific accounting maintained
for non-capitalized decimals with reference to
setup.
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Scheduled Dues section

Due Day Min Specify the minimum value allowed for the due
day for this instrument.

Due Day Max Specify the maximum value allowed for the due
day for this instrument.

Note: If billing cycle is selected as weekly, then
Due Day Max field value cannot be greater than
7.

Max Due Day Change / Year Specify the maximum number of due day
changes allowed within a given year for this
instrument.

Max Due Day Change / Life Specify the maximum number of due day
changes allowed over the life of a product funded
with this instrument.

Max Due Day Change Days Specify the maximum number of days a due date
can be moved.

Pmt Tolerance Amt* Specify the payment tolerance amount. This is
the threshold amount that must be achieved
before a due amount is considered PAID or
DELINQUENT. If (Payment Received + Pmt
Tolerance: $Value) >= Standard Monthly
Payment, the Due Date will be considered as
satisfied in terms of delinquency. The amount
unpaid is still owed.

Pmt Tolerance%* Specify the payment tolerance percentage. This
is the threshold percentage that must be
achieved before a due amount is considered
PAID or DELINQUENT. If Payment Received >=
(Standard Monthly Payment * Pmt Tolerance% /
100), the due date will be considered satisfied in
terms of delinquency. The amount unpaid is still
owed.

The system uses the greater of these two values.

Promise Tolerance Amt* Specify the promise tolerance amount. This is
the threshold amount that must be achieved
before a due amount is considered KEPT or
BROKEN. If (Payment Received + Promise
Tolerance: $Value) >= Promise Amount, the Due
Date will be considered KEPT (satisfied).

Promise Tolerance %* Specify the promise tolerance percentage. This
is the threshold percentage that must be
achieved before a due amount is considered
KEPT or BROKEN. If Payment Received >=
(Promised Amt * Promise Tolerance%), the due
date will be considered KEPT (satisfied).

The system uses the greater of these two values.

Billing section
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Prebill Days Specify the prebill days. This is the number of
days, before the first payment due, that accounts
funded with this instrument will be billed for the
first payment. Thereafter, the accounts will be
billed on the same day every month. If an
account has a first payment date of 10/ 25/2003
and Pre Bill Days is 21, then the account will bill
on 10/04/ 2003, and then bill on the 4th of every
month.

Bill Type Select the billing type for accounts funded using
this instrument from the drop-down list.

Bill Method Select the billing method for accounts funded
using this instrument from the drop-down list.

Balloon Method If the lease calculation method is selected as
Interest Rate, then the balloon payment method
for accounts funded using this instrument is N +
1 PMTS by default. Amortization happens based
on N+1 payments. However, this field is not
applicable if the lease calculation method is Rent
Factor.

Multiple Billing Asset Rate Check this box to indicate if multiple asset rates
are applicable for one billing period.

System considers billing period from current due
date to the next due date. Multiple rates are
fetched only when rate end date (rate start date
+ rate frequency) ends one or more cycle(s)
before the next due date i.e. current rate record
does not cover the entire billing period.

Prorate Stub Pmt This checkbox is enabled only for 'Amortized'
Lease calculation method.

Select this box to indicate if the interest during
stub/broken period is to be collected on prorated
basis. Else, the interest is collected for the full
amount applicable for the selected cycle.

By default system prorates the interest rate by
calculating the number of days in the cycle up to
the next billing date.

Delinquency section

Late Charge Grace Days Specify the number of grace days allowed for the
payment of a due date before a late charge is
assessed on the account.

Stop Accrual Days Specify the number of days a contract can be in
delinquent state, after which the interest accrual
must stop for an account.

A Batch Job is run daily to select accounts in
delinquent status for a pre-defined number of
days and post No Accrual transaction for such
accounts on current date. When the account
recovers from Delinquency, the system will then
post a Start Accrual Transaction on the date
the account is recovered from delinquency.
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Delq Grace Days Specify the number of grace days allowed for the
payment of a due date before an account is
considered delinquent. This affects DELQ
Queues, the system reporting, and the
generation of collection letters.

Time Bar Years Specify the total number of years allowed to
contact the customer starting from the first
payment date and beyond which the account is
considered delinquent. You can specify any value
between 0-999.

Cure Letter Gen Days Specify the number of delinquency days to
initiate cure letter generation.

Cure Letter Valid Days Specify the number of days during which the
issued cure letter is valid. Usually financial
institutions will start the collection activities after
the lapse of cure letter validity date.

Delq Category Method Select the delinquency category method to
determine how the system populates
delinquency counters on the Customer Service
form.

Note: This value does not affect credit bureau
reporting.

Accrual Post Maturity Check this box to indicate that this is the post
maturity default rate.

Extensions allow you to extend the maturity of
the contract by one or more terms by allowing
the customer to skip one or more payments. The
skipped terms are added to the end of the
contract.

Note: If the lease calculation method is selected
as Rent Factor, this field is disabled since it is not
applicable.
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Cycle Based Fees - This section allows to define the parameters for calculating cycle based fees at
individual account level. Using the below parameters, system derives the Cycle Base Fees and
updates the account balances on processing the following batch jobs - TXNCBC_BJ_100_01
(CYCLE BASED COLLECTION LATE FEE PROCESSING) and TXNCBL_BJ_100_01 (CYCLE
BASED LATE FEE PROCESSING). For more information, refer to Fee Consolidation
Maintenance section in Appendix chapter.

System calculates the below type of fee in combination of associated and master account and is
assessed only when total due crosses Threshold amount (that is defined in Setup > Products >
Contract > Fees tab and Setup > Products > Fees screen):

Fee Late Charge (FLC)
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount

Cycle Based Collection Late Fee
• Flat amount
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount
• Percentage of payment due
• Percentage of standard payment
• Percentage of billed amount
• Percentage of total due amount
• Percentage of sum of total due amount

Cycle Based Late Fee
• Flat amount
• Percentage of sum of total due amount
• Percentage of sum of payment due
• Percentage of sum of standard payment
• Percentage of sum of billed amount
• Percentage of total due amount
• Percentage of payment due
• Percentage of standard payment
• Percentage of billed amount

Cycle Based Collection Late Fee Check this box to enable cycle based collection
late fee assessment on the account.

If selected, the balance type CYCLE BASED
COLLECTION LATE FEE is made available in
the Balances tab which further allows to define
how system should derive the balances when an
account is booked and funded.

If unchecked (default), system does not display
the Cycle based Collection Late Fee balance in
Contract >Balances tab on clicking Load
Balances button.
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Cycle Based Late Fee Check this box to enable cycle based late fee
assessment on the account.

If selected, the balance type CYCLE BASED
LATE FEE is made available in the Balances tab
which further allows to define how system should
derive the balances when an account is booked
and funded.

If unchecked (default), system does not display
the Cycle Based Late Fee balance in Contract
>Balances tab on clicking Load Balances
button.

Cycle Based Collection Late Fee Grace Days Specify the number of grace days allowed before
cycle based collection late fee is assessed on
the account. This field is enabled only if the
Cycle Based Collection Late Fee option is
checked above.

Cycle Based Late Fee Grace Days Specify the number of grace days allowed before
cycle based late fee is assessed on the account.
This field is enabled only if the Cycle Based Late
Fee option is checked above.

Fee Consolidation - If Cycle Based Late Fee is assessed based on above parameters, this section
allows to enable/disable the option to consolidate the late fee at Master Account level.

Late Charge at Master Account Check this box to allow system to consolidate the
late charge assessment at master account level.

Cycle Based Collection Late Fee at Master
Account

Check this box to allow system to consolidate the
cycle based collection late fee assessment at
master account level.

Ensure that, the option Cycle Based Collection
Late Fee is also checked for fee consolidation at
Master Account level.

Cycle Based Late Fee at Master Account Check this box to allow system to consolidate
cycle based late fee assessment at master
account level.

Ensure that, the option Cycle Based Late Fee is
also checked for fee consolidation at Master
Account level.

Lease Contract section

Lease Type Select the lease type from the drop-down list.
You can select the lease type as either Direct
Finance or Operating Lease.

If the lease Type is selected as Direct Finance,
system enables the field Residual Value in
Final Bill under Residual Details section for
selection.

Tax Book Type Select the lease tax book type for depreciation
from the drop-down list.
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Table 4-23    (Cont.) Contract Definition

Field Do this

Depreciation section
In this section you can define asset depreciation method and frequency. The same is used for asset
depreciation calculation when the batch job TAMDEP_BJ_121_01 (DEPRECIATION RATE
PROCESSING) is executed.

If asset is associated to an account then an Asset Depreciation amortization transaction is posted
on to the account with new delta depreciated value. Asset depreciation is calculated till the entire
lease term or till the asset residual amount becomes 0.

Depreciation Method Select the asset depreciation method to be used
for calculation as one of the following from the
drop-down list.
• FLAT RATE: This method is used to

depreciate the asset over a fixed time using
a fixed rate. This method of calculation is
similar to Written Down Value Method
(Diminishing Balance Method / Reducing
Installment Method). On selecting this
option, the following fields - Base Rate,
Adjusting Rate and Bonus Rate are enabled
to define the flat rate.

• LIFE BASED: This method is used to
depreciate the asset over a fixed time using
the specified rates. This method of
calculation is similar to Straight Line Method
(Original Cost Method / Fixed Installment
Method). On selecting this option and saving
the record, Depreciation Rate Schedule
sub tab is enabled to define depreciation
rates slab.

Depreciation Convention Select the frequency at which the leased account
should be updated with depreciation details from
the drop-down list. The list is populated with
frequency details (i.e. monthly, weekly, and so
on) maintained in
FIRST_LAST_YEAR_CONVENTION_CD
lookup code.

Base Rate If you have selected the Depreciation Method as
Flat Rate, specify the estimated base
depreciation rate.

Adjusting Rate If you have selected the Depreciation Method as
Flat Rate, specify the adjusting rate at which the
above base rate should be increased to derive
the flat rate of depreciation.

For example,
• If base rate is 10 and adjusted rate is 10

then flat rate is 11
• If base rate is 10 and adjusted rate is 20

then flat rate is 12
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Table 4-23    (Cont.) Contract Definition

Field Do this

Bonus Rate If you have selected the Depreciation Method as
Flat Rate, specify the bonus rate (if any) which is
additional depreciation allowed on base rate for
calculating flat rate depreciation.

Bonus rate is a tax incentive offered to deduct a
percentage of the purchase price of eligible
business assets and as a measure of relief for
small to medium sized businesses to buy
additional equipment.

For example,
• If base rate is 10 and bonus rate is 10 then

flat rate is 20
• If base rate is 10 and bonus rate is 2 then

flat rate is 12

Depreciation Rate View the system calculated flat rate depreciation
value which is calculated as:

Depreciation Rate% = (Base Rate x (1 +
Adjusting Rate/100)) + Bonus Rate.

Tax section

Sales Tax Mode Select the sales tax mode from the drop-down
list.

Sales Tax Method Select the sales tax method from the drop-down
list.

Early Termination section

Allowed To Terminate Check this box to indicate if the contract is
allowed to be terminated before the maturity
date.

Note that, system validates and allows
termination only if either the Billed Term or Lease
Amount Recovered % is met.

Billed Term Specify the minimum number of bills that needs
to be generated before allowing for early
termination.

Lease Amt Recovered % Specify the percentage of lease amount to be
recovered to allow early termination.

The calculation for minimum lease amount to be
recovered for Rent Factor and Interest Rate is as
indicated below:

For calculation method as Rent Factor, Minimum
lease amount = (Depreciation + Rent Charge i.e.
Lease Receivable balance) that needs to be
recovered before allowing early termination.

For calculation method as Interest Rate, the
Minimum lease amount = (Depreciation + Rent
Charge i.e. Lease Receivable balance + Interest
balance) that needs to be recovered before
allowing early termination.
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Table 4-23    (Cont.) Contract Definition

Field Do this

Lease Recovery Type Select the Lease Recovery Type from the drop-
down list.

You can either select as 'FIXED' to recover the
full lease amount or 'PROPORTIONATE' (default)
to recover only the prorated lease amount.

The type selected here is updated as the value
for parameter 'LEASE CHANGE RECOVERY
TYPE' in Lease Account Maintenance, Lease
Termination and Payoff Quote transactions.

Ever Green Details
This section allows you to define Evergreen lease parameters that are required for system to decide
if the contract is eligible and automatically put the account on Evergreen mode on maturity. These
parameters also indicates when to post auto renewal transaction, the renewal term, and billing
based on the derived evergreen billing amount.

Evergreen lease transaction is posted on running the schedule batch job TXNEGC_BJ_121_01
(POST MATURITY EVER GREEN TRANSACTION PROCESSING).

Note: Evergreen Lease in OFSLL supports Stub/Broken/Fiscal Period billing and Evergreen Lease
is not supported for RENT FACTOR type of lease calculation method.

The Ever Green details maintained here are propagated to Origination on selecting the instrument.
Also on funding, the details are updated to Servicing - Account Details and Contract Details
screens. However, the Ever Green parameters in Account Details screen can further be updated by
posting LS_EVER_GREEN_MAINT (EVER GREEN MAINTENANCE non-monetary transaction.

Auto Post & Renew on Maturity Check this box to allow system to auto post and
renew the evergreen lease contract on maturity
date + ever green grace days.

When a contract is in evergreen lease terms, this
option allows to renew the contract automatically
for specific terms without any intervention. In
addition, you can also specify the number of
payments for which the Contract must be
renewed during evergreen.

Note

On selecting this check box:
• All the fields in Ever Green Details

section are enabled and
mandatory to be updated with
required details.

• If check box is unselected, any
predefined values in this section is
set to default value.

• The Auto Include Residual Value
option in Residual Details section
is disabled.

Number of Unpaid Bills Specify a value. Auto renewal of contract to
evergreen lease is allowed only when actual
number of unpaid bills is greater than the
specified value.
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Table 4-23    (Cont.) Contract Definition

Field Do this

Unpaid Bills % Specify the percentage (0 - 100) of total unpaid
bills remaining for system to consider for auto
renewal of contract to evergreen lease.

System uses the greater of these two values i.e.
Number of Unpaid Bills and Unpaid Bills %

Pmt Amount Method Select one of the following payment amount
method from drop-down list which is to be
accounted for billing on auto renewal of contract
to evergreen lease. This is the rental amount for
asset usage.
• % on Maturity Bill - Percentage of lease

payment amount as on maturity.
• Fixed Amount - Fixed lease amount
• % on Standard Payment Amount - If the

account has multiple payments, then the last
payment cycle amount is considered as
standard payment Amount. For example: In
a 6-month term account, if first 3 terms Pmt
Amount is 1000$ and next 3 terms Pmt
Amount is 2000$, system considers 2000$
as the standard payment amount.

Value Specify the value to derive the asset usage
billing amount based on any of the above
Payment Amount Method.

Grace Days Specify the total number of grace days allowed
after maturity for system to consider for auto
renewal of contract to evergreen lease.

Evergreen Term Specify the new extension term which is the
agreed term between customer and financial
institution.

This term is mapped to extension term of EVER
GREEN LEASE monetary transaction.

Residual Reduction % Specify a percentage value to indicate how much
residual value has to be reduced while posting
Evergreen transaction. You can specify
numerical value up to 2 decimal with minimum as
zero and maximum of 100.

For example, if the residual value of asset =1000
and and Residual Reduction % is 100, then
system considers residual value of asset as
ZERO.

Residual Details section

Minimum Residual % Specify the minimum residual percentage that is
allowed to be specified in Origination > Contract
screen (Residual % field).

Maximum Residual % Specify the maximum residual percentage that is
allowed to be specified in Origination > Contract
screen (Residual % field).
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Table 4-23    (Cont.) Contract Definition

Field Do this

Auto Include Residual Value Check this box to indicate if the Residual value of
the asset is to be included in the final bill. This
check box is disabled if the lease Agreement
Type in Selection Criteria section is selected as
USAGE RENTAL.

When bill is generated, system validates if the
generated bill is last bill and includes the
Residual Value (either Contract Value or FMV
(fair market value) based on selection) in the final
bill. For FMV, the total value of all collaterals are
considered.

Here, Contract value is the value determined as
residual value during the contract agreement
time and FMV is the value of asset at the end of
the lease term.

Also when residual value is included in final bill,
system does not allow to post an Extension
transaction and displays an error while posting
the same.

Residual Valuation If the above check box is selected, you need to
select the Residual Valuation as either Contract
Value or Fair Market value from the drop down
list.

Note: Fair Market Value is referred from
Collateral > Valuation tab.

Payment Caps section

Max Pmt Inc / Year Specify the maximum payment increase allowed
in a year.

Note: If the lease calculation method is selected
as Rent Factor, this field is disabled since it is not
applicable.

Max Pmt Inc / Life Specify the maximum payment increase allowed
in the life of the lease.

Note: If the lease calculation method is selected
as Rent Factor, this field is disabled since it is not
applicable.

Extension section
Note: If the lease calculation method is selected as Rent Factor, the fields in this section are
disabled since it is not applicable.

Max Extn Period / Life Specify the maximum number of terms that the
contract may be extended, beyond the life of the
Lease.

Max # Extn / Life Specify the maximum number of extensions that
may be granted beyond the life of the Lease.

Minimum # of Payments Specify the minimum number of payments that
must be made before lease extension.

Rate Cap & Adjustments section
Note: If the lease calculation method is selected as Rent Factor, the fields in this section are
disabled since it is not applicable.

Max Rate Inc / Year Specify the maximum rate increase allowed in a
year.
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Field Do this

Max Rate Inc / Life Specify the maximum rate increase allowed in
the life of the lease.

Max Rate Dec / Year Specify the maximum rate decrease allowed in a
year.

Max Rate Dec / Life Specify the maximum rate decrease allowed
during the life of the lease.

Max # Adjust / Year Specify the maximum number of rate changes
allowed in a year.

Max # Adjust / Life Specify the maximum number of rate changes
allowed during the life of the lease.

Min Int Rate (Floor) Specify the minimum rate.

Max Int Rate (Ceiling) Specify the maximum rate.

Statement section
This section allows to define the preferences for Mock Statement generation at Master Account
level. Generating a Mock Statement helps to mock the asset billing process with a future date and
to get an upfront statement indicating future dues of Master and Associated Accounts. In Vacation
Ownership industry, such statements are required to forecast future dues based on current
Timeshare holdings.

The selected preference here are propagated to Application > Contract screen when the instrument
is loaded.

Mock Statement Req Select this check box to indicate if the account is
to be include in Mock statement Generation.

Note: Based on this selection, others fields
related to Mock Statement below are enabled
and becomes mandatory for providing details.

Mock Start Month Select the start month of Mock Statements
period from the dropdown list.

Note: During the Mock Statement Next Run
Date validation if next run date is less than
Contract Date or GL Date, system moves the
Mock Start Month to same month of next year.
For more information, refer to Mock Statement
Maintenance in Appendix - Non Monetary
transactions sections.

Mock Statement Cycles Select the total number of billings (between 1-12)
that are to be generated post Mock Statement
Start Date.

Mock Pre Statement Days Specify the number of Pre bill days for Mock
Statements generation.

Other section
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Field Do this

Rent Collection Method Select the applicable rent collection method from
the drop-down list.

If the lease calculation method is selected as
Rent Factor, the rent collection method is set to
ADVANCE by default. For Interest Rate
calculation method, you can either select
ADVANCE or ARREARS.

In case of ADVANCE, the first payment date
must be equal to contract date and first bill would
be generated on contract date.

In case of ARREARS, you can specify the first
payment date as future date and bill would be
generated accordingly.

Refund Allowed Check this box to indicate that refunding of
customer over payments are allowed.

Refund Tolerance Amt Specify the refund tolerance amount. If the
amount owed to the customer is greater than the
refund tolerance, the over payment amount will
be refunded if Refund Allowed box is selected.

Anniversary Period Specify the anniversary term that define the
anniversary period. This is based on billing cycle,
so normally for MONTHLY the value is 12 and for
WEEKLY the value is 52.

Contract Expiry Letter Days Specify the number of days before the maturity to
generate the Contract Maturity letter.

WriteOff Tolerance Amt Specify the write off tolerance amount. If the
remaining outstanding receivables for accounts
funded using this instrument is less or equal to
the write off tolerance amount, the remaining
balance on the account will be waived.

Recourse Check this box if recourse is allowed. This
indicates whether the unpaid balance may be
collected from the producer if the consumer fails
to perform on the lease.

Max Recourse% Specify the maximum percentage of the
outstanding receivables that may be collected
from the producer if the Recourse Allowed box
was selected.

Repmt Currency Select the designated repayment currency for
this contract from the drop-down list.

PDC Security Check Check this box to indicate that post dated checks
are the method of repayment for this contract.

Default Pmt Spread Select the default payment spread to be used
when receiving payments for this account if one
is not explicitly chosen, from the dropdown list.

ACH Fee Check this box to indicate that direct debit fee is
included.

Note: The ACH Fee/Direct Debit Fee balance will
be displayed in Balances sub tab only when this
checkbox is selected.
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Field Do this

Track Down Payment Balance Select this check box for system to validate if
Down Payment Balance is loaded. This helps to
record the Down Payment balance Agreed and
Paid by the customer.

If selected, system validates if Down Payment
Balance is loaded in the contract setup. However,
system does not validate Down Payment
Balance if unchecked. This check box is available
only for Lease contracts.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Extension of Terms

The system facilitates extension of terms, provided the following conditions are satisfied:

• Specified number or more payments made in the account

• Gap between the previous and current extension provided in the account must be a
specific number of months that could be specified

If the above conditions are not satisfied, then the system displays an appropriate error
message.

A new transaction Force Extension will be available. This transaction will be posted when you
want the system to bypass the extension validations defined at the contract level.

When a backdated transaction with TXN Date exists before the transaction date of extension,
all the transactions are reversed and posted again. If extension transaction is posted again,
then the validation rules are not validated again.

This section consists of the following topics:

• Staged Funding

• Balances

• Amortized Balances

• Itemizations

• Fees

• Depreciation Rate Schedule

• Passthrough Fees

4.8.1 Staged Funding
Staged Funding

Staged funding for closed-end loans allows you to disburse funds to customers through
multiple advances or draws up to the approved amount within a specified draw period.

To create a multiple disbursement contract for a transaction

1. In the Contract Definition section, click Add and complete the fields following the
instructions above, making sure to complete the following steps:

• In the Advance Details section, select the Multiple Disbursement Permitted check box.
When you select a contract instrument that permits staged funding (multiple
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disbursements) on the Funding screen, the system copies the information for that
instrument from the Setup Module screen’s Contract screen to the Funding screen’s
Contract screen.

Note

You cannot clear the Multi Disbursement Allowed box in the Advance section
on the Contract screen.

• Complete the fields in the Advance Details section to define the limits for initial and
subsequent advances for staged funding.

Note

This information appears in the Advance section of the Funding screen’s
Contract link.

2. If you choose, set the following APPLICATION CONTRACT EDITS as an ERROR or
WARNING on the Setup Module screen’s Edits screen.

Note

For more information, see the Edits link (Edits screen) section in this chapter.

1. REQUIRED: ADV DRAW END DATE

2. XVL: ADV DRAW END DT MUST BE AFTER CONTRACT DT

3. XVL: ADV DRAW END DT MUST BE LESS THAN FIRST PMT DT - PREBILL DAYS

These edits appear on the Funding screen’s Verification screen.

Repayment scheduling for staged funding

When funding a loan, the system computes repayment schedules from the contract date,
irrespective of whether funds have been disbursed or not. The system uses the approved
amount (amount financed) for computing repayment schedules on the contract date.

As the might have been disbursed through multiple draws, or the draws have been less than
the approved amount, or the amount may have been repaid in some amount before the draw
end date, you may need to change the payment amount. In such cases, you can manually
change the payment in the system by posting the monetary transaction CHANGE PAYMENT
AMOUNT on the Customer Service screen’s Maintenance link.

Disbursements for staged funding

The approved amount for staged funding can be disbursed with the Funding screen or at a
later time using the Advances screen. If the first disbursement is requested during funding, you
may enter it on the Itemization sub screen of the Funding screen’s Contract screen.

If the entire approved amount is not disbursed during initial funding, it can be disbursed using
the Advances screen’s Advance Entry screen.

If the initial amount on the Advance Entry screen is not within the minimum or maximum limits
(as entered in the Advance Details section on the Setup Module screen’s Contract screen), the
system displays any of the following error or warning messages in the Advances section’s
Error Reason field:
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• ADVANCE AMOUNT IS LESS THAN THE INITIAL ADVANCE AMOUNT MINIMUM
-or-

• ADVANCE AMOUNT IS MORE THAN THE INITIAL ADVANCE AMOUNT MAXIMUM

The Advance Entry screen also allows you to enter subsequent funding / disbursements. If
subsequent advances are not within the predetermined minimum or maximum amounts, the
system displays any of the following warning or error messages in the Advances section’s
Error Reason field:

• ADVANCE AMOUNT IS LESS THAN THE ALLOWED SUBSEQUENT ADVANCE
AMOUNT
-or-

• ADVANCE AMOUNT IS MORE THAN THE ALLOWED SUBSEQUENT ADVANCE
AMOUNT

Additional messages in the Error Field regarding Staged Funding

If you attempt to post an advance after the draw end date, then the system displays the
message in the Advances section’s Error Reason field as, ADVANCE DT IS AFTER DRAW
PERIOD END DATE.

If you attempt to post an advance above the approved amounts, including tolerance, the
system displays the message in the Advances section’s Error Reason field as ADVANCE
AMOUNT IS MORE THAN THE TOTAL APPROVED AMOUNT INCLUDING TOLERANCE.

Since this is not a revolving loan, if any repayment is made against the approved amount
principal balance, the system will not adjust the disbursed amount allowing for subsequent
additional staged funding or advances.

Note

There is no change to the payoff quote functionality in the system. The system uses
the actual amount of the advance(s) and any interest accrued since the date of the last
payment or credit in the PAYOFF QUOTE VALID UPTO DATE value when the payoff
quote is requested before the draw end date.

4.8.2 Balances
The Balances sub screen lists the balances that will be established when an account is booked
and funded.

CAUTION: Please contact your Implementation Manager for changes to this section.

To set up the Balances

1. Click Setup > Setup > Administration > User > Products > Contract > LoanLineLease
> Balances.

2. On the Balances sub screen, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 4-24    Balances

Field Do this

Balance Type Displays the balance type.
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Table 4-24    (Cont.) Balances

Field Do this

Displays the balance type. Select the charge off method to determine how
the outstanding amount of this balance type will
be handled from the drop-down list, if the
account becomes uncollectable and the product
is charged off.

Writeoff Method Select the write off method to determine how the
outstanding amount of this balance type will be
handled from the drop-down list, if the account is
within the write off tolerance of being PAID.

Reschedule Method Select the reschedule method to determine how
the outstanding amount of this balance type will
be handled from the drop-down list, if the
account is rescheduled.

Sort Specify the sort order of how account balances
will appear on the Customer Service form’s
Balance screen.

Billed Check this box to indicate that outstanding
amounts for this balance type are considered a
part of the billed amount. This also determines
whether payments applied to this balance type
are considered when satisfying outstanding
amounts due.

Accrued Check this box to indicate that outstanding
amounts for this balance type will be included
when interest is accrued against the account.

Non Performing Rollover Check this box to indicate that non-performing
is used as an intermediary status on your
general ledger prior to charge off and want to
create balances for non-performing accounts for
this balance type.

Note: (The Non-Performing Rollover box applies
only to Balance Types of ADVANCE/PRINCIPAL
and INTEREST. For all other Balance Types, this
box would be cleared).

Non Performing Balance Type Select the balance type you want to rollover from
drop-down list, if you select the Non-Performing
Rollover box (Advance/ Principal).

Enabled Check this box to indicate that this balance type
will be created when the account is booked and
funded.

This section is applicable if the capitalization frequency is selected as Balance Frequency for the
contract and allows you to define capitalization parameters for a specific type of account balance
such as Interest.

Note: The value of parameters defined in this section supersedes the values defined in header
section.

Capitalize Check this box to enable capitalization
parameters for the selected balance type. By
default, this option is un-checked.

Note: The option is disabled for Advance /
Principal type of Loan Line contracts and for
Lease Receivables.
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Field Do this

Vendor Passthrough 'Passthrough' in financial term refers to a portion
of a payment made to a vendor for specific
service. This amount is basically collected by
lessor from a lessee and is passed to vendor. For
example, maintenance fee paid to a vendor for
servicing/maintaining photocopier in corporate
office based on a service agreement. Here, the
corporate office (lessee) pays to the supplier
(lessor) and is transferred to vendor.

Select the check box to indicates if there is
certain balance enabled for 'Vendor
Passthrough'.

Note

Vendor Passthrough is supported only
for 'Fee Balances' and for fee type
'FPMF'. If any other fee type is selected
for passthrough, system displays an
error as 'Passthrough flag supported for
Fee Periodic Types only'.

Frequency Select the capitalization frequency from the drop-
down list. Frequency can be selected using any
of the following options:
• Based on specific intervals such as Monthly,

Quarterly, Annual and so on.
• Based on contract Billing Frequency, Billing

Date, Due date.
• Specifically on every Month End.

Grace Days Specify the grace days allowed in the frequency
(minimum 0, maximum 31) before capitalizing the
balances to account. This is also the deciding
factor for executing the capitalization batch job
which is based on Capitalization Frequency +
Grace Days.

However, note that Grace Days are not
accounted for Month End type of capitalization
frequency and is ignored even if specified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The system loads the currently defined balances for accounts.

If your organization maintains additional balances, contact your Implementation Manager
for information regarding those balances.

4.8.3 Amortized Balances
With the Amortize Balances sub screen, you can select one or more balances to be amortized
over the life of the LoanLine of CreditLease. You can also define the amortization method.

To set up the Amortization Balances
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1. Click Setup > Setup > Administration > User > Products > Contract > LoanLineLease
> Amortized Balances.

2. In the Amortization Balances section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-25    Amortization Balances

Field Do this

Amortize Balance Type Select the amortize transaction type from the
drop-down list.

Amortization Method Select the amortization method used to calculate
the net amortization amount from the drop-down
list.

Cost/Fee method Select the amortization cost/fee method.

Sort Specify the sort sequence to define the order of
the amortize balances.

Enabled Check this box to enable the amortize balance to
be created when the account is booked and
funded.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8.4 Itemizations
On the Itemizations sub screen, you can define the itemized components for each type of
contract, indicate if it is required, and determine whether it has a positive or negative bearing
on the contract itemization math. You can establish the following groups of itemization
transactions:

Advance Total amount of the product that is not a part
of financed fees; in other words, the total
amount the customer requested to be
advanced.

Financed Fees Fees rolled into the principal balance of the
product. Financed fees are also considered to
be a part of the finance charge.

Pre-Paid Fees Fees that are paid by the consumer prior to
the funding of the LoanLine of CreditLease.
These fees are not rolled into the balance of
the product but are considered as part of the
finance charge and are included in the
calculation of the APR.

Producer Fees that are paid to or by the producer of the
LoanLine of CreditLease; for example, a fee
that is being charged to the producer. These
transactions will affect proceeds.

Escrow Allows you to connect the actual escrow
itemization with the escrow type and the
funding transaction.
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To set up the Itemizations

1. Click Setup > Setup > Administration > User > Products > Contract > LoanLineLease
> Itemizations.

2. On the Itemization sub screen select the option button to indicate the type of itemization
you are working with: Advance, Financed Fees, Pre-Paid Fees, Producer, or Escrow.

3. On the Itemization sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-26    Itemizations

Field Do this

Itemization Select the itemization from the drop-down list.

Disbursement Type Select the disbursement type from the drop-down
list.

Transaction Select the funding transaction type from the
drop-down list.

Itemization Type Select the itemization type from the drop-down
list.

Note: On selecting the Prefunding Txns as
itemization type, it indicates that this particular
itemization expects a payment from the customer
prior to funding.

Sort Specify the sort order to define the order of the
itemization transactions.

Sign If the itemized transaction increases the group
balance, click +ve.

-or-

If the itemized transaction decreases the group
balance, click -ve.

Enabled Check this box to enable the itemization and
indicate that this itemization transaction will be
created when the account is booked and funded.

Amortize Balance Select the amortize balance affected by this
itemization transaction from the drop-down list.
Note: Advance itemizations do not affect
amortize balances.

Refund Calculation Method Select the refund calculation method from the
drop-down list.

Taxable Check this box, if the itemization type is taxable.
However, note that the taxable option defined in
Setup > Administration > System > Sale Tax
screen will supersede with this preference.

Seller Pmt Check this box to enable seller payment.

Escrow Select the escrow from the drop-down list.

Itemization Formula Select the itemization formula description from
the drop-down list.

Refund Calculation Method Check this box to enable Refund calculation
Method.
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Table 4-26    (Cont.) Itemizations

Field Do this

Escrow Required If this is an escrow account, check this box to
indicate that an escrow is required during the
application process (though at that time the user
can choose Opt Out to decline.)

Discount Rate Specify the discount rate for the itemization.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8.5 Fees
Any fees that are defined in the contract are set up on the Fees sub screen. The system
currently supports the following contract fees:

• Late charges

• Non sufficient funds

• Extensions

• Prepayment penalties

• Delay Fee

• ACH Fee

The Fees sub screen allows you to define those fees whose value and method of calculation
are set at the time of the LoanLine of CreditLease. As these amounts cannot be changed after
the product is booked and funded, you should only set up fees here that will not change over
the life of the LoanLine of CreditLease. Individual contract fee types may be defined multiple
times in order to create graduated fees.

Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such
cases, the contract fee, if present, is used first.

To set up the Fees

1. Click Setup > Setup > Administration > User > Products > Contract > LoanLineLease
> Fees.

2. In the Fees section, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 4-27    Contract Fees

Field Do this

Type Select the fee type from the drop-down list.

Txn Amt From Specify the lowest transaction amount or balance
amount against which this contract fee definition
may be applied.
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Table 4-27    (Cont.) Contract Fees

Field Do this

Amount Financed From Specify the minimum value of amount financed
on the contract.

Note: This is the Contracted loan amount
during origination and would always be the
Amount Financed on contract even if principal
addition is done through a transaction in
servicing.

Credit Limit From Specify the minimum value of credit limit for the
pricing.

Gross Capitalized Cost From Specify the minimum value of gross capitalization
cost.

Method Select the method of calculating the fee to be
assessed from the dropdown list.

Frequency Select the frequency of calculating the fee to be
assessed from the drop-down list.

Threshold Amt This field is enabled only if the Contract Fee type
is either CYCLE BASED COLLECTION LATE
FEE or CYCLE BASED LATE FEE.

Specify the threshold amount which is less than
or equal to minimum fee amount to be assessed.
Based on this amount, system calculates and
posts the Cycle Based Collection Late Fee or
Cycle Based Late Fee based on the account.

If calculated fee amount is less than threshold
amount, fee is posted with transaction amount =
0.

If calculated fee amount is greater or equal to
threshold amount, fee is posted based on
existing min amt and max amt comparing logic.

Min Amt Specify the minimum fee amount to be assessed.

Max Amt Specify the maximum fee amount to be
assessed. If you selected FLAT in the Method
field, then this field is not used and is normally
populated as $0.00.

Percent Specify the fee percentage of the outstanding
transaction amount to be assessed as a fee. This
amount will be adjusted to fall within the Min
Amount and the Max Amount.

Passthrough - This is applicable only for Lease Contracts - Rent Factor, Interest Rate, Amortized
Methods including Usage/ Rental Methods. 'Passthrough' in financial term refers to a portion of a
payment made to a vendor for specific service. This amount is basically collected by lessor from a
lessee and is passed to vendor.

Post Maturity 'Post Maturity' is applicable for 'Evergreen Lease'
type of contracts and to indicate if there is an
'Evergreen Lease' transaction posted for account
or not.

Select the 'Post Maturity' checkbox to indicate if
the passthrough rate is applicable for post
maturity also of the account.

Enabled Check this box to create the selected contract fee
when the account is booked and funded.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.8.6 Depreciation Rate Schedule
This tab is enabled if you have selected LIFE BASED depreciation method in Contract
Definition and allows to define depreciation rates slab.

To define Life Based Depreciation Rate Schedule

1. Click Setup > Administration > User > Products > Contract > Lease > Depreciation
Rate Schedule tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 4-28    Depreciation Rate Schedule

Field Do this

Period Specify the cycle period sequence for life based
depreciation calculation.

Duration Specify the tenure for which the rate slab is
applicable.

For example, if duration is 12, and depreciation
convention frequency is Monthly, then rate slab is
applicable for first 12 months.

Depreciation % Specify the percentage of depreciation to be
calculated during the above duration.

Enabled Select the check box to enable the rate schedule.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8.7 Passthrough Fees
'Passthrough' in financial term refers to a portion of a payment made to a vendor for specific
service. This amount is basically collected by lessor from a lessee and is passed to vendor. For
example, maintenance fee paid to a vendor for servicing/maintaining photocopier in corporate
office based on a service agreement. Here, the corporate office (lessee) pays to the supplier
(lessor) and is transferred to vendor.

This sub screen allows you to define Passthrough Fee definition which is used in evergreen
lease contracts.

To set up Passthrough Fees

1. Click Setup > Setup > Administration > User > Products > Contract > Lease >
Passthrough Fees.

2. In the Passthrough Fees section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 4-29    Passthrough Fees

Field Do this

Balance Type Select the required account balance that is
enabled for vendor pass through from the drop-
down list. The list displays all the 'FPMF (Fee
Periodic Maintenance Fee)' balances attached to
the contract fee type.

Disbursement Type Select the type of passthrough disbursement
type as either Billing date or Full Fee Receipt
from the drop-down list.

Note

System supports only Full Pass through
and not Partial.

.

Passthrough % Specify the passthrough percentage to be
processed.

Retaining Bal Type Select the lessor retention balance type from the
drop-down list. The list displays all the balances
attached to the contract for selection.

Enabled Check this box to enable the Passthrough feed
definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.9 Edits
Edits ensure your organization’s guidelines are properly followed and that all exceptions are
sent to the appropriate personnel to review.

You can configure your system so that during the origination process, at each change to an
application’s status, the system will perform a set of edits on the Verification link’s Edits screen
(found on the Application Entry, Underwriting, and Funding windows).

Edits ensure your organization’s guidelines are properly followed and that all exceptions are
sent to the appropriate personnel to review. If the edits check fails, then the system will not
allow the change of status, and the application will remain in its current status. This screen
allows you to define the validations the system must perform on the Verification master tab, as
the status of application changes.

Origination edits are used to validate applications entered through the standard Application
Entry and Applications windows. The Edits screen contains two sections, the Edit Type
Definition section and the Edit Sub Type Definition section.

To set up the Edits

You can either define new Edit Type Definition details or specify a new name in the New Edit
Type field and click Create Copy to create a copy of selected edit type definition with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Edits > LoanLineLease.

2. On the Edits screen, choose Origination or Open Interface.
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3. In the Edit Type Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-15    Edits

Figure 4-16    Edits
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Figure 4-17    Edits

A brief description of the fields is given below:

Table 4-30    Edit Type Definition

Field Do this

Edit Specify the edit name.

Description Specify the description for the edit.

Edit Type Select the edit type code from the drop-down list.

System Defined Select Yes, if the entry is system defined.
System defined entries cannot be modified.
Select No, if the entry is not system defined and
it can be modified.

Enabled Check this box to enable the edit.

Company Select the portfolio company associated with this
edit, from the drop-down list. This may be ALL or
a specific company.

Branch Select the portfolio branch within the company
associated with this edit, from the drop-down list.
This may be ALL or a specific branch. This must
be ALL if you selected ALL in the Company field.

Channel Select the channel from the drop-down list, This
can be ALL or a specific channel.

Product Select the product associated with this edit, from
the drop-down list. This may be ALL or a specific
product.

State Select the state with this edit from the drop-down
list. This may be ALL or a specific product.

Currency Select the currency associated with this edit,
from the drop-down list. This may be ALL or a
specific branch.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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5. In the Edit Sub Type Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-31    Edit Sub Type Definition

Field Do this

Edit Sub Type Select the edit sub type for the edit, from the
drop-down list.

Edit Select the description for the edit, from the drop-
down list.

Result Select the result type for the edit, from the drop-
down list.

Enabled Check this box to enable the edit.

Value Specify the expected value for the first edit. The
Value field records the threshold value for the
edit. The actual function of the entered value is
dependent on the edit category.

Override Responsibility Select the responsibility that can override the
edit, from the drop-down list, if the edit result is
an override. Designates the user responsibility
level required to continue processing applications
that fail the edit based on the Value field. You
may define the same edit multiple times with a
Result = OVERRIDE and different Value and
Override Responsibility combinations to
encompass various results.

System Defined Select Yes, if the entry is system defined.
System defined entries cannot be modified.
Select No, if the entry is not system defined and
it can be modified.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
Using the Edit Type field of the Edit Type Definition section, you can define when you
want the edits check to occur by selecting from the following list of edit types:

Table 4-32    Edit Type Definition

Edit type Description

APP ENTRY EDITS Edits that normally run on Application Entry form.

APP PRESCREENING EDITS Edits that run between application entry and the
pulling of a credit bureau. These edits determine
whether the application should be reviewed
further, and whether a credit bureau should be
pulled.

PRE Qualify Edits Edits that run to check whether the minimum
details which are required to prequalify the
application are satisfied or not.

APP AUTOMATIC APPROVAL EDITS Edits that run after a credit bureau has been
pulled and scored. These edits determine
whether an application should be automatically
approved or declined.
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Table 4-32    (Cont.) Edit Type Definition

Edit type Description

APP APPROVAL EDITS Edits that run whenever an application is
manually changed to a status/sub status that
indicates the application (in its current state)
should be approved.

APP DECLINE EDITS Edits that run whenever an application is
manually changed to a status/sub status that
indicates the application (in its current state)
should be declined.

APP CONTRACT EDITS Edits that run whenever an APPROVED or
CONDITIONEDAPPROVED application is about
to be funded. These edits ensure the validity of
the contract data.

Each entry in the Edit Sub Type field is grouped into the following categories:

Table 4-33    Edit Sub Type field

Origination edit sub types Description

ORIGINATION APPLICANT EDITS Edits that pertain to data entered for an applicant
on an application.

ORIGINATION APPLICATION EDITS Edits that pertain to data entered for the
requested loanline of creditlease.

ORIGINATION ASSET EDITS Edits that pertain to data entered for asset
entered on the application.

ORIGINATION CONTRACT EDITS Edits that pertain to data entered for the contract
on the application.

ORIGINATION CREDIT BUREAU EDITS Edits that pertain to data gathered from the credit
bureau reports for the applicants on the
application.

ORIGINATION DECISION EDITS Edits that pertain to data required to make a
decision on the application.

Each entry in the Edit Sub Type field can be set up with more than one entry in the
Description field. The purpose of specific edits fall into the following types:

Table 4-34    Description

Description starts with (Edit Category) Description of Edit Category

CHD: (RECORD POPULATION EDITS) Check for the
existence of an entire data record.

DUPLICATE: (DUPLICATION EDITS) Check for duplication of
existing data.

RANGE: (VALUE RANGE/TOLERANCE EDITS) Check to
determine whether data entered for a specific
data field is within the specific tolerance.

REQUIRED: (REQUIRED FIELD EDITS) Check to determine
whether a specific data field has been populated
within a data record.

FLK: (LOOKUP VALUE EDIT) Check API entered data
against the existence of that value in the related
lookup types lookup codes.
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Table 4-34    (Cont.) Description

Description starts with (Edit Category) Description of Edit Category

XVL: (CROSS VALIDATION EDIT) Check to determine
whether specific field, or set of fields, value
corresponds to a value obtained by calculating
them from another field or set of fields (for
example, Total Payments = Terms * Standard
payment amount).

An Edits check can produce one of three results: an ERROR, a WARNING, or an
OVERRIDE.

Table 4-35    Edits check

Edit type Results

ERROR The system will prevent you from proceeding
when an edits check fails. The only option is to
change the source data. The application will
revert to its previous status/sub status. The user
will be directed to correct the specific error. Until
the edits that return an ERROR value are
addressed, the user cannot continue processing
the application.

Warning When an edits check fails in these cases, the
system allows the process to continue. Warnings
serve as informational messages and can be
ignored. The user will be notified that an edit
failed, but the failure need not stop the current
processing of the application. The user can
either ignore the error, or have the application
revert to its previous status/sub status and
address the error before processing the
application further.

Override The edit check has failed; however, the system
allows users with the responsibility specified in
the Override Responsibility field to continue.
Multiple override levels can be setup depending
upon the resulting value of the edit. If the user
has override responsibility, the application will
process as if the edit had not failed. If the user
does not have override responsibility, the
application will revert to its previous status/sub
status and the sub status changes to OVERRIDE
REQUIRED. The system will then direct the
application to a user with the authority to process
the application. (See the Queues chapter for
more information).

Note

Do not set the Result field to Override for credit application edits.

This section consists of the following topic:

• Interfacing OFSLL with Oracle Rule Author
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4.9.1 Interfacing OFSLL with Oracle Rule Author
Oracle Business Rules is a component of Oracle Application Server that enables applications
to rapidly adapt to regulatory and competitive pressures. This increased agility is possible due
to the adoption of Oracle Rule author wherein a lending Institution can create or change a
business rule without having to indulge in coding and also without stopping the business
process. Also, externalizing business rules allows to manage business rules directly, without
involving programmers. It provides best of breed solutions that would help in configuring the
rules very quickly by a business analyst or user with some insight on the database.

4.10 Cycles
The Cycles screen allows you to define the origination workflow process of your organization.
As you delineate the steps in the origination process, you will also define:

• The user responsibilities that have access to perform the steps

• Any edits you want the system to perform between changes in status/sub status.

The following diagram displays the general concept of workflow:

Figure 4-18    Application Entry - Flowchart

Cycle code definitions drive the application cycle. The following pairs of status/sub status
define status/sub statuses that have system defined meanings and should be included in your
origination workflow, if they are not already included.

After entering the basic details of the applicant, you can check whether the application
prequalifies or not. If the pre-qualified edits are satisfied, the status is changed to NEW-
PREQUALIFY APPROVED and you can modify or update any further details in the Application
Entry screen. If the edits are not satisfied, the application will be pushed to the REJECTED
APPLICATIONS queue with a status update to REJECTED-PREQUALIFY REJECTED, then
you can also view the rejected pre-qualification in the Underwriting window.
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Note

The system status and sub status lists are predefined and cannot be changed by the
administrator. If you require additional sub status codes, please contact Oracle
Financial Services Software to determine whether they can be added.

Table 4-36    Cycle code definitions

Status/Sub status Description

NEW-BLANK This is the status/sub status of applications during
data entry. Applications remain NEW-BLANK until
you choose the Next Application on the
Application Entry form and the system successfully
performs the application edits check.

NEW-PRESCREEN The system processes the prescreen edits to
determine whether a credit report should be pulled
for this application or not.

NEW-PRESCREEN APPROVED Applications in this status/sub status have passed
the prescreen edits. The system will now request a
credit bureau pull.

NEW-PREQUALIFICATION The system checks the applicant details whether it
is qualified or not.

NEW-PREQUALIFY APPROVED If the pre-qualified edits are satisfied, the status is
changed to NEW-PREQUALIFY APPROVED and
you can modify or update any further details in the
Application Entry screen.

REJECTED-PREQUALFY REJECTED If the edits are not satisfied, the application will be
pushed to the REJECTED APPLICATIONS queue
with a status update to REJECTED-PREQUALIFY
REJECTED.

REJECTED-PRESCREEN REJECTED Applications in this status/sub status failed the
prescreen edits. These applications will receive no
further processing. The producer will be sent a
decision fax and the consumer will receive an
adverse action letter.

NEW-REVIEW REQUIRED Either based on the scoring of the application’s
credit bureau(s) pull, or the fact that a credit bureau
report was not successfully obtained, the
application needs to be reviewed by an underwriter.

NEW-RECOMMEND APPROVAL Based on the scoring of the application’s credit
bureau(s) pull, the application should be reviewed
by an underwriter. However, based on the current
setup, the system recommends approving this
application.

NEW-RECOMMEND REJECTION Based on the scoring of the application’s credit
bureau(s) pull, the application should be reviewed
by an underwriter. However, based on the current
setup, the system recommends rejecting this
application.

APPROVED-AUTO APPROVED Based on the scoring of the application’s credit
bureau(s) pull, the system automatically approves
the application. The producer will be sent a
decision fax, and the application will be passed to
funding.
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Table 4-36    (Cont.) Cycle code definitions

Status/Sub status Description

REJECTED-AUTO REJECTED Based on the scoring of the application’s credit
bureau(s) pull, the system automatically rejects the
application. The producer will be sent a decision
fax and the consumer will receive an adverse
action letter.

APPROVED-BLANK Application has been manually approved. Normally
this occurs when an application is in the NEW-
RECOMMEND APPROVAL, NEWRECOMMEND
APPROVAL status/sub status, or less often in the
NEW- RECOMMEND REJECTION status/sub
status. Any cycle code definition with next values of
APPROVED-BLANK should have a lookup value of
APP APPROVAL EDITS to ensure that all of the
required data has been gathered in making the
decision to approve the application (unless the
application is currently in a status/sub status that
assures the APP APPROVAL EDITS have been
run).

NEW-OVERRIDE REQUIRED A user without sufficient override authority
attempted to approve an application, which, based
on setup, required a higher over-ride authority to
approve.

APPROVED-VERIFYING Contract has been received from the producer.

APPROVED-FINAL DOCUMENT CHECK The contract has been reviewed and the data is
correct. Normally this occurs when an application is
in APPROVED-FINAL DOCUMENT CHECK OR
CONDITIONED-FINAL DOCUMENT CHECK
status/sub status. Any cycle code definition with
next values of APPROVED-FINAL DOCUMENT
CHECK or CONDITIONED-FINAL DOCUMENT
CHECK should have a value of APP CONTRACT
EDITS to ensure that all of the required data has
been gathered in making the decision to approve
the application, unless the application is currently in
a status/ sub status that assures the APP
CONTRACT EDITS have run.

APPROVED-VERIFIED The application has been processed and is
awaiting funding.

APPROVED-FUNDED The application has been funded, and a check
requisition has been created. If Customer Service
form is being used, then an account is also created
at this time.

REJECTED-BLANK The application for whatever reason is being
manually rejected regardless of its current
status/sub status. Any cycle code definition with
Next values of REJECTED-BLANK should have a
lookup value of APP DECLINE EDITS to ensure
that all of the required data has been gathered in
making the decision to approve the application
(unless the application is currently in a status/sub
status that assures the APP DECLINE EDITS have
run).

WITHDRAWN-BLANK The applicants have indicated that they are no
longer pursuing this loanline of creditlease.
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Table 4-36    (Cont.) Cycle code definitions

Status/Sub status Description

CONDITIONED -<ANY> These status/sub status pairs are analogous to the
corresponding APPROVED-<ANY> pair and
indicate that the application has had additional
conditions placed on its approval.

<ANY>-<ANY OVERRIDE> Requires OVERRIDE approval. The meaning of the
sub status is analogous to the corresponding
OVERRIDE sub status, and may require that
specific EDITS run before proceeding.

<ANY>-AGED APPLICATION These applications have been decisioned but no
contract has been received after a period of time
determined by setup. If not acted on, these
applications will become VOID.

<ANY>-AGED CONTRACT Contracts have been received after a period of time
determined by setup. If not acted on these
applications will become VOID.

<ANY>-VOID Indicate application previously had a sub status of
AGED CONTRACT or AGED APPLICATION.
These applications have not been completed and
were made VOID after another period of time had
passed.

Using these status and sub status, let us re-examine the early workflow diagram in this section.

Figure 4-19    Application Entry - Flowchart 2
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In the Cycles setup screen, you can also define how Status change of an application is to be
permitted in the system i.e. you can configure the system to validate and allow a specific user /
responsibility to perform the subsequent status change of the application.

It is like either same User/Responsibility is Permitted or Not Permitted to perform
subsequent cycle changes of an application. This can be achieved in Cycle Code Definition
section in Validate Successive Change field.

Note

It is extremely important that the APP CONTRACT EDITS run prior to an application
being funded. All cycle code definitions should be reviewed to ensure that there are no
paths through the origination cycle that bypass this EDIT type.

To set up the Cycles

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Cycles > LoanLineLease.

2. While defining new cycle definition, you can make use of copy feature to quickly create
new cycle using the existing cycle definition details. Click on the required record in Cycle
Definition section and specify the product name (available in Products setup screen) in
New Product Cycle field. Click Create Copy. New cycle definition is created with selected
cycle setup details but without user responsibility.

3. In the Cycle Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-20    Cycle Definition

Chapter 4
Cycles

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 98 of 174



Figure 4-21    Cycle Definition

Figure 4-22    Cycle Definition

A brief description of the fields is given below:

Table 4-37    Cycle Definition

Field Do this

Cycle Specify the cycle code.
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Table 4-37    (Cont.) Cycle Definition

Field Do this

Type Displays the cycle type.

Product Select the product from the drop-down list.

4. In the Cycle Code Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-38    Cycle Code Definition

Field Do this

Current Code Select the current code to transition FROM, from
the drop-down list.

Current Sub Code Select the current sub code to transition FROM,
from the dropdown list.

Next Code Select the current code to transition TO from the
drop-down list.

Next Sub Code Select the next sub code to transition TO, from
the drop-down list.

Origination Stage Code Select the origination stage code of the
application from the adjoining drop-down list.

Edit Type Select the edit type to associate to the cycles,
from the drop-down list.

Chapter 4
Cycles

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 100 of 174



Table 4-38    (Cont.) Cycle Code Definition

Field Do this

Validate Successive Change Select the type of user / responsibility who is
permitted to perform application status change.
The following options are available in the drop-
down list as maintained in the Lookup Type
STATUS_ CHANGE_VALIDATION_CD.

NONE: (Default option) Here system does not
validate for User / Responsibility while making
status change.

USER - SAME: Here system validates for same
User while making the status change.

USER - DIFFERENT: Here system validate for
different User while making the status change.

RESPONSIBILITY - SAME: Here system
validates for same Responsibility of the Current
User while making the status change.

RESPONSIBILITY - DIFFERENT: Here system
validates for different Responsibility of the
Current User while making the status change.

Note that, the application status change is further
controlled by Sub Code value defined in cycle
setup for Lookup Type STATUS_
CHANGE_VALIDATION_CD. For example, if Sub
Code =2 for USER - SAME Lookup Code, then
the previous 2 cycles of status change has to
performed by the same user.

When a wrong user/responsibility is trying to
change the status of the application, system
validates with above selection and displays an
error indicating User/Responsibility must be
same or different between current and
previous status change.

During such cases, to know which User or
Responsibility has performed the previous
application status change, refer to appropriate
columns in Underwriting / Funding > Verification
tab > History sub tab.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Cycle Code Responsibility Definition section, you can define the responsibilities that
are authorized to change the code. If you have selected a specific user / responsibility in
the Validate Successive Change field in the above section, it is recommended to define
the user responsibility in this section. Perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-39    Cycle Code Responsibility Definition

Field Do this

Responsibility Select the responsibility that will be capable of
executing this transition, from the drop-down list.

Allowed Select Yes to allow change to the status
responsibility and No to disallow.
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7. Perform any of the Basic Actions mentioned in Navigation chapter.

4.11 Scoring Models
The Scoring screen allows you to setup individual and multiple scoring models. You can define
different scoring models by company, branch, currency and product. Scoring models are used
to automate the decisioning process during underwriting and grade applications.

When you complete the Application Entry process, the system determines which scoring model
to use by finding a best match. The system searches the Company, Branch, Currency and
Product fields of all enabled scoring models that contain either the exact value on the
application or ALL. (Exact matches for each field are given a higher weight than matches to
ALL.) The system then ranks the returned matches in descending order, based on the
weighted values and the hierarchical position of the field and then by Start Date. The system
recognizes the first row returned as the best match. This scoring model information is then
used to determine the next status and sub status of the application.

If you use a standard bureau score as a scoring model, you can set up the system to use the
adverse action reasons provided by the standard bureau score on the Stipulations sub screen.

To set up the Scoring

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Products > Scoring Models > LoanLineLease. You can set the
following categories of scoring models:

• Credit Score Models

• Behavioral Score Models

4.11.1 Credit Score Models
You can either define new Credit Score Model or specify a new name in the New Credit Model
field and click Create Copy to create a copy of selected score model with details.

1. Click Setup > Setup > Administration > User > Products > Scoring Models >
LoanLineLease > Credit Score Models.

• In the Score Models section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-23    Score Models

Figure 4-24    Score Models
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Figure 4-25    Score Models

A brief description of the fields is given below:

Table 4-40    Score Models

Field Do this

Model Specify the code for the scoring model.

Description Specify a description of the scoring model.

Start Dt Specify the start date for the scoring model.
You can even select the date from the
adjoining Calendar icon.

End Dt Specify the end date for the scoring model.
You can even select the date from the
adjoining Calendar icon.

Enabled Check this box to enable the scoring model.

Results section

Max Score Specify the maximum score allowed. (This is
normally the sum of the Max Value fields within
the scoring parameters.).

Selection Criteria section

Company Select the company for the scoring model,
from the drop-down list. This may be ALL or a
specific company.

Branch Select branch within the company for the
scoring model, from the drop-down list. (This
may be ALL or a specific branch. However, if
you have selected ALL in Company field, then
you must select ALL for this field).

Product Select the product for the scoring model, from
the drop-down list. This may be ALL or a
specific product.
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Table 4-40    (Cont.) Score Models

Field Do this

Currency Select the currency for the scoring model, from
the drop-down list. This may be ALL or a
specific currency.

Bureau Score Reasons Check this box to use the score reasons
supplied by the credit bureau. If unchecked,
then automatically rejected applications scored
using this scoring model display the Adverse
Action Reasons from the Parameters sub
screen.

Auto Decision Check this box to assign an application, a
status/sub status based on the grade
associated with the score returned for this
scoring model. If not selected, the system
assigns applications scored using this scoring
model a status/sub status of NEW-REVIEW
REQUIRED.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Parameters

The Parameters records the parameters used to determine the score calculated by the scoring
model. You can define multiple parameters and adverse action reason associated with each
parameter in a scoring model. Each scoring parameter can have maximum values set. The
score range is based upon the information in the Range Definition section on the Parameters
sub tab.

The system calculates a final score by adding the score for each parameter in the scoring
model. A parameter weighted value is used to find the four adverse action reasons, if bureau
reasons are not used.

Note

• A character parameter range definition should contain the exact value of the
parameter.

• Each scoring parameter should have range definitions defined that encompass all
of the values that might result.

1. Click Setup > Setup > Administration > User > Products > Scoring Models >
LoanLineLease > Credit Score Models > Parameters.

2. In the Parameters section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 4-41    Parameters

Field Do this

Parameter Select the parameter from the field, from the
drop-down list.
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Table 4-41    (Cont.) Parameters

Field Do this

Max Value Specify the maximum value allowed for the
selected parameter.

Adverse Action Reason Select the adverse action reason, from the drop-
down list. (If, on the Scoring Models screen, the
Bureau Screen check box is checked for the
scoring model, you cannot update this field).

Weighted Value Specify the adverse action weighted value. This
indicates the priority of this parameter when
determining which adverse action reasons to use
on the application. The top ten adverse action
reasons based on the weighted value of the
parameter will be populated.

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Range Definition section allows you to translate the calculated value for a scoring
parameter into the value to be used, depending on the returned value of the parameter.

5. In the Range Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-42    Range Definition

Field Do this

Value From Specify the lowest calculated value to apply the
specific translation. The ceiling of the range
definition is based on the range definition with
the next highest Value From or the Max Value of
the scoring parameter (whichever is less).

Value From Select the following options to determine how
values for a scoring parameters are translated:

% Max Value – If selected, then the calculated
values within the range definition receives a
value based on a percentage of the Max Value of
the scoring parameter.

% Param – If selected, then the calculated
values within the range definition receives a
value based on a percentage of the calculated
value of the scoring parameter.

Value – If selected, then the calculated values
with in the range definition receives a specific
value.

Percent / Value Specify the percent or value to be used in the
translation of the calculated value of the scoring
parameter.

Enabled Check this box to consider this range definition
while translating values for this scoring
parameter.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Grades
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The Grades sub screen allows you to define how the system translates the scoring model
scores into your organization’s grade. The system uses these grades in the auto-decisioning
process. Each grade has a specific status/sub status that informs the system what to do with
the application of a particular grade as it continues through the origination cycle.

Note

Each scoring model should have grade definitions defined that encompass all of the
values that might result.

1. Click Setup > Setup > Administration > User > Products > Scoring Models >
LoanLineLease > Credit Score Models > Grades.

2. In the Grade Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-43    Grade Definition

Field Do this

Score Specify the score the application receives.

Credit Grade Select the grade to assign to an application, from
the dropdown list.

Application Status Select the status to assign to applications with a
score starting with the value of this grade
definition, from the drop-down list.

Sub Status Select the sub status to assign to applications
with a score starting with the value of this grade
definition, from the dropdown list.

Credit scoring allows you to select the following
status/sub status pairs:

APPROVED - AUTO APPROVED

REJECTED - AUTO REJECTED

NEW - REVIEW REQUIRED

NEW - RECOMMEND APPROVAL

NEW - RECOMMEND REJECTION.

Enabled Check this box to indicate that this grade
definition will be considered when grading an
application using this scoring model.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.11.2 Behavioral Score Models
You can either define new Behavioral Score Model details or specify a new name in the New
Behavioral Model field and click Create Copy to create a copy of selected score model with
details.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Loan
Line Lease > Behavioral Score Models.

2. In the Score Models section, perform any of the Basic Operations mentioned in Navigation
chapter.

Chapter 4
Scoring Models

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 107 of 174



Figure 4-26    Behavioral Score Models

Figure 4-27    Behavioral Score Models
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Figure 4-28    Behavioral Score Models

A brief description of the fields is given below:

Table 4-44    Behavioral Score Models

Field Do this

Model Specify the code for the scoring model.

Description Specify a description of the scoring model.

Result section

Max Score Specify the maximum score allowed. (This is
normally the sum of the Max Value fields within
the scoring parameters.).

Selection Criteria section

Company Select the company for the scoring model, from
the drop-down list. This may be ALL or a specific
company.

Branch Select branch within the company for the scoring
model, from the drop-down list. (This may be ALL
or a specific branch. However, if you have
selected ALL in Company field, then you must
select ALL for this field).

Product Select the product for the scoring model, from
the drop-down list. This may be ALL or a specific
product.

Currency Select the currency for the scoring model, from
the drop-down list. This may be ALL or a specific
currency.

Bureau Score Reasons Check this box if bureau score reason is
applicable.

Auto Decision Check this box if auto decision is applicable.

Start Dt Specify the start date for the scoring model. You
can even select the date from the adjoining
Calendar icon.
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Table 4-44    (Cont.) Behavioral Score Models

Field Do this

End Dt Specify the end date for the scoring model. You
can even select the date from the adjoining
Calendar icon.

Enabled Check this box to enable the scoring model.

Result section

Max Score Specify the maximum score allowed. (This is
normally the sum of the Max Value fields within
the scoring parameters.).

Selection Criteria section

Company Select the company for the scoring model, from
the drop-down list. This may be ALL or a specific
company.

Branch Select branch within the company for the scoring
model, from the drop-down list. (This may be ALL
or a specific branch. However, if you have
selected ALL in Company field, then you must
select ALL for this field).

Product Select the product for the scoring model, from
the drop-down list. This may be ALL or a specific
product.

Currency Select the currency for the scoring model, from
the drop-down list. This may be ALL or a specific
currency.

Bureau Score Reasons Check this box if bureau score reason is
applicable.

Auto Decision Check this box if auto decision is applicable.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Create Copy button on the Score Models screen to create copy of the selected
record with details.
The Parameters section records the parameters used to determine the score calculated by
the scoring model. You can define multiple parameters and adverse action reason
associated with each parameter in a scoring model. Each scoring parameter can have
maximum values set. The score range is based upon the information in the Range
Definition section on the Parameters sub tab.

The system calculates a final score by adding the score for each parameter in the scoring
model. A parameter weighted value is used to find the four adverse action reasons, if
bureau reasons are not used.

Note

• A character parameter range definition should contain the exact value of the
parameter.

• Each scoring parameter should have range definitions defined that
encompass all of the values that might result.

5. In the Parameters section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:
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Table 4-45    Parameters

Field Do this

Parameter Select the parameter from the field, from the
drop-down list.

Max Value Specify the maximum value allowed for the
selected parameter.

Adverse Action Reason Select the adverse action reason.

Weighted Value Specify the weighted value.

Enabled Check this box to enable the parameter.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. The Range Definition section allows you to translate the calculated value for a scoring
parameter into the value to be used, depending on the returned value of the parameter.

8. In the Range Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-46    Range Definition

Field Do this

Value From Specify the lowest calculated value to apply the
specific translation. The ceiling of the range
definition is based on the range definition with
the next highest Value From or the Max Value of
the scoring parameter (whichever is less).

Value From Select the following options to determine how
values for a scoring parameters are translated:

% Max Value – If selected, then the calculated
values within the range definition receives a
value based on a percentage of the Max Value of
the scoring parameter.

% Param – If selected, then the calculated
values within the range definition receives a
value based on a percentage of the calculated
value of the scoring parameter.

Value – If selected, then the calculated values
with in the range definition receives a specific
value.

Percent / Value Specify the percent or value to be used in the
translation of the calculated value of the scoring
parameter.

Enabled Check this box to consider this range definition
while translating values for this scoring
parameter.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

4.12 Fees
The Fee screen allows you to define fees that may be automatically assessed by the system.
The Fee Definition section records fees not defined within the Contract screen’s Fees sub
screen.
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The following fee types are currently supported for automatic assessment:

• Late charge

• NSF

• Extension

• Advance

• Over Credit Limit

• Membership

• Prepayment penalty

• Phone Pay

• Payoff Quote

• Periodic Maintenance Fee

• Rental Fee

• ACH Fee

• Delay Fee

• Other Fee and Tax

Fees can be calculated as either a flat amount or a percentage of payment due based on fee
type.

You can specify minimums and maximums for fee amounts in the Min Amt and Max Amt fields.
Different fee rules can be setup at the company/branch level.

During the life cycle of a LoanLine of creditLease, it is required to post certain recurring
charges or payments that occur at regular intervals, such as monthly, quarterly, or annually
which is termed as periodic fees. System allows to post multiple Periodic fees to handle
recurring auto-post fee definitions on account by the corresponding batch job. Accordingly you
can configure multiple Periodic Fee definitions using Fee Type = FEE PERIODIC
MAINTENANCE and FEE PERIODIC MAINTENANCE 1 up to 5 i.e. FPMF, FPMF1, FPMF2,
FPMF3, FPMF4, and FPMF5.

When Fees are assessed, the system determines the best match using all enabled fee
definitions that meet the following criteria:

• Exactly match the fee type being assessed.

• Have an effective date that is greater than or equal to the start date.

• Have a Txn Amt From that is greater than or equal to the outstanding amount related to the
fee assessment.

• Match either the value or ALL for all other criteria (Exact matches for each field are given a
higher weight than matches to ALL.)

The returned rows are then given a descending rank based on the weighted values and the
hierarchical position of the following criteria:

1. Company

2. Branch

3. Product

4. Application state

5. Transaction amount
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6. Start date

7. End date

8. Currency

On the ranked rows, the first row is returned as the best match.

Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such
cases, the contract fee, if present, is used first. Only if the contract fee is not present in
the state fee used.

To set up the Fee

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Fees > LoanLineLease.

2. In the Fee Definition section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 4-29    Fee Definition
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Figure 4-30    Fee Definition

Figure 4-31    Fee Definition

A brief description of the fields is given below:

Table 4-47    Fee Definition

Field Do this

Fee Rule Specify the fee rule used to identify the particular
fee definition.
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Table 4-47    (Cont.) Fee Definition

Field Do this

Fee Type Select the fee type from the drop-down list. The
system computes these drop-down values from
the TXN_TYPE_CD Lookup, with FEE as the sub
type.

Start Dt Specify the start date. You can even select the
date from the adjoining Calendar icon.

End Dt Specify the end date. You can even select the
date from the adjoining Calendar icon.

Enabled Check this box to enable the fee.

Calc Method Select one of the following method of calculating
the fee, from the drop-down list.

If Flat Amount is selected, then minimum fee will
be charged.

If Percentage is selected, then the amount
charged will be based on percentage defined
subject to minimum and maximum amount (i.e.
Txn Amt From).

Threshold Amt This field is enabled only if the Contract Fee type
is either CYCLE BASED COLLECTION LATE
FEE or CYCLE BASED LATE FEE.

Specify the threshold amount which is less than
or equal to minimum fee amount to be assessed.
Based on this amount, system calculates and
posts the Cycle Based Collection Late Fee or
Cycle Based Late Fee based on the account.

If calculated fee amount is less than threshold
amount, fee is posted with transaction amount =
0.

If calculated fee amount is greater or equal to
threshold amount, fee is posted based on
existing min amt and max amt comparing logic.

Min Amt Specify the minimum amount for the fee.

Max Amt Specify the maximum amount for the fee. If you
selected FLAT AMOUNT in the Calc Method
field, then this field is not used and is normally
populated as $0.00.

Percent Specify the percentage value of the outstanding
transaction amount to be assessed as a fee. This
amount will be adjusted to fall within the Min
Amount and the Max Amount.

Selection Criteria section

Company Select the portfolio company from the drop-down
list. This may be ALL or a specific company.

Branch Select the portfolio branch from the drop-down
list. This may be ALL or a specific branch. (This
must be ALL, if you have selected ALL in the
Company field).

Channel Select the channel from the drop-down list, This
can be ALL or a specific channel.
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Table 4-47    (Cont.) Fee Definition

Field Do this

Product Select the product from the drop-down list. This
may be ALL or a specific product. The available
values come from a validated field based on the
selected Billing Cycle setup and the Product
setup.

State Select the state for this fee, from the drop-down
list. This may be ALL or a specific state.

Currency Select the currency for this fee, from the drop-
down list. This may be ALL or a specific currency.

Txn Amt From Specify the transaction or balance amount. The
fee is calculated using the specifications of this
record only if the transaction amount is greater
than the value specified in this field (and less
than this field in another record for the same fee).

IMPORTANT:
When you select the fee to use, the system
searches for a best match using the following
attributes:

a. Company

b. Branch

c. Product

d. State

e. Amount (Txn Amt From)

f. Effective/start date (Start Dt)

Hence, Oracle Financial Services Software
recommends creating a version of each fee,
where ALL is the value in these fields.

It is also recommended that you define a default
printer for an Organization, Division and
Department.

Amount Financed From Specify the minimum value of amount financed
on the contract.

Note: This is the Contracted loan amount
during origination and would always be the
Amount Financed on contract even if principal
addition is done through a transaction in
servicing.

Credit Limit From Specify the minimum value of credit limit for the
pricing.

Gross Capitalized Cost From Specify the minimum value of gross capitalization
cost.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.13 Asset Billing Rate
In Asset Billing Rate screen you can setup the various parameters associated with Home
collateral which serves as the input for Asset Billing batch job to process and post the dues
on to respective accounts in the system.
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This section consists of the following topics:

• Asset Billing Rate Definition

• Asset Billing Rate Details

• Asset billing Calculations

• Asset Billing Rate Setup - File upload

• Asset Billing Batch Job

4.13.1 Asset Billing Rate Definition
In the Asset Billing Rate Definition tab you can create and maintain Timeshare specific Home
collateral and account details of an account which are used as a selection criteria.

To set up Asset Billing Rate Definition

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Products > Asset Billing Rate.

Figure 4-32    Asset Billing Rate

2. In the Asset Billing Rate Definition section, perform any of the Basic Operations mentioned
in Navigation chapter. A brief description of fields are given below:

Table 4-48    Asset Billing Rate Definition

In this field Do this

Name Enter a unique name for Asset Billing Rate
definition. This field is not editable after saving
the record or during EDIT.

Description Enter the description for Asset Billing Rate
definition.

Enabled Check this box to enable the record.

Selection Criteria

Company Select the portfolio company from the drop-down
list. This list is populated based on Enabled
Company definitions maintained in the system.
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Table 4-48    (Cont.) Asset Billing Rate Definition

In this field Do this

Branch Select the portfolio branch from the drop-down
list.

Product Select the type of product associated with the
collateral from the drop-down list.

State Select the state to which the account operates
from the drop-down list.

Channel Select the channel from the drop-down list.

Asset Type Select asset type from the drop-down list. The
list is populated based on assets setup.

Asset Sub Type Select the asset sub type from the drop-down
list.

Club Name Select the Club Name from the drop-down list.

Phase Number Select the Phase Number from the drop-down
list.

Site of Inventory Select the Site of Inventory from the drop-down
list.

Building Select the Building from the drop-down list.

Unit Select the Unit from the drop-down list.

Week Select the Week from the drop-down list.

Room/Unit Type Select the Room/Unit Type from the drop-down
list.

Usage Type Select the Usage Type from the drop-down list.

Resort Identifier Select the Resort Identifier from the drop-down
list.

Min Actual Points Specify the minimum actual points for the asset
billing definition.

Max Actual Points Specify the maximum actual points for the asset
billing definition.

Min Billing Points Specify the minimum billing points which is used
as the selection criterion in the Asset Billing Rate
Definition. Billing points are used to derive the
transaction amount that is to be charged to an
asset linked to a product of the account.

Max Billing Points Specify the maximum billing points which is used
as the selection criterion in the Asset Billing Rate
Definition. Billing points are used to derive the
transaction amount that is to be charged to an
asset linked to a product of the account.

Association Id Select the Association Id from the drop-down list.

Club Indicator Check this box to indicate Club Indicator.

Plus Membership Type Check this box to indicate Plus Membership
Type.

PR Marking Check this box to indicate PR Marking.

Signature Grand Father Check this box to indicate Signature Grand
Father.
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Table 4-48    (Cont.) Asset Billing Rate Definition

In this field Do this

Additional Attributes - This section consists of
additional 15 configurable fields as indicated
below.

5 check boxes - Membership 1-5 Opt

5 drop-down lists - Other Attribute 1-5

5 Calendar fields - Other Attribute 5-10

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.13.2 Asset Billing Rate Details
In the Asset Billing Details sub tab, you can define Transactions, their Calculation Method, and
other parameters which are posted by Billing Batch Job.

Note that once a record is created in this section, the same is available in Read-Only mode
and you can only Enable or Disable the record in Edit mode.

To set up Asset Billing Rate Details

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Products > Asset Billing Rate.

2. In the Asset Billing Rate Details section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of fields are given below:

Table 4-49    Asset Billing Rate Details

In this field Do this

Start Date Select the date of asset billing from adjoining
calendar.

Transaction Select the transaction from the drop-down list.

This list is populated with transactions where the
Transaction code = FOTH%.

Calc Method Select one of the following calculation method
from dropdown list.
• Flat Amt
• Rate
• Flat Amt + Rate
• Tiered Rate
• Slab Formula

For more information on above calculation
methods, refer to Asset billing Calculations
section.

Flat Amt Specify the flat amount or fixed amount to be
charged during asset billing calculation.

This field is available if the Calc Method is Flat
Amt, Flat Amt + Rate, and Slab based Formula.

Rate Specify the rate for asset billing calculation. This
field is available if the Calc Method is Rate and
Flat Amt + Rate.
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Table 4-49    (Cont.) Asset Billing Rate Details

In this field Do this

Frequency Select the frequency of asset billing calculation
from the drop-down list. The list is populated
based on frequency maintained in lookup code.

% of Calc Amt Specify the percentage of amount for calculation.
By default, this is set to 100.

Base Points Specify the base points for asset billing
calculation. By default this is set to 1 since a
value is required system does not allow to enter
0.

This field is available if the Calc Method is Rate,
Flat Amt + Rate, Tiered Rate, and Slab Formula.

Slab Points Specify the slab points for asset billing
calculation. This field is available if the Calc
Method is Slab Formula.

% Increase Specify the percentage increase in each slab for
asset billing calculation. This field is available if
the Calc Method is Slab Formula.

Min Amt Specify the base minimum amount to be
configured for the resulted transaction amount.

If the resulted Transaction Calculation Amount is
less than the Min Amt defined here, system
posts the transaction with Min Amt.

Max Amt Specify the maximum amount to be configured
for the resulted transaction amount.

Billing Year Specify the year in which the Rate is applicable.

The Billing Year is stamped in billing amount
transaction description only for FOTH%
transactions.

Enabled Check this box to enable the Asset Billing Rate.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

This section consists of the following topics:

• Tiered Rate Details sub tab

4.13.2.1 Tiered Rate Details sub tab
The Tiered Rate Details sub tab you can define points specific tiers with different rates. This
sub tab is enabled only if the transaction calculation method is selected as Tiered Rate in
Asset Billing Rate Details section. For calculation details, refer to Tiered Rate Calculation
section.

To set up Tiered Rate Details

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Products > Asset Billing Rate.

2. In the Tiered Rate Details section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of fields are given below:
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Table 4-50    Tiered Rate Details

In this field Do this

From Points Specify the points from where the respective rate
is applicable.

Rate Specify the rate for defined points range.

Enabled Check this box to enable Tiered Rate detail.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.13.3 Asset billing Calculations
This section explains the following calculation methods based on which the Asset Billing is
processed in the system:

• Flat Amount Calculation

• Rate Calculation

• Flat Amt + Rate Calculation

• Tiered Rate Calculation

• Slab Formula Calculation

4.13.3.1 Flat Amount Calculation
In Flat Amount calculation, system calculates the Transaction Amount using below formula:

Table 4-51    Flat Amount Calculation

Frequency Billing Cycle Transaction Amount
Calculation

Annual Monthly (Flat Amt/12)

Monthly Annual (Flat Amt*12)

Annual Quarterly (Flat Amt/4)

Quarterly Annual (Flat Amt*4)

Annual Semi Annual (Flat Amt/2)

Semi Annual Annual (Flat Amt*2)

Annual Annual (Flat Amt /1)

Consider the above calculation as reference for other combinations of Rate Frequency and
Billing cycle.

4.13.3.2 Rate Calculation
In Rate calculation, system calculates the Transaction Amount using below formula:

Table 4-52    Rate Calculation

Frequency Billing Cycle Transaction Amount
Calculation

Annual Monthly (Rate/12)*(Billing Points at
collateral / Base Points)
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Table 4-52    (Cont.) Rate Calculation

Frequency Billing Cycle Transaction Amount
Calculation

Monthly Annual (Rate*12)*(Billing Points at
collateral / Base Points)

Annual Quarterly (Rate/4)*(Billing Points at
collateral / Base Points)

Quarterly Annual (Rate*4)*(Billing Points at
collateral / Base Points)

Annual Semi Annual (Rate/2)*(Billing Points at
collateral / Base Points)

Semi Annual Annual (Rate*2)*(Billing Points at
collateral / Base Points)

Annual Annual (Rate/1)*(Billing Points at
collateral / Base Points)

Consider the above calculation as reference for other combinations of Rate Frequency and
Billing cycle.

4.13.3.3 Flat Amt + Rate Calculation
In Flat Amt + Rate calculation, system calculates the Transaction Amount using below
formula.

Transaction Amount = Flat Amt + Rate * (Billing Points at Collateral/Base Points)

Note

The Rate and Flat amount are adjusted based on Frequency and Billing Cycle.

4.13.3.4 Tiered Rate Calculation
In Tiered Rate calculation, system selects the Asset Billing Rate Details using the Billing
Points at Asset and other asset parameters and calculates the transaction amount by deriving
the rate from Tiered Rate table.

Transaction Amount = (Tiered Rate) * (Tiered Points / Base Points)

For example, if an Asset has 1.5 million points and the range is maintained as - for first million
points rate=0.66 with Base Points =1000 and for remaining points rate=0.60 with Base Points =
1000, the Transaction Amount = 1million * (0.66/1000) + 0.5 million * (0.6/1000) = 660 + 300 =
960.

Note the following:

• If the range for specific points are not maintained correctly, the same is considered as 0
rate and in-turn the Transaction Amount derived also becomes 0.

For example, if Billing Points are 8000 but if range maintained points is from 10000 with
Rate = 0.55 and Base Points = 1, the transaction amount results as (0*(8000/1) =0).

• Rate is adjusted based on Frequency and Billing Cycle as mention in Rate Method.
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4.13.3.5 Slab Formula Calculation
In Slab Formula calculation, system calculates the Transaction Amount using below formula.

Transaction Amount = [Flat Amt] + Ceil[\{Billing Points - Base Points)/Slab Points}*\
{%Increase / 100)*Flat Amt}]]

The resultant amount will always be rounded-down.

For example,

Transaction Amount = [491.32+[{(61000-5000)/2500}*{(30.4/100)*491.32}]]

= [491.32+ [Round-down {22.4}*{149.36}]]

= [491.32+3435.28]

Transaction Amount = 3926.6

Note

The Rate and Flat amount are adjusted based on Frequency and Billing Cycle.

4.13.4 Asset Billing Rate Setup - File upload
The data in Asset Billing Rate screen can also be created and updated from an external file
through SET-IFP input file upload process. While doing so, ensure that the file format of
Header and Details record are maintained in required order and the input file is placed in
upload area.

During the scheduled batch job run, the asset billing batch job picks-up the data in input file
and loads on to the system to create Asset Billing Rate setup records.

However, before processing the details, system performs the following validations:

• If Name of the record is unique and duplicate record is not being updated.

• For Tiered Rate, the details are added only if the Calc Method = Tiered Rate. If not, system
displays an error indicating Tiered Rate Details are not required for <Calc Method> and
the record is added in bad file.

• For update to existing record details, only Enable/Disable option is supported. If there is a
mismatch in the name of the record, batch job errors out with message Record not found
and the record is added in bad file.

• For new records, all the fields are mandatory and default values are applicable.

• Values provided in fields which are of lookup type are validated with lookup code. In case
of mismatch, batch job errors out with message Lookup value not matching and the
record is added in bad file.

• Negative values is not added for number fields.

• Base Point's field does not contain negative, 0, or decimal values.
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4.13.5 Asset Billing Batch Job
The billing batch job TXNDDT_BJ_100_01 (BILLING/DUE DATES PROCESSING) facilitates to
process the asset billing dues on account for Home collateral and posts the corresponding
transactions.

Listed below is the sequence of processing steps:

1. Billing batch job picks-up the Vacation Ownership (VO) parameters from Servicing >
Account > Collateral (Home) > Vacation Ownership tab.

• The required accounts for Asset billing batch job processing is selected based on the
type of account selected in Due Amt Account Type field. I.e. in Vacation Ownership
Details section if the Billing option is checked and the Due Amt Account Type is
selected as Current or Linked or Master Account, then the billing batch job posts the
transactions based on Asset Billing Rate setup in Current account or Linked Account
of current Account or Master Account of current Account respectively.

• In addition, system includes the asset billing points of Linked Account/Associated
Account only if the status of those accounts are in any of the status defined in lookup
code ACC_STATUS_BILLING_CD (ACCOUNT STATUS FOR ASSET BILLING
CODES). Account statuses which are not maintained in the lookup code are excluded
for asset billing calculation. However, If no statuses are maintained in the lookup, then
system will consider all statuses for consolidation.

– If billing flag is checked and Due Amt Account Type = Current Account, billing
batch job posts the transactions based on Asset Billing Rate setup in Current
account.

– If billing flag is checked and Due Amt Account Type = Linked Account, billing batch
job post the transactions based on Asset Billing Rate setup in Linked Account of
current Account.

– If billing flag is checked and Due Amt Account Type = Master Account, billing batch
job post the transactions based on Asset Billing Rate setup in Master Account of
current Account.

Before the due calculation, batch job validates VO parameters with the following:

• If the selected Usage Type sub code is FULL, system considers Full points for rate
derivation and Billing points is considered for Transaction Amount calculation.

• If the selected Usage Type sub code is HALF, system considers Billing Points for
Transaction Amount calculation but rate is derived using full points.

• If the First Year Proration check box is selected, then the rate is derived using full
points and the Transaction Amount is calculated based on prorated points (not on full
points).

• The prorated points are calculated based on Asset Usage Start Date.

– If the usage start date year is equal to first due year, then system prorates the
points as indicated in example below:

If First Due Date = 01/01/2018, Usage Start Date = 01/10/2018,

Prorated Points = Billing Points * (13-1)/12= Billing Points *1

If First Due Date = 01/01/2018, Usage Start Date = 03/10/2018

Prorated Points = Billing Points * (13-3)/12= Billing Points*10/12

Note: Number 13 here is used as constant.
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• If the usage start date year is before the due date year, system considers the full
points for calculating the Transaction Amount and no proration is required here.

2. Batch job looks of best matching Asset Rate details and Asset Billing definition in Setup.

3. Batch job checks for status (Y/N) of Multiple Billing Asset Rate indicator at Account
Details > Contract > Billing level to decide if multiple asset rates are applicable for one
billing period or not.

• If N, system picks the latest rate which is less than or equal to DUE DATE. In this case
only one best match record is fetched to derive Transaction Amount and no multiple
asset rates are applicable for one billing period.

• If Y, system fetches multiple rates only when rate End Date (i.e. rate start date + rate
frequency) ends with one or more cycle(s) before the next due date. This implies that
current rate record does not cover the entire billing period.

• However, if Multiple Billing Asset Rate is set to Y but there is no Rate available for
Due period beyond the Rate End date, system applies the same rate that is picked for
Due Period which is Less than or Equal to Due End Date.

4. Batch job posts the matched transactions at account level based on calculation method.
The following Asset Billing Rate Details are stamped on the transaction posted:

• Asset Id (Assets)

• Asset Rate Id (Asset Billing Rate Definition)

• Asset Rate Details Id (Asset Billing Rate Details)

• Rate Start Date (Asset Billing Rate Details)

• Rate Frequency (Asset Billing Rate Details)

• Calculation Method (Asset Billing Rate Details)

• Rate (Asset Billing Rate Details)

• In case of Tiered Rate, Effective Rate is stamped

• Base Points (Asset Billing Rate Details)

• Slab Points (Asset Billing Rate Details)

• % Increase (Asset Billing Rate Details)

• Billing Year (Asset Billing Rate Details)

On posting the transactions, following validations and outcome are handled:

• If the respective balance for transaction is missing, batch job fails with an error
message indicating Account #: Transaction posting failed Balance not available in
Batch > Request Results block and does not process the account due amount
calculation.

– This can be rectified by posting Add balance to Account non-monetary
transaction. For more information, refer to Appendix - Non-Monetary transactions
section in Servicing User Guides.

• If the transaction posting failed due to an issue in Access grid configuration or Product
configuration at transaction codes, batch job displays error indicating Account #:
Transaction posting failed <Reason> and does not process the account due amount
calculation.

• If the Resulted transaction amount is less than Min Amount defined, batch job
considers the Min amount and posts the transaction.

Chapter 4
Asset Billing Rate

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 125 of 174



• If the Resulted transaction amount is greater than Max Amount defined, batch job
considers the Max amount and posts the transaction.

4.14 Origination Fees
The system supports the auto computation of origination itemized fees. System administrators
can define and maintain the itemization formula on the Origination Fees screen.

An itemization formula can be set up as a computation of other itemizations (such as adding or
subtracting one itemization from another) and can consist of multiple itemizations. An
itemization formula will have a minimum and maximum value. You can set up a formula value
range to be used as the final value.

Itemizations are linked to a product with the Products screen’s Product Itemizations subtab.

One itemization can be based on one formula, while the same formula can be attached to
multiple itemizations. If a formula is attached to a contract itemization and that formula requires
an itemization not present in Formula Definitions screen, then the system displays an error
message.

The system will search for any circular dependency at the time the contract is enabled. An
example of a circular dependency is when Itemization1 has Formula1 attached requiring
Itemization2 for computation and Itemization2 has Formula2 attached requiring Itemization1 for
computation.

To set up the Origination Fees

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Origination Fees > LoanLineLease.

2. In the Formula Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-33    Origination Fees
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Figure 4-34    Origination Fees

Figure 4-35    Origination Fees

3. A brief description of the fields is given below:

Table 4-53    Formula Definitions

Field Do this

Formula Specify the formula code to define computation.

Description Specify the description for the formula.

Min Amt Specify the minimum value that should be
considered to compute the final value of formula.

Max Amt Specify the maximum value that should be
considered to compute the final value of formula.

Enabled Check this box to allow the origination fees.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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5. In the Formula Details section of Setup > Setup > Administration > User > Products >
Origination Fees > LoanLineLease > Detail, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 4-54    Formula Details

Field Do this

Itemization Select the itemization based on which the
itemization formula will derive its computed
value, from the drop-down list.

Percentage Specify the percentage value that should be
considered while computing value for itemization
formula.

Sort Specify the sort sequence for the itemization to
be considered while computing the value of the
itemization formula.

Sign Select the +ve or -ve sign that needs to be
considered between two itemizations for
computing the value of the itemization formula.

Enabled Check this box to allow the itemization details to
be used by the system.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Range Details section of Setup > Setup > Administration > User > Products >
Origination Fees > LoanLineLease, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-55    Range Details

Field Do this

Amt From Specify the value up to which the percentage of
final value of the itemization formula to be
considered for the final value of itemization
formula.

Percent Specify the percentage value that should be
considered while computing the value for the
final value of the itemization formula.

Enabled Check this box to allow the range details to be
used by the system.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

4.15 Compensation
With the Compensation screen, you can define compensation plans for producers who supply
the financial institution with applications for loansLease. These compensation plans can be set
up at various levels depending upon your organization’s needs.

This information is used on the Compensation sub tab on the Origination > Application >
Contract tab. The Compensation Plan field lists the plans available based on the contract in
use for the application. When you click Load on the Compensation sub tab, the system adds
the information setup on the Compensation screen.
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Compensation can be paid to a producer in a number of ways:

Table 4-56    Compensation

Payment calculation method Description

AS EARNED The compensation amount is paid out in pieces
over the life of the product based upon the interest
earned.

PAY AS U GO The compensation amount is paid out in pieces
over the life of the product based upon the interest
received by virtue of the payment.

UPFRONT The entire compensation amount is paid at the time
of booking the loanLease.

UPFRONT MONTH END The entire compensation amount is paid at the
month-end of booking the loanLease.

UPFRONT MONTH END (amortize spread
formula)

The amount financed will be amortized at a rate
equal to the difference between the contract rate
and buy rate. The finance charge thus derived
would be considered the base compensation
amount. the system then allows this base
compensation to be split into two components:

1. Upfront compensation amount

2. Remaining compensation amount.

The disbursement method will apply to the
remaining compensation portion (total
compensation minus the upfront amount).

Compensations can be charged back from a producer, if a product is prematurely paid or
charged off. The charge back amount can be calculated using the following methods:

• Earned

• Percentage

You can specify whether the unearned portion or a certain percentage of the total
compensation is to be charged back in case of early payoff or charge off.

The period for which the charge back plan can remain active can be set up according to:

• Number of days

• Term (number of months)

To set up the Compensation

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Compensation > LoanLease.

2. In the Compensation Plan Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
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Figure 4-36    Compensation

Figure 4-37    Compensation

A brief description of the fields is given below:

Table 4-57    Compensation Plan Definition

Field Do this

Code Specify the compensation code.

Description Specify a description of the compensation plan
being defined.
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Table 4-57    (Cont.) Compensation Plan Definition

Field Do this

Start Dt Specify the start date for the compensation plan.
You can even select the date from the adjoining
Calendar icon.

End Dt Specify the end date for the compensation plan.
You can even select the date from the adjoining
Calendar icon.

Enabled Check this box to enable the compensation plan.

Result section

Disbursement Method Select the method for calculating the
compensation disbursement to be paid, from the
drop-down list.

Formula Method Select the type of formula to be used to calculate
the compensation to be paid, from the drop-down
list. The system uses following formula methods:

FLAT AMOUNT
• Flat amount is paid.

SPREADMARKUP BASE FORMULA
• A formula based on the spreadmarkup

between the buy rate and the interest rate
offered to the consumer is used.
PERCENTAGE OF ASSET COSTAMOUNT
FINANCED

• To calculate the compensation based on
percentage of amount financedasset cost
using the below formula.
Compensation Amount = (Adjusted
Capitalized Cost) * (Max Markup
Percentage / 100) * (Factor / 100) *
(Additional Factor / 100);

Formula Select the formula to be used to calculate
Compensation, from the dropdown list. The list is
sorted with available option based on Formula
method selected.

Factor Specify the compensation factor; that is, the
percentage applied to the compensation to be
paid. If this value is not 100.00, it will reduce the
compensation amount.

Addl Factor Specify the additional compensation factor. If this
value is not 100.00, it will further reduce the
compensation amount.

Max SpreadMark up Or Percent Specify the maximum compensation SpreadMark
up. This limits the SpreadMark up on which
compensation will be paid. Spreads exceeding
this value will be treated as if the spread was the
specified value.

Flat Amt Specify the flat compensation amount.

Upfront% Specify the percentage of the compensation
allocated upfront.

Paid Off Method Select the method of the compensation that will
be recovered by the producer, from the drop-
down list, if the amount is paid early.
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Table 4-57    (Cont.) Compensation Plan Definition

Field Do this

Paid Off Basis Select the basis used to determine the amount of
compensation to be recovered from the producer,
from the drop-down list, if the amount is paid
early.

Paid Off Days Specify the number of days in which the
compensation can be recovered, if the Basis is
selected as Days.

Paid Off Term Specify the term in which the compensation can
be recovered, if the Basis is selected as Term.

Paid Off Percent Specify the percent of the compensation that will
be recovered by producer, if the amount is paid
off.

Charge off Method Select the method of the compensation that will
be recovered by the producer, from the drop-
down list, if the amount is charge off.

Charge off Basis Select the basis used to determine the amount of
compensation to recover from the producer, from
the drop-down list, if the product is charged off
as uncollectable.

Charge off Days Specify the number of days in which
compensation can be recovered, if the Basis is
DAYS.

Charge off Term Specify the number of terms in which
compensation can be recovered, if the Basis is
TERM.

Charge off Percent Specify the percent of the compensation that will
be recovered by producer if the account is
charged off as uncollectable, and the charge off
basis is PERCENTAGE.

Selection Criteria section

Company Select the portfolio company, from the drop-down
list. This may be ALL or a specific company.

Branch Select the portfolio branch within the company
for the selected compensation plan, from the
drop-down list. This may be ALL or a specific
branch. This must be ALL if in the Company field
you selected ALL.

Billing Cycle Select the billing cycle for the compensation
plan, from the drop-down list.

Product Select the product for the selected compensation
plan, from the dropdown list. This may be ALL or
a specific product. The available values come
from a validated field based on the selected
Billing Cycle setup and the Product setup.

State Select the state for the selected compensation
plan, from the drop-down list. This may be ALL or
a specific state.

Currency Select the currency for the selected
compensation plan, from the dropdown list. This
may be ALL or a specific currency.

Pro Group Select the producer group for the compensation
plan, from the dropdown list. This may be ALL or
a specific producer group.
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Table 4-57    (Cont.) Compensation Plan Definition

Field Do this

Pro Type Select the producer type for the compensation
plan, from the drop-down list. This may be ALL or
a specific producer type.

Producer Select the producer for the compensation plan,
from the drop-down list. This may be ALL or a
specific producer. The available values come
from a validated field based on the Pro Group
and Pro Type.

Grade Select the credit grade for this compensation
plan, from the drop-down list. This may be ALL or
a specific grade.

Amt Specify the minimum amount financed for the
compensation plan.

Term Specify the minimum term for the compensation
plan.

Asset Class Select the asset class for the compensation plan,
from the drop-down list. This may be ALL or a
specific asset class. The available values come
from a validated field based on the Collateral
Type.

Asset Type Select asset type for the compensation plan,
from the drop-down list. This may be ALL or a
specific asset type. The available values come
from a validated field based on your assets
setup.

SubType Select the asset sub type for this compensation
plan, from the dropdown list. This may be ALL or
a specific asset sub type. The available values
come from a validated field based on your assets
setup.

Asset Make Specify the asset make from the drop-down list.
If ALL was selected for either Asset Type or
Asset Sub Type, then ALL will be the only
available selection for the asset make.

Asset Model View the asset model from the drop-down list. If
ALL was selected for either Asset Type or Asset
Sub Type, then ALL will be the only available
selection for the asset model (display only).

Age Specify the asset age.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.16 Commission
The Commission screen allows you to calculate dealer commissions for additional products
(for example, life insurance and disability insurance) for loanslease sold by the dealer and
entered in the Itemization sub screen during loanlease origination. You can setup the various
commission plans, which you use or select during funding.

In addition to the criteria, you can also define the insurance itemization, as well as the
commission itemization for which the plan is valid.

You can select one of the following two system-defined methods to calculate the commissions:
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• Flat amount

• Percentage of itemization amount.

To set up the LoanLease Commission Plan

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Commission > LoanLease.

2. In the Commission Plan Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.

Figure 4-38    Commission

Figure 4-39    Commission

A brief description of the fields is given below:

Table 4-58    Commission Plan Definition

Field Do this

Code Specify the commission code.
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Table 4-58    (Cont.) Commission Plan Definition

Field Do this

Description Specify the commission plan description.

Start Dt Specify the start date associated with the
commission. You can even select the date from
the adjoining Calendar icon.

End Dt Specify the end date associated with the
commission. You can even select the date from
the adjoining Calendar icon.

Enabled Check this box to enable the compensation plan.

Results section

Calculation Method Select the commission calculation method as
either Flat Amount or Percentage of
Itemization Amount from the drop-down list.

Value Specify the commission value.

Commission Itemization Select the commission itemization from the drop-
down list.

Selection Criteria section

IMPORTANT:
When you select commission to use, the system searches for a best match using fields in this
section. Hence, Oracle Financial Services Software recommends creating one version of each
compensation where ALL is the value in these fields when you have the option.

Company Select the portfolio company associated with the
commission, from the drop-down list.

Branch Select the portfolio branch associated with the
commission, from the drop-down list.

Billing Cycle Select the billing cycle associated with the
commission, from the drop-down list.

Product Select the product associated with the
commission, from the drop-down list.

State Select the state associated with the commission,
from the drop-down list.

Currency Select the currency associated with the
commission, from the drop-down list.

Pro Group Select the producer group associated with the
commission, from the drop-down list.

Pro Type Select the producer type associated with the
commission, from the drop-down list.

Producer Select the producer associated with the
commission, from the drop-down list.

Grade Select the credit grade associated with the
commission, from the drop-down list.

Amt Specify the minimum itemization amount
associated with the commission.

Term Specify the minimum insurance, warranty term
associated with the commission, from the drop-
down list.

Asset Class Select the asset class associated with the
commission, from the dropdown list.

Asset Type Select the asset associated with the commission,
from the drop-down list.
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Table 4-58    (Cont.) Commission Plan Definition

Field Do this

SubType Select the asset sub type associated with the
commission, from the drop-down list.

Asset Make Select the asset make associated with the
commission, from the drop-down list.

Asset Model Select the asset model associated with the
commission, from the drop-down list.

Age Specify the asset age associated with the
commission.

Ins/Warranty Itemization Select the insurance or warranty itemization
associated with the commission, from the drop-
down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.17 Insurance
Most financial institutes offer financing for insurance to the borrowers; examples include credit
life, credit disability, and GAP. The insurance product offer permits the customer to cancel the
insurance in mid term or automatically end when the product matures or is paid-off. The
system supports financing of insurance products during origination and automatically end the
insurance when the product is paid-off. The system also can compute the rebate premium
based on Rule of 78 or Actuarial method. As the customer might cancel the insurance in mid
term of the loanlinelease, the system computes the premium rebate on a prorate basis. This
also applies to additional insurance purchase during the life of the loanlinelease. Normally, mid
term insurance cancellations have associated fees and grace period. In such cases, the
customer may cancel the insurance during the grace period without accruing any fees.
However, when a customer cancels after the grace period, the result is a predefined fees which
the system deducts from the computed rebate.

The system supports mid term insurance cancellation with and without grace period and
cancellation fees. With this enhancement of insurance processing, you can define the premium
rebate computation with a prorate basis.

You can define financed insurance related itemizations in the Origination Fees screen, as you
have in previous releases with the Insurance screen. You can also set the refund method to
Pro Rate Basis in the Refund Method field in the Contract Itemization section on the
Itemization sub screen during setup with the on the Contracts screen.

To set up the Insurances

You can either define new Insurance details or specify a new code in the New Insurance field
and click Create Copy to create a copy of selected insurance with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Products > Insurance > LoanLineLease.

2. In the Insurance Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-40    Insurance

Figure 4-41    Insurance
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Figure 4-42    Insurance

A brief description of the fields is given below:

Table 4-59    Insurance Definition

Field Do this

Code Specify the code associated with the insurance
product.

Description Specify a brief description of the insurance
product.

Start Dt Specify the date from which you can start
offering the product to customers. You can even
select the date from the adjoining Calendar icon.

End Dt Specify the date from which to stop offering the
product to customers. You can even select the
date from the adjoining Calendar icon.

Enabled Check this box to allow the offering of this
insurance product.

Result section

Insurance Type Select the insurance types available for
financing, from the drop-down list.

Insurance Company Specify the name of the company through which
the insurance product is offered.

Calculation Method Select the insurance calculation method from the
drop down list.

Max Age Enter the maximum age allowed by the
insurance.

Cancellation /Refund Allowed Check this box to allow the insurance rebate or
refund for cancellation or paid-off.

Grace Days Specify the number of grace days allowed for
cancellation without charging a cancellation fee.

Tier Select the tier from the drop-down list.

Base Select the base from the drop-down list.

Category Select he category from the drop-down list.

Days Enter the number of category days.
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Table 4-59    (Cont.) Insurance Definition

Field Do this

Refund Calculation Method Select the insurance premium refund/rebate
calculation method to be used when insurance is
cancelled, from the drop-down list.

Cancellation Fee Specify the amount of the cancellation fee to be
charged when the insurance is cancelled.

Grace Day's Cancellation Fee Allowed Check this box to allow cancellation fees during
grace period.

Deduct Fee From Select one of the followings option from the drop-
down list to deduct the cancellation fee:

Premium amount - which is deducted upfront
before computation

Rebate amount - which is deducted after
computation

Selection Criteria Section

Company Select the portfolio company that can offer the
insurance product, from the drop-down list.
Select ALL if offered by all companies.

Branch Select the branch of the specified portfolio
company that can offer the insurance product,
from the drop-down list. Select ALL if offered by
all the branches of the specified portfolio
company.

Product Select the product for which you can offer the
insurance product, from the drop-down list.
Select ALL if offered for all the products.

State Select the state for which you can offer the
insurance product, from the drop-down list.
Select ALL if this is offered for all the states.

Currency Select the currency for which you can offer the
insurance product, from the drop-down list.
Select ALL if this is offered for all the states.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Create Copy button in the Insurance Definition section to create copy of selected
record with details.

5. In the Insurance Details section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-60    Insurance Details

Field Do this

Insurance Sub Type Select the insurance sub type you want to define
for the entry in the Insurance section, from the
drop-down list. For example SINGLE.

Term From Specify the minimum term for the insurance sub
type.

Rate Specify the rate for premium calculation
per $1,000.00 for the insurance sub type.
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Table 4-60    (Cont.) Insurance Details

Field Do this

Max Coverage Amt Specify the maximum coverage amount covered
by the insurance sub type.

Enabled Check this box to enable the insurance.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

4.18 Checklists
A checklist is an optional set of steps to follow when completing a task in the system, such as
the underwriting and funding processes.

Checklists can be used as guidelines to help ensure that the system users follow your
business’s standard operating procedures and enter all required data. Some checklists are
optional, but others such as those related to application decisions or contract verification, may
be required depending on the edit sets defined in your system. The Checklists screen allows
you to specify the contents of the checklist.

You can define additional checklists for your organization. You can set up multiple checklists for
a single type of checklist. These checklists can be differentiated by:

• Company

• Branch

• Product

• Account state

To set up the Checklists

You can either define new Checklist Type Definition details or specify a new code in the New
Checklist field and click Create Copy to create a copy of selected checklist type definition with
details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Checklists > LoanLineLease.

2. In the Checklist Type Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-43    Checklists

Figure 4-44    Checklists
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Figure 4-45    Checklists

3. A brief description of the fields is given below:

Table 4-61    Checklist Type Definition

Field Do this

Checklist Code Specify the checklist code that identifies checklist
being defined.

Description Specify the description for the checklist.

Checklist Type Select the checklist type from the drop-down list,
to define where the specific checklist will be
available in the system.

Company Select the portfolio company associated with the
checklist from the drop-down list. This may be
ALL or a specific company.

Branch Select the portfolio branch associated with the
checklist from the drop-down list. This may be
ALL or a specific branch. This must be ALL if in
the Company field you selected ALL).

Channel Select the channel from the drop-down list, This
can be ALL or a specific channel.

Product Select the product associated with the checklist
from the drop-down list. This may be ALL or a
specific product. The available values come from
a validated list based on the selected Billing
Cycle setup and the Product setup.
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Table 4-61    (Cont.) Checklist Type Definition

Field Do this

State Select the state associated with the checklist
type from the drop-down list. This may be ALL or
a specific state.

IMPORTANT: By selecting which edits type to
use, the system searches for a best match using
the following attributes:

1 Company

2 Branch

3 Product

4 State

Hence, Oracle Financial Services Software
recommends creating one version of each
checklist type where ALL is the value in these
fields.

Currency Select the currency associated with the checklist
from the drop-down list. This may be ALL or a
specific currency.

Enabled Check this box to enable the checklist.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
Checklist actions are steps (a set of one or more tasks) related to the checklist you are
creating. They are loaded on the Checklist Action Definition section.

5. In the Checklist Action Definition - Regular section, perform any of the Basic Operations
mentioned in Navigation chapter
A brief description of the fields is given below:

Table 4-62    Checklist Action Definition

Field Do this

Action Code Specify the action code for the checklist.

Description Specify the description for the action type.

Sort Specify the sort order to define the placement of
the action type on the Checklist sub screen.

Enabled Check this box to include this action in the
checklist.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Checklist Action Definition - Document section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 4-63    Checklist Action Definition

Field Do this

Action Code Specify the action code for the checklist.

Description Specify the description for the action type.

Document Type Select the document type from the drop-down
list.

Chapter 4
Checklists

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 143 of 174



Table 4-63    (Cont.) Checklist Action Definition

Field Do this

Document Sub Type Select the document sub type from the drop-
down list.

Document Mandatory Check this box to indicate that the document is
mandatory.

Sort Specify the sort order to define the placement of
the action type on the Checklist sub screen.

Enabled Check this box to include this action in the
checklist.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

4.19 Stipulations
The system supports the automatic generation of default stipulations for loanline of creditlease
during origination on the Underwriting window’s Stipulation sub screen (Decision link). The
default stipulations can be maintained by company, branch, product, state, application status
and application sub-status on the Stipulations screen.

To set up the Stipulations

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Stipulations > LoanLineLease.

2. In the Stipulation Setup section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-46    Stipulations
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Figure 4-47    Stipulations

Figure 4-48    Stipulations

A brief description of the fields is given below:

Table 4-64    Stipulation Setup

Field Do this

Company Select the portfolio company associated with the
default stipulations, from the drop-down list.

Branch Select the portfolio branch associated with the
default stipulations, from the drop-down list.

Product Select the product associated with the default
stipulations, from the drop-down list.

State Select the state associated with the default
stipulations, from the drop-down list.
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Table 4-64    (Cont.) Stipulation Setup

Field Do this

Currency Select the currency associated with the default
stipulations, from the drop-down list.

Grade Select the credit grade from the drop-down list.
The list consists of grade parameters defined in
Admin User setup to load stipulations during
underwriting and funding.

Pricing Select the pricing from the drop down list. The
list consists of pricing parameters defined in
Admin User setup to load stipulations during
underwriting and funding.

Application Status Select the application status associated with the
default stipulations, from the drop-down list.

Application Sub-Status Select the application sub status associated with
the default stipulations, from the drop-down list.

Enabled Check this box to allow the default stipulations to
be used.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Stipulation Details section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-65    Stipulation Details

Field Do this

Stipulations Select the stipulation from the drop-down list.

Sort Specify the sort sequence for the stipulation.

Enabled Check this box to allow the stipulations details to
be used by the system.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

4.20 Spreads
The Spreads screens allows you to define the payment allocation strategy used by your
business while applying payments to accounts. Spreads are selected on the Payment Entry
(Payment Maintenance) screens.

Depending on account status and condition, you can also define various combinations of
spreads for same account using the Spread Matrix, which can be defaulted when particular
accounts are selected for payments.

The Spreads screens consists of the following tabs:

• Spread Definition

• Spread Matrix
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4.20.1 Spread Definition
The Spread Definition section is used to define individual spreads. Many common spreads
have already been defined. With each spread, you can define the due date advancement
method to use, BRING CURRENT, FUTURE, or NONE.

The Spreads screen records the order in which balances are satisfied when a payment is
applied to an account. (Unless someone indicates otherwise, payments will be applied against
each balance type, in sort order, until either there is no remaining balance, or the payment has
been completely allocated.)

To set up the Spreads

You can either define new Spread Definition details or specify a new name in the New Spread
field and click Create Copy to create a copy of selected spread definition with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Products > Spreads > LoanLineLease > Spread Definition.
In the Spread Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-49    Spreads
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Figure 4-50    Spreads

Figure 4-51    Spreads

A brief description of the fields is given below:

Table 4-66    Spread Definition

Field Do this

Spread Specify the code identifying the spread.

Description Specify the description for the spread. (This
usually reflects when this spread is used.).
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Table 4-66    (Cont.) Spread Definition

Field Do this

Due Dt Adv Select the due date advancement code that
determines how payments applied using this
spread will affect due amounts, from the drop-
down list. The system uses the following
predefined Due Dt Adv Codes:

NONE – Payments applied using this spread will
not affect the due amounts of the account in any
way.

BRING CURRENT – The payment allocations for
transactions against an account’s outstanding
balances that make up the billed balances. This
will be applied against billed due amounts.

FUTURE – The payment allocations for
transactions against an accounts outstanding
balances that make up the billed balances. This
will be applied against billed due amounts. Any
remaining amount allocated against billed
balances will be accumulated and applied
against future due amounts.

FUTURE WITH PRINCIPAL, INTEREST THEN
ESCROW

FUTURE WITH ESCROW, THEN PRINCIPAL
AND INTEREST

Enabled Check this box to enable the spread.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. In the Spread Transaction Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 4-67    Spread Transaction Definition

Field Do this

Balance Type Select the balance type to allocate a portion of
the received payment, from the drop-down list.

Note: Oracle Financial Services Software
recommends that you always setup an
ADVANCE/PRINCIPAL balance type for each
spread.

Cycle Specify the balance cycle during which to apply
payments. This collects payment on bad (unpaid)
cycles. You can go back by only five cycles.
Cycle will have a value of 0 for loans.

Sort Specify the sort order in which the balance type
has payments allocated against it.

Enabled Check this box for the system to consider this
spread transaction when allocating payments.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

To Load Details

1. Create a record in Spread Definition section, with Enabled check box unchecked.
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2. Click Load Details button, the system will load the spread transaction definition details.

4.20.2 Spread Matrix
The Spread Matrix tab in Spreads screens allows you to define and maintain different
combinations of spreads depending on a particular account status, Conditions, Primary
Customer State, Amount FinancedCredit LimitCapitalized Cost and Priority.

When there are multiple spreads defined for an account with different conditions, you can set
the priority for the system to sequence the same.

The details maintained here are used to default the Spread when a particular account is
selected in the Payment Entry or Payment Maintenance screen.

To set up the Spread Matrix Details

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Products > Spreads > LoanLineLease > Spread Matrix.

Figure 4-52    Spread Matrix
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Figure 4-53    Spread Matrix

Figure 4-54    Spread Matrix

2. In the Spread Matrix section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 4-68    Spread Matrix

Field Do this

Start Dt Select the start date for the spread from the
adjoining calendar.

End Dt Select the end date for the spread from the
adjoining calendar.

Enabled This check box is selected by default indicating
that the spread is enabled.

Spread Select the required product active spread from
the drop-down list.
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Table 4-68    (Cont.) Spread Matrix

Field Do this

Selection Criteria

Account Status Select the account status for the spread from the
drop-down list.

Account Condition Select the account condition for the spread from
the dropdown list.

Note: You can define multiple conditions for the
same account.

State Select the state of the primary applicant from the
drop-down list.

Loan Amt From Specify the value of Loan amount from where the
system should consider the current spread.

Credit Limit From Specify the value of credit limit amount from
where the system should consider the current
spread.

Capitalized Cost From Specify the value of capitalization cost from
where the system should consider the current
spread.

Priority Specify the priority when there are multiple
conditions posted on the same account. System
considers the least numbered priority as first in
the sequence.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.21 Statement Messages
The Messages screen allows you to set up messages that appear on account statements sent
to customers. You can set up statement messages for different products. When the system
generates a statement for an account, all statement messages matching the selection criteria
are included in the statement file for that account.

The system inserts the message in the Text field into the statement file produced during the
nightly batch job for the appropriate consumers.

A record of an account’s statement history, including the messages included in the statement,
appears on the Statement’s screen on the Customer Service screen.

To set up the Messages

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Statement Messages > LoanLineLease.

2. In the Statement Messages section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-55    Statement Messages

Figure 4-56    Statement Messages
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Figure 4-57    Statement Messages

A brief description of the fields is given below:

Table 4-69    Statement Messages

Field Do this

Seq Specify the sort sequence of how the statement
message should be printed.

Code Specify the message code identifying the
statement message.

Start Dt Specify the first date the statement message is
available. You can even select the date from the
adjoining Calendar icon.

End Dt Specify the last date the statement message is
available. You can even select the date from the
adjoining Calendar icon.

Enabled Check this box to enable the message.

Result section

Text Specify the text of the statement message.

Selection Criteria section

Company Select the company for the statement message
from the drop-down list. This may be ALL or a
specific company.

Branch Select the branch within the company for the
statement message from the drop-down list. This
may be ALL or a specific branch. This must be
ALL if in the Company field you selected ALL.

Product Select the product for which this statement
message will be used from the drop-down list.
This may be ALL or a specific product.

Currency Select the currency for the statement message
from the drop-down list. This may be ALL or a
specific currency.
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Table 4-69    (Cont.) Statement Messages

Field Do this

Producer Select the producer for the statement message
from the drop-down list. This may be ALL or a
specific producer. The available values come
from a validated field based on the Pro Group
and Pro Type.

IMPORTANT: By selecting which message to
use, the system searches for a best match using
the following attributes:

1. Company

2. Branch

3. Product

4. Producer

5. Currency

Hence, Oracle Financial Services Software
recommends creating one version of each edit
type where ALL is the value in these fields.

4.22 Letters
The Letters screen allows you to define letters that the system automatically generates when
the application or the account for a products meets certain conditions, or trigger events. Each
letter has its own trigger event. For example, you can configure the system to automatically
send a welcome letter when an application becomes an account or send a collection letters
when an account becomes delinquent.

The system supports the following types of letters:

Table 4-70    Types of letters

Type of letter Definition

ACCOUNT STATEMENT Generated when account is to receive a billing
statement (this time is defined in contract setup).
Letter is sent to customer.

ADVERSE Action letter Generated in nightly batch jobs for applications that
were declined. This letter is sent to the consumer
to indicate the reasons why the application was
declined.

CONDITIONAL ADVERSE Generated in nightly batch jobs for applications that
were declined.

ACTION LETTER This letter is sent to the consumer to indicate the
reasons why the application was declined. This
letter also indicates steps that the consumer may
take to gain approval of the application.

COLLECTION LETTER 1 Generated when an account becomes delinquent.
This is the first dunning letter sent to the customer.

COLLECTION LETTER 2 Generated when an account remains in
delinquency for an extended period. This is the
second dunning letter sent to the customer.
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Table 4-70    (Cont.) Types of letters

Type of letter Definition

COLLECTION LETTER 3 Generated when an account remains in
delinquency for an extended period, even after
having received previous notices. This is the final
dunning letter sent to the customer.

CONTRACT FUNDING fax/ email Generated when an application is APPROVED:
FUNDED or CONDITIONED: FUNDED. This letter
is sent to the producer.

DECISION FAX/ EMAIL Generated when an application is APPROVED,
CONDITIONED, or REJECTED. This letter is sent
to the consumer or producer, depending on
whether the product is a direct or in-direct loan.

PAID IN FULL LETTER Generated in nightly batch jobs when the account
pays off. This letter is sent to the customer.

PAYOFF QUOTE LETTER Generated when a payoff quote is created for an
account. This letter is sent to the customer.

WELCOME LETTER Generated when an application is APPROVED:
FUNDED. This letter is sent to the consumer.

STATEMENT PAST MATURITY Generated when
an accounts are matured but unpaid.

This letter is sent to the account holders as a
reminder to make their payments.

When the system generates letters, it searches the Letters screen for letter definitions that
meet the following criteria:

• Definition is enabled.

• Definition is an exact match of the letter code being generated.

• Definition is a match of either the application/account value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches to ALL.

The returned rows are then given a descending rank based on the weighted values and the
hierarchical position of these fields:

1. Company

2. Branch

3. Product

4. State

5. Currency

On the ranked rows, the first row is returned as the best match.

To set up the Letters

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Letters > LoanLineLease.

2. In the Letter Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-58    Letters

Figure 4-59    Letters
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Figure 4-60    Letters

A brief description of the fields is given below:

Table 4-71    Letter Definition

Field Do this

Letter Code Specify the code for the letter.

File Name Specify the file name of the Oracle report used to
generate the letter. The file should be named
<File Name>.rep on your server.

Letter Type Select the type of letter you want to generate
from the drop-down list.

Channel Select the application source (channel) for the
letter from the drop-down list. This may be ALL
or a specific channel.

Enabled Check this box to enable this letter definition.

Result section

Batch Printer Select the batch printer being used to generate
the letter from the drop-down list.

Batch User Select the user who will submit this letter from
the drop-down list. This will normally be set to
BATCH.

Selection Criteria section

Company Select the portfolio company for which this letter
will be used from the drop-down list. This may be
ALL or a specific company.

Branch Select the portfolio branch for which this letter
will be used from the drop-down list. This may be
ALL or a specific branch. This must be ALL if in
the Company field you selected ALL).

Product Select the product for which this letter will be
used from the drop-down list. This may be ALL or
a specific product.
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Table 4-71    (Cont.) Letter Definition

Field Do this

State Select the state for which this letter will be used
from the drop-down list. This may be ALL or a
specific state.

Currency Select the currency for which this letter will be
used from the drop-down list. This may be ALL or
a specific currency.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.23 Promotions
The Introductory tab of Promotions screen allows you to set up the promotions that a financial
institution can offer its customers. Promotion details defined here can be selected during
Application Entry and Application processing.

You can define multiple promotions for a product, then select the appropriate promotion at the
time the application is processed. Promotions also serve as a selection criteria on the Pricing
screen.

CAUTION: The system supports promotions selected only when a product is funded.

Note

Promotions will not be supported for amortized and pre-compute loansonly be
supported for Interest Rate type of lease calculation method.

Same as Cash promotions

In the case of the same as cash promotion:

• If the outstanding amount at the end of the promotional period is within the tolerance
amount, then the customer receives the full benefit of the promotion and the system will
not charge any interest on the borrowers’ account.

• If the outstanding amount is higher than the authorized tolerance amount, then the
customer loses the benefit of the promotion and the system computes and charges the
borrower interest from the date the product was funded.

Interest & Payments

Interest still continues to accrue for a account that is funded using the SAME AS CASH
promotion. However, the interest accrued during the promotion period is not charged or
collected on the account until the end of the promotion period.

Any repayment made by the customer during the promotion period is applied towards the
loanlinelease receivables amount. The system then calculates the interest accrual using the
reduced loanlinelease receivables amount, if applicable.

If the product remains unpaid after the end of the promotion period and the loanlinelease
receivables balance is above any stated tolerance amount, then the system starts collecting
interest earned and accrued during the promotion period.

Pay-off quote during promotion period
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If the account is set-up using the SAME AS CASH promotion, then during the promotion
period:

1. On the Customer Service > Account Details screen, the system displays only the principal
amount and any fees/expenses due. Interest amounts will not be included.

2. The payoff quote generated through the Customer Service > Maintenance screen displays
only the principal amount and any fees/expenses due from the borrower(s). If all or any
portion of the account is unpaid at the end of the promotion period and is over any set
tolerance limit, then the PAYOFF amount displays the total amount (Principal + Interest +
other charges, if any) using the current amounts.

Reduced Rate Introductory Promotions

Oracle Financial Services Lending and Leasing’s promotion method PROMOTIONAL RATE
allows you to create and specify promotions where customers can be charged lower interest
rates during a specific promotional period of time. You may define the length of the promotion
in either terms or days. Also, you will be able to set the specific interest rate you want to attach
to the promotion. During the promotional period, interest on an account is accrued at the
promotional rate. When the promotional period expires, the system changes the interest rate of
the product to the contractual interest rate to accrue interest. The promotion expires on the
promotion end date defined by the length of the promotion. However, the system allows you to
set a grace period for extending the automatic cancellation of the promotion due to
delinquency, similar to the grace period associated with a payment date.

To set up the LoanLineLease Introductory

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Promotions > LoanLineLease Introductory.

2. In the Promotion Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-61    Promotions-Loan Introductory
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Figure 4-62    Promotions-Lease Introductory

A brief description of the fields is given below:

Table 4-72    Promotion Definitions

Field Do this

Code Specify the code identifying the promotion.

Description Specify a description of the promotion being
offered.

Type Select the promotion type from the drop-down
list.

Period Type Select the period type from the drop-down list.

Note: Select PROMOTIONAL DAYS, if the length
of the promotion is to be measured in days.
Select PROMOTION TERM, if the length of the
promotion is more accurately measured in terms.

Period Specify the specific promotion period. If you have
selected PROMOTIONAL DAYS in the Period
Type field, then enter the number of days of the
promotion period duration. If you selected
PROMOTION TERM, then enter the number of
terms for which the promotion applies.
Remember that the system uses the same length
of the term increment that is used in the billing
cycle for the loanLease; for example, weekly,
monthly, semi-annual, or annual.

Tolerance Amt Specify the dollar amount of the allowed
tolerance, if applicable. This is the amount that
can be outstanding at the end of the promotion
period.

Note: This applies only to the promotion type
SAME AS CASH.

Index Select the promotional index rate from the drop-
down list.

Margin Specify the promotional margin rate.

Chapter 4
Promotions

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 161 of 174



Table 4-72    (Cont.) Promotion Definitions

Field Do this

Cancel Delq Days Specify the tolerance days for the promotion
cancellation due to delinquency.

Enabled Check this box to enable the promotion.

Lease Calc Method The lease calculation method is selected as
INTEREST RATE on save since lease promotion
is applicable only for Interest Rate type of
calculation method.

Table 4-73    Promotion Definitions

Field Do this

Code Specify the code identifying the promotion.

Description Specify a description of the promotion being
offered.

Type Select the promotion type from the drop-down
list. Oracle Financial Services Lending and
Leasing supports the following promotion types
for lines of credit:

NO PAYMENT DUE ANY INTEREST DUE (No
payments are required and no interest is accrued
on the outstanding accrual balances for x terms).

Term Select the promotion term from the drop-down
list.

Index Select the promotion index from the drop-down
list.

Margin Specify the promotion margin rate.

Cancel Delq Days Specify the promotion cancellation delinquency
days.

Cancel Overlimit% Specify the promotion cancellation over limit
percentage.

Enabled Check this box to enable the promotion.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Promotions > Line Incentive.

5. In the Promotion Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-63    Promotions-Line Incentive

6. A brief description of the fields is given below.

Table 4-74    Promotion Definitions

Field Do this

Code Specify the code identifying the promotion.

Description Specify a description of the promotion being
offered.

Start Date Select the start date from the drop-down list.

End Date Select the end date from the drop-down list.

Enabled Check this box to enable the promotion.

Result section

Type Select the promotion type from the drop-down
list.

Term Specify the promotion term.

Index Select the promotion index from the drop-down
list.

Margin Specify the promotion margin rate.

Cancel Delq Days Specify the promotion cancellation delinquency
days.

Cancel Overlimit% Specify the promotion cancellation over limit
percentage.

Selection Criteria section

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down
list.

Product Select the product from the drop-down list.

State Select the state from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.24 Subvention
The Subvention Setup screen’s loanlease Subvention tab allows you to set up loanlease
subvention plans for producers (groups or individuals). Multiple producers may contribute to
one subvention plan or a plan can be set for a specific producer.

Subvention Types

Subvention can be offered in many forms for vehicle loansleases. The most common format is
the rate subventionRent factor for vehicle loansleases. RateRent factor subvention involves
sharing the finance charge (interest) by the participant (most frequently with the manufacturer).
The finance company sets its buy rate (the minimum cost to the company to extend the
loanslease to a customer). If the customer rate is less than this buy rate, then the amount is
equivalent to the interest amount for the difference (the buy rate minus the customer rate) is
paid by the participant as the subvention amount.

Currently Oracle Financial Services Lending and Leasing supports the following subvention
types:

LoanLease subvention types:

• Rent factor

• Residual

• Deposit waiver

• Rate

• Cash bonus

• Buy down

Subvention plans can be defined for one participant (for example, a manufacturer or a
particular dealer) or group of participants (such as a dealer association). One subvention plan
could have multiple sub plans and multiple participants could participate to each sub plan.

Example

Subvention plan:

• “Summer Special Event”
Subvention sub-plans for above plan:

• 1.9% for 36 months
-or-

• 2.99% for 48 months
-or-

• 3.99% for 60 months
-or-

• $1500.00 cash bonus

Multiple participants may participate in each sub plan. For example, for the 1.9% rate, 1%
might be shared by the manufacturer and 0.9% might be shared by the dealer. Similarly, for
the $1,500 cash bonus, $1,000 might be shared by the manufacturer and $500 by the dealer.
Or, the complete $1,500 might be covered by the manufacturer.

Collection of subvention amounts can be set for each participant in the subvention plan with
the Collection Method.
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Oracle Financial Services Lending and Leasing supports following collection methods:

Table 4-75    Collection Method

Type Details

UPFRONT The entire subvention amount is collected at the
booking of the LoanLease from the producer
proceed.

UPFRONT STATEMENT The entire subvention amount is collected at the
time of the subvention statement.

PAY AS U GO The subvention amount is billed to the producer
when the customer pays the LoanLease payment.
The producer is due for the amount at each
statement.

Subvention Refund

There are times when a LoanLease is either paid-off early or gets charged off and the finance
company refunds the unearned subvention amount back to the producer. The refund is
available only when the subvention amount is collected from the producer proceeds
(UPFRONT) or the whole amount is billed in the first statement (UPFRONT STATEMENT).

You can set up the system to allow refunds only for a certain period and not beyond that. The
period can be set differently for charge offs and paid offs and can be based on two methods:

1. Days

2. Term

The system provides the following methods for refund amount calculation:

1. Earned

2. Percentage

The earned method is used to refund the unearned portion of the collected subvention amount.
The percentage method is used to refund a certain percentage of the subvention amount
collected.

This section consists of the following topic:

• LoanLease Subvention Plans

4.24.1 LoanLease Subvention Plans
The LoanLease Subvention Plans screen allows you to set up subventions for LoansLeases.

To set up the LoanLease Subvention Plans screen.

1. On the Oracle Financial Services Lending and Leasing home screen, Click Setup > Setup
> Products > Subvention > LoanLease.

2. The system displays the LoanLease Subvention screen. The details are grouped into
three.

• Plan Definition

• Sub Plan Definition

• Plan Details.
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3. In the Plan Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-64    Subvention

Figure 4-65    Subvention

A brief description of the fields is given below:
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Table 4-76    Plan Definition

Field Do this

Code Specify the subvention plan code.

Description Specify the subvention plan description.

Company Select the company name from the drop-down
list.

Branch Select the branch name from the drop-down list.

State Select the state from the drop-down list.

Start Date Specify the start date for the subvention plan
(required). You can select the date even from the
adjoining Calendar icon.

End Date Specify the end date for the subvention plan. You
can select the date even from the adjoining
Calendar icon.

Enabled Check this box to activate the record.

Selection Criteria

Billing Cycle Select billing cycle from the drop-down list.

Product Select the product from the drop-down list.

Asset Class Select the asset class from the drop-down list.

Asset Type Select the asset type from the drop-down list.

Asset Sub Type Select asset sub type from the drop-down list.

Asset Make Select asset make from the drop-down list.

Asset Model Select the asset model from the drop-down list.

Asset Age Specify the asset age.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Sub Plan Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-77    Sub Plan Definition

Field Do this

Code Specify the subvention sub plan code.

Description Specify the subvention sub plan description
(required).

State Select the state from the drop-down list.

Pro Group Select the producer group from the drop-down
list.

Pro Type Select the producer type from the drop-down list.

Producer Select the producer from the drop-down list.

Enabled Check this box to activate the record.

Amt From Specify the amount.

Subvention Type Select the subvention type from the drop-down
list.

Grade Select the grade from the drop-down list.

Term Specify the term.

Asset Class Select the asset class from the drop-down list.

Asset Type Select the asset type from the drop-down list.
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Table 4-77    (Cont.) Sub Plan Definition

Field Do this

Sub Type Select asset sub type from the drop-down list

Asset Make Select asset make from the drop-down list.

Asset Model Select the asset model from the drop-down list

Age Specify asset age.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Plan Details section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 4-78    Plan Details

Field Do this

Participant Select the participant from the drop-down list.

Collection Method Select the collection method for the subvention
plan from the drop-down list.

Transaction Select the transaction code from the drop-down
list.

Rate Specify the subvention rate.

Enabled Check this box to activate the record.

Calculation section:

Method Select the subvention calculation method from
the drop-down list. The list displays the following
values:
• SPREAD DEFAULT
• SPREAD DEFAULT - (minus) PRESENT

VALUE
• FLAT AMOUNT
• % OF AMT FINANCED
• % OF AMT FINANCED + FLAT AMOUNT
• % OF CAPITALIZATION COST GROSS
• % of CAPITALIZATION COST GROSS +

FLAT AMOUNT

Override Check this box to allow overriding the rate at the
time of underwriting / funding.

Max Amt Specify the maximum subvention amount.

% Amt Financed Specify the percentage of amount financed to
derive the Subvention Amount.

For example: If Amount Financed = 100$, and %
of Amt Financed = 5%, then the Subvention
Amount = 100 * 0.05 = 5$

% Capitalized Cost Specify the percentage of capitalized cost to
derive the Subvention Amount.

For example: If Capitalized Cost = 100$, and %
of Capitalized Cost = 5%, then the Subvention
Amount = 100 * 0.05 = 5$

Flat Amt Specify the flat amount.

Factor Specify the subvention factor.
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Table 4-78    (Cont.) Plan Details

Field Do this

Spread Max Specify the maximum subvention spread value.

Refund section:

Paid Off Method Select the method from the drop-down list, if the
account is paid-off early.

Paid Off Basis Select the basis from the drop-down list, if the
account is paid-off early.

Paid Off Period Specify the number of terms in which the
subvention can be refunded to the producer, if
the account is paid-off early.

Paid Off Percent Specify the refund percentage, if the account is
paid-off.

Charge Off Calc Method Select the calculation method from the drop-
down list, if the account is charged-off.

Charge Off Basis Select the charge off basis from the drop-down
list.

Charge Off Period Select the charge off period from the drop-down
list.

Charge Off Percent Select the charge off percent from the drop-down
list.

Amortization section:

Balance Type Select the amortize balance type from the drop-
down list.

Method Select the amortize method from the drop-down
list.

Frequency Select the amortize frequency from the drop-
down list.

Cost / Fee Select the cost / fee from the drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.

4.25 Escrow
Oracle Financial Services Lending and Leasing provides tax and insurance escrow for loans.
The Escrow screen contains subsection that allow you to set up these features.

This chapter explains the Escrow screen and how to set up escrow in the system.

• Escrow

4.25.1 Escrow
The Escrow Definition screen allows you to review or set up escrow definitions for taxes and
insurance and note whether or not cushion is allowed.

Navigating to Escrow

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Products > Escrow. The Escrow details can be setup across three subsections:

• Escrow

• Shortage/Cushion Rules
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• Disbursement Rules

4.25.1.1 Escrow
To setup Escrow

1. Click Setup > Setup > Products > Escrow > Escrow.

2. In the Escrow Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-66    Escrow Definition

A brief description of the fields is given below:

Table 4-79    Escrow Definitions

Field Do this

Escrow Specify the escrow code. This is protected
against update and cannot be changed after
initial set up.

Description Specify the escrow description.

Escrow Type Select the escrow type, usually INSURANCES or
TAXES from the drop-down list.

Cushion Allowed Check this box if the escrow you are defining
allows for cushion.

Note: Cushion rules are used to determine how
much cushion should be retained.

Incl 1098 Check this box to include in 1098 reporting.

Enabled Check this box to enable the escrow definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.25.1.2 Shortage/Cushion Rules
In Shortage/Cushion Rules, you can review and set up escrow analysis shortage/cushion
rules. Shortage/cushion rules determine how much cushion you are allowed on a particular
escrow line and if there is a predicted shortage, how to eliminate it by increasing payment.

To setup Shortage/Cushion Rules

1. Click Setup > Setup > Products > Escrow > Shortage/Cushion Rules.

2. In the Rules section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 4-67    Shortage/Cushion Rules

A brief description of the fields is given below:

Table 4-80    Rules

Field Do this

Rule Specify the rule code. This is protected against
update and cannot be changed after initial set
up.

Description Specify the rule description.

Start Dt Specify the start date for this rule. You can even
select the date from the adjoining Calendar icon.

End Dt Specify end date for this rule. You can even
select the date from the adjoining Calendar icon.

Enabled Check this box to enable the rule.

Parameters section

Shortage Threshold Select the shortage threshold, either an amount
or number of installments, from the drop-down
list.

Shortage Value Specify shortage threshold value.

Shortage Spread Increase% Specify shortage spread increase percent.

Chapter 4
Escrow

Line Collection Setup Guide
G48641-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

November 28, 2025
Page 171 of 174



Table 4-80    (Cont.) Rules

Field Do this

Term Specify shortage spread term.

Max Term Specify the maximum amount of shortage
spread terms.

Surplus Amt Specify surplus threshold amount for this rule.

Company Select the company for this rule from the drop-
down list.

Branch Select the branch for this rule from the drop-
down list.

Product Select the product for this rule from the drop-
down list.

State Select state for this rule (required).

IMPORTANT: When you select which escrow
rule to use, the system searches for a best
match using the following attributes:

1. Company

2. Branch

3. Product

4. State

Hence, the system recommends creating one
version of each rule, where ALL is the value in
these fields.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Rule Details section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 4-81    Rule Details

Field Do this

Escrow Type Select escrow type from the drop-down list.

Cushion Type Select cushion type from the drop-down list.

Cushion Value Specify cushion value.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

While considering the cushion rules, preference is provided either for all records
and then for Insurances or taxes maintained in a particular shortage or cushion
rule.

4.25.1.3 Disbursement Rules
The Rules screen allows you to define the disbursement rules for your escrow.

To setup Disbursement Rules

1. Click Setup > Setup > Products > Escrow > Disbursement Rules.
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2. In the Escrow Disbursement Rules section, perform any of the Basic Operations
mentioned in Navigation chapter.

Figure 4-68    Escrow Disbursement Rules

A brief description of the fields is given below:

Table 4-82    Escrow Disbursement Rules

Field Do this

Disbursement Rule Specify the disbursement rule. This is protected
against the update and cannot be changed after
initial set up.

Description Specify the description.

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Start Dt Specify the start date. You can even select the
date from the adjoining calendar icon.

End Dt Specify the end date. You can even select the
date from the adjoining calendar icon.

Enabled Check this box to enable this disbursement rule.

Disbursement section

Jan% Specify the percent to be disbursed in January.

Feb% Specify the percent to be disbursed in February.

Mar% Specify the percent to be disbursed in March.

Apr% Specify the percent to be disbursed in April.

May% Specify the percent to be disbursed in May.

Jun% Specify the percent to be disbursed in June.

Jul% Specify the percent to be disbursed in July.

Aug% Specify the percent to be disbursed in August.
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Table 4-82    (Cont.) Escrow Disbursement Rules

Field Do this

Sep% Specify the percent to be disbursed in
September.

Oct% Specify the percent to be disbursed in October.

Nov% Specify the percent to be disbursed in November.

Dec% Specify the percent to be disbursed in
December.

Total% Displays total annual disbursement percentage.
This figure is the sum of the monthly
disbursements and must equal 100 percent.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

You cannot save the disbursement rule, if the Total% is not equal to 100.
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A
Appendix : System Parameters

This topic consists of the following sections:

• Introduction

• System Parameters

• Organization Parameters

• Company Parameters

• Other Parameters

A.1 Introduction
System defined parameters help in configuring system specific data, User-access, location of
system files; reports related URLs and other administration controlled data. These are
essential to be configured during installation and some of them by nature of application will
have to be reviewed and maintained in a regular and periodic manner.

Following are the types of parameters are used in OFSLL system depending on the areas of
the system that these would apply and impact:

• System Parameters

• Organization Parameters

• Company Parameters

• Other Parameters

Note

All the above parameters can be controlled (enabled/disabled) only by System
Administrators, and users with Admin/Super User privileges who would be involved in
setting-up OFSLL system.

A.2 System Parameters
System parameters apply to the entire system. They relate to the overall processing of the
system like application server file locations, data purging configurations and so on.

Table below details the list of system parameters with their description and pre-defined values.

Table A-1    System Parameters

Parameter Description

ACA_DLQ_AMT_EXCLUDED This parameter is used to exclude delinquency
amount for account ACH
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Table A-1    (Cont.) System Parameters

Parameter Description

ACA_PAYMENT_AUTO_ LOAD This parameter is used to control posting directly
from the ACH file that has been created for
customer payments. Input parameter value is
Boolean (Yes/No). If the parameter is set to Y, the
system automatically creates payment batches for
the payments in the ACH file and posts them on the
day of payment.

ACA_PRENOTE_DAYS This parameter is used to define the number of
days the prenote should be initiated for customer
ACH (Automated Clearing House) accounts. Input
parameter value is numeric.

ACA_PRE_PROCESS_DAYS This parameter is used to specify the number of
days before draft day for Account ACH process.
Input parameter value is numeric.

ACH_PAYEE_PRENOTE_DAYS This parameter is used to define the number of
days for prenote to occur for Producer or Vendor
ACH accounts. Input parameter value is numeric.

ADMIN_SERVER_URL This parameter is used to define the admin server
URL.

ADR_DIRECTORY This parameter is used to define the Oracle
Directory Object Name for ADR file location.

ADR_PROCESSED_DIRECTORY This parameter is used to define the Oracle
Directory Object Name for ADR file location.

AGE_APPROVED_CONDITIONED_ DAYS This parameter is used to specify the number of
days by which an application in Approved or
Conditioned status is treated as Aged Application.
Input parameter value is numeric with no upper
limit.

AGE_CONTRACT_DAYS This parameter is used to specify the number of
days by which a contract is treated as Aged
Contract. Input parameter value is numeric with no
upper limit.

ASC_COL_SER_ENABLED_ IND This parameter is used as the Collection Servicing
Enabled Indicator.

CAC_DIRECTORY This parameter is used to define the Oracle
Directory Object Name for CAC file location.

CAC_PROCESSED_DIRECTORY This parameter is used to define the Oracle
Directory Object Name for CAC file location.

CHECK_PRINT_PREVIEW Using this parameter we can allow preview of
application in pdf form before printing. Input
parameter value is Boolean (Yes/No).

CMN_AMOUNT_ROUND_ FACTOR This parameter is used to define the rounding
factor for applicable fields (in this case calculated
amounts). Input parameter value is ROUND
AMOUNT TO 2 DECIMALS. Currently system
supports rounding factor 2 only.
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Table A-1    (Cont.) System Parameters

Parameter Description

CMN_AMOUNT_ROUND_ METHOD This parameter is used to define the amount round
method during system set-up and would be
applicable for all calculated amounts (calculated
fees, payment etc.) across the application. Input
values are ROUND, RAISE and CUTOFF:

ROUND: Rounded to nearest number higher or
lower

RAISE: Rounded to the nearest higher number

CUTOFF: Truncate the digits without rounding or
raising

CMN_APP_ACC_TITLE_ FN_LN This parameter is used to set the Application or
Account title in one of the formats – First/Last
Name or Last/First Name. Input parameter value is
Boolean (Yes/No). If Yes is chosen, title would be in
the format – First/Last Name, else the other option.

CMN_APP_SERVER_HOME This parameter is used to set the Application
Server Home Directory. Input parameter value is
user defined.

CMN_CURRENT_MODEL_YEAR This parameter is used to default the Current Model
Year.

CMN_DEBUG_LEVEL This is the Common Debug Level

CMN_DEBUG_METHOD This parameter allows to define the location to
which generic debug logs (other than Alert/Warning
and GRI) are to be written. If set to
ADVANCE_QUEUE, system writes the logs in
Logs table and if set to UTL_FILE, system
generates the alert log file.

CMN_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the incoming or outgoing files/documents
are to be processed. If set to Y, system processes
the data to/from LOB and if set to N, system
processes the data to/from FILE.

The same is used by the batch jobs available in
SET-IFP (input file processing) Batch Job Set.

CMN_GL_POST_DT This parameter is used to specify the General
Ledger Posting date. If scheduler is enabled, it
automatically updates this to current system date.
Else Admin User would need to set this date
manually to ensure correct posting dates in GL.

CMN_HTTP_PROXY_ PORT This parameter is enabled to specify the port to be
used for outgoing HTTP connections. Input
parameter value is user defined.

CMN_HTTP_PROXY_SERVER This parameter is enabled to specify the proxy
server to be used for outgoing HTTP connections.
Input parameter value is user defined. There exists
an interdependency of this parameter with
CMN_HTTP_PROXY_PORT mentioned above.
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Table A-1    (Cont.) System Parameters

Parameter Description

CMN_INT_360_ACCRUAL_DAYS_MTHD This parameter is used to specify the interest
accrual method for 360 days, to be used by the
System for all calculations with interest. Currently
two methods are supported. Input parameter value
is US or EU representing American and European
method of interest accrual for 360 days.

CMN_TEST_TOOL_LOGGING This parameter is used to set testing tool logging
parameter

CMN_SCHEMA_ID This is used to specify the schema identifier for all
users.

CMN_SCHEMA_NAME This is used to specify the Oracle User Name for a
specific schema. Input parameter value is user
defined.

CMN_SCHEMA_PASSWORD This captures the password for Oracle, for the
specific schema. Input parameter value is user
defined. This parameter need not be enabled when
in Oracle Network.

CMN_SERVER_HOME This parameter captures the Server Home
Directory. Input parameter value is user defined.

CMN_SERVER_TEMP_DIR This parameter is used to specify the temporary
directory on the server along with the path. Input
parameter value is user defined.

CMN_SER_ENVIRONMENT_ FILE This parameter captures the environment file (and
its path) for running the Operating System
commands from Job Service. Input parameter
value is user defined.

CMN_WALLET_PASSWORD This parameter is used to specify the common
wallet password. Input parameter value is user
defined.

CMN_WALLET_PATH This parameter is used to specify the common
wallet path for oracle database. Input parameter
value is user defined.

CPP_NO_OF_PROMISES This parameter is used to define the maximum
number of promises/chances allowed for a
customer who is delinquent and promises to pay.
Input parameter value is numeric with no upper
limit.

CPP_PROMISE_HELD_DAYS This parameter is used to define the maximum
number of days after the promises made by the
customer to pay are broken to initiate further
actions. Input parameter value is numeric with no
upper limit.

CRD_CHS_BIN This parameter holds the value of the credit card
BIN (Bank Identification Number for Credit Cards),
for CHASE interface. Input parameter value is user
defined. (P.S: OFSLL supports CHASE interface for
credit card payments processing)

CRD_CHS_CUR_CODE This parameter is used to specify the currency
code of the transacting currency for CHASE
interface. Input parameter value is user defined.
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CRD_CHS_DIR_PATH This parameter is used to specify the directory path
for CHASE payment interface for Credit Cards.
Input parameter value is user defined.

CRD_CHS_IND_TYPE This is used to specify the industry type for CHASE
payment interface for Credit Cards. Input parameter
value is user defined.

CRD_CHS_MERCHANT_ ID This captures the merchant ID number for CHASE
payment interface for Credit Cards. Input parameter
value is user defined.

CRD_CHS_REMOTE_HOST_NAME This captures the remote host name for seeking
approvals for CHASE payment interface. Input
parameter value is user defined.

CRD_CHS_SEC_REMOTE_HOST_NAME Similar to the previous parameter this captures the
secondary remote host name of CHASE interface
for seeking approvals for credit card payments.
Input parameter value is user defined.

CRD_CHS_TIMEOUT This parameter is used to define the timeout limit
when polling the interface for processing credit card
payments. Input parameter value is numeric.

CRD_CHS_USR_ID This parameter captures the user id for CHASE
interface which is required whenever the System
needs to access/ seek authorizations/process
payments for credit cards etc. Input parameter
value is user defined.

CRD_PTB_REMOTE_HOST_NAME This is the Protobase Remote Host Name

CRD_PTB_REMOTE_HOST_PORT This is the Protobase Remote Host Port

CRD_PTB_TIMEOUT This is the Protobase Timeout Value

CRD_SOURCE_TYPE_CD This is the Source Type Code

DDT_CREATE_DUE_ DATE_HISTORY This parameter must be enabled to create a due
date history for any account. Due date history sub
tab under Transaction history displays the
delinquency history of an account in a tabular
format detailing Due date, Due Amount, Last
Payment date, Payment Amount, Balance Amount,
Days past due and Payment received flag. The
input parameter value for this parameter is Boolean
(Yes/ No).

DECISION_ BUY_RATE_TOLERANCE This parameter is used to define the variance in
buy rate

EDF_DIALER_ACCT_TYPE This parameter is used to set up the account
number reference for the dialer file to pick-up
records for Auto dialer interface. Input parameter
value is account number.

FLL_BPEL_PROCESS This parameter is set to use BPEL process in
OFSLL. Input parameter value is Boolean (Yes/No).

ICA_INPUT_FILE_FORMAT This parameter is used to define the input call
activity file format

IFD_DIRECTORY This parameter is used to define the Oracle
directory object name for IFD file location

IFD_PROCESSED_DIRECTORY This parameter is used to define the Oracle
directory object name for IFD file location
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INCOMING_ LOB_PURGE_DAYS This parameter is used to define the incoming
process file table purge days

INPUT_DIRECTORY This parameter is used to define the Oracle
directory object name for INPUT file location

ITU_DIRECTORY This parameter is used to define the Oracle
directory object name for ITU file location

ITU_PROCESSED_DIRECTORY This parameter is used to define the Oracle
directory object name for ITU file location

IVR_DIRECTORY This parameter is used to define the Oracle
directory object name for IVR file location

IVR_PROCESSED_DIRECTORY This parameter is used to define the Oracle
directory object name for IVR file location

JSC_TIMEOUT This parameter is used to set the polling interval for
job scheduler. Input parameter value is numeric. To
check whether it represents minutes/seconds.

JSV_ARCHIVE_SERVER_CONFIG This parameter is used to set the configuration file
for reports archive server. Input parameter value is
user defined.

JSV_ARCHIVE_SERVER_URL This parameter is used to specify the archive
server url. Input parameter value is user defined.

JSV_BI_PASSWORD This parameter is used to define the BI Publisher
Password

JSV_BI_USER This parameter is used to define the BI Publisher
User ID

JSV_TEMPORARY_DIRECTORY This parameter is used to define Oracle directory
object name for Job Service Temp file location

JSV_BI_PASSWORDJSV_REPORTS_RUNTIME This parameter is to specify the reports runtime
program. Input parameter value is user defined.

JSV_REPORTS_RUNTIME_CMDFILE This parameter is used to specify the reports
runtime command file. Input parameter value is
user defined.

JSV_REPORTS_SERVER_CONFIG This parameter is used to specify the configuration
file for reports server. Input parameter value is user
defined.

JSV_REPORTS_SERVER_URL This is used to specify the URL for the reports
server. Input parameter value is user defined.

JSV_REPORT_ARCHIVE_DIRECTORY This is used to specify the path and directory of
Reports archive, input parameter value being
numeric.

JSV_SMTP_SERVER This parameter specifies the SMTP server used by
job service for sending email messages. Input
parameter value is user defined.

JSV_TIMEOUT This is to specify the polling interval for the job
service during time out. Input parameter value is
numeric. To check whether it represents minutes/
seconds.

JSV_USE_BI_PUBLISHER This parameter defines whether BI publisher
should be used to process reports are not. Input
parameter value is Boolean (Yes/No).
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JSV_USE_REPORTS_SERVER This parameter is used to specify whether reports
server from job service should be used or not.
Input parameter value is Boolean (Yes/No).

LBX_TXN_GROUPING_CNT This parameter is used to specify the no. of records
per batch for payment transactions and lock box
batch records. Input parameter value is numeric.

LCO_COL_LETTER1_GEN_DAYS This parameter specifies the number of days post
which first collection letter should be generated for
accounts with dues unpaid. Input parameter value
is numeric.

LCO_COL_LETTER2_GEN_DAYS This parameter specifies the number of days post
which second collection letter should be generated
for accounts with dues unpaid. Input parameter
value is numeric.

LCO_COL_LETTER3_GEN_DAYS This parameter specifies the number of days post
which third collection letter should be generated for
accounts with dues unpaid. Input parameter value
is numeric.

LIEN_RELEASE_DAYS This parameter is used to define the Lien Release
Days

LOCKBOX_DIRECTORY This parameter is used to define the Oracle
directory object name for Lockbox file location

LOCKBOX_PROCESSED_DIRECTORY This parameter is used to define the Oracle
directory object name for processed Lockbox file
location

LOR_ADVERSE_ACTION_GEN_DAYS This parameter is used to specify the number of
days after the third collection letter post which the
adverse action letter is to be generated. Input
parameter value is numeric.

LOG_LOB_PURGE_DAYS This parameter is used to log files header table
purge days

MAX_AGED_TXN_AUTHORIZE_ DAYS This parameter is used to specify the maximum
number of days within which a transaction should
be authorized. Input parameter value is numeric
and represents the number of days.

MAX_VOID_TXN_AUTHORIZE_DAYS This parameter is used to set the maximum days to
authorize transaction

OCP_CUSTOMER_PMT_SITE_ID This parameter is used to set the customer
payment extract file site id

OCP_INCLUDE_ACH_ACC This parameter is used to set the customer
payment extract including ach accounts

OUTGOING_LOB_PURGE_DAYS This parameter is used to define the outgoing
process file table purge days

OUTPUT_DIRECTORY This parameter is used to define Oracle directory
object name for OUTPUT file location

PAC_ARCHIVE_DAYS This parameter is used to define number of days
for periodic archiving of account. Input parameter
value is numeric.

PAC_OARCHIVE_DAYS This parameter is used to define the number of
days for archiving accounts from O tables i.e. old
tables. Input parameter value is numeric
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PAP_ARCHIVE_DAYS This parameter is used to define the number of
days for archiving applications on a periodic basis.
Input parameter value is numeric.

PAP_OARCHIVE_DAYS This parameter is used to define the number of
days for archiving applications from O tables. Input
parameter value is numeric.

PCU_CHECK_REFUND_DAYS This parameter is used to specify the maximum
number of days within which an overpayment from
the customer can be refunded. Input parameter
value is numeric.

PDC_PRE_PROCESS_DAYS This parameter value will define the number of
days prior to the due day, regular account PDC
process should be initiated. Input parameter value
is numeric.

PENDING_PDC_DAYS This parameter value will define the number of
days before the initiation day for pending PDC
accounts.

PGL_ARCHIVE_DAYS This parameter defines the number of days, post
which the transactions in GL would be archived.
Input parameter value is numeric.

PGL_OARCHIVE_DAYS This parameter is used to define the number of
days, post which the transactions in GL will be
moved to the O tables. Input parameter value is
numeric.

PJR_PURGE_DAYS This parameter is used to specify the days post
which the job requests are to be purged. Input
parameter value is numeric.

POD_PURGE_DAYS This parameter is used to define the number of
days after which the Output data file headers are to
be purged. Input parameter value is numeric.

PPA_ARCHIVE_DAYS This parameter is used to specify number of days
after which pools and its transactions archiving is to
be done to O tables. Input parameter value is
numeric.

PPA_OARCHIVE_DAYS This parameter is used to specify number of days
after which pools and its transactions archiving is to
be done to OO tables. Input parameter value is
numeric

PPR_ARCHIVE_DAYS This is used to specify the days for archival of
producers details on a regular basis. Input
parameter value is numeric.

PPR_OARCHIVE_DAYS This is used to specify the days after which the
producers details from O tables need to be
archived. Input parameter value is numeric.

PPX_ARCHIVE_DAYS This is used to specify the days after which
producer transactions are to be archived. Input
parameter value is numeric.

PPX_OARCHIVE_DAYS This is used to specify the days after which the
producer transactions are to be moved from O
tables. Input parameter value is numeric.

PJR_COPY_PURGED_DATA This parameter is used to copy data into purge
tables.
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PST_ARCHIVE_DAYS This parameter specifies the number of days for
which the statements are to be archived. Input
parameter value is numeric.

PST_OARCHIVE_DAYS This parameter specifies the number of days for
which the statements are to be archived in the O
tables. Input parameter value is numeric.

PTT_PURGE_DAYS This is used to specify the number of days after
which the PTT table is to be purged. Input
parameter value is numeric.

PTX_ARCHIVE_DAYS This parameter is used to specify the number of
days the transactions are to be archived. Input
parameter value is numeric.

PTX_OARCHIVE_DAYS This parameter is used to specify the number of
days after which the archived transactions from O
tables are to be moved. Input parameter value is
numeric.

PUL_PURGE_DAYS This parameter is used to specify the number of
days post which the User login details are to be
purged. Input parameter value is numeric.

PVA_ARCHIVE_DAYS This parameter stores the number of days for
archival of regular vendor assignments. Input
parameter value is numeric.

PUP_ARCHIVE_DAYS This parameter stores the number of days for
archival of transaction upload. Input parameter
value is numeric.

PUP_OARCHIVE_DAYS This parameter is used to specify the number of
days after which the archived transactions from O
tables are to be moved. Input parameter value is
numeric.

PVA_OARCHIVE_DAYS This parameter value specifies the number of days
for archival of vendor assignments from O tables to
OO tables. Input parameter value is numeric.

PVI_ARCHIVE_DAYS This parameter is used to specify the number of
days for which the regular vendor invoices are to be
archived. Input parameter value is numeric.

PVI_OARCHIVE_DAYS This parameter is used to specify the number of
days post which the regular vendor invoices are to
be moved from O tables to OO tables. Input
parameter value is numeric.

RAC_LOAD_FREQUENCY This parameter is used to specify Accounts RDH
Load Frequency

RAP_LOAD_FREQUENCY This parameter is used to specify Applications RDH
Load Frequency

RAT_LOAD_FREQUENCY This parameter is used to specify Asset Tracking
RDH Load Frequency

RBK_LOAD_FREQUENCY This parameter is used to specify Bankruptcy
Details RDH Load Frequency

RCA_LOAD_FREQUENCY This parameter is used to specify Call Activities
RDH Load Frequency

RCH_LOAD_FREQUENCY This parameter is used to specify Deficiency
Details RDH Load Frequency
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RCO_LOAD_FREQUENCY This parameter is used to specify Contracts RDH
Load Frequency

RFO_LOAD_FREQUENCY This parameter is used to specify Repo-
Foreclosure RDH Load Frequency

RPR_LOAD_FREQUENCY This parameter is used to specify Producers Rdh
Load Frequency

RST_LOAD_FREQUENCY This parameter is used to specify Setup Data RDH
Load Frequency

RTX_LOAD_FREQUENCY This parameter is used to specify Txns RDH Load
Frequency

SALESAGENT_MAIL_SEND_IND This parameter is used to specify whether decision
fax needs to be sent to sales agent (yes/no)

SCORING_PARAMETER_ ALERT This parameter is used to set the scoring
parameter alert

SQL_DIRECTORY This parameter is used to set the Oracle directory
object name for SQL file location

TES_ANA_PRE_PROCESS_CYCLES This parameter is used to specify the pre-process
cycles required for Escrow analysis. Input
parameter value is numeric.

TES_DSB_ANALYSIS_PERCENT This parameter is used to specify the percentage
for escrow disbursements. Input parameter value is
numeric.

TES_DSB_PRE_PROCESS_DAYS This is used to specify the number of days for pre-
process for escrow disbursements. Input parameter
value is numeric.

TPE_AMORTIZE_ACCRUED_INT_ONLY This parameter is used to specify that system has
to amortize accrued interest at month end

TPE_APPLY_LTC_FROM_CURR_DUE_DT This parameter is used for pyramid law fee method
to apply late charge from current due date

TPE_ESC_ANALYSIS_ DELQ_AMT Parameter considers billed but uncollected amount
for escrow analysis

TPE_EXCESS_PAYMENT_TO_MEMO Excess payment on the account will be moved to
memo payment.

TPE_EXCLUDE_ESC_LTC This parameter defines whether escrow should be
included or excluded while calculating late charge.
Input parameter value is Boolean (Yes/No).

TPE_EXT_CYCLES_BACKDATED This parameter is used to define the maximum
extension cycles allowed for back dating. Input
parameter value is numeric with no upper limit

TPE_FUTURE_PAYOFF_DAYS The value specified in this parameter validates the
Valid Up to Date with Payoff quote during
monetary transactions posting.

TPE_GL_REFUND_ HOLD_DAYS This parameter is used to define the number of
days the non-refunded amount can be held in GL.
Input parameter value is numeric.
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TPE_MAX_CYCLES_BACKDATED This parameter is used to define the maximum
cycles that are allowed for backdating an account
in OFSLL. Only when a status change transaction
is reversed, account backdate field is set based on
this parameter. The input parameter value is
numeric.

TPE_MIN_1098_INT_AMT_PAID This parameter is used to specify the lower limit or
minimum interest amount paid for 1098 i.e.
Mortgage Interest Statement. In the US, FIs need
to report mortgage interest of $600 or more
received from individuals, during the course of their
business. Input parameter value is 600, the
minimum value above which reporting by FI is
required in form 1098 for each mortgage account.

TPE_OLDEST_DUE_DT_NEW_MTHD This parameter is enabled to specify whether new
method for calculation of oldest due date based on
given data should be used or not. Input parameter
value is Boolean (Yes/No).

TPE_PAID_TO_CLOSE_DAYS This parameter is used to specify the number of
days allowed post which a paid account would be
closed. Input parameter value is numeric.

TPE_PAYMENT_TO_MULTI_ACCOUNTS This parameter is enabled to allow one payment for
dues in multiple accounts. Input parameter value is
Boolean (Yes/ No).

TPE_PAYOFF_VALID_THRU_DAYS This parameter is used to specify the number days
the pay-off quote is valid by default. i.e. if the
parameter is set as 7, the payoff quote is valid for 7
days and customer can pay the quoted amount as
final closure amount within those days. Input
parameter value is numeric.

TPE_PMT_POST_EOD This parameter is used to allow payments when the
batch process for End of Day is running. Input
parameter value is Boolean (Yes/No). If this is set
to Y, payments can be allowed during EOD.

TPE_SCHGOFF_DLQ_DAYS This parameter is used to define the number of
delinquent days to treat an account for SCHGOFF
(charge – off). Input parameter value is numeric.
(To verify)

TPE_SCHGOFF_REVIEW_DAYS This parameter is used to define the number of
days allowed for review of SCHGOFF accounts.
Input parameter value is numeric.

TPE_SCRA_DEFAULT_INTEREST_RATE This parameter is used to define the default interest
rate that is to be applied for customers who are in
military duty. OFSLL will apply the lower of the
prevailing interest rate or SCRA default interest rate
specified through this parameter. Input parameter
value is numeric (in this case 6, which is interest
rate to be applied for SCRA accounts.

TPE_SHOW_BACKDATE_WARNING This parameter is used to define whether a warning
message is to be shown if monetary transaction is
backdated.
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TPE_STM_INC_ALL_TXNS This parameter is enabled to define whether all
transactions should be included in the statements
or otherwise. Input parameter value is Boolean
(Yes/No).

TPE_STOP_COMP_DELQ _DAYS This parameter is used to stop computation when
delq days > 60

TPE_TXN_POST_DEFAULT_GLDATE This parameter is used to default GL date in date
type parameters during txn posting (y/n)

TPE_VOID_TO_CLOSE_DAYS This parameter is used to define the number of
days allowed for closing Void accounts. Input
parameter value is numeric.

UIX_DEFAULT_IMAGE_PATH This parameter is used to define the default image
directory maintained for the purpose of online
attachment of document images to an application
using documents maintenance section under
Account documentation. Input parameter value is
user defined.

UIX_DIRECT_LOAN_COMBO_ULN_UFN This parameter when set to yes allows underwriting
and funding to be carried on by a single
responsibility for direct loans only. Input parameter
value is Boolean (Yes/No).

UIX_INCOMING_FILE_PATH This parameter is used to specify incoming file path
of app server

UIX_LOCAL_COUNTRY_CD Through this parameter we can set the local
country where an FI has multiple branches across
different geographies. Input parameter value is user
defined.

UIX_LOCK_UNLOCK_AND_COPY This parameter is used to enable the user interface
lock / unlock and copy features. Input parameter
value is Boolean (Yes/No).

UIX_MAX_ACC_SEARCH_ROWS This parameter is used to specify the maximum
number of account rows to be returned for search
functionality. Input parameter value is numeric.

UIX_MAX_APP_SEARCH_ROWS This parameter is used to specify the maximum
number of application rows to be returned for
search functionality. Input parameter value is
numeric.

UIX_OUTGOING_FILE_PATH This parameter is used to specify outgoing file path
of app server

UIX_REPORTS_SERVER_CONFIG This parameter can be used to specify the user
interface reports server configuration file. This is
not required for OFSLL.

UIX_REPORTS_SERVER_URL This parameter sets the URL for Reports server.
Input parameter value is user defined.

UIX_SHOW_LN_VARIABLE_RATE_TABS This parameter can be used to show loan variable
rate tabs. Input parameter value is Boolean (Yes/
No). This is not required for OFSLL.

UIX_UTILITIES_SERVLET_URL This parameter can be used to specify the User
Interface utilities servlets URL. This is not required
for OFSLL.
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UPR_PRO_NBR_SYS_GENERATED This parameter can be used to specify whether
producer number should be system generated or
seek input from user. Input parameter value is
Boolean (Yes/No). Generally this is set to yes for
system generation.

VEV_NADA_TOKEN_URL This parameter is used to set the token URL for
vehicle evaluation interface NADA. Input parameter
value is user defined.

VEV_NADA_UPDATE_DAY This parameter is used to specify the day of the
month to update the vehicle evaluations every
month. Input parameter value is numeric.

VEV_NADA_URL This parameter is used to set the URL for vehicle
evaluation interface NADA. Input parameter value
is user defined.

VEV_NADA_USER_ID This parameter is used to specify the User id for
login to the NADA interface. Input parameter value
is user defined.

VEV_NADA_USER_PASSWORD This parameter is used to specify the password for
login to the NADA interface. Input parameter value
is user defined.

VEV_VALUATION_REGION This parameter is used to define the default region
for vehicle evaluation. Input parameter value is the
region name, and is user defined.
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VEV_VALUATION_SOURCE_CD This parameter is used to specify the default
vehicle evaluation source code. Input parameter
value is user defined. A number of parameters are
possible in OFSLL as below:

1. Appraisal Company

2. Broker

3. BUC GUIDE

4. DATA QUICK

5. NAMS/SAMS SURVEY – USED

6. REALTOR

7. NADA INTERFACE USED CARS

8. BLACKBOOK INTERFACE USED CARS

9. KELLY INTERFACE

10. NADA – NEW

11. NADA – USED

12. KELLY NEW BLUE BOOK

13. KELLY USED BLUE BOOK

14. INVOICE

15. BLACK BOOK

16. NADA INTERFACE COMMERCIAL TRUCKS

17. COMPANY INVOICE

18. GOLD BOOK

19. GALVS

20. OTHER

21. ALG

WFP_DIRECTORY This parameter is used to specify the Oracle
directory object name for WFP file location.

WFP_MAX_CYCLES_BACKDT This parameter is used to specify the back dated
cycles date for WFP.

WFP_PROCESSED_DIRECTORY This parameter is used to define oracle directory
object name for wfp file location.

WFP_REVERSE_TXN_IND This parameter is enabled to define the WFP
reversal indicator. Input parameter value is Boolean
(Yes/No).

XAE_DEALUPD_MAX_ALLOWED_DAYS This parameter is used to define the max allowed
days for Deal Update.

XAE_DEALUPD_ALLOWED_IND This parameter is used to indicate whether deal
update is allowed or not.

OUTBOUND_CALL_Q This parameter is used to generate reports
(including emailing statements/letters) using
Application Server instead of Database server.
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ACA_PRE_PROCESS_DAYS_FIRST This parameter is used to configure the number of
days before the debit day for ACH process in first
time/ one-time case.

IPR_PROCESSED_DIRECTORY This parameter is used to define the Oracle
directory object name for processed IPR file
location

IPR_DIRECTORY This parameter is used to define the Oracle
directory object name for IPR file location

UIX_PWD_MGMT_EXTERNAL_URL This parameter is used to set external password
management url, if applicable.

UIX_PWD_MGMT_EXTERNAL This parameter is used to define the parameter if
password management is external. (SET Y IF
PASSWORD MANAGEMENT IS EXTERNAL (Y/
N)).

ICU_PROCESSED_DIRECTORY This parameter is used to define the Oracle
directory object name for processed ICU file
location

ICU_DIRECTORY This parameter is used to define the Oracle
directory object name for ICU file location

UIX_BILL_CYCLE_ALLOWED_IND This parameter is used to indicate whether Billing
cycle is allowed at the application level

CMN_EOD_SLEEP_MINS This parameter is used to set in minutes the EOD
sleep time

CMN_CORE_BANK_TXN_CD This parameter is used to set code for OFSLL and
Core Banking integration

UIX_DIRECT_DISB_MANUAL_SELECT This parameter will allow manual selection of
disbursement mode for direct loans

ICC_DLQ_AMT_EXCLUDED This parameter enabling will exclude delinquency
amount for CASA account

CMN_CORE_BANK_IND This parameter is used to set whether OFSLL can
integrate with Core Banking.

BKRP_FILE_REC_LIMIT This parameter is used to set the limit of total
number of records allowed to be added in the Input
Data File shared from external interface.

Note: If the number of records exceeds the set
limit, multiple Input Data Files are to be created.

UVN_VEN_NBR_SYS_GENERATED This parameter is used to validate if Vendor
Number has to be auto generated (if set to Y) or to
be specified manually in the Vendor details screen.

METRO_WITHOUT_COLL_IND This parameter indicates whether Metro II reporting
is handled without OFSLL Collections module
being used. If the parameter value is set as Y i.e.
collection module is not used, system updates the
collateral status directly as part of REPO call
activity.

However when Collections module is being used,
the Collateral status is tracked with the
repossession details updated in Repo/Foreclosure
screen of Collections module.
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METROII_FIRST_DELQ_DT_ADD_DAY This parameter is used to calculate the first
delinquency date that needs to be reported in the
Metro II reporting file.

By default the parameter is disabled indicating that
the initial delinquency date calculated by the
system is used for Metro II reporting. The same
needs to be enabled to add the parametrized
number of days to the system calculated first
delinquency date for the Metro II reporting purpose.

DAYS_TO_PULL_CRB_ REPORT This parameter is used to configure the number of
days permitted to pull a Bureau report from the
same company and for the same customer.

XWS_ACS_RESP_MULTI_RECORD_IND This parameter is used to indicate if multiple
records exist in the response file received for
account search.

Accordingly, when there are multiple records found
and this parameter is enabled and set to No
(default), system displays an error message Too
Many Records Found. Please Refine Search by
Adding One More Parameter.

However, when this parameter is set to Yes,
system only indicates that there are multiple
records/rows in response file.

GRI_DLQ_DAYS_AUTO_STATUS_CHG This parameter is used to define the delinquency
days which inturn is used to automatically update
the status of a work order to PENDING ON HOLD
status.

TPE_PMT_POSTING_CLS_ACCOUNT This parameter is used to define the payment
posting criteria for Closed - Paid Off/ Charged-off
accounts.

Accordingly, OFSLL accepts payment posting on
closed accounts only when the parameter is set to
Y and all the payments received through Payment
Entry screen or Payment Upload file are posted to
a Suspense account.

TPE_BACKDT_PMT_ POSTING This parameter is used to define the payment
posting criteria for backdated payments for the
following type of account conditions:
• Paid off
• Charged-off
• Account under activation
• Account under conversion
• Non-performing Account
• PC2 SI (Pre-computed to Simple Interest)

Reschedule

Accordingly, OFSLL accepts backdated payment
posting only when the parameter is set to Y and all
the payments received through Payment Entry
screen or Payment Upload file are posted to a
Suspense account.
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EXP_PA_SOFT_PULL_IND This parameter when enabled allows Soft Pull
Credit Bureau request, specifically for Experian
Premier Attribute Consumer Report without
impacting the consumer FICO score.

PMT_BATCH_POSTING This parameter (PAYMENT BATCH POSTING
PREFERENCE) is used to define the status of
payment transactions which are uploaded in bulk
through a batch process.

POOL_ACTIVE_ACCOUNTS_ONLY This parameter controls the type of accounts that
can be added to a Securitization Pool and allows
adding only Active status accounts since the same
is enabled (value set to Y) by default. To add
accounts with other status such as Active, Paid Off,
Charged Off, Void, Terminate. and so on, set the
value of system parameter to N.

AUTO_GEN_ACC_NBR_CONV This parameter is used for conversion accounts to
decide option of account number generation. If the
value of parameter is set to Y the account number
is automatically generated in OFSLL during
conversion and if the value is N, then external
reference number (generated in third party system)
itself is appended as the account number.

OUTBOUND_DLR_ TRACK_Q This parameter defines the settings for batch job
SET_XPR to either use MDB (Message Driven
Bean) flow (if value set to Y) or existing work flow
(if value set to N) to dump producer details
maintained in the system into Dealer Track.

MDB flow generates outbound JMS message
though the configured MDB interface and can avoid
current database outbound calls and session
timeout.

In the existing workflow, the database makes
synchronous outbound calls to producer data dump
web service, to dump the data and acknowledge
the database with the status (success or failure).

OUTBOUND_ROUTEONE_Q This parameter defines the settings for batch job
SET_XPR to either use MDB (Message Driven
Bean) flow (if value set to Y) or existing work flow
(if value set to N) to dump producer details
maintained in the system into ROUTEONE.

MDB flow generates outbound JMS message
though the configured MDB interface and can avoid
current database outbound calls and session
timeout.

In the existing workflow, the database makes
synchronous outbound calls to producer data dump
web service, to dump the data and acknowledge
the database with the status (success or failure).
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Table A-1    (Cont.) System Parameters

Parameter Description

GRI_WEBSERVICE_LOG_IND This parameter is used to decide on logging GRI
(Generic Recovery Interface) communications. If
enabled, system logs all the GRI related web
service communications between OFSLL and
external interfaced system.

The recorded logs can be viewed in Dashboard >
System Monitor > Database Server Log Files tab
by selecting Interfaces view option.

PVE_ARCHIVE_DAYS This parameter stores the number of days for
archival of regular vendors. Input parameter value
is numeric.

PVE_OARCHIVE_DAYS This parameter is used to specify the number of
days post which the regular vendors are to be
moved from O tables to OO tables. Input parameter
value is numeric.

LBX_DR_CR_VALIDATE_AMT_IND This parameter (VALIDATE LOCKBOX DR/CR
BATCH TOTALS) is used to facilitate NACHA file
validation. Based on the status of the parameter,
system is either allowed to validate the file or
process without validation.

PAP_PURGE_DAYS This parameter allows to define the number of days
after which the application data from archival
folders are to be deleted permanently. Purging
happens based on elapsed number of days i.e. if
value is set to 60 days, only those records which
are older by 60 days in archival folder are deleted.

PAC_PURGE_DAYS This parameter allows to define the number of days
after which the accounts data from archival folders
are to be deleted permanently. Purging happens
based on elapsed number of days i.e. if value is set
to 60 days, only those records which are older by
60 days in archival folder are deleted.

CMN_SED_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the incoming or outgoing seed data is to be
processed. If set to Y, system processes the data
to/from LOB and if set to N, system processes the
data to/from FILE.

CMN_EDF_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the incoming or outgoing data from Dialer
Interface is to be processed. If set to Y, system
processes the data to/from LOB and if set to N,
system processes the data to/from FILE.

The same is used by the batch jobs
EDFADR_BJ_100_01 and EDFIVR_BJ_100_01
which are available in SET-EDF Batch Job Set.

CMN_FAX_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the incoming or outgoing Fax data is to be
processed. If set to Y, system processes the data
to/from LOB and if set to N, system processes the
data to/from FILE.
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Table A-1    (Cont.) System Parameters

Parameter Description

CMN_RED_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the outgoing details of Data Masking Policy
(i.e. Redaction policy output file) is to be
processed. If set to Y, system processes the data
from LOB and if set to N, system processes the
data from FILE.

CMN_WFP_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the incoming or outgoing WFP Unit details
are to be processed. If set to Y, system processes
the data to/from LOB and if set to N, system
processes the data to/from FILE.

The same is used by the batch job
WUPPRC_BJ_132_01 available in SET-WFP Batch
Job Set.

CMN_AUD_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the outgoing Audit scripts are to be
processed. If set to Y, system processes the data
from LOB and if set to N, system processes the
data from FILE.

CMN_LBT_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the incoming or outgoing Lockbox files are to
be processed. If set to Y, system processes the
data to/from LOB and if set to N, system processes
the data to/from FILE.

The same is used by the batch jobs
LBXPRC_BJ_100_01 and LBXSEP_BJ_100_01
available in SET-LBT Batch Job Set.

CMN_ODD_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the outgoing ODD or Output Data Dump
files are to be processed. If set to Y, system
processes the data from LOB and if set to N,
system processes the data from FILE.

The same is used by the batch job
ODDPRC_BJ_000_01 available in SET-ODD3
Batch Job Set.

CMN_ALERT_DEBUG_ METHOD This parameter allows to define the location to
which Alert and Warning logs are to be written. If
set to ADVANCE_QUEUE, system writes the logs
in Logs table and if set to UTL_FILE, system
generates the alert log file.

CMN_GRI_WS_DEBUG_ METHOD This parameter allows to define the location to
which GRI (Generic Recovery Interface) web
service logs are to be written. If set to
ADVANCE_QUEUE, system writes the logs in
Logs table and if set to UTL_FILE, system
generates the log file.
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Table A-1    (Cont.) System Parameters

Parameter Description

UIX_CUSTOMER_ BASED_PMT_IND If this parameter is set to Y and is Enabled, system
accepts posting direct payment to an account and
also accepts customer based payments to all linked
accounts.

To facilitate customer based payments, Customer/
Business # and Payment Hierarchy fields along
with Populate Accounts button are enabled in
Payment Entry screen to specify required values.

PMT_HIERARCHY_CODE In this parameter, you can specify a payment
hierarchy which is populated by default in Customer
Details and Business Details (if applicable) screen
after account activation.

However, the specified value is selected by default
only if there is a matching hierarchy definition
enabled record maintained in Setup >
Administration > User > Payment Hierarchy screen.
Else, Equal Amount value is selected which in-
turn adjusts the payment equally to all customer/
business linked accounts.

Note: System does not consider this parameter
value while creating account using existing
customer/business details since the default
selection is done during the creation of existing
customer / business account.

EVI_MAX_RETRY_COUNT This parameter records and controls the maximum
attempts to re-trigger FAILED Webhook requests
which cannot exceed more than 5 times. However,
this parameter can be modified if the maximum re-
trigger attempts is to be less than 5 times.

UIX_CUSTOM_LABEL_ENABLED_IND This parameter indicates if the field label
customizations are allowed i.e. ability to change
label and provide access to fields in Label
Configuration and Security User Access Definition
Details screens.

If set to Y, system refers data from database

If set to N, system refers data from XLIB file.

UIX_MASTER_ACC_BASED_PMT_IND If this parameter is set to Y and is Enabled, system
accepts posting direct payment to a master
account and also accepts master account based
payments to all linked accounts.

To facilitate master account based payments,
Master Account # field is enabled in Payment
Entry screen.

TPE_PMT_REFUND_CURRENCY_SRC_CD This parameter indicates the currency in which
payment refund has to be processed in the system
as either Payment Currency or Account
Currency. The same is considered during payment
refund operation in Payment Maintenance screen.
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Table A-1    (Cont.) System Parameters

Parameter Description

AUTO_GEN_ACTIVE_TXN_CONV This parameter if enabled, auto posts a dummy
ACTIVE transaction on all migrated accounts
during the schedule batch job run. This in-turn
allows to post RESCISSION / VOID transaction
specifically for migrated accounts by selecting the
dummy transaction from Customer Service >
Maintenance screen or Transaction History
transactions tab,

For more information, refer Voiding an Account
section Servicing user guides.

FLL_CMN_JET_JWT_ENABLED_IND

(JET JWT TOKEN ENABLE INDICATOR)

This parameter if set to Y, enables the Account
Dashboard screen in Servicing LHS menu. This
screen is based on Oracle JET framework and
facilitates to view Account summary details
maintained in the system. For information on
screen functionality, refer to Servicing User
Manuals and for details on deployment and
configuration, refer to Installation Manuals.

FLL_CMN_JET_JWT_TOKEN_URL

(JET JWT TOKEN GENERATION URL)

Define the value of the O-JET URL (app-shell
application URL) in the format https://
<hostname>:<port no>/ofsll-appshell/< token>

FLL_SER_JET_ACC_CREATE_URL

(JET SIMPLE ACCOUNT CREATE URL)

Define the value of the O-JET URL (app-shell
application URL) in the format https://
<hostname>:<port no>/ofsll-appshell?
root=accountonboarding

FLL_SER_JET_ACC_DASHBOARD_URL

(JET ACCOUNT DASHBOARD URL)

Define the value of the O-JET URL (app-shell
application URL) in the format https://
<hostname>:<port no>/ofsll-appshell?
root=accountdetailsdashboard

FLL_SET_JET_INTELLIGENTSEG_URL

(JET INTELLIGENT SEGMENTATION URL)

Define the value of the O-JET URL (app-shell
application URL) in the format https://
<hostname>:<port no>/ofsll-appshell?
root=queuecreation

ACCOUNT_PROCESSING_THRESHOLD

(ACCOUNT ON-BOARDING ASYNCHRONOUS
PROCESSING THRESHOLD)

This parameter allows to restrict the number of
accounts that can be created synchronously
using Account onboarding WebService.

However, creating accounts asynchronously in the
system is further processed by the below batch
jobs based on valued defined in this parameter.

SET-API2 (ASYNCHRONOUS ACCOUNT
CREATION)
• ACXVAL_BJ_100_01 (VALIDATE IAPP TABS)
• ACXAAI_BJ_100_01 (ASYNCHRONOUS

ACCOUNT CREATION)

VTX_OUTBOUND_URL (OUTBOUND CALL URL
FOR VERTEX)

This parameter defines the URL of the external
adapter (Vertex) that is used to integrate with
OFSLL.

VTX_VERSION (VERTEX VERSION) This parameter defines the version of Vertex
adapter that is required to be configured by the
system.
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Parameter Description

AUTO_GEN_AGREEMENT_NBR (AUTO
GENERATE AGREEMENT NUMBER FOR
ACCOUNT ONBOARDING)

This parameter defines the mode by which
agreement number is generated to an account. If
set to Y, system generates the agreement number.
If set to N, system accepts the external agreement
number provided in Account on-boarding payload.

Note: When system parameter is set to Y, the
agreement number is also used as an identifier to
validate the contract details and decide on which
accounts should get same Agreement number.

A.3 Organization Parameters
Organization parameters control the functions related to User login, password expirations,
responsibilities and accessibility limits in the OFSLL system. Individual parameters can be
created with different values for uniquely defined organizations, divisions, and responsibility
combinations.

There are three more dimensions other than parameter name, description and enabling
(similar to system parameters) as indicated below:

1. Organization

2. Division

3. Responsibility

These dimensions help to define the applicability of the responsibility for specific User in an
Organization across selected Divisions/departments.

When determining which parameter to use, OFSLL system selects the best match based on a
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL
being a lower order match than an exact match.

While the system allows for Organization parameters to be defined at all three hierarchical
levels (organization, division, and responsibility), not all will be applicable to each parameter.

Table A-2    Organization Parameters

Parameter Description

MAX_PASSWORD_HISTORY_CHECK This is used to set limit for number of times a
password has been repeated during password
change. This can be set for specific branches of the
Organization, Divisions and Users based on
responsibilities. Numeric value to be input to
specify the limit.

UCS_GROUP_FOLLOWUP_DAYS This parameter is used to set up the number of
days range for Group follow-up field in customer
service screen which displays the set of accounts
that share same account condition as the selected
account and bear the same customer ID. The pre-
requisite for this is Group Follow-up indicator
should be enabled in queue setup. Input value is
numeric.
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Parameter Description

UCS_REVIEW_QUEUE_ALLOWED This is used to specify whether review can be done
by the specific responsibility (user group) without
entering details in call activities/activities.
Parameter value to be input is Boolean (Yes/No).

UIX_APP_VIEW_ALL_APPS The system uses this parameter to determine
which users have the ability to view all applications.
The system selects the best match based on a
hierarchical sort by Organization, Division and
Responsibility fields, with values of ALL being a
lower order match than an exact match. Input
parameter value is Boolean (Yes/No).

UIX_HIDE_RESTRICTED_DATA This is used to hide sensitive data relating to the
Contract / Applicant to a specific group/
responsibility etc. Suppose there is a need to hide
data relating to SSN, Bank account details etc. to a
specific user responsibility who will not need such
data, this parameter can be enabled with input
value Boolean (Yes/No). If this parameter is set to
Y, the details appear in a masked format (for e.g.
SSN – XXXXX- 456)

UIX_SMTP_SERVER This parameter is used to set up the email server
for user interface. The input value would be SETME
and check the Enable flag.

UIX_VIEW_SECURED_ACCOUNTS This is used to specify whether an account can be
viewed by a specific responsibility (users).
Parameter value is Boolean (Yes/No) and when
flagged as Yes, such accounts would be viewable
only by users defined in the Organization, Division
hierarchy with the specified responsibilities. For
example, all employee accounts may not be
viewable by all users and should be made available
only to the HR department with specific
responsibility levels.

Note: While creating application, selecting
appropriate applicant’s classification would be
essential for this parameter to be effective.

UIX_VIEW_SECURED_APPLICATION This is used to specify whether an application can
be viewed by a specific responsibility (users).
Parameter value is Boolean (Yes/No) and when
flagged as Yes, such applications would be
viewable only by users defined in the Organization,
Division hierarchy with the specified
responsibilities. For example, all employee
accounts may not be viewable by all users and
should be made available only to the HR
department with specific responsibility levels.

Note: While creating application, selecting
appropriate applicant’s classification would be
essential for this parameter to be effective.

ULG_DAY_END This is used to specify the upper limit time in day
for a user to be able to work in the System.
Parameter value is numeric and range is 1-24, else
system will throw error.
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Parameter Description

ULG_DAY_START This is used to specify the lower limit time in day for
a user to be able to work in the System. Parameter
value is numeric and range is 0-24, else system will
throw error.

ULG_FAILED_LOGIN_TRIALS_MAX This parameter is used to specify the maximum
number of login trials allowed before disabling the
User ID due to security reasons. Input parameter
value is numeric with upper limit of 999999999999.

ULG_INACTIVITY_DAYS_MAX This parameter is used to specify the maximum
number of days the User ID can be without
utilization before disabling the User ID due to
security reasons. Within the specified number of
days the User Id must be utilized for sign in at least
once. Input parameter value is numeric with upper
limit of 999999999999.

ULG_PWD_CASE_SENSITIVE_REQ This is used to allow all passwords to be case
sensitive or otherwise. Input parameter value is
Boolean (Yes/No). When this parameter is set as
NO, password would be stored in Upper case. If
this parameter is set to N then the
ULG_PWD_LOWER_CHAR_REQ parameter
should also be set to N.

ULG_PWD_CHANGE_DAYS_ACTUAL This is used to set the maximum number of days
after which system will force a password change, in
cases where the User has not changed the
password. Input parameter value is numeric with
upper limit of 999999999999.

ULG_PWD_CHANGE_DAYS_PROMPT This is used to set the maximum number of days
after which system will prompt the User for
password change, in cases where password has
not been changed within the set period. Input
parameter value is numeric.

ULG_PWD_LENGTH_MIN This is used to set the minimum length of password
string that is required. If this criterion is not met,
system would throw an alert specifying minimum
character length required to be input.

ULG_PWD_LOWER_CHAR_REQ This is used to allow at least one lower case
character in password strings. Input value is
Boolean (Yes/No). Setting this as NO would mean
passwords would be allowed in uppercase only.

ULG_PWD_NBR_REQ This parameter allows setting password with at
least one numeric character. Input value is Boolean
(Yes/No) and setting this as YES would require
passwords to have at least one numeric character.

ULG_PWD_SPECIAL_CHAR_REQ This parameter is used to allow special characters
like ‘$’, ‘#’, ‘@’, in passwords. Input value is
Boolean (Yes/No) and setting this as YES would
require passwords to have at least one special
character.

ULG_PWD_UPPER_CHAR_REQ This is used to allow at least one upper case
character in password strings. Input value is
Boolean (Yes/No). Setting this as NO would mean
passwords would be allowed in lowercase only.
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Parameter Description

ULG_WEEK_END This parameter enables to set the last day of the
week when a user can have access to the system.
Input parameter value is numeric ranging from 1 to
7. This is useful in business requirements where
the Organization does not need a specific set of
responsibilities (users) to not access the system on
a weekend / week-off day etc.

ULG_WEEK_START This parameter is used to set the start day of the
week when a user is allowed to access the system.
Input parameter value is numeric.

CRB_ERROR_VALIDATION_IND This parameter is used to validate the Credit
Bureau report generation request depending on the
number of days permitted to pull a Bureau report
from the same company and for the same
customer and report as either warning/error.

When the number of days is less than or equal to
the permitted days (as defined in parameter
DAYS_TO_PULL_CRB_REPORT), system
displays an Error message stating Bureau Report
exists for the same Customer from the same
Bureau for Account# XYZ along with list of
account number(s) and/or application number( s). If
not, a Warning message is display and request is
accepted for processing.

Note: Both CRB_ERROR_VALIDATION_IND and
DAYS_TO_PULL_CRB_REPORT are to be
enabled for Credit Bureau report processing.

OCP_CUST_PMT_PREF This parameter MASTER ACCOUNT ROLLUP
FOR PMT EXTRACT FILE is used to decide the
basis of dues consolidation at master account level
based on the parameter values selected. For more
information, refer to Outbound Customer
Extracts To Payment Agencies Batch section.

A.4 Company Parameters
Company parameters control the processes associated with functions that vary for different
companies and branches. These parameters address credit scoring, credit bureau interfaces,
fax services, and fax generation.

Individual parameters may be set up with different values for uniquely defined company and
branch combinations (i.e. these can be defined to the level of branches in each company or a
group of companies in terms of applicability).
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Parameter Description

AUD_ADV_REASON_MODEL This parameter is used to set-up default adverse
action reasons for scoring models during set-up in
the Parameters sub page. Whenever the flag
Bureau Score Reasons is unchecked during
credit bureau scoring model set-up, then
automatically rejected applications scored using
this scoring model picks up the Adverse Action
Reasons from the Parameters sub page.

AUD_SCORING_METHOD This parameter is used to set when/where the
application scoring method has to be applied within
the company. So when the parameter value is
chosen as primary applicant only, the system will
perform the application scoring for the primary
applicant only and according to other applicable
parameters specified. Other parameter input values
are Minimum Score, Maximum Score, Minimum
Tier (Grade), Maximum Tier (Grade).

AUD_SCORING_METHOD_IN_BUREAU This parameter is used to define what value to be
picked up for application scoring from the scores
returned from the various bureaus. The input
parameter values are Maximum Score and
Minimum Score. If Maximum score is setup in
company parameters, then for all applications
where a bureau report is pulled, the system will
pick-up the Maximum score from the different
bureaus.

CBU_DATA_SET_SIZE Parameter to define the metro 2 file data selection
criteria, option values are monthly, Daily, weekly,
semi monthly.

CBU_FILE_FORMAT Metro 2 file format definition, user need to select
from the parameter value drop down.

CMN_ASE_VALIDATE_MAKE_MODEL This parameter is set up to specify to the system
whether it needs to validate the asset make and
model at the time of data entry. In parameter value
is Boolean (Yes/No).

CMN_CMB_DEFAULT_PRINTER This is used to define the default printer for printing.
The input parameter value is the printer name.
There is no LOV for this field. If no default printer is
defined and the parameter enabled, the system
would display Undefined.

CMN_WEEKLY_NONBUSINESS_DAYS This parameter is used to set-up the weekly
holidays at the company level. The input parameter
value is character string; if no details specified and
parameter is enabled, system would display
UNDEFINED.

COR_STORAGE_DIRECTORY This parameter is used to specify the path/location
for Oracle directory object template for
correspondence documents. Input parameter value
is SETME; if none is specified and parameter
enabled, UNDEFINED.
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Parameter Description

DBR_JOINT_INC_DEBT_WITH_2NDRY This parameter defines whether system should
consider income and debt details of the Spouse
and Secondary Applicant along with that Primary
Applicant. Input parameter value is Boolean (Yes/
No).

DBR_JOINT_INC_DEBT_WITH_SPOUSE This parameter is used to define whether system
should consider the income and debt details of
Spouse alone along with that of Primary applicant
details. Input parameter value is Boolean (Yes/No).

DDP_CRB_EXPIRATION_DAYS This parameter is used to define the credit bureau
report expiration days. So if this is set as 30,
system will use all available credit bureau reports
pulled which are not older than 30 days from
current day, during de-dupe. Input value is numeric
with no upper limit.

DDP_DEDUP_ DEBT_WITH_2NDRY This parameter defines whether the system should
dedupe credit bureau liabilities for Spouse and
Secondary Applicants, in addition to de-duping
Primary applicant’s liabilities. Input parameter value
is Boolean (Yes/No).

DDP_DEDUP_ DEBT_WITH_SPOUSE This parameter defines whether the system should
dedupe credit bureau liabilities for Spouse, in
addition to deduping Primary applicant’s liabilities.
Input parameter value is Boolean (Yes/No).

DOT_STORAGE_DIRECTORY This parameter is used to define the location/path
of the Oracle Directory Object name for Account
Document Loading. Input parameter value is
SETME.

ECB_EDIT_FAIL_ANY_APL This parameter is used to set the credit bureau edit
to fail in case the bureau report for any of the
applicant fails. Input parameter value is Boolean
(Yes/No). So if this parameter is set to YES, the
edit will fail even if one of the applicant’s bureau
score fails to qualify.

ECB_USE_APL_CURRENT_SCORE_CRH This parameter is used to define whether the
system should run the credit bureau edits only on
the current scored applicant bureau. Input
parameter value is Boolean (Yes/No).

LOR_AUTOMATIC_CON_FUND_FAX This is used to define the decision fax generation
when an application is funded. The input parameter
value is Boolean (Yes/No), and when this is set as
YES, system automatically generates the fax
approval in the predefined template whenever an
application is approved.

LOG_STORAGE_DIRECTORY This parameter is used to define the Oracle storage
directory. Input parameter value is user (System
Administrator) defined.

LOR_AUTOMATIC_APPROVAL_FAX This is used to define the decision fax generation
when an application is approved. The input
parameter value is Boolean (Yes/No), and when
this is set as YES, system automatically generates
the fax approval in the predefined template
whenever an application is approved.
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Parameter Description

LOR_AUTOMATIC_REJECTION_FAX This is used to define the decision fax generation
when an application is rejected. The input
parameter value is Boolean (Yes/No), and when
this is set as YES, system automatically generates
the rejection fax in the pre-defined template
whenever an application is declined.

MAX_LEAD_DAY_AGE This parameter is used to define the maximum no.
of days, post which the sales lead would be
considered cold. Input parameter value is numeric
with no upper limit.

MULTI_OFFER Through this parameter the multiple offers (sub-tab)
in pricing can be enabled or disabled for a
Company/Branch. Input parameter value is
Boolean (Yes/No). If the flag is set as Y, the
underwriter can view multiple offers and select one
of them to be applied for the specific application.

MULTI_OFFER_MAX_NUMBER This parameter is used to specify the maximum
number of multiple offers that can be permitted for
an application. Input parameter value is numeric
with no upper limit. If MULTI_OFFER company
parameter is set as N, this parameter can be
ignored as there is no use specifying a value.

MULTI_OFFER_MAX_TERM This company parameter sets the maximum term
(as in no. of instalments, whichever billing cycle is
selected) for which multiple offers are calculated
and displayed during pricing. Input parameter value
is numeric.

MULTI_OFFER_ MIN_TERM This company parameter sets the minimum term
(as in no. of instalments, whichever billing cycle is
selected) for which multiple offers are calculated
and displayed during pricing. Input parameter value
is numeric.

MULTI_OFFER_PMT_TOLERANCE For Multi offer variance in payment is defined in this
parameter.

MULTI_OFFER_TERM_VAR For multi offer Term variance will be defined in the
parameter.

PRESENT_VALUE_COMPUTE_RATE This parameter will perform Present Value
Computation Rate (Inflation/Discounting Rate).

RATE_CHG_LTR_PRE_PROCESS_DAYS This parameter is used to set up the number of
days prior to rate change effective date to generate
rate change letters in order to provide advance
intimation to customers. Input parameter value is
numeric with no upper limit.

STM_GEN_AFTER_MATURITY_IND This parameter is used to enable the statement
generation for an account after the maturity date
but Account remains unpaid. Input parameter value
is Boolean (Yes/No). If this is set to Y, statements
will get generated for accounts that remain unpaid
even after maturity.

UIX_RUN_AAI_ACT This parameter is used by the system to determine
whether to create and activate an account online.
Input parameter value is Boolean (Yes/No).
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Table A-3    (Cont.) Company Parameters

Parameter Description

UIX_UCS_CAC_MAX_FOLLOWUP_DAYS This parameter is used to set up the maximum
number of days for follow up when the account is in
delinquent state. Input parameter value is numeric
with no upper limit.

UIX_UCS_CAC_MAX_PROMISE_DAYS This parameter is used to set up the maximum
number of days allowed for customers who promise
to pay when following up for delinquent accounts.
Input parameter value is numeric.

AUD_QUEUE_INITIAL_CRB_FAILED This parameter enabling will Queue the application
if any bureau failed.

UIX_UCS_CUA_MAX_FOLLOWUP_DAYS This parameter will allow the user to maintain the
Collections maximum follow-up days that are
allowed in the system.

XSL_TAX_INTERFACE This parameter is used to specify the sales tax
interface in OFSLL. Input parameter value is user
defined. In this case it is held as Manual.

CMN_SYSTEM_UNDER_MAINTENANCE This parameter specifies whether the system is
under maintenance or not. Input parameter value is
Boolean (Yes/No).

CMN_GL_POST_DT This parameter is used to define the GL Post Date
of Company in MM/DD/YYYY format. The same is
also updated by Scheduler if ENABLED.

PTX_TXN_ LAST_PURGE_DT This parameter stores the date when transactions
were purged last in the OFSLL system. Input
parameter value is date.

PUP_TUP_LAST_PURGE_ DT This parameter stores the date when transactions
upload were purged last in the OFSLL system.
Input parameter value is date.

JSC_START_OF_BUSINESS_TIME This parameter is used to set the start of business
time. Input parameter value is time in 24 hour
format.

CMN_PROMISE_FUTURE_MTHD This parameter helps to define the future promise
handling method in the system.

When multiple Promise to Pay records are defined
on an account and if any one of the promise is not
satisfied i.e. if there is no credit / Payment
transaction of the corresponding amount on the
promise date, then system uses any of the
following method defined in this parameter to
update the future promises.
• No Action on future promises (default)
• Mark current and future promises as broken
• Mark current as broken but future promise as

cancelled

A.5 Other Parameters
The following additional set of parameters are also available to control system specific data
and other administration process.
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Table A-4    Other Parameters

Parameter Description

CRB_MAX_BUREAU_PULL This parameter is used to determine the number of
credit reports automatically per applicant. Input
parameter value is numeric.

CRB_ALL_APL_BUREAU_PULL This parameter is used to set up whether credit
bureau reports should be pulled for the primary
applicant only or to all other applicants also (for
joint applications), regardless of their relationship
with the primary applicant. Input parameter value is
Boolean (Y/N).

CBU_FILE_FREQUENCY This parameter is used to set the Metro II File
Frequency and determine whether output file is to
be generated daily or monthly. If this is monthly,
then output file is written with daily data but
generated monthly.

JOINT_DEDUP_ SPOUSE_LIABILITIES This parameter is used to determine duplicate
liabilities in the Spouse’s liabilities in de-duping
logic. Input parameter value is Boolean (Yes/No).

JOINT_DEDUP_ALLAPL_LIABILITIES This parameter is used to determine duplicate
liabilities of all applicants’ liabilities in de-duping
logic, irrespective of whether they are related to
each other. Input parameter value is Boolean (Yes/
No).

ASC_COL_SER_ENABLED_IND This parameter is used for enabling the Collection
Servicing Indicator. Input parameter value is
Boolean (Y/N).

CMN_TEST_TOOL_LOGGING This parameter is used to set the testing tool
logging to enable or disable testing tool log in. Input
parameter value is Boolean (Yes/No).

ICA_INPUT_FILE_FORMAT This parameter is used to specify the Input format
for call activity file. Two Parameter values are
possible – US format and OFSLL format.

JSV_BI_USER This parameter is used to define the BI publisher
User ID. Input parameter value is user defined
(Admin user).

JSV_BI_PASSWORD This parameter is used to define the BI publisher
User password. Input parameter value is user
defined (Admin user).

PJR_COPY_PURGED_DATA This parameter is used to specify whether data
should be copied into the purge tables or not. Input
parameter value is Boolean (Yes/No).

PUP_ARCHIVE_DAYS This parameter is used to specify the number of
days after which the transactions upload details are
to be archived. Input parameter value is numeric.

PUP_OARCHIVE_DAYS This parameter is used to specify the number of
days after which the transactions upload details are
to be moved from O tables. Input parameter value
is numeric.

TPE_APPLY_LTC_FROM_CURR_DUE_DT This parameter is used to specify whether late
charge should be applied from current due date for
Pyramid Law fee method. Input parameter value is
Boolean (Yes/No).
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Table A-4    (Cont.) Other Parameters

Parameter Description

TPE_EXCESS_PAYMENT_TO_MEMO This parameter will make excess payment to the
memo payment by marking this Parameter as YES.

TPE_STOP_COMP_DELQ _DAYS This parameter is enabled to stop computation if
the account is delinquent for more than 60 days.
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B
Appendix : Webhooks

This section consists of the following topics:

• Introduction

• Webhook Architecture

• Webhook Workflow

• Webhook Message Format

• Processing Webhook Request

• Webhook Support for OBRH Integration

B.1 Introduction
The Webhook option in OFSLL extends the support of interfacing with third-party applications
by sending REST API based notifications of changes through system generated Webhook
event actions.

In the Webhook integrated model, it is the server to client direction of conversation in which the
server pushes data to the client that hosts an HTTP based API endpoint. OFSLL uses the
existing weblogic key-store to register third-party application credentials such as User Name,
Password and SSL/TSL Certificate.

B.2 Webhook Architecture

Figure B-1    Webhook Architecture

As per the above image:
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• A change in the base system can either be triggered by an user performed action or
through REST API call.

• The Events refer to system generated information indicating the change in system which is
to be propagated to third-party applications that are interfaced with OFSLL. For more
information on configuring events in the system, refer to Events section.

• The Webhook UI is the Webhook setup screen in which Webhook definitions (channel)
and Event Details are defined by registering third-party applications that are interested in
OFSLL events. For more information on configuring Webhook in the system, refer to
Webhook section.

• The Webhook Adapter is Webhook MDB (Message Driven Bean) and is used to
propagate OFSLL messages to thrid-party applications.

B.3 Webhook Workflow

Figure B-2    Webhook Workflow

As per the above workflow:

• On defining WEBHOOK, a WEBHOOK action is added to Events framework.

• Based on the Event definition defined in setup, system triggers Events.

• For all Events with WEBHOOK as the associated action, AQ JMS message is generated
and the same is consumed by WEBHOOK MDB adapter. If there is one Event subscribed
to 5 channels then system places 5 WEBHOOK messages into MDB.

• WEBHOOK MDB read the channel configuration detail from both Database and WebLogic
CSF to propagate JSON message.
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• Based on the outcome of call to the third-party application, system updates the STATUS
and HTTP response code for the message.

• A retry batch job picks the failed messages and then resubmit into AQ. The number of
retries is based on System Parameter which cannot exceed more than 5.

B.4 Webhook Message Format
Webhook Events are published in json message format. This message content can be
customized using Response User Defined Tables. For more information on json message
format, refer to Events section.

To send/receive data between OFSLL and external systems Request/Response entities are
used. OFSLL allows to send Header/Body details for data transfer with each Request/
Response.

As indicated below,

• Header consists of key value pairs some are standardized and other can be specific to
implementation.

• Body details are defined either in XML/JSON.

Figure B-3    Webhook Request/Response

B.5 Processing Webhook Request
• When an event is triggered in OFSLL, system checks if there are any Webhook actions

defined for different channels.

• If there are multiple registries available, OFSLL creates multiple WEBHOOK messages to
propagate event details to the third-party applications.

• WEBHOOK MDB reads the messages and generates response based on User Defined
Table available for individual Events.

• When response data is generated, system generates POST request to third-party
applications and marks these requests as COMPLETED on successful notification.

• If the third-party notification is failed, OFSLL updates the message as FAILED.
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• On receiving the notifications, OFSLL expects third-party application’s POST service to
return one of the following HTTP status code:

Table B-1    Processing Webhook Request

HTTP Status Code MDB Dashboard Status Description

2XX, 3XX COMPLETED

4XX FAILED Need to resubmit manually.
MDB will update retry count to 5

5XX FAILED Will be resubmitted by batch job

• The system parameter EVI_MAX_RETRY_COUNT records and controls the maximum
attempts to re-trigger FAILED Webhook requests which cannot exceed more than 5 times.
However, this parameter can be modified if the maximum re-trigger attempts is to be less
than 5 times.

• The batch job EVEPRC_BJ_100_02 in SET-EVE batch job set picks the FAILED status
messages for re-trigger and considers the above system parameter to control the
maximum attempts to re-trigger.

• The system parameter CMN_HTTP_CONNECTION_TIMEOUT determines the maximum
allowed response time (in seconds) from the third-party application. If response time
exceeds than the system parameter configured value, then the status of request is updated
as FAILED with 500 HTTP Status Code.

• If the system is running behind a firewall/proxy network, OFSLL provides below system
parameters to configure proxy details.

Table B-2    System Parameters

System Parameter Description

CMN_HTTP_PROXY_ENABLED_IND PROXY INDICATOR FOR ALL OUTSIDE HTTP/
HTTPS CONNECTION

CMN_HTTP_PROXY_PORT HTTP PROXY SERVER PORT FOR OUTGOING
HTTP CONNECTIONS

CMN_HTTP_PROXY_SERVER HTTP PROXY SERVER FOR OUTGOING HTTP
CONNECTIONS

B.6 Webhook Support for OBRH Integration
OFSLL supports integration with OBRH (Oracle Banking Routing Hub) which is used to
Authenticate, Invoke and Route request from Source to Destination using SOAP/Rest Api.

Below is a representation of OBRH process indicating how data from source (Service
Consumer) is processed to destination (Service Provider) using OBRH gateway which
supports transforming, routing, authenticating the request and response.

For details about the request and response format, refer to Webhook Message Format section.
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Figure B-4    Webhook OBRH

This section consists of the following topic:

• OBRH Interfacing support

B.6.1 OBRH Interfacing support
Webhook in OFSLL facilitates to send Event outcome data to external system. If the external
system is OBRH which is the endpoint to receive and process Event data payload from
OFSLL, ensure that the Authentication Mode in Webhook is configured to ORACLE BANKING
ROUTING HUB. For more information, refer to Webhook Definition section.

Below is an illustration indicating the flow of data between OFSLL and OBRH.
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Figure B-5    Webhook - OBRH Process

• OFSLL Webhook generates events which are configured for specific actions.

• From Webhook, the data is transferred in the form of Request using http protocol and is
first authenticated in an Authenticate Server. On authentication, a response is received in
Response Token Key.

• Post authentication, to connect OBRH, OFSLL further needs to send addition
Authentication attributes and Request Header. The same can be defined in Attribute Value
field of Webhook definition. For more information, refer to Authentication Attributes
section.
Below are some of the example of Attribute Values that can be defined for OBRH headers:

Table B-3    OBRH Interfacing support

Attribute Value Example

TOKEN REQUEST HEADER – appId

REQUEST HEADER – entityId
– appId
– branchCode
– userId
– SERVICE-CONSUMER
– SERVICE-CONSUMER SERVICE
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Note

OBRH currently does not support return of customizing HTTP header [X-Hmac]
because of which enable of Verified indicator using Test button cannot be done.
Verification functionality should be done manually/via script and needs to be
automated using OBRH once new feature of customizing HTTP header is
enabled.
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C
Appendix : Configuration at Company Level

This section consists of the following topics:

• Introduction

• Existing Configuration

• Configuration at Company Level

• Setup Company Definition

• Setup Multiple Companies in Same/Different Time Zone

• Impact on Defining Configuration at Company Level

C.1 Introduction
OFSLL supports defining multiple Portfolio Companies in an Organization and facilitates to
configure these Portfolio Companies to operate in different time zones. The nightly batch jobs
for processing can also be configured to run as per the operating hours of the Portfolio
Companies.

Using this, system can be configured in Setup to either process at Organization level or at
Company level. To process at Organization level, no specific change is required since it is the
default setup.

The below details in this section is intended to give an overview of the changes required to
setup the system to process at Company level.

C.2 Existing Configuration
In the default setup, there is no definition of GL date at company level and this implies that
organization can define the independent companies to which accounts belongs. But the EOD
scheduling and job run happens at organization level and ‘not’ at each company level. Also the
GL date is defined at System Parameters Level.

Figure C-1    Existing Configuration
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C.3 Configuration at Company Level
In the configuration at Company level (not Branch level), the following options are supported:

• To configure only one EOD schedule for one or all companies - Configure batch jobs at
ALL level with or without having multiple company definitions. If OFSLL is upgraded from
earlier to current release version, this helps to continue with existing ALL company level
scheduling of batch job run.

• To configure EOD for each company independently - Define GL date at each Company
level to schedule and run batch jobs at each company level. The scheduler changes the
GL date of specific company, after successful completion of batch job run.

However in this setup, note that:

• It is advised to Enable flag at ALL GL date level, but disable batch jobs at ALL level so that
scheduler does the rollover of date but does not pick-up batch jobs for EOD run.

• After EOD run, system rollovers the GL date or ALL company entry, after completion of run
of other specific company GL date rollover.

• Ensure the Company parameter System Under Maintenance is also set to Y for
corresponding company during EOD run of same company.

• Company Start of Business Time can be configured at company level. If the parameter
value is set to 0500, it implies that scheduler rollovers the GL date based on this time.

• System refers the Company Time Zone (new field at company definition page) to identify
the time zone in company parameter.

Figure C-2    Configuration at Company Level

C.4 Setup Company Definition
In this setup, define the company and company parameters.

1. Define Company and date format
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• Define the company in Companies Definition screen and ensure to maintain
Company Time Zone.

• Define company code with Alphanumeric characters only.

• Ensure to define the Display Format organization Definition Division Definition
Display Formats.

Note

Fixed simple date format definition is one time setup for each company and Admin
user is not expected to change it again in life time. Currently it is allowed to select
only MM/DD/YYYY format.

2. Define the following company parameters:
The default shipped seed data of Company level GL date is set to All.

• GL POST DATE - COMPANY IN MM/DD/YYYY FORMAT (UPDATED BY
SCHEDULER IF ENABLED)

• CMN_SYSTEM_UNDER_MAINTENANCE - SYSTEM UNDER MAINTENANCE

• JSC_START_OF_BUSINESS_TIME (COMPANY START OF BUSINESS TIME (24HR
FORMAT)

• PTX_TXN_LAST_PURGE_DT - LAST PURGE DATE OF TXNS

• PUP_TUP_LAST_PURGE_DT - LAST PURGE DATE OF TXNS UPLOAD

Example: The following is an illustration on how 3 companies are defined with 3 different
time Zones in USA, UK and Australia.

Figure C-3    Setup Company Definition

Table C-1    Company Parameters

Parameter USA UK AUS

GL Post Date 31 Dec 2019 02 Jan 2020 02 Jan 2020
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Table C-1    (Cont.) Company Parameters

Parameter USA UK AUS

CMN_SYSTEM_UNDER
_MAINTENANCE

Y N N

JSC_START_OF_BUSIN
ESS_TIME

0500 0500 0500

PTX_TXN_LAST_PURG
E_DT

01/01/2019 01/01/2019 01/01/2019

PUP_TUP_LAST_PURG
E_DT

01/01/2019 01/01/2019 01/01/2019

This section consists of the following topics:

• Holiday Setup and Processing

• Batch Jobs Processing

C.4.1 Holiday Setup and Processing
The holiday defined in setup is processed as indicated below:

• Scheduler picks up the jobs for EOD run based on Next Date and time' set at each batch
job level.

• After successful completion of job run for the individual company, system rollovers the date
for respective company.

• Once the EOD run and date rollover is completed for individual company, system verifies
the Enabled indicator for All company. If none of batch jobs are enabled - rollovers the
ALL GL date.

• If 01 Jan 2020 is recorded as holiday in setup, scheduler will/will not execute the batch
jobs based on the Batch job holiday maintenance and subsequently rollovers the next date
to 02 Jan 2020, at proper start of business time for the company.

C.4.2 Batch Jobs Processing
The default shipped seed data of Batch Jobs is set to All. Define the company and copy the
batch jobs. Note that the Copy option copies all the batch jobs at one go.

C.5 Setup Multiple Companies in Same/Different Time Zone
• Define company level time zone using the field Company Time Zone at Companies

Definition screen.

• This parameter is used to consider the Company level and Start of Business Time. The
same can be configured to the same time zone or different time zone for scheduler to
process EOD / BOD.

• Company wise file upload facility is supported as follows:
As part of creating company, following are automated:

– Directory objects in db is created

– System parameter is created for directories
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– External table is created for selected uploads - collateral and txn upload automatically

– Physical directories are not created

– Directory permissions is to be defined manual

• If Company specific file upload jobs are used, the file upload process happens from
company specific folders.

This section consists of the following topics:

• Setup for New Company Added Subsequently

C.5.1 Setup for New Company Added Subsequently
For New Company Added Subsequently (not on Day zero), follow the same steps to be
followed on Day zero setup. Raise SR to execute script of directory creation of new company
for file upload.

C.6 Impact on Defining Configuration at Company Level
System displays the following details at each configured Company level.

• Company Level Configuration Settings

• Scheduler

• Debug Logs

• Setup Screens

• File Uploads

• Transactions

• Web Services

• Letters, Correspondence

• Reports

• Credit Bureau & Metro II

• GL

• ODD1, ODD2, ODD3

• Migration

• Conversion

• Archive

• Purge

• Standard Payees

• Data Masking

• WFP Module

• Batch Jobs and File uploads

• Assumptions
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C.6.1 Company Level Configuration Settings
Company level LOV selection is available at following screens to configure:

• System Monitor > Batch Jobs

• System Monitor > Jobs > Batch

• System Monitor > Jobs > Background

• System Monitor > Jobs > Credit Request

• System Monitor > JMS Queues > Messages

• System Monitor > Events

• Data Files > Input folder

C.6.2 Scheduler
Once the batch jobs are completed for that specific company, scheduler picks-up the company
specific scheduled batch jobs and updates the GL Post Date of that specific company.

Note

• No two companies should be configured to run jobs by scheduler at the same
time.

• Ensure to setup the Parent and child batch jobs with marginal difference in time
setup to get picked-up by the scheduler.

C.6.3 Debug Logs
• Batch level Debug logs are maintained at system parameter level and allowed to enable /

disable debug batch job logging at system parameter level only.

• System allows to enable batch job level debug jobs by enabling in User Defined Table.

• The debug log file generated is appended with Company Name.

• The date format in debug logs is MM/DD/YYYY - standard format only, irrespective of logs
generated for any company.

C.6.4 Setup Screens
All setup screens refers to system date for validation. Example: Start and End Date.

C.6.5 File Uploads
If only ALL Company Definition is used, the file upload process continues to use the existing
folder and infrastructure.

• As part of creating company, following are automated:

– Directory objects in db is created

– System parameter is created for directories
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– External table is created for selected uploads - collateral and txn upload automatically

– Physical directories are not created

– Directory permissions is to be defined manual

• If Company specific file upload jobs are used, the file upload process happens from
company specific folders.

This section consists of the following topics:

• Input File

• Output File

C.6.5.1 Input File
The Input File is processed based on the following conditions:

• Changes are accepted in same file structure and input file has to be placed under input/
directory/company specific folder.

• In case certain file does not have company definition like Asset Upload, the same can be
placed in any company folder to process and upload records.

• Some input files are not programmed to refer Data Files > Input file definitions and hence
any date in the file will follow MM/DD/YYYY format. For example, Call activity posting,
promise date are to be given in the same format.

• Some input files are programmed to refer Data Files > Input file definitions and hence
system expects the date in the file as defined as date format in definition.

C.6.5.2 Output File
Output file name is appended with Company Name and is generated in one folder.

Note

A script crt_company_directories.sh is provided with installer in the path
core_db\ofslldb.zip\dba_utils\ to create directories and to create folders for
each defined Company. The same is to be run during installation. Also, the CLOB
indicator is retained at system parameter level.

C.6.6 Transactions
• Monetary transaction refers to the company specific GL date.

• Non-Monetary transactions refers to system date.

• Transactions data in the account continues to show the dates with reference to Fixed
simple date format maintained at company level.

C.6.7 Web Services
• GL date of service refers to company level GL date.

• Company has to be passed for certain web services to take reference of corresponding
company GL date.
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C.6.8 Letters, Correspondence
• Letters are generated based on company level batch job run.

• Date format in letter is not controlled by company level display format and refers to the
letter template.

C.6.9 Reports
• Changes are done to report template and reports are generated with Company Name

appended to file and generated data for specific company, where the job is run.

• Date format in report is not controlled by company level display format and refers to the
report template.

C.6.10 Credit Bureau & Metro II
• Bureau pull does not have any impact to handle because user has to select the specific

company and then bureau triggers the pull from UI.

• Metro II - No impact. System generates file for all companies; but based on product level
flag and with configured setup.

C.6.11 GL
Current GL Setup (Attributes, Translations and Transaction Links and so on) is at Company
level and hence there is no impact.

C.6.12 ODD1, ODD2, ODD3
If job is run at company level,

• ODD1 (Producer ACH, Adverse Action letters, Adverse Action Condition Letter file) job
generates the data at company level.

• ODD2 (Account ACH, Vendor ACH, Statement, Letter File and so on) job generates the
data at company level.

• ODD3 job generates the data at company level.

C.6.13 Migration
For all screens where company has been added, the default value ALL is provided and user is
expected to enable this in seed data screen.

C.6.14 Conversion
No specific impact since API tables have definition of company. User can upload the
conversion files based on company.

C.6.15 Archive
Parameter to specify the archive days are defined at system level but user can run the Archive
batch jobs at each company level and the same archives data for that specific company.
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C.6.16 Purge
Parameter to specify the purge days and following parameters are moved to company level.

• PTX_TXN_LAST_PURGE_DT - LAST PURGE DATE OF TXNS

• PUP_TUP_LAST_PURGE_DT - LAST PURGE DATE OF TXNS UPLOAD

C.6.17 Standard Payees
• User would be able to define payee bank account for each company / branch combination.

• AP Requisition batch job generates the requisition considering the account number defined
at company level.

C.6.18 Data Masking
Not handled and hence data masking can be configured at organization level only.

C.6.19 WFP Module
Not handled.

C.6.20 Batch Jobs and File uploads
For list of batch jobs and File uploads handled to run at company level, refer to product release
notes.

C.6.21 Assumptions
System considers the criteria defined for company in Queues > Criteria Based Condition
screen and ignores the branch level differentiation across application. Hence, even if user
defines multiple records (as indicated below), system considers the combination as same and
executes records are company level.

Company = AUS and Branch = ALL

Company = AUS and Branch = Sydney
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Figure C-4    Criteria Based Condition
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